Manuale di aiuto di GnuCash

Yawar Amin, Gruppo della documentazione di GnuCash
J. Alex Aycinena, Gruppo della documentazione di GnuCash
Frank Ellenberger, Gruppo della documentazione di GnuCash
Chris Good, Gruppo della documentazione di GnuCash
Dave Herman, Gruppo della documentazione di GnuCash
Geert Janssens, Gruppo di sviluppo di GnuCash
Chris Lyttle, Gruppo della documentazione di GnuCash
Cristian Marchi, Gruppo della documentazione di GnuCash
John Ralls, Gruppo della documentazione di GnuCash
Robert Ratliff, Gruppo della documentazione di GnuCash
Mark Simpson, Gruppo della documentazione di GnuCash
Christian Stimming, Gruppo della documentazione di GnuCash
Manuale di aiuto di GnuCash
di Yawar Amin, J. Alex Aycinena, Frank Ellenberger, Chris Good, Dave Herman, Geert Janssens, Chris Lyttle, Cristian Marchi, John Ralls, Robert Ratliff, Mark Simpson, e Christian Stimming

Questo manuale descrive l’utilizzo del programma finanziario GnuCash.

Diritto d’autore © 2002-2020 Gruppo della documentazione di GnuCash
Diritto d'autore © 2011 Cristian Marchi

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License (GFDL), Version 1.1 or any later version published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts. You can find a copy of the GFDL at this link [ghelp:fdl] or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this manual separately from the collection, you can do so by adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are claimed as trademarks. Where those names appear in any GNOME documentation, and the members of the GNOME Documentation Project are made aware of those trademarks, then the names are in capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED UNDER THE TERMS OF THE GNU FREE DOCUMENTATION LICENSE WITH THE FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS FREE OF DEFECTS MERCHANTABILITY, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. THE ENTIRE RISK AS TO THE QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES ARISING OUT OF OR RELATING TO USE OF THE DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Commenti

Per avvertire della presenza di un bug o per proporre dei suggerimenti a riguardo di questo programma o del manuale, seguire le istruzioni fornite nel sistema di tracciamento dei bug di GnuCash [http://bugs.gnucash.org]. Per contribuire alla traduzione del manuale segnalando eventuali errori, inviare un messaggio alla lista Italiana di GnuCash contattabile inviando una mail all’indirizzo <gnucash-it@gnucash.org>
# Indice

1. Introduzione a GnuCash ................................................................. 1
2. Utilizzare questo documento e ottenere assistenza ........................................ 2  
   Accedere all’aiuto ........................................................................... 2  
   Guida ai concetti e manuale di GnuCash ................................................... 2  
   Assistenza on-line di GnuCash .................................................................. 3  
3. Per iniziare ....................................................................................... 4  
   Avviare GnuCash ................................................................................. 4  
   Schermata di Benvenuto in GnuCash! ....................................................... 4  
   Impostare una nuova struttura dei conti ...................................................... 4  
   Importare i file QIF .............................................................................. 6  
   Suggerimento del giorno ......................................................................... 10  
4. Panoramica delle finestre e delle opzioni del menu di GnuCash .................. 11  
   Finestre e menu di GnuCash .................................................................. 11  
   Finestra principale di GnuCash ................................................................. 11  
   La scheda dei conti .............................................................................. 12  
   Struttura dei conti - Menu .................................................................. 13  
   Struttura dei conti - Pulsanti e icone della barra degli strumenti .............. 22  
   Barra delle schede .............................................................................. 22  
   Riquadro principale - Struttura dei conti ................................................... 22  
   Barra di riepilogo ............................................................................... 23  
   Barra di stato .................................................................................... 23  
   Registro del conto/Libro mastro generale ................................................. 23  
   Registro del conto e finestra del libro mastro generale ................................ 23  
   Menu del registro dei conti ................................................................... 24  
   Registro del conto - Icone e pulsanti della barra degli strumenti ............ 30  
   Barra delle schede .............................................................................. 31  
   Elenco delle transazioni ....................................................................... 31  
   Barra di riepilogo ............................................................................... 31  
   Barra di stato .................................................................................... 31  
   Finestra del resoconto ......................................................................... 31  
   Finestra di visualizzazione del resoconto ............................................... 31  
   Menu Resoconti ............................................................................... 32  
   Resoconti - Icone dei pulsanti della barra degli strumenti ...................... 36  
   Barra delle schede .............................................................................. 37  
   Schermata principale del resoconto ........................................................ 37  
   Barra di riepilogo ............................................................................... 37  
   Barra di stato .................................................................................... 37  
   Finestra di riconciliazione ...................................................................... 37  
   Finestra di riconciliazione ...................................................................... 37  
   Finestra della transazione pianificata ...................................................... 39  
   Finestra principale delle transazioni pianificate ...................................... 39  
   Budget Window .................................................................................. 41  
   Budget Window Menus ....................................................................... 41  
   Budget Window Toolbar Buttons ............................................................ 42  
   Budget Window Main Display .................................................................. 43  
   Budget Options .................................................................................. 43  
   Business Windows ............................................................................... 43  
   Customers Overview ........................................................................... 43  
   Vendors Overview ............................................................................. 44  
   Employees Overview .......................................................................... 44  
5. Impostare, modificare e lavorare con i conti ............................................ 46
Tipi di conti in GnuCash .......................................................... 46
Creare una struttura dei conti .................................................. 48
Modificare una struttura dei conti ............................................. 48
Creare un nuovo conto ............................................................ 49

Scheda delle informazioni generali ........................................... 49
Scheda del bilancio di apertura ................................................ 53
Modificare un conto ............................................................... 54
Rinumerare i sotoconti ........................................................... 54
Cancellare un conto ............................................................... 55
Riconciliare un conto a un estratto conto ................................. 55

Reconciling Information ......................................................... 56
Riconcilia ........................................................................... 56
6. Operazioni comuni per le transazioni .................................... 59
Cambiare la visualizzazione del registro ................................... 59
Transfer Funds Dialog Box ....................................................... 59

Basic Information ............................................................... 60
Transfer Accounts .............................................................. 60
Currency Transfer .............................................................. 60
Finishing Up ..................................................................... 61

Inserire una transazione dal registro ...................................... 61
Inserimento diretto dalla finestra del registro ............................ 61
Transazioni con suddivisioni multiple ..................................... 62
Multiple Currency/Commodity Transactions ............................... 64
Modificare una transazione .................................................... 64
Cancellare una transazione .................................................... 65
Rimuovere le suddivisioni da una transazione ........................... 65
Copiare una transazione ....................................................... 65
Setting the reconcile status (R field) of a transaction ................. 66
Saltare al registro di un altro conto ......................................... 66
Pianificare le transazioni ...................................................... 66

Finestra della transazione pianificata ...................................... 67
Finestra di modifica della transazione pianificata ....................... 68
Stampare gli assegni ............................................................ 68

Operazioni online... ............................................................. 69

Ricevi saldo ......................................................................... 69
Ricevi transazioni .............................................................. 69
Inoltra transazione ............................................................. 70
Addebito diretto ................................................................. 70

Giornale generale ............................................................... 70

7. Business Features ............................................................. 71
Initial Setup ...................................................................... 71

Account Setup ................................................................. 71
Tax Tables ........................................................................ 71
Company Registration .......................................................... 72
Counters ........................................................................ 72
Business Preferences ............................................................ 72
Billing Terms .................................................................... 72

Crediti correnti ................................................................. 73
Customers ....................................................................... 74

Nuovo ........................................................................... 74
Find and Edit ................................................................. 75

Fatture ........................................................................... 76

Nuovo ........................................................................... 76
Modifica ....................................................................... 76
8. Strumenti e assistenti

Post ................................................................. 78
Find ................................................................. 78
Stampa ............................................................. 79
Assign Starting Invoice Number ................................ 79
Customer Jobs .................................................... 79
Process Payment .................................................... 80
  Over Payments or Pre-Payments ............................... 81
  Partial Payments ................................................ 81
  Writing Off a Bad Debt ........................................ 81
Changing the Invoice Appearance .............................. 82
Debiti correnti ..................................................... 83
Vendors .............................................................. 83
  Nuovo .............................................................. 83
  Find and Edit ..................................................... 83
Ricevute ............................................................ 84
  Nuovo .............................................................. 84
  Modifica .......................................................... 85
  Post ............................................................... 86
  Find .............................................................. 86
Vendor Jobs .......................................................... 87
Process Payment ..................................................... 87
  Over Payments or Pre-Payments ............................... 88
  Partial Payments ................................................ 88
Employees .......................................................... 88
  New Employee .................................................... 88
  Find and Edit ..................................................... 89
  New Expense Voucher/Credit Note ......................... 90
  Find and Edit Expense Voucher/Credit Note ............. 91

8. Strumenti e assistenti

Find ................................................................. 92
  Find Transaction ................................................ 92
  Find Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher 96
Assistente dall’ultimo avvio .................................. 104
Assistente per mutui e ipoteche ............................... 105
Registrare un frazionamento azionario ..................... 108
  Assistente per il frazionamento azionario ................ 108
Procedura guidata per l’Online Banking ..................... 109
Editor prezzi ........................................................ 109
  Aggiungere manualmente il prezzo di un’azione .......... 110
  Configurazione per l’utilizzo del pulsante Ricevi quotazioni 111
Editor titoli ........................................................ 111
  Aggiungere o modificare una commodity .................. 112
  Configurare titoli e valute per la ricezione online dei prezzi 112
Calculatore di prestiti .......................................... 112
Chiusi libro ......................................................... 113
  Dialog Box Details .............................................. 113
  How It Works .................................................... 113
  What It Doesn’t Do ............................................. 114
  Necessity ........................................................ 114
  Conclusion ....................................................... 114
Lots in Account .................................................. 114
  Lots for Security Capital Gains .............................. 114
  Lots for Business Features ................................... 118

9. Resoconti e diagrammi ........................................... 119
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>119</td>
</tr>
<tr>
<td>Saving a Report Configuration</td>
<td>119</td>
</tr>
<tr>
<td>Working with Saved Report Configurations</td>
<td>120</td>
</tr>
<tr>
<td>Configuring Reports and Charts</td>
<td>120</td>
</tr>
<tr>
<td>Report Options Buttons</td>
<td>120</td>
</tr>
<tr>
<td>Common Report Options</td>
<td>120</td>
</tr>
<tr>
<td>Reports Listed By Class</td>
<td>122</td>
</tr>
<tr>
<td>Resoconti generali</td>
<td>122</td>
</tr>
<tr>
<td>Attività e passività</td>
<td>128</td>
</tr>
<tr>
<td>Resoconti per gli affari</td>
<td>132</td>
</tr>
<tr>
<td>Entrate e Uscite</td>
<td>136</td>
</tr>
<tr>
<td>Esempi e personalizzazioni</td>
<td>136</td>
</tr>
<tr>
<td>Bilancio</td>
<td>137</td>
</tr>
<tr>
<td>Printing or Exporting Reports and Charts</td>
<td>138</td>
</tr>
<tr>
<td>Creating Reports and Charts</td>
<td>139</td>
</tr>
<tr>
<td>Accessing the GnuCash API</td>
<td>139</td>
</tr>
<tr>
<td>Report Rendering</td>
<td>139</td>
</tr>
<tr>
<td>10. Personalizzare GnuCash</td>
<td>140</td>
</tr>
<tr>
<td>Opzioni di visualizzazione del conto</td>
<td>140</td>
</tr>
<tr>
<td>Impostare le preferenze</td>
<td>140</td>
</tr>
<tr>
<td>Periodo contabile</td>
<td>141</td>
</tr>
<tr>
<td>Conti</td>
<td>142</td>
</tr>
<tr>
<td>Impresa</td>
<td>143</td>
</tr>
<tr>
<td>Data e ora</td>
<td>144</td>
</tr>
<tr>
<td>Generali</td>
<td>145</td>
</tr>
<tr>
<td>Online Banking</td>
<td>147</td>
</tr>
<tr>
<td>Stampa</td>
<td>149</td>
</tr>
<tr>
<td>Registro</td>
<td>150</td>
</tr>
<tr>
<td>Predefinite del registro</td>
<td>151</td>
</tr>
<tr>
<td>Resoconti</td>
<td>152</td>
</tr>
<tr>
<td>Transazioni pianificate</td>
<td>153</td>
</tr>
<tr>
<td>Finestre</td>
<td>154</td>
</tr>
<tr>
<td>Book Options</td>
<td>155</td>
</tr>
<tr>
<td>Accounts Book Options Tab</td>
<td>155</td>
</tr>
<tr>
<td>Budgeting Book Options Tab</td>
<td>157</td>
</tr>
<tr>
<td>Business Book Options Tab</td>
<td>157</td>
</tr>
<tr>
<td>Counters Book Options Tab</td>
<td>157</td>
</tr>
<tr>
<td>Modificare i fogli di stile</td>
<td>158</td>
</tr>
<tr>
<td>Foglio di stile predefinito</td>
<td>158</td>
</tr>
<tr>
<td>Foglio di stile Semplice</td>
<td>159</td>
</tr>
<tr>
<td>Foglio di stile Piè di pagina</td>
<td>161</td>
</tr>
<tr>
<td>Foglio di stile Technicolor</td>
<td>162</td>
</tr>
<tr>
<td>Impostare le opzioni per i resoconti delle tasse</td>
<td>164</td>
</tr>
<tr>
<td>TXF Export - Known Anomalies and Limitations</td>
<td>165</td>
</tr>
<tr>
<td>Detailed TXF Category Descriptions</td>
<td>166</td>
</tr>
<tr>
<td>Ripristina avvisi</td>
<td>195</td>
</tr>
<tr>
<td>Changing the Language</td>
<td>196</td>
</tr>
<tr>
<td>A. Suggerimenti e consigli utili su GnuCash</td>
<td>198</td>
</tr>
<tr>
<td>Finance::Quote Sources</td>
<td>198</td>
</tr>
<tr>
<td>Finance::Quote Sources - Currency source</td>
<td>198</td>
</tr>
<tr>
<td>Fonti delle quotazioni - fonti individuali</td>
<td>198</td>
</tr>
<tr>
<td>Finance::Quote Sources - Multiple sources</td>
<td>200</td>
</tr>
<tr>
<td>Yahoo Specifics</td>
<td>201</td>
</tr>
<tr>
<td>TIAA-CREF Specifics</td>
<td>203</td>
</tr>
</tbody>
</table>
## Lista delle figure

4.1. La finestra principale di GnuCash ................................................................. 11  
4.2. Una visualizzazione della struttura ad albero dei conti .................................. 12  
4.3. La visualizzazione del registro del conto ....................................................... 24  
4.4. La finestra del resoconto .................................................................................. 32  
8.1. Lots in Account window for Security Capital Gains ........................................ 114  
8.2. Lots in Account window for business features .................................................. 118  
9.1. Transaction Report, Report Options ................................................................. 123  
10.1. The Preferences window, Accounting Period tab ............................................ 141  
10.2. The Preferences window, Accounts tab ......................................................... 142  
10.3. The Preferences window, Business tab ......................................................... 143  
10.4. The Preferences window, Date/Time tab ....................................................... 144  
10.5. The Preferences window, General tab ............................................................ 145  
10.6. The Preferences window, Online Banking tab ............................................... 147  
10.7. The Preferences window, Printing tab ............................................................ 149  
10.8. The Preferences window, Register tab ............................................................ 150  
10.9. The Preferences window, Register Defaults tab ............................................... 151  
10.10. The Preferences window, Reports tab ............................................................ 152  
10.11. The Preferences window, Scheduled Transactions tab .................................. 153  
10.12. The Preferences window, Windows tab .......................................................... 154
Lista delle tabelle

4.1. Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa. .......................................................... 13
4.2. Struttura dei conti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati. ............................................................................................................ 14
4.3. Struttura dei conti - Menu Visualizza - modifica la vista della finestra. .......................................................... 15
4.4. Struttura dei conti - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni. ............................................................................................................. 16
4.5. Struttura dei conti - Menu Impresa - permette l’accesso alle funzioni di GnuCash dedicate all’impresa. .......................................................................................................................... 17
4.6. Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash. ........................................................................................................................................ 19
4.7. Struttura dei conti - Menu Strumenti - Permette l’accesso a diversi strumenti e editor .......................................................................................................................... 21
4.8. Struttura dei conti - Menu Finestre .......................................................................................................................... 21
4.9. Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale. ............................................................................................................. 21
4.10. Barra degli strumenti - Finestra della struttura dei conti .......................................................... 22
4.11. Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa. .......................................................................................................................... 24
4.12. Registro del conto - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati. ........................................................................................................................................ 26
4.13. Registro del conto - Menu Visualizza - Modifica le opzioni di visualizzazione della finestra di GnuCash. ........................................................................................................................................ 26
4.15. Registro del conto - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni. .......................................................................................................................... 28
4.16. Barra degli strumenti della finestra del registro del conto (registro delle transazioni) .......... 30
4.17. Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa. ........................................................................................................................................ 32
4.18. Resoconti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati. ........................................................................................................................................ 34
4.19. Menu Operazioni - Permette l’impostazione delle transazioni pianificate. .......................................................... 35
4.20. Report - Reports Menu. .......................................................................................................................... 36
4.21. Resoconti - Pulsanti della barra degli strumenti .......................................................................................... 36
4.22. Componenti della finestra di riconciliazione. .......................................................................................... 38
4.23. Menu Riconcilia - permette l’accesso alle informazioni di riconciliazione e ai comandi utili per terminare la riconciliazione o rinviarla. .......................................................................................................................... 38
4.24. Menu Conto - permette l’accesso alle operazioni relative al conto. ........................................................................................................................................ 38
4.25. Menu Transazione - accede alle operazioni di modifica della transazione. ........................................................................................................................................ 38
4.26. Menu Aiuto - accesso all’aiuto. .......................................................................................................................... 39
4.27. Barra degli strumenti della finestra di Riconciliazione ........................................................................... 39
4.28. Componenti della finestra per le transazioni pianificate. ........................................................................................................................................ 40
4.29. Menu Pianifica - permette di accedere alle operazioni di modifica della transazione pianificata. ........................................................................................................................................ 40
4.30. Barra degli strumenti della finestra Transazioni pianificate ........................................................................................................................................ 41
4.31. Edit Menu - Special items for the budget window. ......................................................................................... 41
4.32. Actions Menu - Items in the standard menu that relate to budgets. .......................................................... 42
4.33. Reports Menu - Items in the standard menu that relate to budgets. .......................................................... 42
4.34. Budget Window Toolbar .......................................................................................................................... 43
4.35. Budget options ................................................................................................................................................. 43
4.36. Customers Overview - Toolbar Buttons .......................................................................................................................... 43
Capitolo 1. Introduzione a GnuCash

_Cos'è GnuCash?_

GnuCash è un’applicazione per la gestione delle finanze personali e di piccole attività. È progettato per essere facile da usare, ma comunque potente e flessibile. GnuCash permette di registrare le entrate e le uscite, di riconciliare i conti bancari, di monitorare le azioni e di amministrare le finanze della propria attività professionale. È basato sulle leggi fondamentali della contabilità per assicurare registrazioni in bilancio e resoconti accurati.
Capitolo 2. Utilizzare questo documento e ottenere assistenza

Questo documento è consultabile in due modi:

• tramite le descrizioni dei componenti dell’interfaccia grafica (GUI) si accede alle spiegazioni delle opzioni disponibili e alle loro funzioni, con collegamenti alle descrizioni più approfondite e alle istruzioni di utilizzo; Capitolo 4, *Panoramica delle finestre e delle opzioni del menu di GnuCash*;

• classificando operazioni, compiti, o funzioni a seconda che si tratti di un conto, di una transazione, di un resoconto o altre operazioni particolari. Per esempio possono essere:
  - Operazioni sui conti - Capitolo 5, *Impostare, modificare e lavorare con i conti*
  - Operazioni con transazioni e registro - Capitolo 6, *Operazioni comuni per le transazioni*
  - Strumenti e assistenti - Capitolo 8, *Strumenti e assistenti*
  - Resoconti e grafici - Capitolo 9, *Ressoconti e diagrammi*
  - Personalizzazione - Capitolo 10, *Personalizzare GnuCash*

Accedere all’aiuto

Questa finestra viene visualizzata accedendo al menu Aiuto e scegliendo o Guida ai concetti e manuale oppure Sommario (F1). sezione chiamata «Struttura dei conti - Menu Aiuto»

La finestra di aiuto ha una *barra degli strumenti* il cui significato é descritto nel seguito.

• Indietro mostra l’argomento visualizzato in precedenza.

• Avanti mostra l’argomento visualizzato in precedenza.

• Aiuto permette di accedere alle pagine di aiuto di GNOME.

• Cerca Inserire qui il termine da ricercare nell’Aiuto di GNOME. Non cerca nell’aiuto di GnuCash.

Il lato destro della finestra di aiuto mostra la pagina attualmente aperta. Il lato sinistro contiene invece la lista degli argomenti. Selezionando uno degli argomenti dell’aiuto, la corrispondente pagina verrà aperta nella finestra di destra.

**Guida ai concetti e manuale di GnuCash**

La guida è il complemento a questo aiuto; spiega infatti i concetti utilizzati in GnuCash e presenta un esempio che accompagna l’utente attraverso tutte le fasi dell’utilizzo di GnuCash per gestire i propri conti. La guida verrà aperta se si sceglie Aprire la guida per i nuovi utenti nella finestra di Benvenuto in GnuCash!.

Per aprire questa guida selezionare Aiuto → Guida ai concetti e manuale dal menu.

Si raccomanda di leggere questa guida se si sta utilizzando GnuCash per la prima volta o se non si ha familiarità con i concetti della contabilità.
Assistenza on-line di GnuCash

There are several online channels you can access for more assistance.

GnuCash has several mailing lists:

- **Lista degli utenti** <gnucash-user@gnucash.org>: è indirizzata alle domande degli utenti e alle discussioni in generale. Gli sviluppatori e alcuni utenti molto disponibili, si ritrovano qui.

- **Lista degli sviluppatori** <gnucash-devel@gnucash.org>: vengono discusse le questioni riguardanti la progettazione e lo sviluppo di GnuCash, e la presentazione di patch.

Or you can chat live with the developers on IRC. Join them on #gnucash at irc.gnome.org.

The GnuCash web site [http://www.gnucash.org] has more details on these channels. You will also find pointers there to additional useful resources such as the GnuCash wiki and bug tracking system.
Capitolo 3. Per iniziare

Avviare GnuCash

GnuCash può essere avviato dal menu principale del proprio sistema selezionando la relative voce del menu.

In alternativa può essere avviato da linea di comando con il comando `gncash`.

Durante l’avvio di GnuCash verrà mostrata la schermata di avvio di GnuCash in cui sono visualizzate alcune informazioni relative al programma e al processo di caricamento.

Schermata di Benvenuto in GnuCash!

Next you will be presented with the Welcome to GnuCash! dialog with three choices:

- Create a new set of accounts: Runs the New Account Hierarchy Setup assistant (see sezione chiamata «Impostare una nuova struttura dei conti»). Select this option if you want to be assisted in creating a set of accounts.

- Import my QIF files: Runs the Import QIF Files assistant (see sezione chiamata «Importare i file QIF»). Select this option if you already have Quicken files (.qif files) from another financial application and wish to import them into GnuCash.

- Open the new user tutorial: Opens the GnuCash Tutorial and Concepts Guide. Select this option if you are completely new to GnuCash and accounting concepts.

**Nota**

È possibile eseguire le operazioni elencate anche dopo aver effettuato una scelta nella finestra, ma il menu di Benvenuto in GnuCash! non verrà visualizzato di nuovo. Per provare le altre scelte in un secondo momento, consultare sezione chiamata «Impostare una nuova struttura dei conti», sezione chiamata «Importare i file QIF» e sezione chiamata «Guida ai concetti e manuale di GnuCash» per sapere come avviarlo dal menu di GnuCash.

Questa schermata è stata pensata per consentire all’utente di GnuCash di iniziare immediatamente a utilizzare il programma. Il pulsante Annulla permette di chiudere la schermata. Premendolo verrà richiesto se Mostrare di nuovo la finestra di benvenuto. Per non far visualizzare di nuovo la schermata di Benvenuto in GnuCash! fare clic sul pulsante No. Fare clic su Sì o premere il tasto Invio della tastiera per selezionare l’opzione predefinita che prevede la riapertura al prossimo avvio della schermata di Benvenuto in GnuCash!.

**Nota**

Qualsiasi opzione venga selezionata, verrà aperta una finestra di GnuCash minimale. Le operazioni disponibili in questa finestra sono descritte in Capitolo 4, Panoramica delle finestre e delle opzioni del menu di GnuCash.

Impostare una nuova struttura dei conti

Questa procedura assiste l’utente nella creazione di un gruppo di conti in GnuCash. Apparirà se verrà selezionato Crea nuova struttura conti nel menu di Benvenuto in GnuCash!. 

4
Verrà così creato un nuovo file vuoto di GnuCash e avviato automaticamente l’assistente per l’Impostazione di una nuova struttura dei conti.

**Suggerimento**

Per avviare l’assistente manualmente, andare in File → Nuovo per creare un nuovo file. Per avviare l’assistente all’interno di un file aperto, andare in Operazioni → Nuova struttura conti... quando è visualizzata la scheda della struttura dei conti.

1. L’assistente per l’Impostazione di una nuova struttura dei conti si apre con una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.

   • Cancel: exit the process and cancel creating a new set of accounts.

   **Avvertimento**

   Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

   • Back: brings up the previous screen so that you can change a previous selection until the first screen.

   • Forward: brings up the next screen so you can continue through the assistant.

2. La schermata successiva permette la Scelta della valuta da utilizzare come predefinita per i conti.

   • La lista a comparsa Valuta: è impostata al valore configurato nella scheda Conti delle Preferenze di GnuCash (sezione chiamata «Conti»). Per assegnare ai propri conti una valuta predefinita differente, basta selezionarla dalla lista.

   • Il tasto Avanti è utilizzato per confermare la selezione e procedere alla schermata successiva.

3. La schermata successiva riguarda la Scelta dei conti da creare.

   Verrà visualizzata una schermata suddivisa in tre parti

   • La parte in alto a sinistra presenta una lista di Categorie per le strutture di conti più comunemente utilizzate. Selezionare dalla lista quella che si desidera utilizzare. È possibile selezionare tutte le categorie che si desidera.

   • La porzione in basso a sinistra presenta una Descrizione della categoria che mostra una descrizione dettagliata della categoria selezionata.

   • La porzione di destra riporta la lista dei Conti che verranno creati dalla categoria selezionata.

   • Il pulsante Seleziona tutto permette di includere tutte le categorie disponibili.

   • Il pulsante Cancella tutto permette di deselezionare tutte le categorie selezionate.

4. La schermata successiva riguarda l’Impostazione dei conti selezionati che prevede l’inserimento dei Bilanci di apertura e l’eventuale marcatura dei conti come Segnaposto.

   **Nota**

   I conti dei *capitali* non hanno un bilancio di apertura pertanto questo campo è bloccato e impostato a zero da GnuCash.
**Nota**

I conti _segnaposto_ sono utili per creare una struttura dei conti e normalmente non hanno né transazioni né bilancio di apertura.

Seguire le istruzioni a video su come selezionare un conto e inserire il bilancio di apertura. Un singolo clic permette di selezionare un conto.

- Sul lato sinistro della schermata, c’è una lista dei Nomi dei conti. Selezionare un conto con un singolo sul clic sul suo nome: verrà così aperto il campo del nome per applicare dei cambiamenti.

- Il lato destro fornisce delle opzioni selezionabile attraverso le quali è possibile indicare se il conto è un Segnaposto e un campo per aggiungere il Bilancio d’apertura per il conto selezionato. Anche qui un singolo clic nella colonna del Bilancio d’apertura o nella colonna Segnaposto apre il relativo campo per effettuare dei cambiamenti.

5. La schermata di Conclusione della configurazione dei conti è l’ultima e fornisce una descrizione delle tre scelte possibili per terminare l’assistente.

- Cancel: exits the assistant and cancels creating a new set of accounts.

**Avvertimento**

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

- Back: brings up the previous screen so that you can change a previous selection until the first screen.

- Apply: creates the accounts you have selected.

Si dovrebbe ora avere una struttura dei conti nella finestra principale di GnuCash.

**Importare i file QIF**

Questo assistente assiste nell’importazione di file Quiken (QIF). Verrà aperto se si seleziona Importare file QIF nella finestra di Benvenuto in GnuCash!.

Per avviare manualmente l’assistente, andare in File → Importa... → Importa QIF....

Nel seguito tutte le schermate che possono essere visualizzate in questo assistente sono descritte in ordine di apparizione.

1. L’ assistente per l’Importazione dei file QIF si avvia presentando una finestra contenente una breve descrizione delle sue funzionalità. I tre pulsanti in basso nella finestra non cambieranno durante tutte le fasi di utilizzo dell’assistente.

- Cancel: exit the process and cancel importing QIF files.

**Avvertimento**

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

- Back: brings up the previous screen so that you can change a previous selection until the first screen.

- Forward: brings up the next screen so you can continue through the assistant.
2. Nella schermata successiva verrà richiesto di Scegliere un file QIF da caricare. Il pulsante Seleziona... in questa finestra permette di accedere alla lista di file e cartelle aprendo il dialogo per Scegliere il file QIF.

Navigare fino alla posizione in cui sono stati salvati i propri file QIF; selezionare il primo fra quelli che si desidera importare e premere Importa. La schermata successiva visualizzerà il nome del file nella finestra per Scegliere il file QIF da importare.

Nota
Se il file che si sta caricando non possiede una data QIF verrà visualizzata la finestra per Impostare un formato di data per il file QIF. Selezionare quello appropriato dal menu a comparsa e continuare.

Nota
Se il file che si sta caricando non contiene un nome del conto verrà visualizzata la finestra per Impostare il nome predefinito del conto QIF. Diversamente verrà invece visualizzata la finestra descritta nella prossima sezione dove saranno visualizzati i file QIF caricati.

• Il campo del Nome del conto: permette di impostare un nome del conto per il file QIF.

3. La pagina successiva visualizza i File QIF che sono stati caricati. È possibile tornare alla pagina precedente e selezionare altri file QIF. Qui è anche possibile eliminare qualsiasi file che sia stato caricato per errore.

• Il pannello superiore visualizza l’elenco dei file QIF che sono stati caricati.

• Il pulsante Carica un altro file riporta alla schermata precedente per aggiungere alla lista un ulteriore file QIF.

• Il pulsante Scarta il file selezionato permette, dopo aver selezionato un file nell’elenco presente nel riquadro superiore, di rimuoverlo dall’elenco.

Quando sono stati selezionati tutti i file QIF da importare, fare clic sul pulsanti Avanti.

4. A seconda del tipo di dati contenuti nei file QIF da importare, verranno visualizzate una o più delle seguenti schermate:

Conti e azioni

Questa schermata fornisce una descrizione del processo di associazione di Conti e azioni che avverrà nella schermata successiva relativa all’Associazione dei conti QIF ai conti di GnuCash.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione dei conti QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi dei conti QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.

Per cambiare il conto di GnuCash è necessario selezionare il conto QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.
Per iniziare

- Selezionare un conto dalla lista per utilizzarne uno già esistente.
- Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.
- Il pulsante OK permette di confermare la selezione.
- Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.

Categorie di entrate e uscite

Questa schermata fornisce una descrizione del processo di associazione delle Categorie di entrate e uscite nella schermata successiva relativa all’Associazione delle categorie QIF ai conti di GnuCash.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione delle categorie QIF ai conti di GnuCash. Verrà mostrata una lista di Nomi della categoria QIF a sinistra e, a destra, il Nome del conto GnuCash suggerito. La colonna Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.

Per cambiare il conto di GnuCash è necessario selezionare la categoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.

- Selezionare un conto dalla lista per utilizzarne uno già esistente.
- Il pulsante Nuovo conto permette di aggiungere un nuovo nome di conto come sottoconto (figlio) del conto selezionato.
- Il pulsante OK permette di confermare la selezione.
- Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.

Beneficiari e promemoria

Questa schermata fornisce una descrizione del processo di associazione di Beneficiari e promemoria che avverrà nella schermata di Associazione di beneficiari e promemoria ai conti di GnuCash.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La pagina successiva permette l’Associazione di beneficiari e promemoria ai conti di GnuCash. Verrà mostrata una lista di Nomi di beneficiari e promemoria QIF a sinistra e, a destra, i Nomi dei conti di GnuCash suggeriti. Il conto predefinito di GnuCash utilizzato in questa fase ha un nome Non specificato. La colonna
Per iniziare

Nuovo? indica se il nome del conto di GnuCash verrà creato dalla procedura di importazione.

Per cambiare il conto di GnuCash è necessario selezionare il beneficiario e promemoria QIF; apparirà una finestra in cui sarà possibile selezionare un altro conto o crearne uno nuovo.

- Selezionare un conto dalla lista per utilizzarne uno già esistente.
- Il pulsante Nuovo conto permette di inserire un nuovo nome di conto come sottoconto del conto selezionato.
- Il pulsante OK permette di confermare la selezione.
- Il pulsante Annulla permette di uscire dalla finestra di dialogo scartando tutte le scelte effettuate.

5. La schermata successiva consente di Immettere la valutadel file QIF. La lista a comparsa fornisce la valuta predefinita configurata nella scheda Conti (sezione chiamata «Conti») delle Preferenze di GnuCash. Per utilizzarne una diversa, selezionarla dalla lista.

Dopo aver selezionato la valuta, premere Avanti.

6. A seconda del tipo di dati contenuti nei file QIF da importare, potrebbero essere visualizzate una o più delle seguenti schermate:

Commodity scambiabili

Questa schermata fornisce una descrizione del processo delle Commodity scambiabili.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (sezione chiamata «Online Banking») delle Preferenze di GnuCash.

Una serie di schermate per ogni azione, fondo comune o commodity, visualizza il cambio, il nome completo e il simbolo per ogni commodity elencata nel file QIF che si sta importando in modo che sia possibile controllarne le informazioni prima di procedere.

Transazioni corrispondenti

Questa schermata fornisce una descrizione del processo di associazione delle Transazioni corrispondenti che avverrà nella seguente schermata di Selezione dei possibili duplicati.

Suggerimento

Questa e le altre schermate informative dell’assistente all’Importazione di file QIF possono essere disabilitate nella scheda Online Banking (sezione chiamata «Online Banking») delle Preferenze di GnuCash.

La schermata successiva permette di Selezionare i possibili duplicati tra le transazioni. Le transazioni importate sono visualizzate nel riquadro di sinistra e le possibili transazioni corrispondenti sono riportate a destra.

- Il riquadro di sinistra mostra l’elenco delle transazioni importate tra cui selezionare i duplicati.
Per iniziare

- Il riquadro di destra mostra l’elenco dei possibili duplicati delle transazioni selezionate per l’importazione. Selezionare quella con la corrispondenza più adatta

7. L’ultima schermata, Aggiornare i conti di GnuCash, fornisce una lista di tre scelte possibili per uscire dall’assistente.

- Cancel: exit the process and cancel importing QIF files.

**Avvertimento**

Se si preme questo pulsante, qualsiasi selezione fatta fino a questo punto verrà persa.

- Back: brings up the previous screen so that you can change a previous selection until the first screen.
- Forward: imports the data and creates the accounts you have specified.

A questo punto i conti dovrebbero essere stati importati correttamente.

**Suggerimento**

Imported transactions might need to be reconciled. This process is described in the GnuCash Tutorial and Concepts guide.

**Suggerimento del giorno**

La finestra del Suggerimento del giorno si apre all’avvio di GnuCash a meno che questa funzione non sia stata disabilitata. I suggerimenti del giorno forniscono dei consigli sulle caratteristiche e sull’utilizzo di GnuCash. In basso nella finestra sono presenti tre pulsanti che permettono di muoversi tra i suggerimenti.

Chiudi  Dismiss the Tip of the Day screen
Prev    Shows the previous tip
Avanti   Shows the next tip

L’opzione Visualizza i suggerimenti all’avvio è utile per abilitare o disattivare il Suggerimento del giorno all’avvio di GnuCash.

È anche possibile configurare l’opzione di avvio del Suggerimento del giorno nella scheda Generali delle Preferenze di GnuCash. Il Suggerimento del giorno può anche essere avviato manualmente dal menu Aiuto → Suggerimento del giorno.
Capitolo 4. Panoramica delle finestre e delle opzioni del menu di GnuCash

La finestra principale di GnuCash mostra i conti, i resoconti, le voci dei menu e gli strumenti disponibili per l’elaborazione dei propri dati finanziari. Questa sezione fornisce una panoramica delle differenti finestre e sezioni di finestre che si incontreranno utilizzando GnuCash.

I collegamenti nelle varie tabelle forniranno ulteriori dettagli sull’argomento.

Finestre e menu di GnuCash

Finestra principale di GnuCash

L’accesso alle schermate secondarie utilizzate più comunemente e agli strumenti del conto, avviene attraverso questa finestra.

Figura 4.1. La finestra principale di GnuCash

All’avvio di GnuCash, dopo un paio di finestre (Schermata di avvio e suggerimento del giorno) apparirà la finestra principale. Questa è suddivisa nelle seguenti sezioni (vedere Figura 4.1, «La finestra principale di GnuCash» per un riferimento):

- **Barra del titolo**: Mostra il nome del file aperto e il nome della scheda visualizzata.
- **Barra del menu**: Visualizza le voci di menu disponibili.
Barra degli strumenti | Visualizza i pulsanti della barra degli strumenti disponibili
---|---
Barra delle schede | Elenca i resoconti, i registri e le strutture dei conti aperti
Riquadro principale | Lo spazio di visualizzazione principale in cui viene mostrato il contenuto della scheda selezionata
Barra di riepilogo | Mostra un riepilogo dei dati finanziari
Barra di stato | Contiene una breve descrizione delle voci di menu e una barra di avanzamento

**Nota**

I contenuti e le opzioni all’interno dei vari menu secondari delle varie sezioni della finestra principale di GnuCash potranno variare in funzione della finestra attiva.

La struttura dei conti è individuata con il nome Conti nella barra delle schede; qui, vengono visualizzati tutti i propri conti e un riepilogo dei rispettivi saldi. I conti sono raggruppati a seconda della tipologia basandosi sullo standard utilizzato nella contabilità.

**Suggerimento**

Per aprire un ulteriore finestra della struttura dei conti, andare in Visualizza → Nuova pagina dei conti; verrà aperta la struttura dei conti nella finestra esistente.

**Suggerimento**

Per aprire una nuova finestra con una struttura dei conti, andare in Finestre → Apri la pagina in una nuova finestra.

**La scheda dei conti**

**Figura 4.2. Una visualizzazione della struttura ad albero dei conti.**

![Immagine della scheda Conti](Image)

Questa è un’immagine della scheda Conti.
Struttura dei conti - Menu

La barra del menu per la finestra della struttura dei conti contiene le seguenti opzioni:

Struttura dei conti - Menu File

La tabella seguente descrive le opzioni del menu File.

Premendo l'opzione File sulla barra del menu, comparirà un menu «a discesa» contenente le opzioni descritte in Tabella 4.1, «Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».

### Tabella 4.1. Struttura dei conti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo file (Ctrl+N)</td>
<td>Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)</td>
</tr>
<tr>
<td>Apri... (Ctrl+O)</td>
<td>Apre un file dei dati di GnuCash già esistente.</td>
</tr>
<tr>
<td>Importa →</td>
<td>Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.</td>
</tr>
<tr>
<td>Import QIF...</td>
<td>Avvia il processo di importazione di file QIF.</td>
</tr>
<tr>
<td>Import OFX/QFX...</td>
<td>Avvia il processo di importazione di file OFX/QFX.</td>
</tr>
<tr>
<td>Import Accounts from CSV...</td>
<td>Starts the CSV Account file import process. The file to import must be in the same format as the one exported by GnuCash.</td>
</tr>
<tr>
<td>Import Transactions from CSV...</td>
<td>Starts the CSV Transactions file import process. The file to import must be a delimited file.</td>
</tr>
<tr>
<td>Ripeti file log di GnuCash...</td>
<td>Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.</td>
</tr>
<tr>
<td>Importa MT940</td>
<td>.</td>
</tr>
<tr>
<td>Importa MT942</td>
<td>.</td>
</tr>
<tr>
<td>Importa DTAUS</td>
<td>.</td>
</tr>
<tr>
<td>Importa DTAUS e invia</td>
<td>.</td>
</tr>
<tr>
<td>Import Bills &amp; Invoices...</td>
<td>Open the Import Transactions from text file window.</td>
</tr>
<tr>
<td>Import Customers and Vendors ...</td>
<td>Open the Import Customers and Vendors from text file window.</td>
</tr>
<tr>
<td>Salva (Ctrl+S)</td>
<td>Salva il file attualmente aperto.</td>
</tr>
<tr>
<td>Salva come... (Maiusc+Ctrl+S)</td>
<td>Salva il file attualmente aperto con un altro nome.</td>
</tr>
</tbody>
</table>
### Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Avvertimento</strong></td>
<td></td>
</tr>
<tr>
<td>Revert</td>
<td>Reload the last saved version of the currently opened file. Useful if you need to discard changes made to the data and not yet saved.</td>
</tr>
<tr>
<td>Stampa</td>
<td><a href="https://www.gnucash.org/">Grayed out option.</a></td>
</tr>
<tr>
<td>Imposta pagina...</td>
<td>Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.</td>
</tr>
<tr>
<td>(Maiusc+Ctrl+P)</td>
<td>Apre il menu secondario con le voci relative all’esportazione dei conti. →</td>
</tr>
<tr>
<td>Export Accounts Tree to CSV</td>
<td>Exports your account hierarchy to a delimited CSV file. Does not export data.</td>
</tr>
<tr>
<td>Export Transactions to CSV</td>
<td>Exports transactions to a delimited CSV file.</td>
</tr>
<tr>
<td>Esporta conti</td>
<td>Exports your account hierarchy to a new GnuCashfile. Does not export data.</td>
</tr>
<tr>
<td>Proprietà (Alt+Inserisci)</td>
<td>Impostazione delle opzioni per il file di GnuCash corrente.</td>
</tr>
<tr>
<td>File aperti di recente</td>
<td>Lista numerata dei file aperti più di recente da GnuCash.</td>
</tr>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Close the current tab.</td>
</tr>
</tbody>
</table>

### Nota

In the initial Account tree this item is not available - it will be grayed out.

| Esci (Ctrl+Q)          | Esce da GnuCash. |

### Struttura dei conti - Menu Modifica

**Tabella 4.2. Struttura dei conti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.**

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taglia (Ctrl+X)</td>
<td>Esegue una operazione standard di Taglio.</td>
</tr>
<tr>
<td>Copia (Ctrl+C)</td>
<td>Esegue una operazione standard di Copia.</td>
</tr>
<tr>
<td>Incolla (Ctrl+V)</td>
<td>Esegue una operazione standard di incollaggio.</td>
</tr>
<tr>
<td>Modifica conto (Ctrl+E)</td>
<td>Modifica il nome e le caratteristiche del conto selezionato. sezione chiamata «Modificare un conto»</td>
</tr>
<tr>
<td>Cancella conto...</td>
<td>Rimuove un conto. Consultare la sezione chiamata «Cancellare un conto»</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
</table>
| Rinumera sottoconti...      | Avvia l’assistente per la rinumerazione dei conti. Consultare sezione chiamata «Rinumerare i sottoconti».

**Nota**
Questa voce è disponibile solo se è stato selezionato un conto che possiede almeno un sotto-conto.

<table>
<thead>
<tr>
<th>Apri conto</th>
<th>Apre la finestra del registro per il conto selezionato.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apri sottoconti</td>
<td>Apre una finestra del registro che visualizza tutte le transazioni per il conto selezionato e per tutti i suoi sottoconti.</td>
</tr>
<tr>
<td>Trova... (Ctrl+F)</td>
<td>Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.</td>
</tr>
</tbody>
</table>
| Preferences (GnuCash → Preferences on Mac OS X). | Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare sezione chiamata «Impostare le preferenze».

<table>
<thead>
<tr>
<th>Fogli di stile</th>
<th>Permette di modificare e personalizzare i fogli di stile. Vedere la sezione chiamata «Modificare i fogli di stile».</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opzioni resoconto tasse</td>
<td>Imposta le caratteristiche delle tasse per uno o più conti (solo per Stati Uniti).</td>
</tr>
</tbody>
</table>

### Struttura dei conti - Menu Visualizza


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barra degli strumenti</td>
<td>Seleziono per abilitare o disabilitare la visualizzazione della barra degli strumenti.</td>
</tr>
<tr>
<td>Barra di riepilogo</td>
<td>Seleziono per abilitare o disabilitare la visualizzazione della barra di riepilogo.</td>
</tr>
<tr>
<td>Barra di stato</td>
<td>Seleziono per abilitare o disabilitare la visualizzazione della barra di stato.</td>
</tr>
<tr>
<td>Filtra per...</td>
<td>Imposta il filtro per i conti visualizzati nella finestra della struttura dei conti.</td>
</tr>
<tr>
<td>Aggiorna (Ctrl+R)</td>
<td>Ridisegna la schermata visualizzata.</td>
</tr>
<tr>
<td>Nuova pagina dei conti</td>
<td>Apre una nuova scheda in cui è visualizzata la struttura dei conti.</td>
</tr>
</tbody>
</table>
## Tabella 4.4. Struttura dei conti - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operazioni online →</td>
<td>Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash</td>
</tr>
<tr>
<td>Ricevi saldo</td>
<td></td>
</tr>
<tr>
<td>Ricevi transazioni</td>
<td>Scarica le transazioni dai conti online</td>
</tr>
<tr>
<td>Inoltra transazione...</td>
<td>Invia una o più transazioni a un conto online</td>
</tr>
<tr>
<td>Issue SEPA Transaction...</td>
<td></td>
</tr>
<tr>
<td>Transazione interna...</td>
<td></td>
</tr>
<tr>
<td>Addebito diretto...</td>
<td></td>
</tr>
<tr>
<td>Show log window...</td>
<td>Open the Online Banking Connection Window</td>
</tr>
<tr>
<td>Transazioni pianificate →</td>
<td>menu secondari della voce «transazioni pianificate»</td>
</tr>
<tr>
<td>Editor transazioni pianificate</td>
<td>Richiama lo strumento di modifica di una transazione pianificata. Vedere la sezione chiamata «Finestra di modifica della transazione pianificata»</td>
</tr>
<tr>
<td>Dall’ultimo avvio</td>
<td>Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. sezione chiamata «Assistente dall’ultimo avvio»</td>
</tr>
<tr>
<td>Rimborso di mutui e ipoteche...</td>
<td>Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. sezione chiamata «Assistente per mutui e ipoteche»</td>
</tr>
<tr>
<td>Bilancio →</td>
<td>Menu secondario per l’impresa</td>
</tr>
<tr>
<td>Nuovo bilancio preventivo</td>
<td>Apre la finestra per la creazione di un nuovo bilancio preventivo.</td>
</tr>
<tr>
<td>Apri bilancio preventivo</td>
<td>Apre un bilancio esistente.</td>
</tr>
<tr>
<td>Copy Budget</td>
<td>Copy a budget.</td>
</tr>
<tr>
<td>Nuovo conto...</td>
<td>Crea un nuovo conto e apre la finestra delle proprietà del conto.</td>
</tr>
<tr>
<td>Nuova struttura conti...</td>
<td>Avvia l’assistente per la creazione di una Nuova struttura conti.</td>
</tr>
<tr>
<td>Trasferimenti... (Ctrl+T)</td>
<td>Avvia la procedura di trasferimento tra conti.</td>
</tr>
<tr>
<td>Riconcilia...</td>
<td>Open the Reconcile window. sezione chiamata «Riconciliare un conto a un estratto conto»</td>
</tr>
<tr>
<td>Liquidazione automatica...</td>
<td>Apre la schermata di liquidazione automatica dove è possibile inserire le informazioni per la liquidazione automatica.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frazionamento azionario...</td>
<td>Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella sezione chiamata «Registrazione un frazionamento azionario».</td>
</tr>
<tr>
<td>Visualizza lotti...</td>
<td>Apre la schermata dei lotti nel conto.</td>
</tr>
<tr>
<td>Controlla e ripara →</td>
<td>Menu secondari della voce Controlla e ripara</td>
</tr>
<tr>
<td></td>
<td>Controlla e ripara conto</td>
</tr>
<tr>
<td></td>
<td>Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.</td>
</tr>
<tr>
<td></td>
<td>Controlla e ripara sottoconti</td>
</tr>
<tr>
<td></td>
<td>Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato e nei suoi sottoconti.</td>
</tr>
<tr>
<td></td>
<td>Controlla e ripara tutti</td>
</tr>
<tr>
<td></td>
<td>Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane in tutti i conti.</td>
</tr>
<tr>
<td>Ripristina avvisi...</td>
<td>GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.</td>
</tr>
<tr>
<td>Rinomina pagina</td>
<td>Apre la casella per rinominare la scheda o la pagina corrente.</td>
</tr>
</tbody>
</table>

Struttura dei conti - Menu Impresa


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cliente →</td>
<td>Seleziona le operazioni relative al cliente.</td>
</tr>
<tr>
<td></td>
<td>Customers Overview</td>
</tr>
<tr>
<td></td>
<td>Apre una pagina con la panoramica dei clienti.</td>
</tr>
<tr>
<td></td>
<td>Nuovo cliente...</td>
</tr>
<tr>
<td></td>
<td>Avvia la scheda per la creazione di un nuovo cliente.</td>
</tr>
<tr>
<td></td>
<td>Trova cliente...</td>
</tr>
<tr>
<td></td>
<td>Avvia la procedura di ricerca di un cliente.</td>
</tr>
<tr>
<td></td>
<td>Nuova fattura...</td>
</tr>
<tr>
<td></td>
<td>Avvia la scheda per la creazione di una nuova fattura.</td>
</tr>
<tr>
<td></td>
<td>Trova fattura...</td>
</tr>
<tr>
<td></td>
<td>Avvia la procedura di ricerca di una fattura.</td>
</tr>
<tr>
<td></td>
<td>Nuovo lavoro...</td>
</tr>
<tr>
<td></td>
<td>Avvia la scheda per la creazione di un nuovo lavoro.</td>
</tr>
<tr>
<td></td>
<td>Trova lavoro...</td>
</tr>
<tr>
<td></td>
<td>Avvia la procedura di ricerca di un lavoro.</td>
</tr>
</tbody>
</table>
### Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedura di pagamento...</td>
<td>Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.</td>
</tr>
<tr>
<td>Venditore →</td>
<td>Seleziona le operazioni relative al venditore.</td>
</tr>
<tr>
<td>Vendors Overview</td>
<td>Apre una pagina con la panoramica dei venditori.</td>
</tr>
<tr>
<td>Nuovo venditore...</td>
<td>Avvia la scheda per la creazione di un nuovo venditore.</td>
</tr>
<tr>
<td>Trova venditore...</td>
<td>Avvia la procedura di ricerca di un venditore.</td>
</tr>
<tr>
<td>Nuova ricevuta...</td>
<td>Avvia la scheda per la creazione di una nuova ricevuta.</td>
</tr>
<tr>
<td>Trova ricevuta...</td>
<td>Avvia la procedura di ricerca di una ricevuta.</td>
</tr>
<tr>
<td>Nuovo lavoro...</td>
<td>Avvia la scheda per la creazione di un nuovo lavoro.</td>
</tr>
<tr>
<td>Trova lavoro...</td>
<td>Avvia la procedura di ricerca di un lavoro.</td>
</tr>
<tr>
<td>Procedura di pagamento...</td>
<td>Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.</td>
</tr>
<tr>
<td>Dipendente →</td>
<td>Seleziona le operazioni relative al dipendente.</td>
</tr>
<tr>
<td>Employees Overview</td>
<td>Apre una pagina con la panoramica dei dipendenti.</td>
</tr>
<tr>
<td>Nuovo dipendente...</td>
<td>Avvia la scheda per la creazione di un nuovo dipendente.</td>
</tr>
<tr>
<td>Trova dipendente...</td>
<td>Avvia la procedura di ricerca di un dipendente.</td>
</tr>
<tr>
<td>Nuova nota spese...</td>
<td>Avvia la scheda per la creazione di una nuova nota spese.</td>
</tr>
<tr>
<td>Trova nota spese...</td>
<td>Avvia la procedura di ricerca di una nota spese.</td>
</tr>
<tr>
<td>Procedura di pagamento...</td>
<td>Avvia l’assistente per la procedura di pagamento. È necessario aver selezionato un conto del tipo debiti correnti per proseguire.</td>
</tr>
<tr>
<td>Tabella imposte di vendita</td>
<td>Visualizza e permette di modificare la lista di tabelle delle imposte.</td>
</tr>
<tr>
<td>Editor termini di pagamento</td>
<td>Visualizza e permette di modificare la lista dei termini di pagamento.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promemoria scadenze ricevute</td>
<td>Visualizza e permette di modificare la lista dei promemoria delle scadenze per le ricevute.</td>
</tr>
</tbody>
</table>

**Struttura dei conti - Menu Resoconti**

This is a brief listing of each of the available reports and graphs. See sezione chiamata «Reports Listed By Class» for specific report details. Each report or graph may be customized by selecting a different *Stylesheet* or by pressing the Options button in the *Toolbar*.

**Tabella 4.6. Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.**

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attività e passività →</td>
<td>Portafoglio avanzato</td>
</tr>
<tr>
<td></td>
<td>Istogramma delle attività</td>
</tr>
<tr>
<td></td>
<td>Grafico a torta delle attività</td>
</tr>
<tr>
<td></td>
<td>Saldo medio</td>
</tr>
<tr>
<td></td>
<td>Stato patrimoniale</td>
</tr>
<tr>
<td></td>
<td>Stato patrimoniale usando eguile-gnc</td>
</tr>
<tr>
<td></td>
<td>Giornale generale</td>
</tr>
<tr>
<td></td>
<td>Libro mastro generale</td>
</tr>
<tr>
<td></td>
<td>Portafoglio degli investimenti</td>
</tr>
<tr>
<td></td>
<td>Istogramma delle passività</td>
</tr>
<tr>
<td></td>
<td>Grafico a torta delle passività</td>
</tr>
<tr>
<td></td>
<td>Istogramma del patrimonio netto</td>
</tr>
<tr>
<td></td>
<td>Net Worth Linechart</td>
</tr>
<tr>
<td></td>
<td>Grafico a dispersione del prezzo</td>
</tr>
<tr>
<td>Resoconti per gli affari →</td>
<td>Resoconto venditori</td>
</tr>
<tr>
<td></td>
<td>Customer Summary</td>
</tr>
<tr>
<td></td>
<td>Fattura semplice</td>
</tr>
<tr>
<td></td>
<td>Resoconto dipendenti</td>
</tr>
<tr>
<td></td>
<td>Fattura elaborata</td>
</tr>
<tr>
<td></td>
<td>Resoconto di lavoro</td>
</tr>
<tr>
<td></td>
<td>Payable Aging</td>
</tr>
<tr>
<td></td>
<td>Fattura stampabile</td>
</tr>
<tr>
<td></td>
<td>Receivable Aging</td>
</tr>
<tr>
<td></td>
<td>Tax Invoice</td>
</tr>
<tr>
<td></td>
<td>Resoconto clienti</td>
</tr>
<tr>
<td>Voce del menu</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Entrate e Uscite</strong> →</td>
<td></td>
</tr>
<tr>
<td>Flusso di liquidi</td>
<td></td>
</tr>
<tr>
<td>Prospetto dei capitali</td>
<td></td>
</tr>
<tr>
<td>Istogramma delle uscite</td>
<td></td>
</tr>
<tr>
<td>Grafico a torta delle uscite</td>
<td></td>
</tr>
<tr>
<td>Expenses vs. Day of Week</td>
<td></td>
</tr>
<tr>
<td>Grafico delle entrate e delle uscite</td>
<td></td>
</tr>
<tr>
<td>Istogramma delle entrate</td>
<td></td>
</tr>
<tr>
<td>Grafico a torta delle entrate</td>
<td></td>
</tr>
<tr>
<td>Prospetto delle entrate</td>
<td></td>
</tr>
<tr>
<td>Income vs. Day of Week</td>
<td></td>
</tr>
<tr>
<td>Profitti e perdite</td>
<td></td>
</tr>
<tr>
<td>Bilancio di previsione</td>
<td></td>
</tr>
<tr>
<td><strong>Esempi e personalizzazioni</strong> →</td>
<td></td>
</tr>
<tr>
<td>Resoconto di benvenuto di esempio</td>
<td></td>
</tr>
<tr>
<td>Resoconto multicolonna personalizzato</td>
<td></td>
</tr>
<tr>
<td>Semplice resoconto con esempi</td>
<td></td>
</tr>
<tr>
<td><strong>Bilancio</strong> →</td>
<td></td>
</tr>
<tr>
<td>Budget Balance Sheet</td>
<td></td>
</tr>
<tr>
<td>Budget Barchart</td>
<td></td>
</tr>
<tr>
<td>Budget Flow</td>
<td></td>
</tr>
<tr>
<td>Budget Income Statement</td>
<td></td>
</tr>
<tr>
<td>Budget Profit &amp; Loss</td>
<td></td>
</tr>
<tr>
<td>Budget Report</td>
<td></td>
</tr>
<tr>
<td><strong>Sommario del conto</strong></td>
<td>Questo resoconto mostra il saldo del conto selezionato.</td>
</tr>
<tr>
<td><strong>Future Scheduled Transactions Summary</strong></td>
<td>Report showing a summary of future transactions.</td>
</tr>
<tr>
<td><strong>Resoconto tasse ed esportazione TXF</strong></td>
<td>Crea un resoconto per le tasse (US) e/o esporta i dati per un software di elaborazione delle tasse (TXF).</td>
</tr>
<tr>
<td><strong>Resoconto delle transazioni</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Saved Report Configurations</strong></td>
<td>Open the screen to manage saved user configured reports.</td>
</tr>
</tbody>
</table>
**Panoramica delle finestre e delle opzioni del menu di GnuCash**

### Struttura dei conti - Menu Strumenti

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impostazione dell’Online Banking...</td>
<td>Avvia la procedura guidata per la configurazione dell’Online Banking se GnuCash è stato compilato con il supporto per l’online banking. sezione chiamata «Procedura guidata per l’Online Banking»</td>
</tr>
<tr>
<td>Editor prezzi</td>
<td>Strumento per la modifica o l’immissione dei prezzi di titoli e fondi. Maggiori dettagli nella sezione chiamata «Editor prezzi»</td>
</tr>
<tr>
<td>Editor titoli</td>
<td>Strumento per la modifica o l’immissione di azioni e commodity. Ulteriori dettagli nella sezione chiamata «Editor titoli»</td>
</tr>
<tr>
<td>Calcolatore di prestiti</td>
<td>Ulteriori dettagli nella sezione chiamata «Calcolatore di prestiti»</td>
</tr>
<tr>
<td>Chiudi libro</td>
<td>Apre una schermata in cui è possibile inserire le informazioni necessarie alla chiusura del libro contabile corrente.</td>
</tr>
<tr>
<td>Giornale generale</td>
<td>Vedere la sezione chiamata «Giornale generale»</td>
</tr>
</tbody>
</table>

### Struttura dei conti - Menu Finestre

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuova finestra</td>
<td>Apre una nuova finestra vuota di GnuCash.</td>
</tr>
<tr>
<td>Apri la pagina in una nuova finestra</td>
<td>Sposta la scheda corrente in una nuova finestra.</td>
</tr>
<tr>
<td>Opened windows</td>
<td>A numbered list of open windows.</td>
</tr>
</tbody>
</table>

### Struttura dei conti - Menu Aiuto

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guida ai concetti e manuale</td>
<td>Spiegazione dei principi di contabilità e di come applicarli in GnuCash</td>
</tr>
<tr>
<td>Suggerimento del giorno</td>
<td>Mostra delle brevi note relative a funzioni che potrebbero non essere conosciute.</td>
</tr>
<tr>
<td>Sommario</td>
<td>Apre questo documento.</td>
</tr>
<tr>
<td>Informazioni</td>
<td>Mostra la schermata delle informazioni contenente la versione, la licenza e i ringraziamenti di GnuCash.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

Struttura dei conti - Pulsanti e icone della *barra degli strumenti*

La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La *barra degli strumenti* può essere facilmente nascosta o visualizzata selezionando la voce Visualizza → Barra degli strumenti. Le opzioni visualizzate nella barra variano a seconda delle operazioni disponibili nella scheda attiva.

Una breve descrizione della funzione di pulsante della *barra degli strumenti* viene visualizzata quando il puntatore del mouse viene mantenuto al di sopra di esso per qualche secondo.

**Tabella 4.10. Barra degli strumenti - Finestra del struttura dei conti**

<table>
<thead>
<tr>
<th>Pulsanti della <em>Barra degli strumenti</em></th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salva (Ctrl+S)</td>
<td>Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.</td>
</tr>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Chiude la pagina dei conti attualmente visualizzata</td>
</tr>
</tbody>
</table>

**Nota**

Questa icona non è disponibile se è aperta una sola scheda; è disponibile per quelle successive che vengono aperte.

<table>
<thead>
<tr>
<th>Pulsanti della <em>Barra degli strumenti</em></th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apri</td>
<td>Apre il registro delle transazioni per il conto selezionato.</td>
</tr>
<tr>
<td>Modifica</td>
<td>Permette di variare le caratteristiche del conto selezionato. sezione chiamata «Modificare un conto»</td>
</tr>
<tr>
<td>Nuovo</td>
<td>Avvia la procedura per la creazione di un nuovo conto. sezione chiamata «Creare un nuovo conto».</td>
</tr>
<tr>
<td>Cancellla</td>
<td>Rimuove il conto selezionato. sezione chiamata «Cancellare un conto»</td>
</tr>
</tbody>
</table>

**Barra delle schede**

La *barra delle schede* visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per la struttura dei conti aperti.

**Riquadro principale - Struttura dei conti**

La schermata della struttura dei conti visualizza la struttura dei conti in ordine gerarchico. Questo permette l’organizzazione dei conti in base alla tipologia.

**Suggerimento**

Il triangolo (o il segno "+") a fianco del nome del conto, è utilizzato per aprire o chiudere la struttura dei conti. Quando si preme su di esso, l’orientamento della punta cambia da rivolta verso
destra a rivolta verso il basso (diventa un segno "."), per indicare che la struttura ad albero è aperta. Più a destra rispetto al nome del conto principale, saranno visibili uno o più sottoconti che potranno a loro volta avere, a fianco del loro nome, un altro simbolo triangolare (segno "+"); questo indica la presenza di un altro livello di sottoconti.

Nel riquadro principale sono mostrate, di default, quattro colonne: Nome del conto, Tipo, Descrizione e Totale. Per ogni conto, queste informazioni, se disponibili, sono

**Suggerimento**

Le colonne visualizzate nella struttura dei conti possono essere personalizzate. Fare clic sull’icona all’estrema destra del riquadro della struttura dei conti per visualizzare una lista a comparsa delle colonne attivabili. Fare clic sul nome della colonna per aggiungerla alla finestra. Fare clic di nuovo sul nome per nasconderla.

Lo stile di visualizzazione predefinito per la finestra della struttura dei conti, è quello a "fascicolatore". Questo è indicato dalla presenza di una scheda nella riga delle schede della finestra principale. Altre schede appariranno a fianco di questa allorché vengano aperti anche dei resoconti, dei registri del conto o altre strutture dei conti.

**Barra di riepilogo**

La *barra di riepilogo* visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo attuale, qualsiasi saldo futuro, un saldo per le operazioni liquidate e un saldo di riconciliazione. I conti per le azioni, comunque, visualizzano le quote totali e il loro valore. La *barra di riepilogo* può essere nascosta o visualizzata selezionando la voce Visualizza → Barra di riepilogo dal menu.

**Barra di stato**

La *barra di stato* visualizza dei suggerimenti che forniscono maggiori dettagli sulla voce del menu selezionata e mostra anche una barra di avanzamento quando si sta apendo o salvando un file o generando un resoconto. La *barra di stato* può essere nascosta o resa visibile selezionando la voce Barra di stato presente nel menu Visualizza.

**Registro del conto/Libro mastro generale**

**Registro del conto e finestra del libro mastro generale**

Questa finestra è utilizzata per l’inserimento e la modifica dei dati del conto; fornisce anche degli strumenti per la pianificazione futura delle transazioni, per cercare e per creare dei resoconti sulle transazioni e per la stampa degli assegni.

Per aprire la finestra del registro di un conto, selezionare quest’ultimo nella struttura dei conti e poi andare in File → Apri conto o premere Ctrl+O: verrà aperta una nuova finestra con il registro del conto. Il pulsante Apri nella barra degli strumenti della finestra della struttura dei conti o il pulsante Salta nella finestra del registro, sono delle possibili alternative.
Panoramica delle finestre e delle opzioni del menu di GnuCash

Figura 4.3. La visualizzazione del registro del conto.

Questa è una schermata della scheda Registro del conto.

Suggerimento

L’aspetto del registro del conto è personalizzabile (vedere sezione chiamata «Cambiare la visualizzazione del registro»).

Nota

I metodi di inserimento delle transazioni sono descritti in maggior dettaglio in sezione chiamata «Pianificare le transazioni»

Menu del registro dei conti

La barra del menu per la finestra del registro delle transazioni, contiene le seguenti opzioni:

Registro del conto - Menu File

Selezionando la voce File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte in Tabella 4.11, «Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».

Tabella 4.11. Registro del conto - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo file (Ctrl+N)</td>
<td>Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)</td>
</tr>
<tr>
<td>Apri... (Ctrl+O)</td>
<td>Apre un file dei dati di GnuCash già esistente.</td>
</tr>
<tr>
<td>Importa →</td>
<td>Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.</td>
</tr>
<tr>
<td>Importa QIF...</td>
<td>Avvia il processo di importazione di file QIF.</td>
</tr>
</tbody>
</table>
### Voce del menu | Descrizione
--- | ---
Importa OFX/QFX... | Avvia il processo di importazione di file OFX/QFX.
Import Accounts from CSV... | Starts the CSV Account file import process. The file to import must be in the same format as the one exported by GnuCash.
Import Transactions from CSV... | Starts the CSV Transactions file import process. The file to import must be a delimited file.
Ripeti file log di GnuCash... | Avvia la ripetizione di un file di log di GnuCash. Utilie per recuperare i dati dopo un crash del programma.
Import MT940 | .
Import MT942 | .
Importa DTAUS | .
Importa DTAUS e invia | .
Import Bills & Invoices... | Open the Import Transactions from text file window.
Import Customers and Vendors ... | Open the Import Customers and Vendors from text file window.
Salva (Ctrl+S) | Salva il file attualmente aperto.
Salva come... (Maiusc+Ctrl+S) | Salva il file attualmente aperto con un altro nome.

### Avvertimento

NON salvare i file dei dati in ~/.gnucash/books.

Stampa assegni... (Ctrl+P) | Avvia l’assistente per la stampa degli assegni. Consultare sezione chiamata «Stampare gli assegni».
Imposta pagina... (Maiusc+Ctrl+P) | Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa.
Apre il menu secondario con le voci relative all’esportazione dei conti. → | Apre il menu secondario con le voci relative all’esportazione dei conti.
Export Accounts Tree to CSV | Exports your account hierarchy to a delimited CSV file. Does not export data.
Export Transactions to CSV | Exports transactions to a delimited CSV file.
Esporta conti | Exports your account hierarchy to a new GnuCash file. Does not export data.
Proprietà (Alt+Inserisci) | Impostazione delle opzioni per il file di GnuCash corrente.
File aperti di recente | Lista numerata dei file aperti più di recente da GnuCash.
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Closes the currently opened transaction register.</td>
</tr>
<tr>
<td>Esce (Ctrl+Q)</td>
<td>Esce da GnuCash.</td>
</tr>
</tbody>
</table>

Registro del conto - Menu Modifica


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taglia (Ctrl+X)</td>
<td>Esegue una operazione standard di Taglio.</td>
</tr>
<tr>
<td>Copia (Ctrl+C)</td>
<td>Esegue una operazione standard di Copia.</td>
</tr>
<tr>
<td>Incolla (Ctrl+V)</td>
<td>Esegue una operazione standard di incollaggio.</td>
</tr>
<tr>
<td>Assign as payment...</td>
<td>Assign as payment the selected transaction.</td>
</tr>
<tr>
<td>Modifica conto</td>
<td>Apre la scheda per la modifica delle caratteristiche e dei parametri del conto.</td>
</tr>
<tr>
<td>Trova... (Ctrl+F)</td>
<td>Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.</td>
</tr>
<tr>
<td>Preferences (GnuCash → Preferences on Mac OS X).</td>
<td>Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare sezione chiamata «Impostare le preferenze».</td>
</tr>
<tr>
<td>Fogli di stile</td>
<td>Permette di modificare e personalizzare i fogli di stile.</td>
</tr>
<tr>
<td>Opzioni resoconto tasse</td>
<td>Imposta le caratteristiche delle tasse per uno o più conti (US). Assign tax form and line to account.</td>
</tr>
</tbody>
</table>

Registro del conto - Menu Visualizza


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barra degli strumenti</td>
<td>Selezione per abilitare o disabilitare la visualizzazione della barra degli strumenti.</td>
</tr>
<tr>
<td>Barra di riepilogo</td>
<td>Opzione per abilitare o disabilitare la visualizzazione della barra di riepilogo.</td>
</tr>
<tr>
<td>Barra di stato</td>
<td>Opzione per abilitare o disabilitare la visualizzazione della barra di stato.</td>
</tr>
<tr>
<td>Libro mastro basilare</td>
<td>Opzione per la scelta dello stile di visualizzazione del registro.</td>
</tr>
<tr>
<td>Mastro a espansione automatica</td>
<td>Opzione per la scelta dello stile di visualizzazione del registro.</td>
</tr>
<tr>
<td>Giornale della transazione</td>
<td>Opzione per la scelta dello stile di visualizzazione del registro.</td>
</tr>
<tr>
<td>Doppia linea</td>
<td>Opzione per abilitare o disabilitare la visualizzazione a doppia linea.</td>
</tr>
</tbody>
</table>
### Voce del menu | Descrizione
---|---
**Sort by...** | Imposta il criterio di ordinamento della schermata delle transazioni. Fare clic per aprire la scheda delle opzioni. Per chiedere la scheda delle opzioni premere i pulsanti Annulla o OK.

<table>
<thead>
<tr>
<th>Ordine standard</th>
<th>Mantiene l’ordine normale del conto</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Ordina per data</td>
</tr>
<tr>
<td>Data di immissione</td>
<td>Ordina per data di immissione.</td>
</tr>
<tr>
<td>Data dell’estratto conto</td>
<td>Ordina per data dell’estratto conto (elementi non riconciliati per ultimi).</td>
</tr>
<tr>
<td>Numero</td>
<td>Ordina per numero.</td>
</tr>
<tr>
<td>Importo</td>
<td>Ordina per importo.</td>
</tr>
<tr>
<td>Promemoria</td>
<td>Ordina per promemoria.</td>
</tr>
<tr>
<td>Descrizione</td>
<td>Ordina per descrizione.</td>
</tr>
<tr>
<td>Operazioni</td>
<td>Ordina per operazione</td>
</tr>
<tr>
<td>Note</td>
<td>Ordina per campo delle note</td>
</tr>
<tr>
<td>Reverse Order</td>
<td>Reverse the sort order.</td>
</tr>
<tr>
<td>Save Sort Order</td>
<td>Save the sort order between sessions.</td>
</tr>
</tbody>
</table>

**Filtra per...** | Imposta il filtro per i conti visualizzati nella struttura dei conti o nella schermata del registro delle transazioni.

<table>
<thead>
<tr>
<th>Aggiorna (Ctrl+R)</th>
<th>Ridisegna la schermata visualizzata.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuova pagina dei conti</td>
<td>Apre una nuova scheda in cui è visualizzata la struttura dei conti.</td>
</tr>
</tbody>
</table>

---

**Registro del conto - Menu Transazione**


**Voce del menu** | **Descrizione**
---|---
Taglia transazione | Taglia la transazione selezionata e la mantiene in memoria.
Copia transazione | Copia la transazione selezionata nella memoria.
Incolla transazione | Incolla la transazione selezionata dalla memoria.
Duplica transazione | Inserisce nel registro una copia della transazione selezionata.
Elimina transazione | Cancella la transazione selezionata.
Remove Other Splits | Rimuove tutte le suddivisioni dalla transazione selezionata.
Inserisci transazione | Inserisce nel registro la transazione a cui si sta lavorando.
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annulla transazione</td>
<td>Blanks all fields in the selected transactions if it has not yet been recorded.</td>
</tr>
<tr>
<td>Invalida transazione</td>
<td>Invalida la transazione selezionata.</td>
</tr>
<tr>
<td>Riconvalida transazione</td>
<td>Riconvalida la transazione selezionata.</td>
</tr>
<tr>
<td>Aggiungi transazione di inversione</td>
<td>Add a copy of the selected transaction with an inverted amount.</td>
</tr>
<tr>
<td>Associate File with Transaction</td>
<td>Associate a file to the selected transaction.</td>
</tr>
<tr>
<td>Associate Location with Transaction</td>
<td>Associate a URL to the selected transaction.</td>
</tr>
<tr>
<td>Open Associated File/Location</td>
<td>Open the file or location associated with the transaction. Available if a file or location was associated to the currently selected transaction.</td>
</tr>
</tbody>
</table>

Registro del conto - Menu Operazioni

Tabella 4.15. Registro del conto - Menu Operazioni - Permette di impostare le transazioni pianificate, di riparare i conti, di effettuare dei frazionamenti azionari, di trasferire del denaro e di riconciliare le transazioni.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operazioni online →</td>
<td>Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash</td>
</tr>
<tr>
<td>Ricevi saldo</td>
<td>Scarica le transazioni dai conti online</td>
</tr>
<tr>
<td>Ricevi transazioni</td>
<td>Invia una o più transazioni a un conto online</td>
</tr>
<tr>
<td>Inoltra transazione...</td>
<td></td>
</tr>
<tr>
<td>Issue SEPA Transaction...</td>
<td></td>
</tr>
<tr>
<td>Transazione interna...</td>
<td></td>
</tr>
<tr>
<td>Addebito diretto...</td>
<td></td>
</tr>
<tr>
<td>Show log window...</td>
<td>Open the Online Banking Connection Window</td>
</tr>
</tbody>
</table>

Transazioni pianificate → menu secondari della voce «transazioni pianificate»

| Editor transazioni pianificate         | Richiama lo strumento di modifica di una transazione pianificata. Vedere la sezione chiamata «Finestra di modifica della transazione pianificata» |
| Dall’ultimo avvio                     | Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. sezione chiamata «Assistente dall’ultimo avvio»                                  |
| Rimborsio di mutui e ipoteche...      | Avvia l’assistente di rimborsio di mutui e ipoteche per impostare le rate. sezione chiamata «Assistente per mutui e ipoteche»                  |

28
<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bilancio →</td>
<td>Menu secondario per l’impresa</td>
</tr>
<tr>
<td></td>
<td>Nuovo bilancio preventivo</td>
</tr>
<tr>
<td></td>
<td>Apri bilancio preventivo</td>
</tr>
<tr>
<td></td>
<td>Copy Budget</td>
</tr>
<tr>
<td>Trasferimenti... (Ctrl+T)</td>
<td>Avvia la procedura di trasferimento tra conti.</td>
</tr>
<tr>
<td>Riconcilia...</td>
<td>Start the Reconcile process for the selected account. sezione chiamata «Riconciliare un conto a un estratto conto»</td>
</tr>
<tr>
<td>Frazionamento azionario...</td>
<td>Avvia l’assistente per il frazionamento azionario. Ulteriori dettagli nella sezione chiamata «Registrazione del frazionamento azionario»</td>
</tr>
<tr>
<td>Visualizza lotti...</td>
<td>Apre la schermata dei lotti nel conto.</td>
</tr>
<tr>
<td>Transazione vuota</td>
<td>Sposta la selezione alla transazione vuote sul fondo del registro</td>
</tr>
<tr>
<td>Transazione suddivisa</td>
<td>Espande la transazione selezionata mostrandone le suddivisioni.</td>
</tr>
<tr>
<td>Modifica tasso di cambio</td>
<td>Modifica il tasso di cambio della transazione selezionata.</td>
</tr>
<tr>
<td>Pianifica...</td>
<td>Crea una transazione pianificata utilizzando questa transazione come modello.</td>
</tr>
<tr>
<td>Salta</td>
<td>Salta alla transazione corrispondente nell’altro conto.</td>
</tr>
<tr>
<td>Controlla e ripara →</td>
<td>Menu secondari della voce Controlla e ripara</td>
</tr>
<tr>
<td>Tutte le transazioni</td>
<td>Ricerca e ripara le transazioni non in bilancio e le suddivisioni orfane nel conto selezionato.</td>
</tr>
<tr>
<td>Questa transazione</td>
<td>Controlla e ripara le suddivisioni in questa transazione.</td>
</tr>
<tr>
<td>Ripristina avvisi...</td>
<td>GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione, permettono di disabilitarli. L’opzione Ripristina avvisi permette di ripristinare gli avvisi predefiniti, cioè abilita la visualizzazione dei messaggi.</td>
</tr>
<tr>
<td>Rinomina pagina</td>
<td>Apre la casella per rinominare la scheda o la pagina corrente.</td>
</tr>
</tbody>
</table>

**Registro del conto - Menu Impresa**


**Registro del conto - Menu Resoconti**


- Resoconto del conto
Panoramica delle finestre e delle opzioni del menu di GnuCash

- Resoconto delle transazioni del conto

Registro del conto - Menu Strumenti


Registro del conto - Menu Finestre

Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti - Menu Finestre».

Registro del conto - Menu Aiuto

Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale.».

Registro del conto - Icone e pulsanti della barra degli strumenti

La finestra principale di GnuCash mette a disposizione una serie di pulsanti e icone utili per accedere facilmente alle funzioni più comunemente utilizzate nella scheda attiva. La barra degli strumenti può essere facilmente nascosta o visualizzata selezionando la voce Barra degli strumenti dal menu Visualizza. Le opzioni visualizzate nella barra variano a seconda delle operazioni eseguibili nella scheda attiva.

Nota

Le opzioni specifiche visualizzate nella barra degli strumenti variano in funzione delle operazioni disponibile nella scheda corrente.

Una breve descrizione della funzione di un pulsante è visualizzata quando il puntatore del mouse viene mantenuto al di sopra di essa per qualche secondo.

Tabella 4.16. Barra degli strumenti della finestra del registro del conto (registro delle transazioni)

<table>
<thead>
<tr>
<th>Pulsanti della Barra degli strumenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salva (Ctrl+S)</td>
<td>Esegue il salvataggio del file dei dati, inserendo tutte le transazioni nel file.</td>
</tr>
<tr>
<td>Chiudi</td>
<td>Chiude il registro.</td>
</tr>
<tr>
<td>Duplica</td>
<td>Permette di creare una copia della transazione selezionata.</td>
</tr>
<tr>
<td>Cancella</td>
<td>Cancella dal registro la transazione selezionata.</td>
</tr>
<tr>
<td>Inserisci</td>
<td>Registra la transazione corrente.</td>
</tr>
<tr>
<td>Annulla</td>
<td>Annulla la transazione corrente.</td>
</tr>
<tr>
<td>Vuota</td>
<td>Sposta il cursore nella transazione vuota alla fine del registro.</td>
</tr>
<tr>
<td>Suddivisione</td>
<td>Show all splits in the current transaction. Not highlighted if View → Auto-Split Ledger is enabled.</td>
</tr>
<tr>
<td>Salta</td>
<td>Salta alla transazione corrispondente nell’altro conto</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Pulsanti della Barra degli strumenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pianifica</td>
<td>Crea una transazione pianificata utilizzando questa transazione come modello.</td>
</tr>
<tr>
<td>Trasferimento</td>
<td>Avvia l’assistente per il trasferimento di fondi da un conto a un altro.</td>
</tr>
<tr>
<td>Riconcilia</td>
<td>Start the Reconcile process for the selected account. sezione chiamata «Riconciliare un conto a un estratto conto»</td>
</tr>
</tbody>
</table>

Barra delle schede

La barra delle schede visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per le strutture dei conti aperti.

Elenco delle transazioni

L’elenco delle transazioni visualizza tutti i movimenti che sono stati inseriti e un saldo corrente. Presenta anche una transazione vuota da utilizzare per inserire dei nuovi movimenti. Le intestazioni delle colonne variano in funzione del tipo di conto a cui il registro si riferisce. Le intestazioni più comunemente visualizzate sono Data, Descrizione, Trasferimento e Saldo.

Il menu Visualizza permette di modificare lo stile di visualizzazione dell’elenco delle transazioni variando il numero di elementi visualizzati, utilizzando un criterio di ordinamento differente oppure cambiando lo stile per poter visualizzare più facilmente le transazioni. Il pulsante Suddivisione permette di mostrare velocemente tutte le parti di una transazione.

Barra di riepilogo

La barra di riepilogo visualizza dei saldi relativi al tipo di conto aperto. Normalmente i conti visualizzano il saldo Attuale, il saldo Futuro, un saldo per le operazioni liquidate, un saldo di riconciliazione e un saldo Minimo previsto. I conti per le azioni, inoltre, visualizzano le quote totali e il loro valore. La barra di riepilogo puVisualizzaBarra di riepilogo dal menu.

Barra di stato

La barra di stato funziona esattamente come già descritto in sezione chiamata «Barra di stato».

Finestra del resoconto

Finestra di visualizzazione del resoconto

Questa finestra è visualizzata ogni qualvolta viene selezionato un resoconto o un grafico dal menu Resoconti.

Per aprire la finestra del resoconto, selezionare una tipologia di resoconto dalla lista fornita nel menu Resoconti. Verrà aperta una nuova finestra dove sarà visualizzato il resoconto selezionato con uno stile simile a quello di una pagina internet in cui sono visualizzati dei collegamenti attivabili ai dati del conto.

Nota

In funzione della tipologia selezionata, potrebbe essere necessario attendere qualche istante prima che la generazione del resoconto sia terminata. Nella Barra di stato è comunque possibile vedere
lo stato di avanzamento della generazione tramite la barra di progressione se questa non è stata nascosta in precedenza.

**Figura 4.4. La finestra del resoconto**

Questa è un’immagine del Grafico di entrate e uscite.

**Menu Resoconti**

La barra del menu per la finestra dei resoconti contiene le seguenti opzioni.

**Resoconti - Menu File**

La tabella seguente descrive le opzioni del menu File.

Premendo l’opzione File sulla barra del menu, comparirà un menu a discesa contenente le opzioni descritte in Tabella 4.17, «Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.».

**Tabella 4.17. Resoconti - Menu File - Permette l’accesso ai file, alle operazioni sui conti e alla stampa.**

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo file (Ctrl+N)</td>
<td>Crea un nuovo file dei dati (per iniziare con dei nuovi conti e dei nuovi dati)</td>
</tr>
<tr>
<td>Apri... (Ctrl+O)</td>
<td>Apre un file dei dati di GnuCash già esistente.</td>
</tr>
<tr>
<td>Importa →</td>
<td>Apre il menu secondario che permette l’importazione dei file creati con altri programmi finanziari.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importa QIF...</td>
<td>Avvia il processo di importazione di file QIF.</td>
</tr>
<tr>
<td>Importa OFX/QFX...</td>
<td>Avvia il processo di importazione di file OFX/QFX.</td>
</tr>
<tr>
<td>Import Accounts from CSV...</td>
<td>Starts the CSV Account file import process. The file to import must be in the same format as the one exported by GnuCash.</td>
</tr>
<tr>
<td>Import Transactions from CSV...</td>
<td>Starts the CSV Transactions file import process. The file to import must be a delimited file.</td>
</tr>
<tr>
<td>Ripeti file log di GnuCash...</td>
<td>Avvia la ripetizione di un file di log di GnuCash. Utile per recuperare i dati dopo un crash del programma.</td>
</tr>
<tr>
<td>Importa MT940</td>
<td>.</td>
</tr>
<tr>
<td>Importa MT942</td>
<td>.</td>
</tr>
<tr>
<td>Importa DTAUS</td>
<td>.</td>
</tr>
<tr>
<td>Importa DTAUS e invia</td>
<td>.</td>
</tr>
<tr>
<td>Import Bills &amp; Invoices...</td>
<td>Open the Import Transactions from text file window.</td>
</tr>
<tr>
<td>Import Customers and Vendors ...</td>
<td>Open the Import Customers and Vendors from text file window.</td>
</tr>
</tbody>
</table>

Salva (Ctrl+S) | Salva il file attualmente aperto. |
Salva come... (Maiusc+Ctrl+S) | Salva il file attualmente aperto con un altro nome. |

**Avvertimento**

NON salvare i file dei dati in ~/.gnucash/books.

| Revert | Reload the last saved version of the currently opened file. Useful if you need to discard changes made to the data and not yet saved. |
| Stampa resoconto... (Ctrl+P) | Stampa il resoconto selezionato. |
| Imposta pagina... (Maiusc+Ctrl+P) | Permette di selezionare la dimensione del foglio, la disposizione e i margini per la stampa. |
| Export as PDF | Exports the displayed report as a PDF file. |
| Apre il menu secondario con le voci relative all’esportazione dei conti. | Apre il menu per l’esportazione. |
| Export Accounts Tree to CSV | Exports your account hierarchy to a delimited CSV file. Does not export data. |
| Export Transactions to CSV | Exports transactions to a delimited CSV file. |
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esporta resoconto</td>
<td>Esporta il resoconto corrente in un file in formato HTML.</td>
</tr>
<tr>
<td>Esporta conti</td>
<td>Esports your account hierarchy to a new GnuCash file. Does not export data.</td>
</tr>
<tr>
<td>Proprietà (Alt+Inserisci)</td>
<td>Impostazione delle opzioni per il file di GnuCash corrente.</td>
</tr>
<tr>
<td>File aperti di recente</td>
<td>Lista numerata dei file aperti più di recente da GnuCash.</td>
</tr>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Chiude il resoconto corrente.</td>
</tr>
<tr>
<td>Esci (Ctrl+Q)</td>
<td>Esce da GnuCash.</td>
</tr>
</tbody>
</table>

**Resoconti - Menu Modifica**

**Tabella 4.18. Resoconti - Menu Modifica - Accede alle operazioni e alle preferenze dei conti e dei dati.**

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taglia (Ctrl+X)</td>
<td>Esegue una operazione standard di Taglio.</td>
</tr>
<tr>
<td>Copia (Ctrl+C)</td>
<td>Esegue una operazione standard di Copia.</td>
</tr>
<tr>
<td>Incolla (Ctrl+V)</td>
<td>Esegue una operazione standard di incollaggio.</td>
</tr>
<tr>
<td>Trova... (Ctrl+F)</td>
<td>Permette di impostare i criteri di ricerca per una specifica transazione. Consultare la sezione chiamata «Find» per maggiori dettagli sulla funzione di ricerca.</td>
</tr>
<tr>
<td>Preferences (GnuCash → Preferences on Mac OS X).</td>
<td>Personalizzazione di GnuCash per quanto riguarda la posizione, lo stile e tante altre opzioni. Consultare sezione chiamata «Impostare le preferenze».</td>
</tr>
<tr>
<td>Fogli di stile</td>
<td>Permette di modificare e personalizzare i fogli di stile.</td>
</tr>
<tr>
<td>Opzioni del resoconto</td>
<td>Open form to edit/modify report selection criteria, stylesheets, date ranges, and many other parameters.</td>
</tr>
<tr>
<td>Opzioni resoconto tasse</td>
<td>Imposta le caratteristiche delle tasse per uno o più conti (US). Assign tax form and line to account.</td>
</tr>
</tbody>
</table>

**Resoconti - Menu Visualizza**

A eccezione di Filtra per..., le voci presenti nel menu Visualizza sono le stesse elencate in Tabella 4.3, «Struttura dei conti - Menu Visualizza - modifica la vista della finestra.». 
Resoconti - Menu Operazioni


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operazioni online</td>
<td>Questa voce del menu è mostrata solamente se è abilitato l’Online Banking GnuCash</td>
</tr>
<tr>
<td>Show log window...</td>
<td>Open the Online Banking Connection Window</td>
</tr>
<tr>
<td>Transazioni pianificate</td>
<td>menu secondari della voce «transazioni pianificate»</td>
</tr>
<tr>
<td>Editor transazioni pianificate</td>
<td>Richiama lo strumento di modifica di una transazione pianificata. Vedere la sezione chiamata «Finestra di modifica della transazione pianificata»</td>
</tr>
<tr>
<td>Dall’ultimo avvio</td>
<td>Mostra le transazioni pianificate dall’ultimo avvio di GnuCash. sezione chiamata «Assistente dall’ultimo avvio»</td>
</tr>
<tr>
<td>Rimborso di mutui e ipoteche...</td>
<td>Avvia l’assistente di rimborso di mutui e ipoteche per impostare le rate. sezione chiamata «Assistente per mutui e ipoteche»</td>
</tr>
</tbody>
</table>

Resoconti - Menu Impresa


Resoconti - Menu Resoconti

The items shown in the Reports menu are the same listed in Tabella 4.6, «Struttura dei conti - Menu Resoconti - Permette la scelta dei resoconti e dei grafici forniti da GnuCash.» with the addition of:
Panoramica delle finestre e delle opzioni del menu di GnuCash


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Report Configuration</td>
<td>Save the current report configuration. If you are not working with a saved report configuration, you will be asked to give it a name. You will be able to run the exact same report again by using the Reports → Saved Report Configurations menu item.</td>
</tr>
<tr>
<td>Save Report Configuration As...</td>
<td>Save the current report configuration with a new name.</td>
</tr>
</tbody>
</table>

Resoconti - Menu Strumenti


Resoconti - Menu Finestre

Gli elementi visualizzati nel menu Finestre sono gli stessi elencati in Tabella 4.8, «Struttura dei conti - Menu Finestre».

Resoconti - Menu Aiuto

Gli elementi visualizzati nel menu Aiuto sono gli stessi elencati in Tabella 4.9, «Struttura dei conti - Menu Aiuto - Permette l’accesso a questo documento e alla guida ai concetti e manuale».

Resoconti - Icône dei pulsanti della barra degli strumenti

La finestra del resoconto è dotata di una barra degli strumenti che permette un rapido accesso alle funzioni utilizzate per i resoconti. La barra degli strumenti può essere nascosta o visualizzata selezionando Visualizza → Barra degli strumenti.

Tabella 4.21. Resoconti - Pulsanti della barra degli strumenti

<table>
<thead>
<tr>
<th>Pulsante della Barra degli strumenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salva (Ctrl+S)</td>
<td></td>
</tr>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Chiude il resoconto attualmente visualizzato.</td>
</tr>
<tr>
<td>Indietro</td>
<td>Sposta un passo indietro nella cronologia</td>
</tr>
<tr>
<td>Avanti</td>
<td>Sposta un passo avanti nella cronologia</td>
</tr>
<tr>
<td>Ricarica</td>
<td>Ricarica (aggiorna) il resoconto corrente.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the HTML requests.</td>
</tr>
<tr>
<td>Save Report Configuration</td>
<td>Saves the displayed report. You will be able to run the exact same report again by using the Reports → Saved Report Configurations menu item.</td>
</tr>
<tr>
<td>Save Report Configuration As...</td>
<td>Saves the displayed report in a configuration file with a given name. You will then be able to run the exact same report again by using the Reports → Saved Report Configurations menu item.</td>
</tr>
<tr>
<td>Apre il menu secondario con le voci relative all’esportazione dei conti.</td>
<td>Esporta il resoconto in un file di formato HTML.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Pulsante della Barra degli strumenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opzioni</td>
<td>Modifica le opzioni per il tipo specifico di resoconto.</td>
</tr>
<tr>
<td>Stampa (Ctrl+P)</td>
<td>Invia alla stampante il resoconto corrente.</td>
</tr>
<tr>
<td>Export as PDF</td>
<td>Esports the selected report as a PDF file.</td>
</tr>
</tbody>
</table>

### Barra delle schede

La «barra delle schede» visualizza in stile «fascicolatore» le schede per i registri delle transazioni, per i resoconti e per le strutture dei conti aperti.

### Schermata principale del resoconto

Qui viene visualizzato il resoconto o il grafico selezionato. Le proprietà di questa finestra sono modificabili in due modi. Selezionando il pulsante Opzioni sulla barra degli strumenti, è possibile modificare ciò che viene mostrato dal resoconto e da quale conto vengono prelevate le informazioni. Selezionando Modifica → Fogli di stile... si possono modificare le proprietà della pagina web che visualizza il resoconto.

Il resoconto è in grado di agire come una pagine internet se contiene dei collegamenti a delle pagine esterne. I pulsanti della barra degli strumenti permettono di muoversi Avanti e Indietro attraverso le pagine. Facendo clic sui collegamenti ai nomi dei conti contenuti nel resoconto verranno anche aperte le informazioni nella finestra del registro.

È inoltre possibile esportare il proprio resoconto e effettuarne la stampa attraverso i pulsanti della barra degli strumenti.

### Barra di riepilogo

La Barra di riepilogo non è mostrata quando è visualizzato un resoconto.

### Barra di stato

La barra di stato funziona esattamente come già descritto in sezione chiamata «Barra di stato».

### Finestra di riconciliazione


La spiegazione dettagliata del processo di riconciliazione di un conto è fornita in sezione chiamata «Riconciliare un conto a un estratto conto».

### Finestra di riconciliazione

Per aprire la finestra di Riconciliazione, selezionare Operazioni → Riconciliazione... dalla barra del menu o il pulsante Riconciliazione dalla barra degli strumenti in una finestra del registro. Verrà aperta una schermata di Riconciliazione in cui è necessario inserire la Data dell’estratto conto e il Saldo finale. Se si seleziona l’opzione Includi i sottocuenti, tutte le transazioni incluse nei sottoconti verranno prese in considerazione per l’operazione di riconciliazione. Premendo il pulsante OK verrà aperta la finestra di Riconciliazione vera e propria in cui è possibile confrontare le transazioni di deposito e di prelievo con il proprio estratto conto.
Tabella 4.22. Componenti della finestra di riconciliazione.

<table>
<thead>
<tr>
<th>Componenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barra del menu</td>
<td>Contiene i menu utilizzati nella finestra di riconciliazione.</td>
</tr>
<tr>
<td><em>Barra degli strumenti</em> (icone e/o testo)</td>
<td>Contiene dei pulsanti utili per accedere alle funzioni più comunemente utilizzate nella finestra di riconciliazione del conto.</td>
</tr>
<tr>
<td>Fondi in entrata</td>
<td>Questo riquadro a sinistra contiene un elenco di transazioni che depositano sul conto.</td>
</tr>
<tr>
<td>Fondi in uscita</td>
<td>Questo riquadro a destra contiene un elenco di transazioni che prelevano dal conto.</td>
</tr>
<tr>
<td>Pannello del saldo</td>
<td>Questo riquadro in basso a destra contiene un elenco dei saldi utili per completare la riconciliazione.</td>
</tr>
</tbody>
</table>

### Menu

La tabella seguente descrive le voci di menu presenti nella finestra di riconciliazione.

Tabella 4.23. Menu Riconcilia - permette l'accesso alle informazioni di riconciliazione e ai comandi utili per terminare la riconciliazione o rinviarla.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informazioni di riconciliazione...</td>
<td>Apre la finestra delle informazioni di riconciliazione.</td>
</tr>
<tr>
<td><strong>Termina</strong> (Ctrl+F)</td>
<td>Completa la riconciliazione di questo conto.</td>
</tr>
<tr>
<td><strong>Posticipa</strong> (Ctrl+P)</td>
<td>Rinvia la riconciliazione di questo conto.</td>
</tr>
<tr>
<td><strong>Annulla</strong></td>
<td>Annulla la riconciliazione di questo conto.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apri conto</strong></td>
<td>Apre il registro delle transazioni per i conti.</td>
</tr>
<tr>
<td><strong>Modifica conto</strong></td>
<td>Modifica il nome e le caratteristiche del conto selezionato. sezione chiamata «Modificare un conto»</td>
</tr>
<tr>
<td><strong>Trasferimenti...</strong> (Ctrl+T)</td>
<td>Apre la procedura di trasferimento di una transazione tra due conti.</td>
</tr>
<tr>
<td><strong>Controlla e ripara</strong></td>
<td>Verifica e ripara il conto selezionato se necessario.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nuovo</strong></td>
<td>Aggiunge una nuova transazione al conto.</td>
</tr>
<tr>
<td><strong>Saldo</strong></td>
<td>Apre il registro del conto con una transazione di bilanciamento pre-compilata.</td>
</tr>
<tr>
<td><strong>Modifica</strong></td>
<td>Modifica la transazione selezionata.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancella</td>
<td>Rimuove la transazione selezionata.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aiuto</td>
<td>Apre questo documento di aiuto.</td>
</tr>
</tbody>
</table>

Pulsanti della *Barra degli strumenti*

La finestra di riconciliazione è dotata di una *barra degli strumenti* che facilita l’accesso ad alcune delle funzioni più comunemente utilizzate per la riconciliazione.

Tabella 4.27. *Barra degli strumenti* della finestra di Riconciliazione

<table>
<thead>
<tr>
<th>Pulsante della <em>Barra degli strumenti</em></th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo</td>
<td>Aggiunge una nuova transazione al conto.</td>
</tr>
<tr>
<td>Saldo</td>
<td>Apre il registro del conto con una transazione di bilanciamento pre-compilata.</td>
</tr>
<tr>
<td>Modifica</td>
<td>Modifica la transazione selezionata.</td>
</tr>
<tr>
<td>Cancella</td>
<td>Rimuove la transazione selezionata.</td>
</tr>
<tr>
<td>Apri</td>
<td>Apre il registro del conto contenente la transazione.</td>
</tr>
<tr>
<td>Termina</td>
<td>Completa la riconciliazione di questo conto.</td>
</tr>
</tbody>
</table>

**Nota**

Questo pulsante non è attivato finché il valore della Differenza nel riquadro del saldo (in basso a destra) è 0.

<table>
<thead>
<tr>
<th>Posticipa</th>
<th>Rinvia la riconciliazione di questo conto.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annulla</td>
<td>Annulla la riconciliazione di questo conto.</td>
</tr>
</tbody>
</table>

Finestra della transazione pianificata


La descrizione dettagliata di cosa si intende per transazione pianificata, è fornita in sezione chiamata «Pianificare le transazioni».

Finestra principale delle transazioni pianificate

Questa finestra è mostrata quando si seleziona la voce Operazioni → Transazioni pianificate → Editor transazioni pianificate dalla *barra del menu*. Verrà aperta una finestra che visualizzerà la transazione pianificata.

Componenti principali della finestra per le transazioni pianificate
Panoramica delle finestre e delle opzioni del menu di GnuCash

Tabella 4.28. Componenti della finestra per le transazioni pianificate.

<table>
<thead>
<tr>
<th>Componenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barra del menu</td>
<td>Contiene il menu utilizzato nella finestra delle transazioni pianificate. Fornisce la lista standard delle opzioni della barra del menu e in più la voce Pianifica, che contiene i comandi Nuovo, Modifica e Cancella. Se non è selezionata alcuna transazione, le voci Modifica e Cancell non saranno selezionabili.</td>
</tr>
<tr>
<td>Barra degli strumenti (icone e/o testo)</td>
<td>Contiene dei pulsanti utilizzabili per accedere alle operazioni relative alle transazioni pianificate.</td>
</tr>
<tr>
<td>Schede</td>
<td>Permettono di muoversi tra le schermate aperte.</td>
</tr>
<tr>
<td>Transazioni</td>
<td>Il riquadro Transazioni contiene un elenco di transazioni pianificate e delle relative caratteristiche.</td>
</tr>
<tr>
<td>Prossime scadenze</td>
<td>Il riquadro delle Prossime scadenze contiene un calendario dei mesi successivi. In questo calendario sono evidenziati i giorni in cui sono pianificate una o più transazioni. È possibile modificare l’intervallo di date visualizzato nel calendario selezionando un periodo diverso dalla lista a comparsa Visualizza sulla destra.</td>
</tr>
</tbody>
</table>

**Suggerimento**

Fare clic con il mouse nel riquadro e verranno visualizzati i dettagli relativi alle transazioni pianificate per la data selezionata.

**Menu Pianifica**

La tabella seguente descrive le opzioni del menu Pianifica disponibile nella *Barra del menu* all’interno della finestra delle Transazioni pianificate.

Tabella 4.29. Menu Pianifica - permette di accedere alle operazioni di modifica della transazione pianificata.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo</td>
<td>Aggiunge una nuova transazione pianificata.</td>
</tr>
<tr>
<td>Modifica</td>
<td>Modifica la transazione selezionata.</td>
</tr>
<tr>
<td>Cancella</td>
<td>Rimuove la transazione selezionata.</td>
</tr>
</tbody>
</table>

**Pulsanti della *Barra degli strumenti* per la finestra delle Transazioni pianificate**

La finestra per le Transazioni pianificate presenta una *barra degli strumenti* utile per accedere velocemente alle funzioni più comunemente utilizzate per la pianificazione.
Panoramica delle finestre e delle opzioni del menu di GnuCash

Tabella 4.30. Barra degli strumenti della finestra Transazioni pianificate

<table>
<thead>
<tr>
<th>Pulsante della Barra degli strumenti</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salva (Ctrl+S)</td>
<td>Modifica la transazione selezionata.</td>
</tr>
<tr>
<td>Chiudi (Ctrl+W)</td>
<td>Chiude la finestra delle Transazioni pianificate.</td>
</tr>
<tr>
<td>Nuovo</td>
<td>Salva la pianificazione della transazione selezionata.</td>
</tr>
<tr>
<td>Modifica</td>
<td>Modifica la transazione selezionata.</td>
</tr>
<tr>
<td>Cancezza</td>
<td>Rimuove la transazione selezionata.</td>
</tr>
</tbody>
</table>

Budget Window

Actions → Budget → Open Budget will open the default budget or offer you a choice if there is more than one budget. A new tab will open with the budget displayed.

Budget Window Menus

Here are some menu items that are particularly useful to working with budgets.

Budget Window - Edit menu

Tabella 4.31. Edit Menu - Special items for the budget window.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate Budget</td>
<td>Estimate a budget value for the selected accounts from past transactions.</td>
</tr>
<tr>
<td>Delete Budget</td>
<td>Delete this budget.</td>
</tr>
<tr>
<td>Budget Options</td>
<td>Edit this budget’s options.</td>
</tr>
</tbody>
</table>

Budget Window - Actions menu

Tabella 4.32. Actions Menu - Items in the standard menu that relate to budgets.

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bilancio →</td>
<td>Opens the Budget sub-menu to select budget actions.</td>
</tr>
<tr>
<td>Nuovo bilancio preventivo</td>
<td>Create a new budget and open it in a new tab.</td>
</tr>
<tr>
<td>Apri bilancio preventivo</td>
<td>If no budget exists, create a new budget and open it. If only one budget exists, open it; otherwise user selects one to open.</td>
</tr>
<tr>
<td>Copy Budget</td>
<td>If no budgets exist yet, just open a new budget. If only one budget exists, create a copy of it; otherwise user selects one to open.</td>
</tr>
</tbody>
</table>
Budget Window - Reports menu

**Using more than one budget**

When there is more than one budget, the reports will use the budget selected in book options by default. See sezione chiamata «Book Options» and sezione chiamata «Budgeting Book Options Tab» for more details. After the report is displayed, the budget it uses can be changed in the report options General tab.

**Tabella 4.33. Reports Menu - Items in the standard menu that relate to budgets.**

<table>
<thead>
<tr>
<th>Voce del menu</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bilancio →</td>
<td>Opens the Budget sub-menu to select a budget report.</td>
</tr>
<tr>
<td></td>
<td>Budget Balance Sheet</td>
</tr>
<tr>
<td></td>
<td>Budget Barchart</td>
</tr>
<tr>
<td></td>
<td>Budget Flow</td>
</tr>
<tr>
<td></td>
<td>Budget Income Statement</td>
</tr>
<tr>
<td></td>
<td>Budget Profit &amp; Loss</td>
</tr>
<tr>
<td></td>
<td>Budget Report</td>
</tr>
</tbody>
</table>

**Budget Window Toolbar Buttons**

The Budget window has a *Toolbar* to quickly access common functions used with budgeting.

**Tabella 4.34. Budget Window Toolbar**

<table>
<thead>
<tr>
<th>Pulsante della <em>Barra degli strumenti</em></th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salva (<strong>Ctrl</strong>+S)</td>
<td>Save the current budget.</td>
</tr>
<tr>
<td>Chiudi (<strong>Ctrl</strong>+W)</td>
<td>Close the Budget window.</td>
</tr>
<tr>
<td>Opzioni</td>
<td>Edit this budget’s options.</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

Pulsante della Barra degli strumenti | Descrizione
--- | ---
Estimate | Estimate a budget value for the selected accounts from past transactions.
Cancella | Delete this budget.

**Budget Window Main Display**

The budget window contains a list of accounts down the left hand side, and a set of columns down the right hand side that represent budget values. Each column corresponds to a budget period. The number of periods for a budget can be changed using the Budget Options dialog.

**Procedura 4.1. Entering a budget value**

1. **Click** the row corresponding to the account you wish to budget
2. Choose the period this value is for, and **click** in the cell corresponding to that period
3. Type the value in the cell
4. Press **Enter** to finish editing the value.

**Budget Options**

**Tabella 4.35. Budget options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget Name</td>
<td>The budget name is used in the tab’s name and also in any reports you create with the budget.</td>
</tr>
<tr>
<td>Note</td>
<td>A description of the budget.</td>
</tr>
<tr>
<td>Budget Period</td>
<td>The budget period includes when the budget starts (start date) and how long each budget period lasts.</td>
</tr>
<tr>
<td>Number of Periods</td>
<td>The number of periods in the budget.</td>
</tr>
</tbody>
</table>

**Business Windows**

**Customers Overview**

To open the Customers Overview window, click Business → Customer → Customers Overview.

**Tabella 4.36. Customers Overview - Toolbar Buttons**

<table>
<thead>
<tr>
<th>Toolbar Buttons</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo</td>
<td>Create a new customer</td>
</tr>
<tr>
<td>Modifica</td>
<td>Edit the selected customer</td>
</tr>
<tr>
<td>New Invoice</td>
<td>Create a new invoice (by default it is for the selected customer)</td>
</tr>
<tr>
<td>Customer Listing</td>
<td>Show customer aging overview for all customers</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

Tabella 4.37. Customer context menu

<table>
<thead>
<tr>
<th>Context menu item</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rinomina pagina</td>
<td></td>
</tr>
<tr>
<td>Edit Customer</td>
<td>Edit the selected customer</td>
</tr>
<tr>
<td>New Invoice</td>
<td>Create a new invoice</td>
</tr>
<tr>
<td>Resoconto venditori</td>
<td>Show customer report</td>
</tr>
</tbody>
</table>

Nota

The customer context menu appears if you right click on a customer in the list.

Vendors Overview

To open the Vendors Overview window, click Business → Vendor → Vendors Overview.

Tabella 4.38. Vendors Overview - Toolbar Buttons

<table>
<thead>
<tr>
<th>Toolbar Buttons</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo</td>
<td>Create a new vendor</td>
</tr>
<tr>
<td>Modifica</td>
<td>Edit the selected vendor</td>
</tr>
<tr>
<td>New Bill</td>
<td>Create a new bill (by default it is for the selected vendor)</td>
</tr>
<tr>
<td>Vendor Listing</td>
<td>Show vendor aging overview for all vendors</td>
</tr>
</tbody>
</table>

Tabella 4.39. Vendor context menu

<table>
<thead>
<tr>
<th>Context menu item</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rinomina pagina</td>
<td></td>
</tr>
<tr>
<td>Edit Vendor</td>
<td>Edit the selected vendor</td>
</tr>
<tr>
<td>New Bill</td>
<td>Create a new bill</td>
</tr>
<tr>
<td>Resoconto clienti</td>
<td>Show vendor report</td>
</tr>
</tbody>
</table>

Nota

The vendor context menu appears if you right click on a vendor in the list.

Employees Overview

To open the Employees Overview window, click Business → Employee → Employees Overview.

Tabella 4.40. Employees Overview - Toolbar Buttons

<table>
<thead>
<tr>
<th>Toolbar Buttons</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuovo</td>
<td>Create a new employee</td>
</tr>
<tr>
<td>Modifica</td>
<td>Edit the selected employee</td>
</tr>
</tbody>
</table>
Panoramica delle finestre e delle opzioni del menu di GnuCash

<table>
<thead>
<tr>
<th>Toolbar Buttons</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Voucher</td>
<td>Create a new voucher (by default it is for the selected employee)</td>
</tr>
</tbody>
</table>

**Tabella 4.41. Employee context menu**

<table>
<thead>
<tr>
<th>Context menu item</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rinomina pagina</td>
<td></td>
</tr>
<tr>
<td>Edit Employee</td>
<td>Edit the selected employee</td>
</tr>
<tr>
<td>New Voucher</td>
<td>Create a new voucher</td>
</tr>
<tr>
<td>Resoconto dipendenti</td>
<td>Show employee report</td>
</tr>
</tbody>
</table>

**Nota**

The employee context menu appears if you right click on a employee in the list.
Capitolo 5. Impostare, modificare e lavorare con i conti

In questa sezione è descritto il processo di impostazione, modifica e funzionamento dei conti di GnuCash. In GnuCash un conto è uno strumento essenziale per organizzare la registrazione della provenienza e della destinazione del denaro. GnuCash estende inoltre il concetto di conto reale, quali il conto bancario o un conto di prestito, per abbracciare anche entrate e uscite. Questo permette di conoscere immediatamente dove il denaro è stato speso e a quanto ammontano entrate ed uscite. GnuCash imposta il tipo di conto (come descritto nella sezione seguente) per assistere nell’organizzazione e nel raggruppamento dei conti. I tipi di conti possono essere utilizzati per creare una struttura dei conti.

Tipi di conti in GnuCash

GnuCash supporta un certo numero di tipi di conti differenti. Si raccomanda di scegliere un tipo di conto appropriato basandosi sull’elenco riportato di seguito.

Avvertimento

The Accounts Payable and Accounts Receivable types are used internally by GnuCash’s business features. Transactions involving these accounts should not be added, changed or deleted in any way other than by using

• post/unpost bill/invoice/voucher or

• process payment

Tabella 5.1. Tipi di conti in GnuCash.

<table>
<thead>
<tr>
<th>Tipo di conto</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debiti correnti</td>
<td>I conti per i debiti correnti sono utilizzati nella contabilità per le imprese allo scopo di registrare gli importi che devono essere pagati. Esempio: l’impresa ha comprato un bene, ma non ha pagato la ricevuta fino a ora.</td>
</tr>
<tr>
<td>Note</td>
<td>Le versioni precedenti di questo aiuto definivano D/C e C/C al contrario.</td>
</tr>
<tr>
<td>Crediti correnti</td>
<td>I conti per i crediti correnti registrano gli importi per cui il denaro non è ancora stato ricevuto. Esempio: un’impresa ha venduto un bene ed ha emesso una fattura ma il cliente non ha pagato fino a ora.</td>
</tr>
<tr>
<td>Note</td>
<td>Le versioni precedenti di questo aiuto definivano D/C e C/C al contrario.</td>
</tr>
<tr>
<td>Attività</td>
<td>I conti delle attività sono utilizzati per tenere traccia di ciò che ha un valore e può essere utilizzato o</td>
</tr>
</tbody>
</table>
### Tipo di conto

<table>
<thead>
<tr>
<th>Tipo di conto</th>
<th>Descrizione</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Banca</strong></td>
<td>I conti di questo tipo denotano i risparmi o il conto corrente accesi presso una banca o altra istituzione finanziaria. Alcuni di questi conti possono produrre interessi. Questa è anche la tipologia di conto appropriata per il libretto degli assegni il quale preleva direttamente da un conto corrente.</td>
</tr>
<tr>
<td><strong>Liquidi</strong></td>
<td>Il conto liquidi è utilizzato per indicare il denaro tenuto nel portafoglio, nella scatola delle scarpe, nel salvadanaio o sotto al materasso.</td>
</tr>
<tr>
<td><strong>Carta di credito</strong></td>
<td>Il conto carta di credito è utilizzato per identificare i conti delle carte di credito. Il Credit Card account type is used to denote credit card accounts, both for cards that allow floating lines of credit (e.g. VISA, MasterCard, or Discover) and with cards that do not permit continuing balances (e.g. American Express)</td>
</tr>
<tr>
<td><strong>Valuta</strong></td>
<td>I conti della valuta erano utilizzati per scambiare le valute, ma sono stati sostituiti dal riquadro per il tarsferimento di valuta presente nella finestra di trasferimento fondi (sezione chiamata «Transfer Funds Dialog Box»).</td>
</tr>
<tr>
<td><strong>Capitale</strong></td>
<td>I conti del capitale sono utilizzati per registrare i bilanci di apertura quando si utilizza GnuCash per la prima volta o quando si inizia un nuovo periodo contabile.</td>
</tr>
<tr>
<td><strong>Uscite</strong></td>
<td>Qualsiasi spesa come il cibo, l’abbigliamento, le tasse ecc... Questa tipologia di conto è identificata come una categoria in Quicken.</td>
</tr>
<tr>
<td><strong>Entrate</strong></td>
<td>Qualsiasi entrata ricevuta da fonti quali stipendio, interessi, dividendi ecc... Questa tipologia di conti è indicata come una categoria in Quicken.</td>
</tr>
<tr>
<td><strong>Passività</strong></td>
<td>I conti di passività sono utilizzati per registrare i debiti o le obbligazioni finanziarie. (Normalmente è un conto segnaposto).</td>
</tr>
<tr>
<td><strong>Fondo comune</strong></td>
<td>Un portafoglio di azioni e bond gestiti da professionisti o altri investimenti comunque divisi in quote.</td>
</tr>
<tr>
<td><strong>Azioni</strong></td>
<td>Una condivisione di proprietà in una corporazione, che impegna il proprietario a tutti i rischi e premi che questo comporta.</td>
</tr>
</tbody>
</table>

L’assistente per la **Creazione di una nuova struttura conti** descritto nella prima sezione di questo documento, è un modo pratico per impostare un gruppo di conti da utilizzare come ossatura dei tipi di conti.

Quando vengono creati dei nuovi conti, le scelte disponibili dei tipi di conti vengono colorate in grigio in accordo con il tipo di conto padre. La lista seguente elenca le scelte possibili.

- Debiti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

---

47
Impostare, modificare
e lavorare con i conti

- Crediti correnti: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Patrimonio: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Banca: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Liquidi: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Carta di credito: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Valuta: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Capitale: solo il conto capitale può essere un conto figlio.
- Uscite: solo i conti di uscite o entrate possono essere conti figli.
- Entrate: solo i conti di uscite o entrate possono essere conti figli.
- Passività: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Fondi comuni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.
- Azioni: tutti i conti a eccezione del capitale, uscite e entrate possono essere conti figli.

Creare una struttura dei conti

La struttura dei conti è come una indice delle proprie finanze. Il miglior modo per concettualizzare una struttura dei conti è di pensarla come un albero. I rami principali rappresentano intere categorie o gruppi, mentre le foglie dell’albero rappresentano conti bancari o categorie di uscite. Quando viene richiesto un resoconto sommario, tipicamente solo i rami principali vengono riportati, invece che i conti individualmente. Per esempio, una struttura dei conti potrebbe assomigliare alla seguente:

300 Uscite | +--310 Bollette | | +--311 Birra | | +--320 Uscite di lavoro | | +--321 Dichetti | | +--322 Dischi Blu-ray | | : :

Codici dei conti

I conti non hanno solo dei nomi; possono avere anche dei codici, per essere ordinati. Quando viene generato un resoconto, l’ordinamento è determinato dalla numerazione. È consuetudine che i numeri dei sottoconti non terminino con zero, mentre i conti padre abbiano numeri crescenti dallo zero.

Avvertimento

GnuCash non impedisce che vengano utilizzati dei numeri duplicati, comunque se ne scoraggia l’utilizzo. I codici dei conti sono trattati come numeri in base 36, quindi, se si terminano i numeri, è possibile utilizzare le lettere dalla a alla z.

Modificare una struttura dei conti

Le modifiche alla struttura dei conti possono essere effettuate direttamente dal riquadro del Conto padre presente nella finestra di Modifica conto. È possibile spostare un conto in qualsiasi parte della struttura.
Si raccomanda comunque di mantenere i conti raggruppati a seconda del tipo come descritto in sezione chiamata «Tipi di conti in GnuCash»; questo aiuta a preservare lo schema della struttura dei conti.

Per spostare il conto selezionato in un differente conto padre è sufficiente selezionare il conto nel riquadro del Conto padre. Se viene selezionato Nuovo conto di livello principale allora il conto verrà spostato al livello principale.

**Creare un nuovo conto**

Per creare un nuovo conto selezionare Operazioni → Nuovo conto... o fare clic sul pulsante Nuovo della barra degli strumenti quando è visualizzata la finestra della struttura dei conti. Verrà aperta la finestra per la creazione di un Nuovo conto.

La finestre di dialogo delle proprietà per un Nuovo conto consta di due schede, quella delle preferenze Generali e quella del Bilancio d’apertura.

Creare un nuovo conto richiede la pianificazione di alcuni dettagli che dovranno essere inseriti nella finestra di dialogo per il nuovo conto.

- Il tipo di conto di cui si ha bisogno.
- Dove si deve posizionare nella struttura dei conti.
- Se è previsto un bilancio preventivo.
- Se c’è la necessità di una commodity (titolo/valuta) per il conto.
- Se si ha bisogno dell’aggiornamento online del prezzo della commodity.

Questi dettagli sono descritti nel seguito.

**Scheda delle informazioni generali**

La scheda Generali permette l’accesso alle informazioni di base del conto. Fornisce un modo di collegare il conto alle informazioni sulle azioni se si tratta di un tipo di conto per la valuta, per i fondi comuni o per le azioni. Qui, il conto può anche essere marcato come segnaposto; viene inoltre mostrato se il conto è identificato come relativo alle tasse (che è configurato attraverso il menu Modifica → Opzioni resoconto tasse).

Sono presenti sette riquadri nella sezione Identificazione di questa scheda.

1. **Nome conto**: il nome per il conto (ad esempio Conto Corrente Banca).
2. **Codice conto**: un codice del conto opzionale come descritto in Codici dei conti.
3. **Descrizione**: una descrizione opzionale per il conto.
4. **Titolo/valuta**

**Nota**

Il campo Tipo alla voce Seleziona titolo dipende dalla selezione fatta nel pannello Tipo di conto nella schermata Nuovo conto.
• Per i conti diversi da **Azioni e Fondi comuni** questa dovrebbe essere la valuta predefinita cioè EUR (Euro) o il simbolo della propria valuta locale. Se questo conto è per una valuta estera, premere il pulsante Seleziona... per scegliere una valuta differente dalla lista a comparsa delle valute.

• Per i conti contenenti azioni e fondi comuni; selezionare dapprima Azioni o Fondi comuni nel riquadro del Tipo di conto, poi il Conto padre, infine usare il pulsante Seleziona..., per scegliere il Tipo (normalmente il mercato dove il titolo viene scambiato) e il Titolo dalla finestra di Scelta del titolo.

Se il titolo o il fondo di cui si ha bisogno non compare nell’elenco ma se ne conosce il Tipo, è possibile creare il titolo o il fondo. Per creare una commodity per i fondi comuni e per le azioni, selezionare Nuovo..., nella schermata di Scelta del titolo, per aprire la schermata del Nuovo titolo:. Le opzioni presenti sono descritte in sezione chiamata «Editor titoli». Inserire un Nome, il simbolo, selezionare il Tipo e infine premere il pulsante Chiudi per creare il titolo. Dopo che il titolo è stato creato, selezionare il Tipo: (normalmente la borsa dove il titolo viene scambiato) e il nome nella lista a comparsa Valuta/titolo: e premere Chiudi per chiudere la finestra.

5. Frazione minima: la frazione minima che verrà registrata.

6. Colore del conto: il colore da assegnare alla scheda del registro relativo a questo conto. Fare clic sul pulsante del colore per aprire la schermata di Selezione del colore. Per ripristinare il colore del conto fare clic sul pulsante Predefinito.

7. Notes: This is a free form text box that can be used for any additional notes about the account.

Below the panes are 3 check-boxes: one to show if the account is Tax Related, one to mark the account as a Placeholder, and one to mark an account Hidden.

The Tax Related check-box means that an account has been flagged to be included in the Tax Schedule Report. This flag is only displayed on the Edit Account dialog and is set in the Income Tax Information dialog (Edit → Tax Report Options). See the Tax Schedule Report and TXF Export section in Reports Chapter (sezione chiamata «Resoconti generali»).

The Placeholder check-box sets an account to read-only status and prevents the addition of transaction data to the account.

**Nota**

Setting an account to Placeholder will also hide that account in the pop-up account list in a register. Sub-accounts to the placeholder account will still display in the pop-up, however.

The Hidden check box hides an account (and any sub-accounts) in the account tree. To reset this option, you will first need to open the View → Filter By... dialog for the account tree and check the Show hidden accounts option. Doing so will allow you to select the account and reopen this dialog.

**Nota**

Hidden accounts still appear in the pop-up account list in a register. To remove an account from this pop-up account list as well, check the Placeholder check box.

Below these checkboxes is a pane that contains a list of Account Types. Select a type from the descriptions in sezione chiamata «Tipi di conti in GnuCash».

Il riquadro successivo contiene un albero dei conti dal quale scegliere il Conto padre. Per creare un nuovo albero dei conti, selezionare Nuovo conto di livello principale.
Nota

Le scelte disponibili nel riquadro del Tipo di conto dipendono dalla selezione effettuata nel riquadro del Conto padre. Per esempio se il Conto padre è Capitali verrà mostrato solamente il Tipo di conto Capitale. Questo permette di mantenere una struttura dei conti coerente.

Procedura per abilitare l’aggiornamento dei prezzi online

- GnuCash si affida a uno strumento esterno per recuperare le quotazioni via internet. Questo strumento è un modulo di Perl denominato Finance::Quote e deve essere installato sul proprio computer indipendentemente da GnuCash. Il primo passo per abilitare l’aggiornamento delle quotazioni tramite internet consiste nell’assicurarsi che Finance::Quote sia installato correttamente.

Per sapere se il modulo di Perl Finance::Quote è già installato nel sistema, digitare «perldoc Finance::Quote» in una finestra del terminale e verificare se c’è qualche documentazione disponibile. Se c’è la documentazione allora il modulo è installato, altrimenti no.

L’installazione di Finance::Quote differisce a seconda del sistema operativo in uso. Per i vari sistemi supportati, è possibile seguire le seguenti linee guida:

- Linux: la maggior parte delle distribuzioni (Fedora, openSuse, Mandriva, Ubuntu, ecc...) forniscono un pacchetto nei propri repository per il modulo di perl Finance::Quote. Quindi nella maggior parte dei casi è sufficiente utilizzare il proprio gestore di pacchetti preferito (yum, apt, rpm, synaptic, yast, ecc...) per installare il modulo. Il nome del pacchetto può variare da distribuzione a distribuzione. In genere ha un nome del tipo «perl-Finance-Quote».

- Windows: Finance::Quote on Windows requires perl to be installed already. If you haven’t done so, you should first install ActivePerl, or more recently, Strawberry Perl.

  Il file installabile di GnuCash disponibile sulla pagina principale, contiene un piccolo programma che assiste nell’installazione di Finance::Quote. È possibile raggiungerlo dal menu «Start» nel gruppo GnuCash ed è chiamato «Installa la funzione di ricerca delle quotazioni online».

- Mac OS X: se GnuCash è stato installato dal pacchetto di installazione disponibile sulla pagina principale di GnuCash, Finance::Quote è già installato.

- Se nessuno dei precedenti casi è adatto alla propria situazione, è possibile seguire le seguenti istruzioni più generali:


2. Trovare la cartella dove è installato GnuCash cercando la stringa «gnc-fq-update» (senza le virgolette).


  Quando l’installazione è terminata, eseguire il programma di test «gnc-fq-dump», nella stessa cartella, distribuito con GnuCash per verificare se Finance::Quote è installato e funziona correttamente.
Impostare, modificare
e lavorare con i conti

Nota

If you feel uncomfortable about performing any of these steps, please either email the GnuCash-user mailing list (<gnucash-user@gnucash.org>) for help or come to the GnuCash IRC channel on irc.gnome.org. More information is available on the GnuCash Wiki FAQ for example https://wiki.gnucash.org/wiki/FAQ#Q:_How_do_I_fix_a_”system_error”_or_”unknown_error”_when_getting_stock_quotes.3F You can also leave out this step and manually update your stock prices.

- Creare il conto per il fondo comune o per le azioni impostando il campo titolo/valuta, come descritto nel seguito.

Suggerimento

Quando si creano questi tipi di conti, si consiglia di creare anche dei conti delle entrate per registrare i dividendi, i guadagni in capitale (nel lungo e nel breve periodo) e i conti per le uscite per registrare le commissioni e le perdite (se si considerano le perdite come uscite).

- Si creino il fondo comune o le azioni sia utilizzando l’editor titoli per le azioni o i fondi esistenti, o la finestra del nuovo titolo per le nuove azioni o fondi.

Selezionare l’opzione Ricevi quotazioni online, il tipo di fonte per le quote e il Fuso orario.

Per la ricezione delle quotazioni via internet, è necessario avere abilitato le opzioni per la ricezione delle quote online e il fuso orario.

- Ricevi quotazioni online - questa opzione permette di abilitare lo specifico titolo o azioni alla ricezione delle quotazioni da una fonte online.

- Tipo di fonte per le quote: selezionare, fra le tre opzioni disponibili, il tipo di fonte da cui ricevere le quotazioni. Le fonti Multi-riga quali «Europe» possono essere usate per superare i problemi di connessione con un unica fonte. Scegliendo invece Singola, verranno ricercate informazioni solo dalla fonte specificata.

Dopo aver selezionato il tipo di fonte per le quotazioni, selezionare un elemento della relativa lista a a comparsa. Attualmente fra le fonti disponibili e supportate, si ricordano: Yahoo, Yahoo Europe, Fidelity Investments, T. Rowe Price, the Vanguard Group, the Australian Stock Exchange (ASX) e TIAA-CREF.

Nota

Si noti che Yahoo fornirà le quotazioni per diversi fondi comuni compresi Fidelity, T.Rowe Price e Vanguard, e che i prezzi indicati da Yahoo dovrebbero essere identici a quelli che è possibile reperire nei siti di origine.

If you are outside the US and use one of the different Yahoo sources or multiple sources containing Yahoo, you should append the market code for the security such as PA for Paris, BE for Berlin, etc. Example: 12150.PA (a Peugeot security in the Paris market). Tabella A.4, «Yahoo Codes for Exchanges and Markets» below lists suffixes for various markets around the world.

Pseudo-simboli per i fondi TIAA-CREF sono elencati nella tabella Tabella A.5, «Pseudo simboli da utilizzare per le quotazioni TIAA-CREF». 
• Impostare, modificare e lavorare con i conti

• Fuso orario - selezionare il fuso orario per la quota che si desidera ricevere. Per esempio, Yahoo fornisce le quotazioni con il fuso orario della costa orientale degli Stati Uniti, quindi occorre scegliere America/New York se si utilizza questa fonte per le quotazioni.

• Selezionare una commodity nell’editor dei prezzi.

• Selezionare Ricevi quotazioni nella finestra di modifica prezzo.

• Controllare l’ultimo prezzo per il titolo selezionato.

If you wish to update price quotes from the command line, you can do so by the following command:

gnucash --add-price-quotes <nome-de-file-di-gnucash>

Il comando `gnucash --add-price-quotes <gnucash-file-name>` può essere utilizzato per ottenere il prezzo corrente delle proprie azioni. Il file specificato «<gnucash-file-name>» dipenderà dal nome e dalla posizione del proprio file dei dati. Questo può essere individuato dal nome visualizzato nella cornice in alto nella finestra di GnuCash prima del «-». Il nome del file può anche essere trovato nel menu File nell’elenco dei file recentemente aperti; il primo elemento, numerato 1, è il nome del file attualmente aperto.

This can be automated in Mac OSX by creating a crontab entry. For example, to update your file every Friday evening (18:00) after markets close (modify the time accordingly for your time zone), you could add the following to your personal crontab:

```
0 18 * * 5 /path/to/gnucash --add-price-quotes /path/to/gnucash-filename > /dev/null 2>&1'
```

For Linux, which needs dbus, usually started by the desktop manager, to communicate with dconf or gconf:

```
0 18 * * 5 env `dbus-launch` sh -c 'trap "kill $DBUS_SESSION_BUS_PID" EXIT; /path/to/gnucash --add-price-quotes /path/to/gnucash-filename > /dev/null 2>&1'
```

Si ricorda che i «prezzi» dei fondi comuni rappresentano dei «valori di capitale netto (NAV)» e richiedono diverse ore dopo la chiusura dei mercati per essere disponibili. Se i NAV vengono scaricati prima del giorno in cui vengono determinati, si riceveranno i valori del giorno precedente.

**Scheda del bilancio di apertura**

The Opening Balance tab is visible only when creating a new account, and is disabled for Stock and Mutual Fund accounts. In the latter case, opening balances must be created by hand. Please see Section 8.5.1 in the *Tutorial and Concepts Guide* for instructions if you need to create an opening balance in a Stock or Mutual Fund account. It is used to record the beginning balance for an account. This allows it to be used for two different scenarios. If using GnuCash for the first time to record transactions, it can be used as a beginning balance. If the accounts in use are closed at the end of a period and new accounts are created, it is used to close and carry balances forward.

In questa scheda sono presenti tre riquadri. Quello superiore contiene le Informazioni sul saldo.

• Saldo: immettere il saldo con cui inizializzare il conto.

• Data: la data con cui il bilancio di apertura deve essere registrato.
Il riquadro successivo è quello del Tipo di trasferimento.

- Utilizza il conto del capitale per i bilanci di apertura: in questo modo si trasferisce il bilancio di apertura per il conto da un conto standard del capitale chiamato bilanci di apertura.

- Selezionare il conto di trasferimento: questa opzione abilita il riquadro inferiore in modo che un conto differente possa essere utilizzato per trasferire il bilancio di apertura.

L’ultimo riquadro è quello del Conto di trasferimento. Selezionare il conto da utilizzare per il bilancio d’apertura scegliendo fra quelli della lista nel riquadro.

**Modificare un conto**

La finestra di modifica del conto consta di una sola scheda per le informazioni generali. Questa finestra presenta le stesse informazioni che sono già state descritte in sezione chiamata «Creare un nuovo conto». Per accedere alla finestra di Modifica conto andare in Modifica → Modifica conto (scorciano di menu Ctrl+E) o premere il pulsante Modifica della *barra degli strumenti* nella finestra della struttura dei conti.

**Rinumerare i sottoconti**

Utilizzare Rinumera sottoconti per riassegnare i codici dei conti per tutti i figli del conto padre corrente. Per esempio, se si ha la seguente struttura dei conti:

**Tabella 5.2. Numeri iniziali dei conti.**

<table>
<thead>
<tr>
<th>Codice</th>
<th>Nome</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Colori</td>
</tr>
<tr>
<td>10-1</td>
<td>Rosso</td>
</tr>
<tr>
<td>10-2</td>
<td>Arancione</td>
</tr>
<tr>
<td>10-3</td>
<td>Giallo</td>
</tr>
<tr>
<td>10-4</td>
<td>Blu</td>
</tr>
<tr>
<td>10-5</td>
<td>Viola</td>
</tr>
</tbody>
</table>

Si voglia ora aggiungere il conto «Verde», ma si voglia anche inserirlo tra i conti «Giallo» e «Blu». Invece di dover rinumerare tutti i conti manualmente a partire dal «Blu», si può usare il comando Rinumera sottoconti per il conto «Colori». Nella finestra che comparirà il valore della voce prefisso dovrebbe essere già impostata a «10», il codice del conto «Colori». Se si imposta un valore dell’intervallo pari a «5» e si preme Rinumera, si otterrà la seguente struttura:

**Tabella 5.3. Numeri dei conti rinumerati**

<table>
<thead>
<tr>
<th>Codice</th>
<th>Nome</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Colori</td>
</tr>
<tr>
<td>10-05</td>
<td>Rosso</td>
</tr>
<tr>
<td>10-10</td>
<td>Arancione</td>
</tr>
<tr>
<td>10-15</td>
<td>Giallo</td>
</tr>
<tr>
<td>10-20</td>
<td>Blu</td>
</tr>
<tr>
<td>10-25</td>
<td>Viola</td>
</tr>
</tbody>
</table>
Impostare, modificare
e lavorare con i conti

Ora è disponibile lo spazio necessario nella numerazione dei conti per aggiungere il conto Verde con un codice adatto per inserirlo dove si desidera.

**Tabella 5.4. Numeri finali dei conti.**

<table>
<thead>
<tr>
<th>Codice</th>
<th>Nome</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Colori</td>
</tr>
<tr>
<td>10-05</td>
<td>Rosso</td>
</tr>
<tr>
<td>10-10</td>
<td>Arancione</td>
</tr>
<tr>
<td>10-15</td>
<td>Giallo</td>
</tr>
<tr>
<td>10-18</td>
<td>Verde</td>
</tr>
<tr>
<td>10-20</td>
<td>Blu</td>
</tr>
<tr>
<td>10-25</td>
<td>Viola</td>
</tr>
</tbody>
</table>

**Cancellare un conto**

Cancellare un conto significa rimuovere dal file tutte le informazioni sulle transazioni e le informazioni del conto stesso. L'operazione di cancellazione non può essere annullata. Verrà richiesto di confermare la rimozione del conto. Se il conto contiene ancora delle informazioni sulle transazioni, si verrà avvertiti che il conto contiene ancora delle transazioni.

Un effetto conseguente alla rimozione di un conto che contiene delle transazioni, è che ci si ritroverà con dei conti non bilanciati. Questo fatto verrà indicato nel conto con un segno di spunta vicino agli importi di debito e credito. È possibile riparare automaticamente questi conti non bilanciati utilizzando il menu Operazioni → Controlla e ripara. Automaticamente verranno assegnati gli importi non bilanciati a un nuovo conto denominato Sbilancio.

**Riconciliare un conto a un estratto conto**

In GnuCash la riconciliazioni dei conti con gli estratti conti bancari o di qualsiasi altra istituzione finanziaria, è un modo di controllare l’accuratezza delle proprie transazioni (e di quelle della banca) e il saldo dei propri conti. È anche un’operazione utile per rintracciare gli assegni non riscossi e altre transazioni insolute.

The reconciling process in GnuCash involves two dialogs: the sezione chiamata «Reconciling Information» dialog followed by the sezione chiamata «Riconcilia» window. They provide access to various GnuCash functions to make it easy to enter and update account information during the reconciliation.

**Suggerimento**

The Reconcile window is accessed from the account tree window or the account register window by going to Actions → Reconcile... or using the menu shortcut Alt+A, R.

The Summary Bar at the bottom of the Account Register Window indicates the amounts of Present (Balance), Future (Balance), Cleared (Transactions), Reconciled (Transactions) and Projected Minimum. On-line account information can be used to mark which transactions the bank has processed by changing the R (reconciliation status) column in the register from n (new) to c (cleared). The bank statement is then used with the Reconcile window to reconcile the account which changes the R field to y (reconciled).
Reconciling Information

The Reconcile Information dialog is used to indicate the closing Statement Date and the Starting Balance (fixed from last reconciliation) and Ending Balance from the statement. The Include Sub-accounts check-box is used if one or more subaccounts are used to track the account you are reconciling. The Enter Interest Payment button is used to add a transfer to the accounts for an interest payment. If selected a dialog will be displayed to add the sezione chiamata «Interest Payment» to the account.

Nota

The Enter Interest Payment button is shown only if you are reconciling an account of Bank type.

When you have entered all relevant data, press Ok to proceed to the sezione chiamata «Riconcilia» dialog or Cancel to discard the reconciliation process.

Interest Payment

There are three panes in the Interest Payment dialog. At the bottom is a button called No Auto Interest Payments for this Account which will cancel the dialog. The top pane contains the Payment Information.

• Importo: inserire l’importo degli interessi.
• Data: selezionare la data del pagamento degli interessi.
• Nr.: inserire un numero per la transazione (opzionale).
• Descrizione: inserire una descrizione per la transazione.
• Promemoria: inserire una nota riguardante la transazione (opzionale).

The Reconcile Account pane highlights in the tree the account that the interest payment will be transferred to or from.

The Payment From pane contains a list of accounts where you can select the source account.

Nota

If the payment is for a credit or loan account then usually the payment would be from an Expense account. If the payment is for a checking or savings account then usually this would be from an Income account.

Suggerimento

The Show Income/Expense check-box shows or hides the Income and Expense accounts.

Select OK to enter the interest transaction (or Cancel the payment) and return to the initial reconciliation screen.

Riconcilia

Nota

For a detailed description of menu items and buttons on the reconcile window, see sezione chiamata «Finestra di riconciliazione».
The Reconcile dialog is where the actual process of matching your statement to GnuCash data takes place on a per transaction basis.

The Reconcile dialog is composed by a toolbar and three panes; Funds In on the left, Funds out on the right and a balance pane.

**Nota**

If you enabled the option Use formal accounting labels in the Accounts section of the GnuCash preferences, you will see Debits and Credits panes instead of Funds In and Funds Out panes.

The Funds In and Funds Out pane shows all unreconciled deposits to the account. Both panes are composed by five columns.

**Suggerimento**

To order the listed transactions with a preferred criteria, click on the relevant column header. To reverse the selected order click a second time on the column header.

- **Data** The date of the unreconciled transaction.
- **Num** The number of the unreconciled transaction.
- **Descrizione** The Description of the unreconciled transaction.
- **Importo** The Amount of the unreconciled transaction.
- **R** Shows a green tick if the transaction will be reconciled when done.

To mark a transaction as reconciled just click on it and a green checkmark will appear on the relevant R column.

**Nota**

Under each pane a Total for reconciled transactions is shown.

The balance pane shows a summary of the balances used in reconciliation.

- **Data dell’estratto conto** The date on the statement set on the sezione chiamata «Reconciling Information».
- **Starting Balance** The balance at the end of the last reconciliation.
- **Ending Balance** The balance entered from the statement.
- **Reconciled Balance** The balance of selected transactions.
- **Difference** The difference between the Reconciled and Ending balances.

The set of unreconciled transactions in the Funds In and Funds Out panes can be changed by using the menus and Toolbar to access the account and transaction information. You can create a New transaction, Edit a selected transaction, add a Balance transaction (of the same amount as listed under Difference in the balance pane), and delete the selected transaction.
Suggerimento

To modify a listed transaction, double click on it.

By pressing the Open icon the register of the account to reconcile will be opened.

If you wish to postpone the reconciliation until later use the Reconcile → Postpone menu item (menu shortcut Ctrl+P) or pressing the Postpone icon. If you wish to cancel the reconciliation use the Reconcile → Cancel menu item or press the Cancel icon.

All previous command are also available in the Reconcile dialog menu.

Select each unreconciled transaction matching a transaction on the statement so a green tick appears in the R column. The Balance pane changes to reflect each selected transaction until the Ending Balance equals the Reconciled Balance and the Difference is zero. Once this is done select the Finish button or Reconcile → Finish (menu shortcut Ctrl+F) to finish the reconcile process.
Capitolo 6. Operazioni comuni per le transazioni

A transaction represents the movement of money from one account to another account. Whenever you spend or receive money, or transfer money between accounts, that is a transaction. In GnuCash transactions always involve at least two accounts.

GnuCash utilizza i conti come metodo per raggruppare ed organizzare la registrazione delle transazioni. Questa sezione descrive i metodi che GnuCash fornisce per aiutare ad inserire velocemente nel registro le transazioni.

GnuCash permette di inserire le transazioni in diversi modi.

• Immettere le transazioni direttamente dalla finestra del registro rappresenta il metodo più immediato.
• Using the Transfer Funds window.
• Importing transactions either from a QIF/OFX file or via "OFX on-line banking".

Cambiare la visualizzazione del registro

GnuCash fornisce diverse opzioni per cambiare il modo in cui viene visualizzato il registro permettendo di mostrare con più chiarezza le transazioni. Lo stile predefinito è quello a "libro mastro basilare": con questa modalità viene mostrata una singola linea per ogni transazione e si tratta del metodo più sintetico per la visualizzazione dei dettagli più rilevanti.

Lo stile di visualizzazione predefinito può essere cambiato dal menu Visualizza: qui sono possibili tre scelte. Quando al finestra del registro viene chiusa, lo stile tornerà a essere quello del libro mastro basilare. Per renderlo il cambiamento permanente occorre cambiare lo stile nella scheda Predefinite del registro delle Preferenze di GnuCash.

• Libro mastro basilare: lo stile predefinito costituito da una riga per transazione. Le suddivisioni sono mostrate come sommario. Il pulsante Suddivisione e l'opzione del menu Operazioni → Suddividi transazione sono abilitati.
• Mastro ad espansione automatica: questo stile espande automaticamente la transazione selezionata se contiene delle suddivisioni.
• Giornale della transazione: questo stile espande tutte le transazioni in modo da poterle visualizzare completamente.
• Doppia linea: questa opzione agisce sugli stili appena descritti visualizzando una riga aggiuntiva per le note della transazione.

Le altre due opzioni per cambiare la visualizzazione del registro sono: Visualizza → Filtra per... per restringere il numero di elementi visualizzati, e Visualizza → Ordina per... sezione chiamata «Registro del conto - Menu Visualizza».

Transfer Funds Dialog Box

The Transfer Funds Dialog Box, accessed via Actions → Transfer... or its shortcut or by pressing the Transfer icon from the account register tab, serves two purposes in GnuCash:
• A way to create a simple (i.e. two-split) transaction between arbitrary accounts.

• Collect exchange rate or amount information in a multi-currency transaction (see sezione chiamata «Multiple Currency/Commodity Transactions»).

Nota
The Basic Information and Transfer Accounts panes will be disabled in the Transfer Funds dialog when it is being used only to collect exchange rate or amount information.

Basic Information
The Basic Information section collects the entries for constructing a transaction: Date, description, amount, etc.

• Amount: The amount of the transaction in the Transfer From account’s commodity.

• Date: The posting date for the transaction, i.e. the date that you want to record it in your book.

• Num: A reference number for the transaction, often a check number.

• Description: The description of the transaction, often the payer or payee.

• Memo: Additional information you might want to note about the transaction. Anything entered here will be added to the Memo fields of both splits.

Transfer Accounts
The Transfer From and Transfer To tree views are used to select the accounts which will participate in the transaction. They normally show only Asset and Liability accounts. If you need to use an Income or Expense account in one of them, check the Show Income/Expense checkbox below the appropriate view.

• Choose the Transfer From account.

• Choose the Transfer To account.

Currency Transfer
The Currency Transfer pane is used to collect the needed information to enter the amount of the Transfer To split. You may enter either a price or an amount and GnuCash will compute the other. If you have Online Price Retrieval installed (see sezione chiamata «Procedura per abilitare l’aggiornamento dei prezzi online») you can use the Fetch Rate button to retrieve a current quote.

The Currency Transfer pane is enabled only if the selected accounts use different commodities or the Transfer Funds dialog was launched to collect price or amount information from editing a transaction in the register.

The Currency Transfer pane is organized as a radio group with two selections, Exchange Rate and To Amount. Each consists of a radio button and a numeric entry.

If a relevant price is available in the price database (see sezione chiamata «Aggiungere manualmente il prezzo di un’azione») the Exchange Rate will have that as a default entry.

• Select the Exchange Rate radio button if you want to enter a price or use the Fetch Rate button.
Operazioni comuni per le transazioni

• Select the To Amount radio button if you want to enter the amount of the To Account split.

• Enter the price/exchange rate or the amount in the numeric entry corresponding to radio button you selected. GnuCash will calculate the other amount for you when you exit the field. If it's enabled you can use the Fetch Rate button to retrieve a current quote.

Nota

If you have created a price in the Price Editor (see sezione chiamata «Aggiungere manualmente il prezzo di un’azione») for the current date quote retrieval will not update that price. You must first delete the manually-created price in the Price Editor before clicking the Fetch Rate button.

Nota

The Fetch Rate button will immediately create or replace a price in the Price Editor unless there is an existing manually-created price for today.

Finishing Up

Select OK to commit the transaction (or confirm the price/amount) or Cancel to dismiss the dialog without entering the transaction.

Nota

When committing a transaction or confirming an exchange rate the price on the transaction date in the Price Editor may be updated. See sezione chiamata «Editor prezzi» for details.

Inserire una transazione dal registro

All’apertura della finestra del registro per un conto, viene visualizzata la lista delle transazioni per quel conto. Questa finestra presenta lo stesso nome del conto sulla scheda. I menu contengono varie funzioni che permettono di modificare la visualizzazione delle transazioni. Ancora la barra degli strumenti contiene delle funzioni comunemente utilizzate per manipolare le transazioni; esse sono descritte nella sezione sezione chiamata «Registro del conto e finestra del libro mastro generale» di questo documento.

Inserimento diretto dalla finestra del registro

The register window will look slightly different depending on the style options you have chosen. The following describes entering simple transactions in the basic ledger style. The cursor is placed in the date field by default when the register window is opened.

Nota

When working on transactions in GnuCash, be aware that the Enter key and the Tab key behave differently, and perform different actions.

The Enter key moves to the first field of the next split, regardless of which field you are in. If there is no next split, proceeds to the next transaction. In any case, Enter finishes the transaction edit, and any imbalance is posted to Imbalance-CUR, where CUR is the currency of the transaction.

The Tab key moves to the next field in the current split. If it’s the last field, moves to the next split, creating a new one if there isn’t one. If the split is blank, the Tab key finishes the transaction and posts any imbalance to Imbalance-CUR, as above.
1. Selecting the small icon on the right of the date field drops down a date selection calendar. Use the arrows to select the correct month and year for the transaction then select the date. Selecting the icon once more will close the date selection calendar. It is also possible to type in the date or part of the date and let GnuCash fill the rest.

2. Premere **Tab** per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente assegnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

3. Premere di nuovo **Tab** per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di completare automaticamente il nome del beneficiario mentre si starà scrivendo.

4. A questo punto possono accadere due fatti alla pressione del tasto **Tab**: se GnuCash individua una transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando automaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel campo del Trasferimento quando è visualizzata una sola riga per la transazione.

5. Accounts may be selected either by typing them in or by pressing the small button on the right of the Transfer field, which will display a pick list of all non-placeholder accounts. Note that this pick list will still display hidden accounts. If you have hidden an account in your chart of accounts, you may want to set the account also to be a placeholder account so that it doesn't display here.

When typing, GnuCash will fill in available accounts as you type. For example, if you have **Equity** and **Expenses** top-level accounts, typing **E** will fill in **Equity** because it sorts before **Expenses**. Continuing to type **x** will present **Expenses** the account separator (: by default, see sezione chiamata «Conti» Account Preferences about changing it) will accept the currently offered account so that you can start typing the name of a child account.

6. Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto nella sezione sezione chiamata «Riconciliare un conto a un estratto conto».

7. Press the **Tab** key to move to the first of the amount fields. The names of the next two columns are different according to what type of account is opened. For example, **Bank** accounts show Deposit and Withdrawal here, **Credit Card** accounts show Payment and Charge, and **Stock** accounts show Shares, Price, Buy and Sell.

8. Inserire un importo per la transazione nel campo corretto. Quando la transazione è «bilanciata» premendo il tasto **Invio**, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione verrà aggiunta al registro la transazione. Selezionando il pulsante Elimina o andando in Transazione → Elimina transazione verrà cancellata la transazione.

9. Transactions with just one transfer account will show the name of that account in the Transfer field in completed transactions. (The Transfer field is the fourth (4) from the left in the register display.)

10. Per spostarsi alla transazione vuota alla fine del registro, premere il pulsante Vuota sulla barra degli strumenti o andare in Operazioni → Transazione vuota.

**Transazioni con suddivisioni multiple**

La finestra del registro può apparire leggermente diversa in funzione delle opzioni di visualizzazione selezionate. Nel seguito verrà descritto il processo di inserimento di una transazione con suddivisioni
Operazioni comuni per le transazioni

multiple quando lo stile del registro è impostato a quello di libro mastro basilare. In GnuCash una *suddivisione* si ha quando il denaro è trasferito da o verso due o più conti per una stessa transazione. Il cursore viene automaticamente posizionato nel campo della data all’apertura della finestra del registro.

Le righe per i conti multipli non saranno visualizzate nella modalità a *libro mastro basilare* a meno che non vengano selezionati o il pulsante Suddivisione o l’opzione Operazioni → Suddividi

1. Selezionando la piccola icona a destra del campo della data, verrà visualizzato un calendario da cui è possibile selezionare la data. Usare le frecce per selezionare il mese e l’anno corretto e infine selezionare il giorno. Premendo nuovamente la piccola icona verrà chiuso il calendario. È anche possibile digitare dalla tastiera la data e GnuCash cercherà di completarla mentre si sta scrivendo.

2. Premere *Tab* per selezionare o spostarsi nel campo del Nr.. Qui è possibile assegnare un numero alla transazione quale, per esempio, il numero dell’assegno. Premendo + (più) verrà automaticamente assegnato un numero aumentato di una unità rispetto a quello dell’ultima transazione dotata di numero.

3. Premere di nuovo *Tab* per selezionare o spostarsi nel campo della Descrizione. Qui è possibile inserire il nome del beneficiario o qualsiasi altra descrizione relativa alla transazione. GnuCash tenterà di completare automaticamente il nome del beneficiario mentre si scrive.

4. A questo punto possono accadere due fatti alla pressione del tasto *Tab*: se GnuCash individua una transazione esistente corrispondente, il cursore salterà in uno dei campi per l’importo, compilando automaticamente il campo del conto di trasferimento; se si seleziona un campo qualsiasi con il mouse invece di utilizzare il tasto di tabulazione, non verrà compilato automaticamente il campo del conto di trasferimento. Se non ci sono transazioni esistenti corrispondenti, GnuCash sposterà il cursore nel campo del Trasferimento quando è visualizzata una sola riga per la transazione.

5. Quando si digita all’interno del campo del Trasferimento, GnuCash tenterà di completare automaticamente il nome del conto. La ricerca avviene alfabeticamente, quindi digitando *Us* verrà individuata la sezione *Uscite* della lista dei conti. Quando è stata isolata la sezione, è possibile muoversi tra i conti figli premendo i: (due punti). Se, dopo aver digitato *Ex* si preme ;, allora il cursore si sposterà nel primo sottoconto nella lista dei conti. La pressione di una combinazione di lettere e dei: permette di muoversi rapidamente attraverso la struttura ad albero dei conti. La piccola icona a destra del riquadro del Trasferimento rappresenta un metodo alternativo per selezionare un conto.

6. Il campo seguente (R) è relativo allo stato di riconciliazione della transazione ed è descritto in sezione chiamata «Riconciliare un conto a un estratto conto»

7. Premere ancora *Tab* per spostarsi nel primo campo dell’importo. I nomi delle due colonne successive sono diversi in funzione del tipo di conto aperto. Per esempio, i conti bancari visualizzano i nomi Deposito e Prelievo, i conti per le carte di credito mostrano Pagamento e Addebito mentre i conti per le azioni visualizzano Quote, Prezzo, Compra e Vend.

8. Inserire l’importo della transazione nel campo corretto. Prima di premere *Tab* o *Invio* leggere il passo successivo.

9. Per inserire delle ulteriori suddivisioni, premere il pulsante Suddivisione sulla *barra degli strumenti* o selezionare la voce Operazioni → Suddividi transazione. Per le transazioni che contengono più di una suddivisione, viene visualizzata la dicitura "--Transazione suddivisa--" e sarà necessario utilizzare il pulsante Suddivisione per mostrare i dettagli.

10.La transazione verrà espansa, i titoli delle colonne dell’importo cambieranno e l’intestazione della colonna Trasferimento sarà vuota. La prima riga contiene la descrizione e l’importo della transazione. La seconda riga contiene il nome del conto attualmente aperto nel campo del Conto e l’importo della transazione. La terza riga contiene il nome del conto di trasferimento nel campo del Conto. Se l’importo
Operazioni comuni per le transazioni

non risulta bilanciato, GnuCash lo indica inserendo delle celle grigie nelle colonne dell’importo e riportando l’ammontare non bilanciato nell’ultima riga vuota del registro.

11. Quando viene selezionata una delle righe più corte, le intestazioni delle colonne cambiano. La prima e l’ultima (Data e Saldo) non avranno un titolo; Nr. cambierà in Operazione, Descrizione in Promemoria e la colonna vuota del Trasferimento cambierà il titolo in Conto. Le ultime due colonne dell’importo visualizzeranno i titoli descritti al passo sette.

12. I campi Operazione e Promemoria sono opzionali in questa fase; il primo può contenere una descrizione del tipo di conto di trasferimento coinvolto mentre il secondo è destinato a una descrizione aggiuntiva della transazione.

13. Sposta il cursore nel campo dell’importo mancante sulla terza riga e lo completa. Premendo il tasto Invio, selezionando il pulsante Inserisci o andando in Transazione → Inserisci transazione il cursore verrà posizionato sulla riga successiva.

14. La colonna del Conto contiene una lista dei conti di trasferimento. Questa colonna è utilizzata per aggiungere delle suddivisioni. Il metodo descritto al passo cinque, può essere utilizzato per selezionare un ulteriore conto su una riga vuota. Si possono aggiungere quante suddivisioni si desiderano.

15. Quando la transazione è bilanciata, le celle grigie spariranno come anche l’importo visualizzato nell’ultima riga vuota.

16. Premendo Invio, come descritto più sopra, si salterà alla transazione successiva. Selezionando la transazione successiva verrà chiusa automaticamente la suddivisione oppure si potrà chiuderla manualmente premendo il pulsante Suddivisione oppure selezionando la voce del menù Operazioni → Suddividi transazione.

Multiple Currency/Commodity Transactions

Any transaction that has splits whose accounts are denominated in different commodities (currencies are a subset of commodities) requires an exchange rate to convert between the two. For more information please see Chapter 10 of the Tutorial and Concepts Guide.

Registers for accounts of type STOCK or FUND display four columns, Shares, Price, Buy, and Sell (the last two will be Credit and Debit respectively if you've enabled Use formal accounting labels in the Accounts tab of Preferences). Enter any two and GnuCash will calculate the other for you; if you enter 3 and the result doesn't balance GnuCash will ask which one to change to make the split balance.

Registers of other types have only Credit and Debit (the names will be different depending on the account type if you haven't enabled Use formal accounting labels) and so use the Transfer Dialog with most of the fields disabled to collect either an Exchange Rate or a To Amount (the amount in the other currency/commodity). Please see (sezione chiamata «Currency Transfer») for details of using this dialog.

Nota

When committing a transaction or confirming an exchange rate the price on the transaction date in the Price Editor may be updated. See sezione chiamata «Editor prezzi» for details.

Modificare una transazione

Per modificare una transazione è sufficiente selezionare la parte della transazione che si desidera modificare. Una volta effettuati i cambiamenti, premere il tasto Invio, oppure selezionare il pulsante
Inserisci o andare in Transazione → Inserisci Transazione per spostare il cursore nella riga successiva della transazione.

Per visualizzare maggiori dettagli relativi a una transazione nella modalità a libro mastro basilare, premere il pulsante Suddivisione nella barra degli strumenti o selezionare Operazioni → Suddividi transazione.

## Cancellare una transazione

Se è necessario rimuovere una transazione dal registro, selezionarla e premere il pulsante Elimina nella barra degli strumenti oppure andare in Transazioni → Elimina transazione. Verrà visualizzata una finestra di conferma dell’eliminazione, a meno che non siano state cambiate le preferenze. La finestra propone due opzioni.

È possibile rimuovere anche solo alcune parti della transazione premendo il pulsante Suddivisione sulla barra degli strumenti o selezionando Operazioni → Suddividi transazione. La parte della transazione da cancellare può essere poi selezionata per l’eliminazione.

## Rimuovere le suddivisioni da una transazione

La rimozione delle suddivisioni da una transazione prevede che vengano eliminate tutte le suddivisioni a esclusione di quella relativa al conto aperto. Questa operazione rappresenta un metodo efficace per riutilizzare una transazione con suddivisioni multiple modificandola a piacimento (si noti che questo può essere fatto senza espandere la transazione, ma così facendo si rendono più visibili gli effetti dell’operazione).

1. Se lo stile del registro è impostato a libro mastro basilare, premere il pulsante Suddivisione sulla barra degli strumenti o selezionare Operazioni → Suddividi transazione per espandere la transazione selezionata. Se la modalità di visualizzazione del registro è un’altra, è sufficiente selezionare la transazione.

Verrà aperta una finestra per confermare la cancellazione, a meno che non siano state cambiate le preferenze. Questa finestra presenta due opzioni: Ricordalo e non chiedermelo di nuovo e Ricordalo e non chiedermelo di nuovo in questa sessione. La risposta verrà impostata in base all’opzione attivata. La scelta effettuata può essere annullata andando in Operazioni → Ripristina avvisi. Sezione chiamata «Ripristina avvisi...».

3. Tutti i conti e i relativi dettagli verranno rimossi a eccezione del conto attualmente aperto.
4. L’importo non risulterà bilanciato e GnuCash lo indicherà inserendo delle celle grigie nelle colonne dell’importo e riportando l’ammontare non bilanciato nell’ultima riga vuota del registro.
5. Modificare la transazione inserendo le nuove informazioni.

## Copiare una transazione

La copia delle transazioni è disponibile dal menu Transazione. Il menu Transazione presenta i comandi Taglia transazione, Copia transazione e Incolla transazione che permettono di copiare, tagliare e incollare l’intera transazione in una nuova riga. Con questa procedura di copia verrà utilizzata la data mostrata nella nuova linea vuota.

La voce Transazione → Duplica transazione... o il pulsante della barra degli strumenti Duplica, a differenza del comando Copia, permettono di scegliere una nuova data.
• Selezionare la transazione da duplicare.
• Andare in Transazione → Duplica transazione...
• Una finestra dal nome **Duplica la transazione** richiederà la data e il numero della transazione stessa.
• Premere OK per aggiungere la transazione al registro.

**Setting the reconcile status (R field) of a transaction**

In the GnuCash register there is a column named R. This field indicates the status of a transaction. Possible values are:

n  Default status when a transaction is created

c  Cleared. Status may be assigned either manually or by an import process.

y  Status assigned solely by the reconciliation process (see sezione chiamata «Riconciliare un conto a un estratto conto»). Places limits optionally requiring confirmation on editing fields in that line of a transaction.

f  Frozen. Not implemented at this time

v  Voided. Status is assigned or released manually through the transaction menu (sezione chiamata «Registro del conto - Menu Transazione») to a transaction and applies to every line in the transaction. It hides most of the transaction details but does not delete them. When a transaction is voided a reason entry is required that appears to the right of the description.

**Saltare al registro di un altro conto**

Quando si utilizza la finestra del registro del conto, può rivelarsi utile essere in grado di vedere un altro conto e il conto di trasferimento allo stesso tempo. GnuCash permette di eseguire velocemente questa operazione utilizzando la funzione di «salto»; è infatti disponibile, nella *barra degli strumenti*, il pulsante Salta raggiungibile anche tramite il menu Operazioni → Salta nella finestra del registro del conto.

Selezionare la transazione nella finestra del registro del conto e premere il pulsante Salta oppure selezionare Operazioni → Salta per aprire la finestra del registro del conto di destinazione. Se la transazione è suddivisa in più di un conto allora sarà necessario visualizzare tutti i conti di suddivisione e selezionare quello in cui si desidera "saltare".

**Pianificare le transazioni**

Le transazioni pianificate consentono di essere avvisati o di inserire automaticamente le transazioni in una data specificata. Questa proprietà combinata con l’assistente Dall’ultimo avvio... > (sezione chiamata «Assistente dall’ultimo avvio») permette di rivedere e inserire le transazioni. L’assistente per il Rimborso di mutui e ipoteche (sezione chiamata «Assistente per mutui e ipoteche») permette di configurare una transazione pianificata per ripagare un prestito con un tasso di interesse composto. L’editor transazioni pianificate (sezione chiamata «Finestra di modifica della transazione pianificata») permette di creare e modificare le transazioni che stanno per essere inserite automaticamente nel registro.

Il metodo più semplice per configurare una transazione pianificata consiste nell’utilizzare come modello una transazione esistente nella finestra del registro di un conto. Selezionare la transazione da utilizzare
come modello e poi selezionare o il pulsante Pianifica sulla barra degli strumenti o andare in Operazioni → Pianifica.... Verrà aperta la finestra dal titolo Crea Transazione pianificata.

- **Nome**: inserire un nome per la transazione pianificata. Questo verrà utilizzato nel campo della Descrizione per la transazione.

- **Frequenza**: selezionare l’intervallo di tempo intercorrente tra due pianificazioni. Le date in cui la transazione verrà inserita saranno visualizzate nel mini calendario in basso.

- **Data d’inizio**: selezionare una data iniziale per la transazione pianificata.

- **Senza fine**: se la transazione non ha un termine.

- **Data di termine**: selezionare una data finale per la transazione pianificata.

- **Numero di occorrenze**: inserire il numero di volte con cui si desidera che la transazione venga inserita nel registro.

Il pulsante Avanzate... apre la finestra dell’Editor transazioni pianificate per modificare la transazione. Questa è descritta nell’apposita sezione: sezione chiamata «Finestra di modifica della transazione pianificata».

### Finestra della transazione pianificata

La finestra per le transazioni pianificate permette di accedere alla lista delle transazioni pianificate e di crearle, modificarle o eliminarle; fornisce anche un calendario. Fermando il cursore per qualche secondo su una data visualizzata dal calendario, verrà mostrata una piccola finestra contenente l’elenco delle transazioni pianificate per quella stessa data; per chiudere la piccola finestra è sufficiente premere su di essa un’altra volta. Le date evidenziate in giallo sul calendario rappresentano i giorni in cui sono pianificate delle transazioni.

Il riquadro superiore della finestra delle transazioni pianificate contiene una lista delle transazioni pianificate attualmente impostate. Questa lista elenca il nome della transazione, se questa è attiva ai fini della pianificazione, la frequenza (mese o giorno) con cui la transazione deve essere inserita, l’ultima data in cui è stata inserita e la prossima data in cui verrà inserita.

Sul lato destro del riquadro è presente una freccia rivolta verso il basso che, quando premuta, permette di selezionare le caratteristiche visualizzate. Togliendo la spunta a una voce, questa verrà rimossa dal riquadro.


Al di sotto della lista delle transazioni pianificate, è posizionato il calendario delle "prossime scadenze"; qui è visualizzato il calendario fino all’anno seguente e sono evidenziate le date in cui sono previste delle transazioni pianificate. Cliccando su di una data nel calendario, verrà aperta una finestra con la lista delle transazioni pianificate per quella stessa data. Spostando il puntatore al di sopra di un’altra data, cambierà di conseguenza anche la lista delle transazioni. Cliccando di nuovo sul calendario verrà chiusa la finestra contenente la lista delle transazioni.

La finestra per le transazioni pianificate è accessibile sia dalla scheda del conto che da quella del registro attraverso la voce del menu Operazioni → Transazioni pianificate → Editor transazioni pianificate.
Finestra di modifica della transazione pianificata

La finestra dell’Editor transazioni pianificate è divisa in aree: Nome, Opzioni, Frequenza, Calendario e Modello di transazione.

Il campo del **Nome** permette di inserire il nome per la transazione pianificata. Questo verrà visualizzato nel campo Descrizione della transazione.

L’area delle **Opzioni** fornisce la possibilità di scegliere se la transazione deve essere creata automaticamente e quanti giorni prima crearla o notificarne la ricorrenza.

L’area delle **Scadenze** fornisce delle opzioni per impostare i limiti di tempo e il numero di transazioni da inserire.

L’area della **Frequenza** permette di impostare le ricorrenze e le date in cui la transazione deve essere inserita.

Il calendario fornisce una rapida visualizzazione delle transazioni già pianificate.

La scheda del **Modello di transazione** permette di impostare la transazione così come deve essere inserita nel registro alla data specificata.

Queste opzioni sono descritte con maggior dettaglio in sezione chiamata «Pianificare le transazioni»

- Dalla scheda delle Transazioni pianificate selezionando una transazione dall’elenco e premendo il pulsante Modifica o Nuovo verrà aperto l’Editor Transazioni pianificate.

Stampare gli assegni

In GnuCash gli assegni sono stampati dal registro del conto. GnuCash fornisce la possibilità di stampare assegni con lo standard Quicken (anche nel formato US Letter) o di creare un formato personalizzato. Anche la posizione dell’assegno e il formato della data sono personalizzabili.

Per stampare un unico assegno in GnuCash, selezionare la transazione di cui stampare l’assegno e andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà per la stampa dell’assegno.

Per stampare più assegni in GnuCash eseguire una ricerca per trovare le transazioni che si intende stampare. Dalla finestra dei risultati della ricerca andare in File → Stampa assegni. Verrà aperta la finestra delle proprietà di stampa degli assegni per stampare tutti gli assegni presenti nella finestra di ricerca.

La finestra per la stampa dell’assegno presenta due schede. La prima è denominata Opzioni e permette di impostare le opzioni più comuni per la stampa dell’assegno; la seconda, denominata Formato personalizzato permette di configurare la posizione dei vari campi sull’assegno. È utile a questo scopo stampare un assegno di prova su un foglio di carta e utilizzarlo per effettuare le correzioni necessarie.

La selezione preimpostata nella finestra delle Opzioni è l’assegno Quicken/Quickbooks (tm) US-Letter.

- Formato dell’assegno: provare prima con il formato Quicken e utilizzare il formato personalizzato se la posizione non è corretta.

- Posizione dell’assegno: permette di selezionare l’assegno da stampare: Top (in alto), Middle (in mezzo) o Bottom (in basso). L’opzione Personalizzato è da selezionare se la posizione degli assegni nella pagina non è corretta.
Operazioni comuni per le transazioni

- Formato data: il valore predefinito visualizzato in questo campo è impostato nelle preferenze di GnuCash. Dalla lista a comparsa è possibile selezionare il formato della data desiderato. Il formato può essere cambiato utilizzando le righe denominate Mesi: e Anni:. Scegliendo Personalizzato sarà possibile impostare il formato della data nel campo Formato: (%m significa mese, %d significa giorno, %Y significa anno). Un esempio del formato selezionato è mostrato appena più sotto nella finestra.

- Indirizzo: l’indirizzo del beneficiario, se il formato dell’assegno contiene uno spazio dedicato e se si intende stampare un unico assegno.

La scheda del Formato personalizzato è divisa in due sezioni. La metà superiore (al di sopra della linea di divisione) contiene due colonne per l’inserimento delle coordinate X e Y della posizione del campo sull’assegno. Le posizioni nel formato di assegno personalizzato sono a partire da x = 0 sul lato sinistro dell’assegno, crescenti verso destra, e y = 0 dal lato superiore dell’assegno, crescenti verso il basso. (Se si utilizza una versione di GTK precedente alla 2.10, allora y = 0 è al bordo inferiore e positiva verso l’alto).

- Beneficiario:
- Data:
- Importo (in parole):
- Importo (in numeri):
- Indirizzo:
- Note:
- Promemoria:
- Importo suddivisioni
- Promemoria suddivisioni
- Conto suddivisioni

La parte della scheda del Formato personalizzato al di sotto della linea di divisione contiene i campi per il posizionamento dell’assegno all’interno della pagina. La Traslazione è la distanza dall’angolo superiore sinistro mentre la Rotazione rappresenta la rotazione in senso orario dell’assegno.

Il campo Unità nella metà inferiore della finestra indica le unità da utilizzare per i campi in entrambe le metà della finestra.

Una volta che è stato premuto il tasto OK nella finestra di stampa dell’assegno, verrà visualizzata la finestra per la stampa di un documento di GnuCash. Premere di nuovo OK per stampare l’assegno.

Operazioni online...

Nota

Questa sezione è “in costruzione - ogni contributo è benvenuto!!”.

Ricevi saldo

Ricevi transazioni ...
Inoltra transazione

Addebito diretto

Giornale generale

Il libro mastro generale è un registro avanzato che permette di inserire le transazioni senza il bisogno di aprire i singoli conti; permette anche di visualizzare tutte le transazioni per tutti i conti in un unico registro.

L’inserimento di una transazione nel libro mastro generale è più complicato rispetto alla stessa operazione compiuta dal registro del conto. Il vantaggio del libro mastro generale risiede nella visualizzazione più esaustiva delle transazioni inserite in tutti i propri conti.

The General Journal defaults to showing only the previous month of transactions. This is changeable by using the "Filter By..." on the View menu.
Capitolo 7. Business Features

The accounting needs of a business are quite different from that of a person. Businesses have customers that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately paid. Accounts Payable (A/P) record bills that they have received, but might not pay until later. These types of accounts are used primarily when you have a lot of bills and receipts flowing in and out, and do not want to lose track of them just because you do not pay or get paid right away. For most home users, A/R and A/P are too complicated to be worth the effort.

Accounts Receivable (or A/R) refers to products or services provided by your company for which payment has not yet been received. This is represented on the balance sheet as an asset, because the expectation is that you will receive payment soon.

Accounts Payable (or A/P) refers to products or services bought by your company for which payment has not yet been sent. This is represented on the balance sheet as a liability because you will have to pay for them.

Initial Setup

To set up GnuCash to handle accounts receivable and accounts payable for a company the following preliminary steps must be done.

Account Setup

There are many different ways to set up a business account hierarchy. You can start with the Business Accounts setup which is available from the New Account Hierarchy assistant, or you could build one manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and proceed until you see the list of available accounts, select Business Accounts.

Nota

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need to make adjustments for the hierarchy to function well with your particular situation. It should be close enough that it is recommended you begin with it.

Tax Tables

Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table can be assigned to an invoice line or bill line.

The default invoice line tax table can be assigned to each customer and the default bill line tax table can be assigned to each vendor.

The default tax table for new customers or new vendors can be specified in the Book Options window which can be accessed by File → Properties → Business tab.

Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business → Sales Tax Table. The following fields should be entered:
Business Features

- Name This is the tax table name.
- Type Either Percent % or Value $.
- Value This is the percentage or value depending on Type.
- Account This is the account to which tax will be posted. For tax collected from customers, this should probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax laws allow tax paid to vendors to offset tax collected from customers, this should probably also be a Liability account (even though it will usually have a debit balance) so that the net tax owed to the government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will be rolled up and can be seen in the GnuCash Accounts tab.

*If unsure about tax law requirements, get professional advise.*

Company Registration

After you have built the account structure and defined your tax tables, register the GnuCash file as belonging to your company by filling in the data requested in the sezione chiamata «Business Book Options Tab» accessible from the File → Properties menu item.

Counters

Define the format and last used numbers of codes such as customer, invoice, vendor, bill, employee, expense voucher, job number and order. See sezione chiamata «Counters Book Options Tab».

Business Preferences

Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences (GnuCash → Preferences on Mac OS X). See sezione chiamata «Impresa».

Billing Terms

Billing Terms can be used to determine the payment due date and be a guide for determining discount for early payment of invoices (or vendor bills).

Nota

As of GnuCash 2.6.7, Billing terms are only partially supported. Date due is calculated but discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done, although neither is recommended, and professional advise should be used to confirm that regulations are being complied with:

- After creating and posting a payment which pays the invoice in full, manually edit the payment transaction (usually strongly discouraged) and split the payment to reduce it by the amount of the discount and a create a compensating split in an income (discount) account.
- Alternatively, after creating and posting a payment for the discounted amount, create a credit note for the discount using a specific negative sales income (discount) account for the transfer account.
You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business → Billing Terms Editor. The following fields should be entered:

- **Name** The internal name of the billing term. For some examples of billing term names and descriptions see https://wiki.gnucash.org/wiki/Payment_Terms
- **Description** The description of the billing term, printed on invoices
- **There are 2 types of billing terms, with different information to be entered**
  - **Type Days**
    - **Due Days** The invoice or bill is due to be paid within this number of days after the post date
    - **Discount Days** The number of days after the post date during which a discount will be applied for early payment
    - **Discount %** The percentage discount applied for early payment
  - **Type Proximo**
    - **Due Day** The day of the month bills are due
    - **Discount Day** The last day of the month for the early payment discount
    - **Discount %** The discount percentage applied if paid early
    - **Cutoff Day** The cutoff day for applying bills to the next month. After the cutoff, bills are applied to the following month. Negative values count backwards from the end of the month.

---

**Crediti correnti**

GnuCash has an integrated accounts receivable system.

To use GnuCash’s integrated accounts receivable system, you must first set up *Accounts Receivable* accounts of type *A/Receivable* under *Assets* to accrue income you're owed. It is within this account that the integrated A/R system will place transactions, debiting it when you post bills and crediting it when you receive payments.

**Basic A/R Account Hierarchy:**

- Assets
  - Accounts Receivable
  - Checking
  - Income
  - Sales
  - Liabilities
  - Tax
    - Tax on Purchases
    - Tax on Sales
Nota

You need to add additional asset, expense, and income accounts to this hierarchy for it to be useful. The important aspects of this hierarchy are the use of an income account and the *Accounts Receivable* asset account, with account type set to *A/Receivable*.

If you deal with customers in more than one currency you will need a separate *Accounts Receivable* account for each currency.

The transactions generated by the A/R system are recorded within the *Accounts Receivable* account. You generally do not work directly with this account. You generally work with the four integrated GnuCash A/R application components available through the Business → Customer sub-menu. These four components are:

- **sezione chiamata «Customers»**
  People or companies to whom you sell products or services on credit.

- **sezione chiamata «Fatture»**
  The physical invoice you send to a customer to request payment. This invoice contains an itemized list of things you sold.

- **sezione chiamata «Customer Jobs»**
  Is where you register Customer Jobs. Jobs are a mechanism by which you can group multiple invoices to a particular customer.

- **sezione chiamata «Process Payment»**
  Used to register payments you received from a customer.

The following sections introduce the individual components in more detail.

Customers

Customers are people or companies to whom you sell goods or services. They must be registered within the A/R system.

Nuovo

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options:

- **Identification - Customer Number** - can be any number by which you would like to refer to this customer. You may leave it blank and a number will be chosen automatically. See sezione chiamata «Counters Book Options Tab» for more info.

- **Identification - Active** - differentiates active customers from inactive ones. This is useful when you have many past customers, and you want to see only those marked active.

- **Billing Address - Name** - is the contact name of the person to receive the invoices.

- **Notes** - records any additional comments about the customer.
• Billing Information - Currency - specifies the billing currency for this customer. It will default to the default currency set in Preferences.

**Nota**

All invoices will be denominated in this currency and GnuCash will require an Accounts Receivable account in this currency.

• Billing Information - Terms - specifies the default billing terms for this customer. Billing terms must be preregistered using Business → Billing Terms Editor.

• Billing Information - Discount - gives the customer a default percentage based discount at the time of invoice creation. Enter a value from 0 to 100. You can override the default discount when you create an invoice.

• Billing Information - Credit Limit - stores the maximum credit you are willing to extend to the customer. This field is for your reference purposes only. GnuCash does not use the value.

• Billing Information - Tax Included - this specifies whether nor not tax is included in invoice amounts by default. You can choose Yes, No, or Use Global.

  • Yes means that the tax is already included in amounts on invoices.
  
  • No means tax is not included.

  • Use Global means to use the setting made in the global preferences accessible through Edit → Preferences (Gnucash → Preferences on Mac OS X).

• Billing Information - Tax Table - specifies a default tax table to apply to invoice line items. Tax tables must be registered from the Business → Tax Table Editor menu item.

• Shipping Address - records the customer’s shipping address if it is different from the billing address. The shipping address is for your reference. GnuCash does not use the value.

**Find and Edit**

To search for an existing customer, use the Business → Customer → Find Customer window. You select a customer to View/Edit from the results of the search. This window is also used to look up customers when creating invoices and processing payments.

If many customers match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the customer is not in the result of the original search, and you only search within this set, the customer cannot be found, regardless of new search criteria.

**Nota**

To return a list of all registered active customers, set the search criterion to matches regex, and place a single dot "." in the text field area. Make sure Search only active data is checked, then click Find. The regular expression "." means to match anything.
**Fatture**

An invoice is the paperwork you send to a customer to request payment for products or services rendered. GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

**Nota**

This section applies to both invoices and credit notes. In order to avoid repeating everything twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to credit notes. Only where the behaviour of credit notes differs from invoices this will be explicitly mentioned. Credit notes were introduced starting with GnuCash stable release 2.6.0.

**Nuovo**

To send an invoice to a customer you must first create a new invoice. To create an invoice use Business → Customer → New Invoice. The New Invoice window must be filled in appropriately:

- **Invoice Information - Type** - the type of customer document to create - either an invoice or a credit note.

- **Invoice Information - Invoice ID** - the identification number of this invoice. This is your internal number for this invoice. If you leave it blank, an invoice number will be generated automatically. See sezione chiamata «Counters Book Options Tab» for more info

- **Invoice Information - Date Opened** - the date this invoice was created.

- **Billing Information - Customer** - the customer who is to receive this invoice. If you remember the company name you entered in the New Customer window for this customer, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Customer window described in sezione chiamata «Find and Edit». Highlight the customer you are looking for with a click in the search results, then press the Select button.

- **Billing Information - Job (optional)** - associates the new invoice with a customer job (see sezione chiamata «Customer Jobs»). If you remember the job name you entered in the New Job window for this job, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Job window. This window is the same to the one described in sezione chiamata «Find and Edit». Highlight the job you are looking for with a click in the search results, then press the Select button.

- **Billing Information - Billing ID** - this is the customer’s PO Number or other «customer reference number». You should use it to identify your invoices to this customer (and job, if you have one).

- **Billing Information - Terms** - the payback terms agreement for this invoice. A list of registered terms is available within the pop up menu. If you specified a default value for the selected customer, this field is initialized with the default.

When you click the OK button, the Edit Invoice window opens.

**Modifica**

From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice in a manner similar to how the account register works. For credit notes you enter an itemized list of goods and services you refunded instead.
There are 15 columns in the Invoice Entries area:

- **Date** - The date this item was sold.
- **Invoiced?** - X means the item is attached to this invoice, an empty box means the item is not attached to this invoice. The item is attached for you when you proceed to the next line item.
- **Description (optional)** - is what the item or service is called.
- **Action (optional)** - is a user defined field. You can place Cost Center information here, or use one of the 3 predefined actions, Hours, Material, or Project.
- **Income Account** - selects which income account is credited with this income.
- **Quantity** - tracks how many of the items you sold.
- **Unit Price** - is the unit price of the item.
- **Discount Type** - is the type of discount:
  - $ means Discount is a monetary value
  - % means Discount is a percentage.
  You can click the field to toggle between the discount types.
- **Discount How** - the discount can be computed as follows:
  - > means the discount applies after tax.
  - < means the discount applies before tax.
  - = means both discount and tax are applied to the pretax value.
  You can click the field to change the setting.
- **Discount (optional)** - is the total discount, in monetary units or percentage, depending on Discount Type. You can leave it blank for no discount. Any default discount you specified for the customer will be automatically entered for each new item.
- **Taxable?** - is this item taxable? X means yes, a blank field means no. You can click the field to toggle the setting.
- **Tax Included?** - has the tax already been included in the unit price? X means yes, a blank field means no. For example, if there is 1 item of $100 with a tax of 5% then:
  - If Tax Included is empty, then subtotal = $100 and tax = $5.
  - If Tax included is set (X), then subtotal = $95.23 and tax = $4.77. The computation is: Subtotal = Total / (1+taxrate) and Tax = Total - Subtotal = Total - (Total / (1+taxrate)).
- **Tax Table (optional)** - this is a pop up menu of all the available tax tables. If you make the item taxable, then this table is used to compute the amount of tax. The tax table determines tax percentages and the accounts to which tax is charged.
- **Subtotal (uneditable)** - is the computed subtotal for this item (less tax).
- **Tax (uneditable)** - is the computed tax for this item.
When you have finished entering all the items, you can Post and print the invoice.

**Post**

When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it. Posting an invoice places the transactions in an accounts receivable account.

The Post Invoice window appears and asks you to enter the following information:

- **Post Date** - specifies the date for the transactions entered into the accounts receivable account. By default this is the invoice’s Date Opened (see sezione chiamata «Nuovo» for information about that date).

- **Due Date** - is the date on which payment for the invoice is expected.
  - If you specified payment terms when you created the invoice, the date is calculated according to selected terms, and the entry field is insensitive.
  - If you did not specify payment terms, enter the expected payment due date here.

- **Description** - is an arbitrary description. When invoice transactions are placed in the accounts receivable account, this description is entered in the memo field of those transactions.

- **Post To Account** - selects the accounts receivable account in which invoice transactions are posted. You can select the account from a list of existing A/Receivable accounts.

- **Accumulate Splits** - determines if invoice items which transfer to the same account are combined into a single split for that account or entered individually. For the sample invoice which sold Nails and a Hammer, the setting affects post results as follows:
  - **Checked** (splits are accumulated) - a single transfer of $575.00 from the *Income:Sales* account is recorded.
  - **Not checked** - the transaction created in the A/Receivable account, shows two transfers from *Income:Sales* account $100.00 and $475.00. The memo fields in the splits indicate the sale of Nails and the Hammer (the item descriptions entered on the invoice) respectively.

**Find**

To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results of the search, you can select an invoice to edit or view.

**Nota**

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get to the same state, so you can reach an invoice from different directions based on the way you think about the problem:

- You can search for the customer first, then list their invoices.
- You can search for invoices by number or by company name.
- You can list invoices associated with a customer job.
Stampa

After you post an invoice, you should print it and send it to your customer. To print an invoice use File → Print Invoice menu item.

Suggerimento

You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the sezione chiamata «Changing the Invoice Appearance».

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.
2. Select the General tab of the report options dialog.
3. Click the Select button next to the Invoice Number field.
4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the sezione chiamata «Process Payment» for instructions on how to do so.

Assign Starting Invoice Number

By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later leads to duplicate numbers.

You can change the starting invoice number if it is important you. Use File → Properties, access the Counters tab, change the Invoice number value to be one less than your desired starting invoice number and click the OK button or the Apply button.

Customer Jobs

Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer, and would like to view all the invoices and credit notes related to a single job.

To use customer jobs, you must create them using the Business → Customer → New Job menu item. You will see the New Job window. The editable fields are:

- Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen for you. See sezione chiamata «Counters Book Options Tab» for more info.
- Job Info - Job Name - the name you want to assign to the new job.
- Owner Info - Customer - the customer for whom the job is created. If you remember the company name you entered in the New Customer window for this customer, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Customer window.
Business Features

described in sezione chiamata «Find and Edit». Highlight the customer you are looking for with a click in the search results, then press the Select button.

• Owner Info - Billing ID - the customer's reference to this job (e.g. their PO Number). This is the "Billing Identification" that they require to correlated your invoices with their order. The Billing ID you enter is used to set the billing id for new invoices associated with this job.

• Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since it is easier to search only among jobs that are marked active.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find Job menu item. Select the desired job in the search results and click the View Invoices button. A window listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click the View Invoice button to open an invoice editor in the main application window.

Process Payment

Eventually, you will receive payment from your customers for outstanding invoices. To register these payments, use the Process Payment application found in Business → Customer → Process Payment.

Suggerimento

There is an alternative way of assigning a payment to (one or more) invoices where the payment transaction already exists, say in the case where transactions have been imported from a bank. There is no way to assign a payment to an invoice during the import process, so this must be done after transactions have been imported.

This can best be done starting from the asset account register holding the imported payment transaction (like your bank account). In that account, select the payment, right-click (control-click for Mac OS X) and choose Assign as payment.... The payment window will pop-up, partly filled in with the information from the transaction. Fill in the missing information like the proper customer and invoice to complete the payment.

One caveat: the logic behind Assign as payment... won't properly detect credit note reimbursements and will wrongfully interpret such a transaction as a vendor bill.

The Process Payment application consists of:

• Payment Information - Customer - the customer who paid you. If you remember the company name you entered in the New Customer window for this customer, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Customer window described in sezione chiamata «Find and Edit». Highlight the customer you are looking for with a click in the search results, then press the Select button.

• Payment Information - Invoice - the invoice for which payment was received. If you remember the invoice ID, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Invoice window described in sezione chiamata «Find». Highlight the invoice you are looking for with a click in the search results, then press the Select button.

• Payment Information - Date - the date you you received payment.

• Payment Information - Amount - the amount of money received.
Business Features

• Payment Information - Num - the check number.
• Payment Information - Memo - any comments about this payment.
• Post To - the A/Receivable account to which to post this transaction.
• Transfer Account - the account where the money will be deposited (a checking account for example).

Over Payments or Pre-Payments

If a customer overpays an invoice or pays for goods or services before they have been invoiced, Process Payment for the total amount received. GnuCash will then keep track of the over-payment (or pre-payment) in the A/R account and you can use the residual when paying the next invoice.

Partial Payments

Partial payments are possible too. Select the invoice to pay. GnuCash will automatically suggest that invoice's remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Writing Off a Bad Debt

Nota

Please check with your accountant to ensure the following is acceptable in your region.

The usual way to do this is to process a payment for the invoice to a BadDebt account. Such an account would be an expense account. However, in GnuCash, you can't process a payment for an invoice directly to an expense account, so it takes two steps:

• Pay the invoice to an asset or liability account, such as your checking account.
• Change the asset or liability account, in the non Accounts Receivable split of the payment transaction, to the BadDebt expense account.

Specifically

• Remove all transactions from the A/R account related to the invoice, except for the invoice's transaction itself. This includes any payment transactions, and transactions between your BadDebt and A/R account.

In case the payment has associated lot link transactions (1), remove those as well.

If all is well, your Process Payment window for this customer should list the invoice the customer won't pay, and no prepayments.

• Pay your invoice to an arbitrary asset or liability account. It can be your checking account. We will fix that in the next step.

• Open the account register for your A/R account. For this invoice there should now be one payment transaction. If you are using GnuCash 2.6.0 - 2.6.4 there will also be one lot link transaction (1).

• Select the payment transaction and change the transfer account to your BadDebt account. Make sure to leave the transaction (eg by clicking on another transaction) to save the changes.

If all is well, your Process Payment window should still be clean: no pre-payments, and the bad debt invoice gone.
Business Features

Nota

(1): GnuCash versions 2.6.0 to 2.6.4 created lot link transactions which show in the A/R account register. This came with its own set of subtle issues. It is recommended to upgrade to the latest (or at least 2.6.6) version, which fixes a lot of small problems. Version 2.6.5 had a flaw in the logic cleaning up the lot links. Once upgraded, please run Actions → Check & Repair on your A/R and A/P accounts to clean up most of the lot link legacy. Don't forget to make a backup first just in case.

Lots are used internally for relating payments to invoices. Lots themselves are invisible in the account registers. To see them you need to open the lot viewer, which can be found in Actions → View lots while in any A/R or A/P account register. Select a lot to see the Splits in lot.

Lot links are transactions which you can see in your A/R and A/P accounts. They are unusual in the sense that all their splits are in one account (A/R or A/P). Each split in a lot link transaction is linked (hence the name) to an invoice or payment transaction by means of a lot.


Changing the Invoice Appearance

The default Invoice style, as shown in sezione chiamata «Stampa», is fairly barren. The default invoice style leaves the top part of the form blank, so you can print on company letterhead paper. There are some things you can do to change invoice appearance.

Use File → Properties to enter your Company informations in the Business tab of the Book Options window. Some of the entered informations are printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets. To do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window that will appear.

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows you to change the colors of various items of the invoice. The Fonts section lets you set fonts type and dimensions. The General section allows you to set the Preparer and Prepared for information, and to Enable Links. The Images section allows you to import graphics into the style sheet. The Tables section allows you to adjust the spacing around the tables which make up the invoice.

To include a company logo, banner heading and background image, use your favorite graphics application such as The Gimp or OpenOffice Draw to save the images in either GIF or PNG format. Then import them into the style sheet using the Images section described above.

Nota

The images are placed in the invoice as follows. The Background Tile is tiled to become the background image, the Heading Banner goes to above the invoice text, and the Logo is placed in the upper left corner of the invoice to the left of the Heading Banner. You will probably have to try a few different sized images until you get the invoices to print nicely. Some sizing suggestions are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm (~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the Options menu.
Debiti correnti

GnuCash has an integrated accounts payable system. As with Accounts Receivable you must have an Accounts Payable account set up under Liabilities for each currency in which you will issue invoices. The Accounts Payable accounts accure the amounts you owe to others, so bills credit these accounts and payments and credit memos debit these accounts. Generally you do not directly work with this account but use the four integrated GnuCash A/P application components. The A/P components are available from the Business → Vendor sub-menu.

These A/P components are:

- Vendors are people or companies from which you buy products or services on credit.
- Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized list of things you purchased.
- Jobs (optional) is where you register Vendor Jobs. Jobs are mechanism by which you can group multiple bills from a particular vendor.
- Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.

Vendors

A vendor is a company or person from whom you purchase goods or services. Vendors must be registered within the A/P system.

Nuovo

To register a new vendor, select the Business → Vendor → New Vendor menu item. Fill in general information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options:

- Identification - Vendor Number - can be any number by which you would like to refer to this vendor. You may leave it blank and a number will be chosen automatically. See sezione chiamata «Counters Book Options Tab» for more info.
- Identification - Active - differentiates active vendors from inactive ones. This is useful when you have many past vendors, and you want to see only those marked active.
- Payment Address - Name - is the contact name of the person to receive payments you make.
- Notes - records any additional comments about the vendor. Use it to track names of contact people within the vendor’s company, for example.
- Payment Information - Currency - specifies the payment currency for this vendor. It will default to the default currency set in Preferences.

Nota

All Bills and Credit Notes will be denominated in this currency and GnuCash will require an Accounts Payable account in this currency.

- Payment Information - Terms - specifies the default payment terms for this vendor. Payment terms must be preregistered using Business → Billing Terms.
• Payment Information - Tax Included - specifies if tax is included in bills from this vendor. You can choose Yes, No, or Use Global.

• Yes means that tax is already included in amounts on bills.

• No means tax is not included.

• Use Global means to use the setting made in the global preferences accessible through Edit → Preferences (Gnucash → Preferences on Mac OS X).

• Payment Information - Tax Table - specifies a default tax table to apply to bills from this vendor. Tax tables must be registered using the Business → Tax Table menu item.

Find and Edit

To search for an existing vendor, use the Business → Vendor → Find Vendor window. You select a vendor to View/Edit from the results of the search. This window is also used to look up a vendor when entering bills and processing payments.

If many vendors match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the vendor is not in the result of the original search, and you only search within this set, the vendor cannot be found, regardless of new search criteria.

Suggerimento

To return a list of all registered active vendors, set the search criterion to matches regex, and place a single dot «.» in the text field area. Make sure Search only active data is checked, then click Find. The regular expression «.» means to match anything.

Ricevute

A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu entries as bills.

Nota

This section applies to both bills and credit notes. In order to avoid repeating everything twice and to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes. Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

Nuovo

When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill. To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window appropriately.
• **Invoice Information - Type** - the type of vendor document to create - either a bill or a credit note.

• **Invoice Info - Invoice ID (optional)** - the identification number of the invoice as emitted by the vendor (IE: the vendor’s internal number for this invoice).

• **Invoice Info - Date Opened** - the date the Invoice was emitted by the vendor.

• **Billing Info - Vendor** - the issuing vendor. If you remember the *company name* you entered in the New Vendor window for this vendor, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Vendor window described in sezione chiamata «Find and Edit». Highlight the vendor you are looking for with a click in the search results, then press the Select button.

• **Billing Info - Job (optional)** - associates a vendor job (see sezione chiamata «Vendor Jobs») with this bill. If you remember the *job name* you entered in the New Job window for this job, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Job window. This window is very similar to the one described in sezione chiamata «Find and Edit». Highlight the job you are looking for with a click in the search results, then press the Select button.

• **Billing Info - Billing ID (optional)** - the vendor’s ID for the bill (e.g.: their invoice #).

• **Billing Info - Terms** - the pay back terms agreement for this bill. A list of registered terms is available within the pop up menu. If you specified a a default value for the selected vendor, this field is initialized with the default.

• **Chargeback Project - Customer (optional)** - the customer to associate with this bill. This is used to charge your customer later.

• **Chargeback Project - Job (optional)** - the customer job to associate with this bill.

When you click the OK the Edit Bill opens.

**Modifica**

From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner similar to how the account register works. For credit notes you enter an itemized list of goods and services the vendor refunded instead.

There are 12 columns in the Invoice Entries area:

• **Date** - The date this item was sold.

• **Invoiced?** - X means the item is attached to this invoice, an empty box means the item is not attached to this invoice. If the box is empty you can attach the item to the invoice by first selecting the item row and then clicking in this box.

• **Description (optional)** - is what the item or service is called.

• **Action (optional)** - is a user defined field. You can place Cost Center information here, or use one of the 3 predefined actions, Hours, Material, or Project.

• **Expense Account** - selects the expense account to change for this item.

• **Quantity** - tracks how many of the items you bought.

• **Unit Price** - is the unit price of the item.
• Taxable? - is this item taxable? X means yes, a blank field means no. You can click the field to toggle the setting.

• Tax Included? - has the tax already been included in the unit price? X means yes, a blank field means no.

• Tax Table (optional) - this is a pop up menu of all the available tax tables. If the item is taxable and tax has not been included in the unit price, then this tax table is used to compute the amount of tax.

• Subtotal (uneditable) - computed subtotal for this item (less tax)

• Billable - is this item billable to the chargeback customer/job?

When you have finished entering all the items, Post the bill.

**Post**

When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an accounts payable account. The Post Bill window appears and asks you to enter information:

• Post Date - specifies the date for the transactions entered into the accounts payable account.

• Due Date - is the date on which payment for the bill is expected.
  - If you specified payment terms when you created the bill, the date is calculated according to selected terms, and the entry field is insensitive.
  - If you did not specify payment terms, enter the expected payment due date here.

• Description - is an arbitrary description. When bill transactions are placed in the accounts payable account, this description is entered in the memo field of those transactions.

• Post To Account - selects the accounts payable account in which bill transactions are posted. You can select the account from a list of existing A/Payable accounts.

• Accumulate Splits - determines if bill items which transfer to the same account are combined into a single split for that account or entered individually. For the sample bill for Letterhead and Envelopes, the setting affects post results as follows:
  - Checked (splits are accumulated) - a single transfer of $100.00 to the Expenses:Office Supplies account is recorded.
  - Not checked - the transaction created in the A/Payable account, shows two transfers to Expenses:Office Supplies account $75.00 and $25.00. The memo fields in the splits indicate the purchase of Letterhead and Envelopes (the item descriptions entered on the bill) respectively.

**Find**

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search, you can select a bill to edit, or view.

**Nota**

Before you can edit a posted bill, you will need to Unpost it.
Nota

There are other ways to access an existing bill. These are similar to accessing invoices for your customers. See sezione chiamata «Find» for more information.

Vendor Jobs

Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You will see the New Job window. The editable fields are:

- Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen for you.
- Job Info - Job Name - the name you want to assign to the new job.
- Owner Info - Vendor - the vendor for whom the job is created.
- Owner Info - Billing ID - the vendor’s reference to this job (e.g. their PO Number).
- Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since it is easier to search only among jobs that are marked active.

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job in the search results, and click the View/Edit Job button.

To select from the bills and credit notes associated with a given job, use Business → Vendor → Find Job menu item. Select the desired job in the search results and click the View Invoices button. A window listing bills and credit notes associated with this job appears. Select a bill or credit note and click the View Invoice button to open a bill editor in the main application window.

Process Payment

Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business → Vendor → Process Payment.

Suggerimento

There is an alternative way of assigning a payment to (one or more) bills where the payment transaction already exists, say in the case where transactions are imported from a bank.

This can best be done starting from the asset account register holding the imported payment transaction (like your bank account). In that account, select the payment, right-click (control-click for Mac OS X) and choose Assign as payment.... The payment window will pop-up, partly filled in with the information from the transaction. Fill in the missing information like the proper vendor and bill to complete the payment.

One caveat: the logic behind Assign as payment... won't properly detect credit note reimbursements and will wrongfully interpret such a transaction as a customer invoice.

The Process Payment application consists of:
• Payment Information - Vendor - the vendor you wish to pay. If you remember the company name you entered in the New Vendor window for this vendor, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Vendor window described in sezione chiamata «Find and Edit». Highlight the vendor you are looking for with a click in the search results, then press the Select button.

• Payment Information - Bill - the bill you wish to pay. If you remember the bill ID, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Bill window described in sezione chiamata «Find». Highlight the bill you are looking for with a click in the search results, then press the Select button in the search window.

• Payment Information - Date - the date you wish to make the payment, normally the current date.

• Payment Information - Amount - the amount of money to transfer in this payment.

• Payment Information - Num - the check number.

• Payment Information - Memo - any comments about this payment.

• Post To - the A/Payable account to post this transaction.

• Transfer Account - the account from which money for the payments comes from, such as a checking account.

Over Payments or Pre-Payments

If you wish to overpay an invoice or pay for goods or services before they have been invoiced, Process Payment for the total amount payed. GnuCash will then keep track of the over-payment (or pre-payment) in the A/P account and you can use the residual in the future.

Partial Payments

You may wish to partially pay a bill. Select the bill to pay. GnuCash will automatically suggest that bill’s remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Employees

GnuCash can help your company by tracking employees. You can register a sezione chiamata «New Employee», sezione chiamata «Find and Edit» existing employees, create sezione chiamata «New Expense Voucher/Credit Note» and sezione chiamata «Find and Edit Expense Voucher/Credit Note».

Expense voucher are used to reimburse employees for authorized expenses (f.e. travels, parking, food etc...). Employees credit notes are the opposite of expense vouchers.

New Employee

To register a new employee, select the Business → Employee → New Employee menu item. The New Employee window will open with two tabs:

• Employee tab

• Access Control tab
Employee tab

- Identification - Employee Number - can be any number by which you would like to refer to this vendor. You may leave it blank and a number will be chosen automatically. See sezione chiamata «Counters Book Options Tab» for more info.

- Identification - Username (Mandatory) - a unique username to identify the employee.

- Identification - Active (Optional) - differentiates active employees from inactive ones. This is useful when you have many past employees, and you want to see only those marked Active.

- Payment Address - Name (Mandatory) - the full name of the employee.

- Payment Address - Address (Mandatory) - the address of the employee.

- Payment Address - Phone, Fax, Email (Optional) - other optional contact information for the employee.

- Interface - Language (Optional) -

- Payment Information - Terms (Optional) - specifies the default payment terms for this employee. Payment terms must be preregistered using Business → Billing Terms.

- Billing - Default Hours per Day (Optional) -

- Billing - Default Rate (Optional) -

- Billing - Currency - specifies the billing currency for this employee. It will default to the default currency set in Preferences.

Nota

All expense vouchers and credit notes for this employee will be denominated in this currency and GnuCash will require an Accounts Payable account in this currency.

- Billing - Credit Account (Optional) -

Access Control tab

- Access Control List

Find and Edit

To search for an existing employee, use the Business → Employee → Find Employee... menu. You select an employee to View/Edit from the results of the search. This window is also used to look up an employee when entering voucher and processing payments.

If many employees match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Nota

If the employee you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the employee is not in the result of the original search, and you only search within this set, the employee cannot be found, regardless of new search criteria.
Business Features

**Suggerimento**

To return a list of all registered active employees, set the search criterion to matches regex, and place a single dot «.» in the text field area. Make sure Search only active data is checked, then click Find. The regular expression «.» means to match anything.

**New Expense Voucher/Credit Note**

To register a new expense voucher/ Credit Note, select the Business → Employee → New Expense Voucher... menu item. The New Expense Voucher window will open. You can enter the following data:

- **Voucher information - Type (Optional)** - select if you are entering a Voucher or a credit note.

- **Voucher information - Voucher ID (Optional)** - can be any number by which you would like to refer to this voucher. You may leave it blank and a number will be chosen automatically. See sezione chiamata «Counters Book Options Tab» for more info.

- **Voucher information - Date opened** - the date of the voucher. Click on the button on the right of the date to open a calendar.

- **Billing information - Employee (Mandatory)** - the employee to which voucher refers.

  **Suggerimento**

  The field supports auto-completion so if you start typing GnuCash will try to complete the text automatically using existing employees name. You can also press the button Select... to open the Find Employee window.

- **Billing information - Billing ID (Optional)** - the identification number of the document (f.e. the bill number for a dinner).

- **Billing information - Terms (Optional)** - the pay back terms agreement for this bill. A list of registered terms is available within the pop up menu.

- **Default chargeback project - Customer (Optional)** - the Customer to which voucher refers.

  **Suggerimento**

  The field supports auto-completion so if you start typing GnuCash will try to complete the text automatically using existing Customer name. You can also press the button Select... to open the Find Customer window.

- **Default chargeback project - Job (Optional)** - the Customer Job to which voucher refers.

  **Nota**

  you can type in this field only if there is one or more job registered in GnuCash belonging to the selected Customer.

  **Suggerimento**

  The field supports auto-completion so if you start typing GnuCash will try to complete the text automatically using existing Customer name. You can also press the button Select... to open the Find Customer window.
• Notes - records any additional comments about the voucher/credit note.

Find and Edit Expense Voucher/Credit Note

To search for an existing Expense Voucher, use the Business → Employee → Find Expense Voucher... menu item. You select an Expense Voucher to View/Edit from the results of the search. This window is also used to look up an expense voucher when entering voucher and processing payments.

If many expense vouchers match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Nota

If the expense voucher you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the expense voucher is not in the result of the original search, and you only search within this set, the voucher cannot be found, regardless of new search criteria.

Suggerimento

To return a list of all expense vouchers, set the search criterion to matches regex, and place a single dot «.» in the text field area. Make sure Search only active data is checked, then click Find. The regular expression «.» means to match anything.
Capitolo 8. Strumenti e assistenti

GnuCash fornisce diversi strumenti specializzati che permettono l’accesso a funzionalità avanzate. Questi strumenti sono selezionabili dal menu Strumenti. Alcuni di essi potrebbero non essere visualizzati se non sono stati configurati alcuni dei supporti quali l’Online Banking, o gli strumenti appropriati per la finestra corrente.

Find

The GnuCash Find assistant can be used to find transactions or to perform business related research on your data file.

Find Transaction

Find Transaction is used to search for transactions in GnuCash and display the results in a register window. To open the Find Transaction dialog in Split Search mode, you can type the keyboard shortcut Ctrl+f.

Exactly which transactions are searched depends on where you invoke the tool from. If you start from the main accounts hierarchy page, all transactions will be searched. If you start from an individual account register, only transactions in that account will be searched. And if you filter the transactions in a register using View → Filter By..., then only transactions in that account and shown by the filter will be searched.

Nota

The first row of the Find Transaction dialog indicates that you are performing a Split Search.

There are two panes in the Find Transaction dialog. The top pane contains the Search Criteria buttons and the bottom pane contains the Type of Search selection.

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another criteria row to search for multiple criteria. The existing criteria row needs to be completed before adding a new row. The right button is used to Search for items where all criteria are met or Search for items where any criteria are met. The all criteria are met search requires all of the criteria rows to have at least one match. The any criteria are met search requires only one of the criteria rows to be matched.

The criteria row in the Search Criteria pane is used to combine different criteria buttons (see table Tabella 8.1, «Search criteria buttons - Split Search» for a comprehensive list of combinations)

In the Type of Search pane there are five selections. The first option is always enabled, the following three are available when you invoke the Find... option from a register window or after performing the first Find if the Find... command was invoked from any other window. Last option is available only for Business search.

- New Search: Perform a new transaction search
- Refine current search: Search within the results of the previous search
- Add results to current search: Search based on the first set of criteria or the new criteria
- Delete results from current search: Discard any results that match the previous search results
Search only active data

Search only if data are marked as active. This selector is greyed out for the Split Search as it is meaningful only for business related search.

Nota

When selecting search criteria keep in mind that criteria are applied to individual splits or fields in transactions, and that the entire transaction is included in the results. There is no visual indication in the results to indicate which split or field met the search criteria.

When search criteria are selected, you can press the Find button. You will be presented with the search results in a new register tab. A report of the search results may created and printed using Reports → Account Report. The Account Report has limited formatting options but, like all GnuCash reports, being in html format, can be copied and pasted into a spreadsheet for further formatting. Alternatively, the Account Report can be exported to an html file, and the html file may be opened in a spreadsheet.

Nota

Press the Close button to close the Find Transaction dialog.

### Tabella 8.1. Search criteria buttons - Split Search

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>contienex</td>
<td>matchesrex</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>contienex</td>
<td>matchesrex</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>contienu</td>
<td>matchesrex</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>contienex</td>
<td>matchesrex</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulsante 1</td>
<td>Button 2</td>
<td>Button 3</td>
<td>Button 4</td>
<td>Button 5</td>
<td>Pulsante 6</td>
<td>Pulsante 7</td>
<td>Pulsante 8</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>matches</td>
<td>campo</td>
<td>alle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>regex</td>
<td>di ricerca</td>
<td>lettere</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not</td>
<td></td>
<td>maiuscole/</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>match</td>
<td></td>
<td>minuscole</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>Campo per</td>
<td>Elimina</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>la selezione</td>
<td>riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>o il</td>
<td>della data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Valore</th>
<th>ha il credito</th>
<th>ha il debito</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ha il credito</td>
<td>minore di</td>
<td>Campo per</td>
<td>Elimina</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>o il debito</td>
<td>minore o</td>
<td>l'immissione</td>
<td>riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td>dell'importo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore di</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>minore di</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>minore o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore di</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>minore di</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>minore o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore di</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>maggiore o</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>uguale a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quote</th>
<th>is less than</th>
<th>Campo per</th>
<th>Elimina</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>or equal to</td>
<td>l'immissione</td>
<td>riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>equals</td>
<td>dell'importo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Explanations of the Criteria

The Reconcile criterion deserves some more explanation. Think of the selected reconciliation status buttons (Not Cleared, Cleared, and so on) as a single group, joined with a logical “or”. In other words, the selection “is” or “is not” applies to the “or” of the selected status buttons. The buttons which are left unselected are simply ignored. (It’s not the same as saying the reconciliation status must not be one of these.)
Strumenti e assistenti

For example: if you select Reconcile is Cleared Reconciled, that means you’re saying “I want all transactions which contain cleared splits OR reconciled splits” (imagine an invisible “OR” between all the selected status buttons). It’s the same as selecting Reconcile is Cleared, then adding another search criterion with the Add button, then on the new line selecting Reconcile is Reconciled, and finally selecting Search for items where any criteria are met. In either case, GnuCash will show you exactly the same set of transactions.

Find Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher

The business find assistant is used to search for business related items (Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher). To open the business search dialog select the desired item to Find from the Business → Customer/Vendor/Employee submenus.

Suggerimento

The titlebar and the first row of the assistant dialog reports the item type you are searching for: Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher.

There are two panes in the Find dialog. The top pane contains the Search Criteria buttons and the bottom pane contains the Type of Search selection.

Search Criteria section

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another criteria row to search for multiple criteria.

Nota

The existing criteria row needs to be completed before adding a new row.

The right button is used to Search for items where all criteria are met or Search for items where any criteria are met. The all criteria are met search requires all of the criteria rows to have at least one match. The any criteria are met search requires only one of the criteria rows to be matched.


Type of Search section

In the Type of Search pane there are five selections. The first and allst options are always selectable while the following three are available only when you perform the first search by setting some search criteria and pressing the Find button.

New Search
Perform a new search

Refine current search
Search within the results of the previous search

Add results to current search
Search based on the first set of criteria or the new criteria
La ricerca di risultati in corso

Rimuovere i risultati dalla ricerca corrente
Rimuovere i risultati che corrispondono ai risultati precedenti.

Ricerca solo dati attivi
Ricerca solo se i dati sono contrassegnati come attivi.

Il resto del dialogo di ricerca

Quando i criteri di ricerca sono selezionati, è possibile premere il pulsante Trova. Sarà presentato il listino dei risultati di ricerca nello stesso dialogo di ricerca.

Suggerimento

Dalla ricerca, GNUCash ti dà alcuni pulsanti per gestire il risultato evidenziato.

Suggerimento

Nel riquadro inferiore destro del dialogo di ricerca c'è un pulsante che permette di creare un nuovo elemento aziendale.

Nota

Premere il pulsante Chiudi per chiudere il dialogo di assistenza di ricerca.

Tabella 8.2. pulsanti di criteri di ricerca - Ricerca del cliente

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Pulsante 2</th>
<th>Pulsante 3</th>
<th>Pulsante 4</th>
<th>Pulsante 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company Name</strong></td>
<td>contiene</td>
<td>matches regex b</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Customer ID</strong></td>
<td>contiene</td>
<td>matches regex b</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Billing Contact</strong></td>
<td>contiene</td>
<td>matches regex b</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Shipping Contact</strong></td>
<td>contiene</td>
<td>matches regex b</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Strumenti e assistenti

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>does not match regex&lt;sup&gt;b&lt;/sup&gt;</td>
<td>maiuscole/minuscole?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tabella 8.3. Search criteria buttons - Invoice Search

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice ID</td>
<td>contiene</td>
<td>matches regex&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>contiene</td>
<td>matches regex&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Opened</td>
<td>è prima del o il</td>
<td>è il non è il è dopo il è il o dopo il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is Posted?</td>
<td>è impostato a vero</td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data di emissione</td>
<td>è prima del o il</td>
<td>è il non è il è dopo il è il o dopo il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is Paid?</td>
<td>è impostato a vero</td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing ID</td>
<td>contiene matches regex&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Strumenti e assistenti

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>contiene matches regex b</td>
<td>contiene matches regex b</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invoice</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>è</td>
<td>Cliente</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>Select...</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Venditore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>non è</td>
<td>Cliente</td>
<td>Espressione inserita nel campo di ricerca</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Venditore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Job</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cliente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Venditore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Job</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tabella 8.4. Search criteria buttons - Job Search</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulsante 1</td>
<td>Button 2</td>
<td>Button 3</td>
<td>Button 4</td>
<td>Button 5</td>
<td>Pulsante 6</td>
<td>Pulsante 7</td>
<td>Pulsante 8</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>Job Name</td>
<td>contiene matches regex b</td>
<td>contiene matches regex b</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Number</td>
<td>contiene matches regex b</td>
<td>contiene matches regex b</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing ID</td>
<td>contiene matches regex b</td>
<td>contiene matches regex b</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Only Active?</td>
<td>è</td>
<td>impostato a vero</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner's Name</td>
<td>contiene matches regex b</td>
<td>contiene matches regex b</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulsante 1</td>
<td>Button 2</td>
<td>Button 3</td>
<td>Button 4</td>
<td>Button 5</td>
<td>Pulsante 6</td>
<td>Pulsante 7</td>
<td>Pulsante 8</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tabella 8.5. Search criteria buttons - Vendor Search**

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>contiene</td>
<td>matches regex</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor ID</td>
<td>contiene</td>
<td>matches regex</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing Contact</td>
<td>contiene</td>
<td>matches regex</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tabella 8.6. Search criteria buttons - Bill Search**

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill ID</td>
<td>contiene</td>
<td>matches regex</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>contiene</td>
<td>matches regex</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td>è prima del Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>o il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulsante 1</td>
<td>Button 2</td>
<td>Button 3</td>
<td>Button 4</td>
<td>Button 5</td>
<td>Pulsante 6</td>
<td>Pulsante 7</td>
<td>Pulsante 8</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Strumenti e assistenti**

<table>
<thead>
<tr>
<th>Date Opened</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>è prima del</td>
<td>Campo per le selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Is Posted?</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>è</td>
<td>impostato a vero</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data di emissione</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>è prima del</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Is Paid?</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>è</td>
<td>impostato a vero</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Billing ID</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>contiene</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matches regex (b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex (b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bill Notes</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>contiene</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L'espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matches regex (b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex (b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bill Owner</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>è</td>
<td>Cliente</td>
<td>Venditore</td>
<td>Dipendente</td>
<td>Job</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>Select...</td>
<td>Elimina riga</td>
</tr>
<tr>
<td>non è</td>
<td>Cliente</td>
<td>Venditore</td>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Tabella 8.7. Search criteria buttons - Employee Search

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee Name</strong></td>
<td>contiene matches regex (^b)</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>does not match regex (^b)</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Employee Username</strong></td>
<td>contiene matches regex (^b)</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>does not match regex (^b)</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Employee ID</strong></td>
<td>contiene matches regex (^b)</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>does not match regex (^b)</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tabella 8.8. Search criteria buttons - Expense Voucher Search

<table>
<thead>
<tr>
<th>Pulsante 1</th>
<th>Button 2</th>
<th>Button 3</th>
<th>Button 4</th>
<th>Button 5</th>
<th>Pulsante 6</th>
<th>Pulsante 7</th>
<th>Pulsante 8</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Voucher ID</strong></td>
<td>contiene matches regex (^b)</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
</tr>
<tr>
<td></td>
<td>does not match regex (^b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Employee Name</strong></td>
<td>contiene matches regex (^b)</td>
<td>Espressione inserita nel campo di ricerca</td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td></td>
<td></td>
<td>Elimina riga</td>
<td></td>
</tr>
<tr>
<td></td>
<td>does not match regex (^b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Due Date</strong></td>
<td>è prima del</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>è prima del o il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>è dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Strumenti e assistenti</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Pulsante 1</strong></td>
<td><strong>Button 2</strong></td>
<td><strong>Button 3</strong></td>
<td><strong>Button 4</strong></td>
<td><strong>Button 5</strong></td>
<td><strong>Pulsante 6</strong></td>
<td><strong>Pulsante 7</strong></td>
<td><strong>Pulsante 8</strong></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>è prima del o il</td>
<td>è il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Date Opened</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>è prima del o il</td>
<td>è il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Is Posted?</strong></td>
<td>è</td>
<td>impostato a vero</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>è prima del o il</td>
<td>è il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data di emissione</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>è prima del o il</td>
<td>è il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Is Paid?</strong></td>
<td>è</td>
<td>impostato a vero</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è prima del</td>
<td>è prima del o il</td>
<td>è il</td>
<td>Campo per la selezione della data</td>
<td>Elimina riga</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è dopo il</td>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>è il o dopo il</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Billing ID</strong></td>
<td>contiene</td>
<td></td>
<td></td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>matches regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Voucher Notes</strong></td>
<td>contiene</td>
<td></td>
<td></td>
<td>L’espressione inserita è insensibile alle lettere maiuscole/minuscole?</td>
<td>Elimina riga</td>
<td></td>
<td></td>
</tr>
<tr>
<td>matches regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>does not match regex b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Voucher Owner</strong></td>
<td>è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non è</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cliente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Venditore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cliente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Venditore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dipendente</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Assistente dall’ultimo avvio

L’assistente Dall’ultimo avvio viene avviato automaticamente quando si esegue GnuCash; permette di inserire nel registro qualsiasi transazione il cui inserimento automatico sta per avvenire. L’esecuzione all’avvio di GnuCash può essere modificata nella finestra delle preferenze di GnuCash all’interno della scheda Transazioni pianificate. Per eseguire l’assistente manualmente, andare in Operazioni → Transazioni pianificate → Dall’ultimo avvio...

Nella finestra Dall’ultimo avvio... sono presenti tre colonne:

<table>
<thead>
<tr>
<th>Transazione</th>
<th>Il nome assegnato nell’Editor transazioni pianificate che identifica la transazione pianificata.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stato</td>
<td>Il valore del campo State può essere uno tra i seguenti:</td>
</tr>
</tbody>
</table>

**Suggerimento**

Fare clic nel campo della colonna dello Stato relativa a una transazione per modificarne lo stato (questa opzione è disponibile solamente se il campo dello stato non è vuoto)

- **Ignora**
  Se viene visualizzata una transazione pianificata, da creare o come promemoria, l’utente può impostare lo stato a Ignorato per scartare l’inserimento. La transazione pianificata non verrà inserita nel registro e la transazione verrà ricordata solamente nell’occorrenza successiva. Per esempio, se è stato impostato un promemoria per una transazione relativa a un trasferimento di 500€ alla fine del mese verso il proprio conto risparmi, e questo mese si è acquistato un nuovo computer a causa del quale non si avrà la disponibilità di quella cifra, si potrà impostare lo stato della transazione a Ignorato.

- **Posticipato**
  If a scheduled transaction has been listed with a status To-create but you want to hold it and not have it entered to your register yet, then you can set it to Postponed. When at some later time you change it back to To-create it will be created with the original posted-date. If you want to change that you must edit the transaction after it’s created.

- **Promemoria**
  Si è a n giorni dalla data di scadenza della transazione pianificata. Il numero di giorni n con cui segnalare in anticipo la scadenza di una transazione pianificata, può essere impostato o nella scheda Transazioni pianificate delle Preferenze di GnuCash o nella scheda Generali dell’Editor transazioni pianificate.

- **Da creare**
  La transazione pianificata verrà creata automaticamente alla pressione del pulsante Ok.

- **Vuoto**
  Un campo vuoto significa che non è prevista alcuna operazione per la transazione pianificata.

Nella parte inferiore della finestra sono presenti due pulsanti:

- Il pulsante Annulla permette di uscire dalla finestra Dall’ultimo avvio... senza creare le transazioni pianificate.
Il pulsante Ok chiude la finestra Dall’ultimo avvio e applica le operazioni in sospeso.

Nella parte inferiore destra della finestra Dall’ultimo avvio... è possibile abilitare l’opzione Controlla le transazioni create. Abilitandola, quando sono presenti una o più transazioni Da creare, premendo il tasto Ok verrà aperta una finestra del registro in cui sono visualizzati dettagli della transazione inserita automaticamente da GnuCash

Assistente per mutui e ipoteche

Questa procedura guidata crea una transazione pianificata per il rimborso di un prestito. Quando è utilizzato per creare una transazione pianificata, l’assistente crea una formula variabile in modo che l’interesse composto venga correttamente calcolato. Per avviare l’assistente occorre selezionare Operazioni → Transazioni pianificate → Rimborso di mutui e ipoteche... dal menu principale.

It does not support zero-interest loans, but one doesn't really need an assistant for that: Just create a scheduled transaction for the principal divided by the number of payments that lasts for the number of payments. For example, if one has borrowed $1200 for a year at no interest and promised to pay it back in monthly installments, the repayment schedule is $100 monthly for twelve months.

L’assistente per il rimborso di mutui e ipoteche presenta all’avvio una schermata che descrive brevemente la sua funzione. I tre pulsanti in basso nella finestra rimarranno invariati in tutte le finestre dell’assistente.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

• Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.

• Il pulsante Avanti permette di avanzare nella procedura.

La schermata seguente permette di inserire le informazioni essenziali per il prestito. Queste sono fornite normalmente dalla banca al momento della firma dei documenti da parte del debitore. Qui è inoltre possibile impostare il conto che la transazione pianificata utilizzerà per inoltrare il pagamento.

• Conto del mutuo: scegliere un conto per le transazioni di pagamento del mutuo o utilizzare il tasto «Nuovo...» per creare un nuovo conto per le transazioni.

• Importo: l’ammontare del prestito.

• Interest Rate: Enter the loan interest rate in percent per compounding period. The Assistant supports rates between .001% and 100%.

• Tipo: scegliere il tipo di prestito. Se viene impostato il tasso fisso, il riquadro della frequenza è disabilitato.

• Frequenza di variazione del tasso di interesse: scegliere la frequenza con cui il tasso cambia e la data di inizio del cambiamento.

• Data d’inizio: selezionare la data in cui il prestito è stato acceso.

• Length: Enter the length of the loan with the number and period, e.g. 60 months or 5 years.

• Months Remaining: This tells the Assistant how many months remain on the loan. The default value assumes that the loan is paid up through today. For example, if a 5-year loan started on 1 January 2012 and today is 12 July 2015, the default months remaining is 18. If you want to create past payment transactions you’ll set the months remaining accordingly: In our example, if you wanted to create all of
Strumenti e assistenti

the payments you'd set "months remaining" to 60; if you wanted to start tracking the payments at the beginning of 2015 you'd enter 24.

La schermata successiva è destinata all’impostazione del conto di garanzia, dell’assicurazione e delle opzioni delle tasse per il prestito; È utile soprattutto per i pagamenti dei mutui. Quando ognuna di queste opzioni è impostata, vengono abilitate delle pagine aggiuntive nell’assistente per impostare queste voci del pagamento. Tutte le pagine verranno descritte in questa sezione anche se alcune potrebbero non venire visualizzate se l’opzione corrispondente non è stata scelta.

• ... usare un conto destinato a garanzia per i pagamenti?: questa opzione abilita l’utilizzo di un conto impostato per tracciare i pagamenti a garanzia. Se il mutuo o il prestito utilizzano un conto destinato a garanzia per il pagamento delle tasse, dell’assicurazione ecc... allora si imposti il conto qui.

• ... pagare imposte?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento delle tasse.

• ... pagare assicurazione?: aggiunge una schermata per impostare una transazione pianificata dedicata al pagamento dell’assicurazione.

• ... pagare "PMI"?: aggiunge una schermata per impostare una transazione pianificata per il pagamento della PMI (Private Mortgage Insurance = assicurazione privata sul mutuo).

• ... pagare altre uscite?: aggiunge una schermata addizionale per impostare una transazione pianificata dedicata al pagamento delle altre spese relative al prestito.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il rimborso del mutuo.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

• Importo: visualizza le variabili utilizzate per il calcolo della rata da pagare.

• Pagamento da: scegliere un conto da cui pagare il prestito.

• Capitale a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso del capitale.

• Interessi a: scegliere un conto in cui trasferire il pagamento della parte del prestito per il rimborso degli interessi.

• Repayment Frequency: Select the Frequency and start date for loan repayments. Note that the start date will be the posted date of the first scheduled transaction. This is not taken into account for calculating the remaining duration of the loan, see Months Remaining.: Make sure that you set both to reflect your intentions or you may get surprising results.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle tasse.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle tasse.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle tasse.
• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle imposte.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell’assicurazione.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento della PMI.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento della PMI.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento della PMI.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento dell'assicurazione privata sui mutui ipotecari.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento dell’importo dell’assicurazione.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento dell’assicurazione.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento dell’assicurazione.

La schermata successiva permette di impostare i dettagli della transazione pianificata per il pagamento delle altre spese.

• Nome: il nome che, immesso in questo campo, verrà utilizzato per identificare la transazione pianificata, la sua descrizione e il promemoria.

• Importo: inserire l’importo da pagare.

• Pagamento da: scegliere un conto da cui trasferire l’importo per il pagamento delle altre spese.

• Pagamento a: scegliere un conto verso cui trasferire l’importo per il pagamento delle altre spese.

• Frequenza di pagamento: selezionare la frequenza e la data di inizio per il pagamento delle altre spese.

L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.

• Il pulsante Annulla permette di uscire dall’assistente e cancellare la creazione della transazione pianificata per il prestito. Qualunque scelta fatta all’interno dell’assistente fino a questo punto, verrà persa.

• Il pulsante Indietro riporterà alla schermata precedente permettendo la modifica delle opzioni immesse in precedenza.

• Il pulsante Termina terminerà l’assistente e creerà la transazione pianificata.

Ora si dovrebbe avere la transazione pianificata per il rimborso del mutuo o del prestito, impostata correttamente.
Registrare un frazionamento azionario

I frazionamenti azionari avvengono quando una società decide che il prezzo dell’azione è troppo elevato per un singolo investitore che vuole acquistarla. Il frazionamento ha l’effetto di far diminuire il prezzo della singola quota mantenendo invariato il valore delle quote possedute dall’investitore che ha già acquistato le azioni.

Assistente per il frazionamento azionario

GnuCash utilizza questo assistente per registrare i frazionamenti azionari; esso fornisce un modo per inserire i dettagli del frazionamento, qualsiasi cambiamento nel prezzo dell’azione o anche il cash disbursement derivante dal frazionamento azionario.

L’assistente per il frazionamento azionario è accessibile dal menu Operazioni → Frazionamento azionario...

L’assistente visualizza subito una schermata che contiene una breve descrizione del suo funzionamento e del suo utilizzo. I tre pulsanti in basso nella schermata, non cambieranno durante l’utilizzo della procedura guidata.

- Il pulsante Annulla permette di uscire dall’assistente e cancellare l’inserimento delle informazioni del frazionamento azionario. Qualsiasi scelta effettuata nella procedura guidata fino a questo punto, verrà persa.
- Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.
- Il pulsante Avanti permette di avanzare nella procedura.

La schermata successiva permette di selezionare un conto per le azioni. Selezionare un conto dalla lista per registrare un frazionamento o una fusione azionaria.

- Conto: viene elencato il nome del conto di GnuCash per l’azione.
- Simbolo: il simbolo dell’azione associata con questo conto.
- Quote: il numero di quote che sono state acquistate nel conto.

La schermata successiva permette di impostare i dettagli del frazionamento azionario. La parte superiore della finestra contiene dei dettagli utilizzati nella creazione della transazione per il frazionamento azionario.

- Data: selezionare la data del frazionamento azionario.
- Share Distribution: inserire il numero di quote guadagnate dal frazionamento azionario. Per una fusione azionaria si inserisca un numero negativo.
- Descrizione: inserire una descrizione o lasciare quella di default.

La parte inferiore della finestra contiene dei dettagli utili per registrare un prezzo per il frazionamento (opzionale).

- Nuovo prezzo: inserire il prezzo delle azioni nel giorno del frazionamento azionario.
- Valuta: selezionare la valuta delle quote.
La schermata successiva permette di inserire una transazione per l’esborso di liquidi (Cash In Lieu) come conseguenza del frazionamento azionario (opzionale).

- Importo in contanti: inserire l’importo dell’esborso di liquidi.
- Promemoria: inserire un promemoria o lasciare quello di default.
- Conto entrate: scegliere un conto delle entrate per l’esborso.
- Conto attività: scegliere un conto delle attività per l’esborso.

L’ultima schermata fornisce una lista di tre scelte possibili per terminare l’assistente.

- Il pulsante Annulla permette di uscire dall’assistente e cancellare il frazionamento azionario. Qualsiasi scelta effettuata nella procedura guidata fino a questo punto, verrà persa.
- Il pulsante Indietro farà apparire la schermata precedente in modo da poter modificare una selezione fatta in quella finestra.
- Il pulsante Termina crea le transazioni necessarie per registrare il frazionamento azionario.

Ora dovrebbe essere stata immessa correttamente il frazionamento o la fusione azionaria.

**Procedura guidata per l’Online Banking**

**Nota**

Questa sezione è “in costruzione - ogni contributo è benvenuto!!”.

La procedura guidata per l’Impostazione dell’Online Banking permette di creare e modificare i dati necessari per accedere alle transazioni registrate dall’online banking. Attualmente, le istruzioni più complete per questo procedimento sono nella wiki di GnuCash all’indirizzo https://wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect. Se la voce Impostazione dell’Online Banking non appare nel proprio menu Strumenti, verificare di essere nella finestra della struttura dei conti o nella scheda del registro.

**Editor prezzi**

**Nota**

GnuCash uses the term *commodity* to mean anything that it counts: Currencies, securities (i.e. intangible assets like stock or mutual fund shares and bonds), or tangible assets like trucks and computers. When valuing one commodity in terms of another it uses the term *Exchange Rate* between two currencies and *Price* between a non-currency commodity and a currency commodity. For the rest of this section we'll use "price" to mean both price and exchange rate and "commodity" to mean any sort of commodity except where currency behavior is different.

The Price Editor is used to list and edit the price of one commodity in another commodity. New prices can be added, existing prices can be edited, and prices can be retrieved from a variety of sources on the World-Wide Web when the commodity is properly configured.

Each commodity pair can have one price per day. An existing price will be overwritten by a newer one if the newer one has the same or a more preferred source. The order of source preference (1 is most preferred) is:

1. user:price-editor: Prices created manually in the Price Editor
2. Finance::Quote: Online quotes

3. user:price: Prices entered explicitly in the Exchange Rate entry of the Transfer Funds dialog box or in the Price column of a register for an account of types STOCK or MUTUAL

4. user:xfer-dialog: Prices calculated from an entry in the To Amount entry of the Transfer Funds dialog box.

5. user:split-register: Prices calculated from the Shares and Debit or Credit columns of a register for an account of types STOCK or MUTUAL

6. user:stock-split: Prices entered in the Stock Split Assistant

**Nota**

Prices created manually in the Price Editor are preferred over prices retrieved via Finance::Quote so Finance::Quote will fail to update such manually-created prices.

The Price Editor displays existing prices as follows:

- **Security**: The Security/commodity being priced. The display is sorted by the Namespace that the individual securities are listed on. The list is expanded by clicking on the caret on the left of the name.

- **Valuta**: la valuta con cui il prezzo è registrato.

- **Data**: la data in cui il prezzo è stato registrato.

- **Source**: The source of the commodities price quote, listed above.

- **Tipo**: esistono diversi tipi di prezzi per le azioni.
  - **Offerta**: indica il prezzo con cui un operatore specializzato è pronto ad acquistare un’azione.
  - **Domanda**: indica il prezzo con cui gli operatori sono pronti a vendere l’azione.
  - **Ultimo**: indica il prezzo con cui è avvenuto l’ultimo scambio per l’azione o titolo. Rappresenta il prezzo più comunemente utilizzato dai media.
  - **Net Asset Value**: Are typically used for mutual funds. They are calculated on the net value of the fund’s assets each day around the time of the market close and are in effect until the next recalculation.
  - **Sconosciuto**: utilizzare questa voce se il tipo di prezzo non è noto.
  - **Prezzo**: il prezzo attuale della commodity.

### Aggiungere manualmente il prezzo di un’azione

Per inserire un nuovo prezzo, premere Aggiungi e inserire i dettagli del titolo e del prezzo nel riquadro. Per modificare un prezzo esistente, selezionarlo dalla lista dei prezzi, premere il pulsante Modifica e modificare i dati presenti.

Per cancellare un singolo prezzo, selezionarlo e premere il pulsante Rimuovi. Per rimuovere tutti i prezzi più vecchi di una certa data, premere il pulsante Rimuovi vecchi e inserire i dettagli nella schermata visualizzata.

Verrà visualizzata una finestra con il messaggio "**Cancella tutti i prezzi delle azioni in base al seguente criterio:**". Inserire quindi la data dell’ultimo prezzo da cancellare.
Strumenti e assistenti

Al di sotto del campo della data sono presenti due opzioni:

- Cancella i prezzi inseriti manualmente - se selezionata, verranno cancellati i prezzi immessi manualmente e datati precedentemente alla data specificata. Diversamente solo i prezzi aggiunti dal modulo Finance::Quote verranno cancellati.

- Cancella l’ultimo prezzo per un’azione - se selezionata, verranno cancellati i prezzi precedenti alla data specificata. Diversamente, l’ultimo prezzo precedente alla data specificata verrà conservato e tutte le quote più vecchie saranno cancellate.

**Configurazione per l’utilizzo del pulsante Ricevi quotazioni**

Per avere il supporto alla ricezione delle quotazioni tramite internet per una particolare azione o fondo comune, occorre prima di tutto abilitare l’opzione per la ricezione delle quotazioni e selezionare una fonte nell’Editor titolo. Questo processo è descritto in dettaglio in sezione chiamata «Configurare titoli e valute per la ricezione online dei prezzi». Una volta abilitato il servizio e installato il modulo Finance::Quote, sarà possibile aggiornare le quote delle proprie azioni e dei propri fondi comuni premendo semplicemente il pulsante Ricevi quotazioni.

**Editor titoli**

L’editor titoli è utilizzato per creare o modificare le commodity che vengono utilizzate dai conti per i fondi comuni e per le azioni; permette anche di visualizzare i dettagli delle valute nazionali utilizzate da GnuCash.

Per mostrare i dettagli delle valute Nazionali, si attivi l’opzione Mostra valute Nazionali in basso nella schermata.

Per ogni elemento della lista, sono visualizzati i dettagli relativi al titolo o valuta:

- **Type**: Categories for organizing securities. GnuCash has the following built in:
  - CURRENCY or ISO4317: These are used for national currencies and are not editable with the Security Editor.
  - FUND: Ordinarily used for open-ended mutual funds, i.e., those that one purchases from and sells to only the issuing company and that are priced daily at their net asset value.
  - AMEX, ASX, EUREX, NASDAQ, and NYSE: These represent a few of the exchanges on which stocks, closed-end mutual funds, and exchange-traded funds are traded.
  - Template: This is a reserved word. It will not normally appear in the Security Editor unless you type it in, and if you do it will cause problems. Don't use it.

If your investment doesn't fit into one of these categories, for example if you trade stocks on the DAX or LSE, you can easily create your own type simply by typing it into the field. The type of security has no meaning to Gnucash (except Template, don't use that!), it's there only to make it easier for you to find the security from the selection lists.

- **Simbolo**: il simbolo o l’abbreviazione della commodity. Generalmente si tratta del simbolo ticker (per le azioni) o un’abbreviazione univoca per la commodity. Se la commodity è scambiata in un mercato pubblico, è importante utilizzare lo stesso identificatore utilizzato nel mercato. Per le valute Nazionali il simbolo è il codice della valuta secondo la norma ISO-4217.
Strumenti e assistenti

- **Nome**: il nome completo della commodity. Assegnare uno riconoscibile come, per esempio, *Dollari USA o azioni IBM*.

- **Codice**: rappresenta un codice numerico o alfanumerico utilizzato per identificare la commodity. Il codice CUSIP è una stringa numerica che identifica univocamente ogni azione, bond o fondo comune e la maggior parte dei tipi di traded options, futures and commodity. Questo codice non è obbligatorio.

- **Frazione**: rappresenta l’unità minima scambiata della commodity, espressa come frazione di una singola unità nominale. Questa unità è utilizzata dai conti in GnuCash come la frazione predefinita per gli scambi della commodity.

### Aggiungere o modificare una commodity

Per inserire una nuova commodity (azione o fondo comune), premere **Aggiungi** e inserire i dettagli della commodity nella finestra per il **Nuovo titolo**. Per modificare una commodity esistente, selezionarla dalla lista, premere il pulsante **Modifica** e modificare la finestra di **Modifica titolo**. Per eliminare una commodity, selezionarla e premere il pulsante **Rimuovi**.

I campi nelle schermate di nuovo titolo e modifica titolo sono le stesse presentate nell’sezione chiamata **“Editor titoli”**. Al di sotto di questi campi sono presenti le opzioni per le quotazioni online.

### Configurare titoli e valute per la ricezione online dei prezzi

Per avere il supporto alla ricezione delle quotazioni online per una particolare azione o fondo comune, è necessario prima di tutto abilitare la ricezione delle quotazioni online e selezionare la fonte dall’editor del titolo. Per ricevere invece i tassi di cambio delle valute, è necessario che sia solamente abilitata l’opzione per le quotazioni online, che venga selezionato il fuso orario e che sia attivata l’opzione «Ricevi quotazioni» nell’”editor titoli”.

Istruzioni dettagliate sono reperibili nella sezione sulla creazione di nuovi conti, sezione chiamata «Procedura per abilitare l’aggiornamento dei prezzi online»

### Calcolatore di prestiti

Il Calcolatore di prestiti è utile per calcolare gli interessi composti. Fornisce la possibilità di inserire quattro parametri dei cinque necessari per calcolare l’interesse composto e di calcolare il parametro incognito.

La calcolatrice è suddivisa in due riquadri: quello di sinistra presenta cinque campi con un pulsante Calcola e un pulsante Pulisci. Il tasto Calcola permette di ottenere il risultato dell’incognita mentre il pulsante Pulisci cancella qualsiasi valore inserito nel campo corrispondente.

- **Numero di rate**: questo campo è destinato al numero di rate da utilizzare per i calcoli.
- **Tasso di interesse**: questo campo è destinato al valore percentuale del tasso di interesse.
- **Valore attuale**: questo campo contiene, di solito, l’importo che è stato chiesto in prestito. È l’importo di base su cui si vogliono calcolare gli interessi.
- **Importo della rata**: questo campo contiene l’importo del pagamento per il periodo selezionato (ad esempio: mensile, settimanale ecc...). Se serve a ripagare un prestito allora dovrebbe avere un segno negativo.
• **Valore futuro:** questo campo è per il valore finale al termine del periodo di pagamento. Nel caso si stesse ripagando un prestito per intero allora sarebbe nullo (=0).

Il riquadro di destra contiene i pulsanti per selezionare il tipo di pagamento e l’interesse composto utilizzati per i calcoli nel riquadro di sinistra.

• Interesse composto: questa opzione permette di impostare l’intervallo temporale utilizzato per il calcolo se è stato selezionato l’interesse composto discreto.

• Rata: questo pulsante permette di impostare l’intervallo da utilizzare per il campo del Numero di rate.

• Pagamenti alla fine del periodo: attivare l’opzione se il pagamento della rata alla fine del periodo.

• Pagamenti all’inizio del periodo: attivare l’opzione se il pagamento della rata all’inizio del periodo.

• Interesse composto discreto: questa opzione è utilizzata quando l’interesse è applicato in modo discreto, cioè a intervalli temporali definiti dal pulsante Interesse composto descritto più sopra.

• Interesse composto continuo: questa opzione è utilizzata quando il tasso di interesse è applicato in modo continuo.

• Pagamento totale: questo campo visualizza l’importo totale da pagare per restituire il prestito.

Esempi di utilizzo del Calcolatore di prestiti di GnuCash sono forniti nella «guida ai concetti e manuale». Capitolo sui prestiti nella «guida ai concetti e manuale» [https://code.gnucash.org/docs/it/gnucash-guide/loans_calcs1.html]

### Chiudi libro

The Close Book dialog box is used for “closing the books,”--an accounting process that resets the balances of the income and expense accounts. In this process, income account balances are transferred into an income equity account, while expense account balances are transferred into an expense equity account. You must specify both these accounts, which may be the same. You must also specify the date for the closing transfer.

### Dialog Box Details

The dialog box has the following parts:

• Closing Date: Specify the date for the closing transfer. You can type in a date or choose one from the drop-down.

• Income Total: Specify the account into which the total balance of all income accounts will be transferred. Optionally you can create a new account to receive the transfer using the New button.

• Expense Total: Specify the account into which the total balance of all expense accounts will be transferred. Again, you can optionally create a new account to receive the transfer using the New button.

• Description: Specify the description that will be entered in the closing entry.

### How It Works

GnuCash closes books by creating one transaction per currency for income accounts, and one transaction per currency for expense accounts. The transactions all use the date selected by the user, and each
transaction may contain any number of splits. Each split moves the balance out of one income or expense account. The last split in each closing transaction moves the total offsetting debit/credit balance into the specified equity account.

Each transaction will use the description provided by the user in the Description: entry.

The fact that GnuCash just uses transactions to close the books makes it very simple to undo a book closing: just delete the closing transactions.

What It Doesn’t Do

The book closing tool does not delete any accounts or transactions; create any new files; or hide any accounts.

Necessity

Note that closing the books in GnuCash is unnecessary. You do not need to zero out your income and expense accounts at the end of each financial period. GnuCash’s built-in reports automatically handle concepts like retained earnings between two different financial periods.

In fact, closing the books reduces the usefulness of the standard reports because the reports don’t currently understand closing transactions. So from their point of view it simply looks like the net income or expense in each account for a given period was simply zero.

Conclusion

If you close your books, be prepared to see inaccuracies in the standard reports. On the other hand, you will see current-period income and expense figures in the chart of accounts.

Lots in Account

GnuCash uses lots in 2 ways:

• To link security buy transactions to sell transactions so the real cost of the sold securities can be used to calculate capital gain or loss. See sezione chiamata «Lots for Security Capital Gains».

• To link payments or credit notes to the invoices to which they apply in the Business Features. See sezione chiamata «Lots for Business Features».

Lots for Security Capital Gains

The Lots in Account SSSS window, where SSSS is the security account, is used to manually or automatically link security transaction splits to lots and create capital gain/loss transactions to account for the difference between the costs of buying a security and the value received by selling it.

To open the Lots in Account window, open the security account register, then select Actions → View Lots.

Figura 8.1. Lots in Account window for Security Capital Gains

An image of the Lots in Account window for a security account.
Screen Elements

Adjusting the Size of Screen Elements

As well as adjusting the size of the whole window, it is possible to adjust the proportions of the window elements both horizontally and vertically.

There are 2 bars for adjusting the window horizontally. One between the Title and the Lots in This Account panel, and the other between the Splits free panel and the >> and << buttons.

The window proportions may be adjusted vertically by dragging the vertical bar located to the right of Show only open lots.

These resizing bars can be hard to see, so move the mouse pointer until it changes to the resize pointer then click and drag the bar. The resize pointers are different depending on your operating system and theme. Here are some examples of resize pointers:

It is not possible to individually adjust the size of panel columns.

Fields

• Title: Shows the title for the highlighted (selected) lot in the Lots in This Account panel. When a new lot is created by clicking the New Lot button, it has a default title of Lot n where n is a number starting at 0 (for each security account) and incrementing by 1. Deleting a lot does not reset the next number to be used, but the title can be changed as required.

• Notes: Notes for the highlighted lot. Users are free to enter anything they wish and the notes can be changed as required.

Panels

The order of the items in all the panels in this window can be adjusted by clicking on the column headings.

• Lots in This Account panel

This panel shows lots for this security account.

If Show only open lots is checked, only lots that have not been completely sold are shown.

Columns

• Type: Always blank for security lots. This window is also used for business lots (which link payments to invoices) when coming from an Accounts Payable or Receivable account and in that case, Type will be I for invoice. Credit Notes are also Type I.

• Opened: Open if there are no splits in the lot, otherwise the date of the earliest split in this lot.

• Closed: Open if the lot is not fully sold, otherwise the date of the last sell split.

• Title: Lot Title.

• Balance: Number of unsold securities in this lot.

• Gains: Calculated gains or losses for this lot.
• **Splits free panel**

This panel shows buy and sell splits for this security account which are not linked to a lot. Capital Gains splits (Shares and Price are 0) are not shown.

**Columns**

- **Date:** Transaction Date Posted.
- **Num:** Transaction Num.
- **Description:** Transaction Description.
- **Amount:** Number of shares bought or sold from the transaction split. Positive for buys, negative for sells. If the security transaction split has been split into multiple subsplits (because a split may only be linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.
- **Value:** Amount x split price.
- **Gain/Loss:** For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.
- **Balance:** Cumulative number of unsold shares for free splits.

• **Splits in Lot panel**

This panel shows splits linked to the highlighted lot in the Lots in This Account panel. This panel will be empty until a lot is highlighted in the Lots in This Account panel. Capital Gains splits (Shares and Price are 0) are not shown.

**Columns**

- **Date:** Transaction Date Posted.
- **Num:** Transaction Num.
- **Description:** Transaction Description.
- **Amount:** Split number of shares bought or sold. Positive for buys, negative for sells. If the security transaction split has been split into multiple subsplits (say by scrubbing because a split may only be linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.
- **Value:** Amount (No of Shares) x split price.
- **Gain/Loss:** For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.
- **Balance:** The number of unsold shares in this lot after this transaction.

**Buttons**

- **>>:** Links a free split (buy or sell) to a lot. This button is not enabled until both a lot and a free split are highlighted. The split moves from the Splits free panel to the Splits in lot panel.

Multiple buy splits and multiple sell splits may be linked to the same lot. Refer to following section about the Scrub Account button for details of the capital gains transactions created in these situations.

- **<<:** Unlinks a split from a lot. The split moves from the Splits in lot panel to the Splits free panel. This button is not enabled until a split in the Splits in lot panel is highlighted. When the last split is unlinked from a lot, the lot is automatically deleted if there is no capital gain/loss transaction.
• New Lot: Creates a new lot which shows in the Lots in This Account panel. The new lot is not linked to any split.

• Scrub Account:
  
  • Creates a lot for each buy transaction split that is not already linked to a lot.
  
  A new lot is created for each unlinked buy transaction split because gains on investments, in some jurisdictions, may be taxed at different rates depending on how long they were held before being sold. As a separate capital gains transaction is created for each lot, this makes it easier to determine tax on the capital gains based on the lot opened and closed dates.

  If you know that the capital gains from a sale are all to be taxed at the same rate, you can manually link multiple buys to a lot so scrubbing will only create 1 capital gains transaction.

  It is also possible to manually link multiple sell transaction splits to a lot. In this case scrubbing creates a capital gains transaction per sell transaction split based on the average cost of securities held at the time of each sale, assuming acquisitions are allocated to sales using the security account costing method (currently only FIFO). As this makes it complicated to manually verify the costs are correct, it may be wise to limit this to specific situations, say for example if there are multiple sales on the same day.

  • Links buy and sell transaction splits to lots using FIFO method.

  • Calculates gain/loss and creates a separate capital gain/loss transaction for each lot that does not already have one.

  **Nota**

  If gain/loss splits have been manually entered as part of a sell transaction, scrubbing does not recognize them, so if manually adding gain/loss, always separate the gain/loss splits from the transaction that reduces the No of Shares, by putting them in a separate transaction.

• Scrub: Scrub only the highlighted lot. This button is only enabled if a lot is highlighted. If no buy splits are linked to the highlighted lot, nothing is done. The Scrub button will link any free sell splits to the lot as required until the sum of the sell split amounts equals the sum of the buy split amounts. If the sum of the sell split amounts is greater than the sum of the buy split amounts, a sell split will itself be split into 2 splits, with the remaining amount in an unlinked split.

  **Nota**

  For both the Scrub Account and the Scrub buttons:

  The Gain/Loss for each lot is recalculated and a capital gain transaction is created if needed. The transaction has 1 split for the security account and the other with account *Orphaned Gains-C CCC* where CCC is the security currency. The *Orphaned Gains-C CCC* account is used because GnuCash doesn't know which capital gain or loss account should be used, so the user must change it to the required income (or expense) gain or loss account.

• Delete: Delete the highlighted lot. Any linked splits are automatically freed (unlinked). This button is only enabled if a lot is highlighted.

• Close: Close the Lots in Account SSSS window.

Lots for Business Features

Introduction

For business features, lots are used to link payments or credit notes to the invoices to which they apply. This is for both customer invoices and vendor bills.

There are 2 main uses for the Lots in Account window in relation to the business features:

1. To enquire about which payments or credit notes offset particular invoices. For each invoice and credit note, GnuCash automatically creates 1 (and only 1) lot. By selecting the lot for the invoice or credit note in the Lots in This Account panel, all the transaction splits for that lot show in the Splits in Lot panel.

   **Suggerimento**

   Alternatively, print the invoice and check the Payments option on the Display tab in the report options. The Tax Invoice always shows payments so does not have the Payments option.

2. To correct mistakes that are hard to correct otherwise (either due to bugs in past versions of gnucash or due to unintended use of said features). Some of these use cases are found on [this wiki page](https://wiki.gnucash.org/wiki/Business_Features_Issues). In the context of the normal operation of business features, the Lots in Account window is **not** used to create, delete, link or unlink lots. Lots are usually generated and manipulated internally only by the business features programs.

   To open the Lots in Account AAAA window, where AAAA is the Accounts Receivable (AR) or Accounts Payable (AP) account, open the AR or AP account register, then select Actions → View Lots.

**Figura 8.2. Lots in Account window for business features**

An image of the Lots in Account window for an Accounts Receivable account.

**Screen Elements**

The screen elements of the Lots in Account window for an AR or AP account are the same as for a security account, although the actions and data are different. As this window is only used for creating, deleting, linking or unlinking lots in **exceptional** circumstances, the differences are not described. See sezione chiamata «Screen Elements» for a description of the screen elements and what the buttons do when used with the lots of a security account.
Capitolo 9. Resoconti e diagrammi

Nota

This section is a «work in process». Some of the material has not been reviewed for V2.0. While it may not be strictly accurate, it is at least a "guide".

Introduction

Resoconti e diagrammi permettono a GnuCash di presentare una vista generale dei dati finanziari in vari modi. Questi strumenti vanno da un semplice sommario dei totali del conto ad una visualizzazione avanzata di un portafoglio. Questa sezione presenterà una spiegazione dei principali resoconti di GnuCash e su come personalizzarli.

To run a report or chart, click on the Reports menu, then either select a report (it will open with standard options), or click on Saved Report Configuration to select a report you have previously configured and saved.

Once the report has opened, click on the Options toolbar button to configure the report as needed, for example to set the report date or select accounts.

Suggerimento

If you intend to save a report configuration, you should choose a named report date option such as Today rather than enter a specific date so it is not necessary to enter a specific date again in future reports.

Suggerimento

If you often run a report with a date as at the start or end of an accounting period, set the accounting period start and end dates in Edit → Preferences → Accounting Period then select appropriate report date options. See sezione chiamata «Periodo contabile».

Suggerimento

If you cannot find a specific report to suit your requirements, you may be able to use the Find Transaction assistant (Edit → Find) to select a set of transactions, and then report them using Reports → Account Report. Further formatting or analysis may be done by copying and pasting the report into a spreadsheet.

After you have configured a report, you can save the configuration for future use by clicking either the Save Report Configuration or Save Report Configuration As... button.

Saving a Report Configuration

To save a report configuration for future use, while the required report tab is selected, go to the report options, select the General tab and change the Report Name to a meaningful unique name. Do not confuse this with the Report Title which prints at the top of a report.

Click the Save Report Configuration or Save Report Configuration As... button. This will store your customized report options in a file in your home directory. E.g. Linux: ~/.gnucash/saved-reports-[versioninfo]
The first time you save a report with a name that has not already been saved, you can use either the Save Report Configuration or the Save Report Configuration As... button. You can modify the report name before saving it.

After a report configuration for a specific name has been saved, the Save Report Configuration button will immediately update the saved report configuration without giving the opportunity to save the configuration with a new name. Use the Save Report Configuration As... button to save the current report configuration with a new name.

After your customized report has been saved, it is available for use by the Reports → Saved Report Configurations menu and it will also be listed when starting Reports → Sample & Custom → Custom Multicolumn Report.

Working with Saved Report Configurations

Selecting Reports → Saved Report Configurations will open a dialog window with a list of the Saved Report Configurations you have previously created. In this context Saved Report Configurations means the set of customized settings for standard reports.

The Saved Report Configurations window lists each of your previously saved report configurations, and 3 small buttons at the end of each. These buttons perform the following actions

• Load (and run) report configuration. Double clicking a report configuration also performs this action.
• Edit report configuration name. This enables a report configuration to be renamed.
• Delete report configuration.

Configuring Reports and Charts

GnuCash reports have many configuration options. First, run the original report itself. Then, access the report options with the Options button on the toolbar.

Nota

Check changed Graphic Engine Options

Report Options Buttons

After modifying report options, either

• Click the OK button to apply the changes, regenerate the report and close the options window.

  or

• Click the Apply button to apply the changes, regenerate the report and leave the options window open for possible further changes. In this case, both the Apply and OK buttons will be disabled, indicating changes have been applied, until further changes are made.

  or

• Click the Cancel button to close the options window without applying any unapplied changes.

Common Report Options

Many reports share similar options. Some common ones include:
• Nome resoconto: imposta il titolo del resoconto; è anche utilizzato per stampare il resoconto allo scopo di visualizzarlo in seguito.

• Opzioni della data: normalmente i resoconti si riferiscono a una specifica data o intervallo di date. Queste possono essere impostate in due modi: direttamente (utilizzando il selettore di data) o selezionando una data relativa dal menu. Le date relative permettono di specificare dei valori quali Inizio di quest’anno o Oggi.

Suggerimento

If you often run a report with a date as at the start or end of an accounting period, set the accounting period start and end dates in Edit → Preferences → Accounting Period then select appropriate report date options. See sezione chiamata «Periodo contabile».

• Intervallo temporale: questa opzione è utilizzata negli istogrammi per impostare l’intervallo con cui ogni barra viene rappresentata. Valori tipici sono: quotidianamente, settimanalmente, mensilmente e annualmente.

• Conti: selezionare il conto appropriato per il resoconto. Si noti che per alcuni resoconti è possibile selezionare solo certi tipi di conti. Per esempio, un grafico a torta delle uscite è visualizzabile solo se viene selezionato un conto delle uscite.

• Mostra il nome completo del conto: questa opzione permette di scegliere se visualizzare il nome del conto nella forma breve (per esempio Elettricità) oppure completa (per esempio Servizi:Elettricità).

• Includi sottoconti: i resoconti di sommario generalmente hanno un’opzione per includere anche i sottoconti che, se selezionata, fa in modo che sia compresi nel resoconto anche i sottoconti del conto padre selezionato.

• Profondità: questa opzione permette di selezionare il numero di livelli con cui il resoconto deve visualizzare i sottoconti. Se questi superano il livello selezionato, verrà calcolato un valore complessivo per tutti i sottoconti e incluso nel totale. Per fare in modo che ogni conto o sottoconto venga visualizzato singolarmente, selezionare tutti.

• Style Sheet: Select a Style Sheet. Style sheets control how reports are displayed. At the moment, there are four style sheets: Default, Easy, Footer and Technicolor. You can customize each of these from the Edit → Style Sheets... menu item. This is described in the sezione chiamata «Modificare i fogli di stile» section.

• Plot Dimensions: There are width and height options for most charts, which specify the displayed dimensions (in pixels).

• Valuta del resoconto: seleziona la valuta da utilizzare per il resoconto. Generalmente le valute verranno convertite in questa valuta per la visualizzazione.

The default Report Currency is defined in Edit → Preferences Reports tab. See sezione chiamata «Resoconti».

• Fonte del prezzo: selezionare come i prezzi delle azioni e delle valute vengono calcolati in questo resoconto. È possibile scegliere tra la media pesata dei prezzi su tutte le transazioni, i prezzi al valore corrente o i prezzi al momento della compilazione del resoconto.

• Totali: per i diagrammi verrà visualizzata una legenda con i totali.

• Fette massime: controlla il numero massimo di fette visualizzate in un diagramma a torta. Gli altri conti verranno raggruppati in una fetta identificata con Altro.
Resoconti e diagrammi

- Numero massimo di barre: controlla il numero massimo di barre da visualizzare in un istogramma.
- Visualizzazione colonne: permette di scegliere le colonne da visualizzare dal registro.

**Reports Listed By Class**

GnuCash has classified the main types of reports into major classes. These are all available under the Reports menu.

**Resoconti generali**

The General Reports include the Account Summary Report, the Future Scheduled Transactions Summary, the Tax Schedule Report and TXF Export, and the Transaction Report and also the reports in the Sample & Custom menu.

**Sommario del conto**

**Future Scheduled Transactions Summary**

**Tax Schedule Report and TXF Export**

The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The report is intended to be used by a taxpayer to manually prepare his or her own tax return, or alternatively, to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections made to transactions, report settings, currency conversion rates or the account structure as needed. This process should be repeated as often as needed until all the amounts on the report are correct before a final version is used and saved along with the tax returns.

For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions for the time period selected (also in the report options) are included. The report sorts transactions by date within account providing subtotals by account within tax code within Form or Schedule line number. Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules. Optionally uses special date processing to include federal estimated tax payments after year end.

All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest the report date as specified in the report options; if none is available, transaction amounts are converted to zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.

**Nota**

For this to work, the user has to segregate taxable and non taxable income to different accounts, as well as deductible and non deductible expenses. The Income Tax Information dialog is used for this. To access the Income Tax Information dialog go to Edit → Tax Report Options. The user also must set the TXF category of each tax related account. The Income Tax Information dialog is described in the sezione chiamata «Impostare le opzioni per i resoconti delle tasse» section.
**Resoconto delle transazioni**

This report lists transactions in selected accounts during a specified financial period. Two fields may be optionally used for sorting and totalling.

**Opzioni del resoconto**

**Figura 9.1. Transaction Report, Report Options**

This is an image of the *Transaction Report, Report Options, Display tab.*

- **Accounts tab**
  - **Accounts:** Select one or more accounts to be reported.
    
    There are 4 buttons to aid account selection

<table>
<thead>
<tr>
<th>Select All</th>
<th>Select all accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear All</td>
<td>Clear the selection and unselect all accounts</td>
</tr>
<tr>
<td>Select Children</td>
<td>Select all descendants of selected account</td>
</tr>
<tr>
<td>Select Default</td>
<td>Select the default account selection</td>
</tr>
</tbody>
</table>

- **Show Hidden Accounts:** Show accounts that have been marked hidden.
- **Filter By:** Optionally select accounts to be either included or excluded depending on Filter type
- **Show Hidden Accounts:** Show accounts that have been marked hidden in the Filter By list of accounts
- **Filter Type:** One of

<table>
<thead>
<tr>
<th>None</th>
<th>Do not do any filtering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Transactions to/from Filter Accounts</td>
<td>Include Transactions to/from Filter Accounts only</td>
</tr>
<tr>
<td>Exclude Transactions to/from Filter Accounts</td>
<td>Exclude Transactions to/from all Filter Accounts</td>
</tr>
</tbody>
</table>

- **Void Transactions:** One of

<table>
<thead>
<tr>
<th>Non-void only</th>
<th>Show only non-voided transactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Void only</td>
<td>Show only voided transactions</td>
</tr>
<tr>
<td>Both</td>
<td>Show both and include voided transactions in totals</td>
</tr>
</tbody>
</table>

- **Reset defaults button:** Reset all values to their defaults

- **Display tab**
  - **Data**
  - **Reconciled Date**
  - **Num**
• Descrizione
• Promemoria
• Notes: Display the notes if the memo is unavailable
• Account Name
• Use Full Account Name
• Account Code
• Detail Level— One of

<table>
<thead>
<tr>
<th>Single</th>
<th>Display 1 line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Line</td>
<td>Display N lines</td>
</tr>
</tbody>
</table>

**Nota**

Before stable version 2.8.0 *Detail Level* was called *Style* on the General tab.

If *Detail Level* is *Multi-Line*, check boxes *Other Account Name* and *Use Full Other Account Name* are automatically deselected and disabled, and the *Transfer* column is not reported.

• Other Account Name: For multi-split transactions, this parameter should be unticked. See below for more details.
• Use Full Other Account Name
• Other Account Code
• Shares: Display number of shares
• Price: Display share prices
• Amount: One of

<table>
<thead>
<tr>
<th>None</th>
<th>Do not display Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>Single column display</td>
</tr>
<tr>
<td>Double</td>
<td>Two column display</td>
</tr>
</tbody>
</table>

• Running Balance
• Totals
• Sign Reverses: One of

<table>
<thead>
<tr>
<th>None</th>
<th>Do not display signs reversed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Accounts</td>
<td>Reverse amount display for Liability, Payable, Equity, Credit Card and Income accounts</td>
</tr>
</tbody>
</table>
Resoconti e diagrammi

<table>
<thead>
<tr>
<th>Income and Expense</th>
<th>Reverse amount display for Income and Expense accounts</th>
</tr>
</thead>
</table>

- Reset defaults button: Reset all values to their defaults

- **General tab**
  - **Report name:** Enter a descriptive name for this report
  - **Stylesheet:** Select Default, Easy, Footer or Technicolor
  - **Start Date:** Enter or select a specific Start Date
    
    or select one of the following named start date options which will be used to determine the start date each time the report is run
    
    | Start of this month | First day of the current month |
    |---------------------|-------------------------------|
    | Start of previous month | First day of the previous month |
    | Start of current quarter | First day of the current quarterly accounting period |
    | Start of previous quarter | First day of the previous quarterly accounting period |
    | Start of this year | First day of the current calendar year |
    | Start of previous year | First day of the previous calendar year |
    | Start of accounting period | First day of the accounting period as defined in the global preferences |

- **End Date:** Enter or select a specific End Date,
  
  or select one of the following named end date options which will be used to determine the end date each time the report is run
  
<table>
<thead>
<tr>
<th>Today</th>
<th>The current date</th>
</tr>
</thead>
<tbody>
<tr>
<td>End of this month</td>
<td>Last day of the current month</td>
</tr>
<tr>
<td>End of previous month</td>
<td>Last day of the previous month</td>
</tr>
<tr>
<td>End of current quarter</td>
<td>Last day of the current quarterly accounting period</td>
</tr>
<tr>
<td>End of previous quarter</td>
<td>Last day of the previous quarterly accounting period</td>
</tr>
<tr>
<td>End of this year</td>
<td>Last day of the current calendar year</td>
</tr>
<tr>
<td>End of previous year</td>
<td>Last day of the previous calendar year</td>
</tr>
<tr>
<td>End of accounting period</td>
<td>Last day of the accounting period as defined in the global preferences</td>
</tr>
</tbody>
</table>

- **Style:** One of

  - **Single** Display 1 line
  - **Multi-Line** Display N lines
Nota

In stable version 2.8.0, the Style option will be renamed to Detail Level and moved to the Display tab.

- **Common Currency**: Convert all transactions into a common currency
- **Report's currency**: Select the currency to display values
- **Table for Exporting**: Formats the table for cut & paste exporting with extra cells
- **Reset defaults button**: Reset all values to their defaults

**Sorting tab**

- **Primary Key**: Primary Sort Key. One of

<table>
<thead>
<tr>
<th>None</th>
<th>Do not sort</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Name</td>
<td>Sort and subtotal by account name</td>
</tr>
<tr>
<td>Account Code</td>
<td>Sort and subtotal by account code</td>
</tr>
<tr>
<td>Data</td>
<td>Ordina per data</td>
</tr>
<tr>
<td>Exact Time</td>
<td>Sort by exact time</td>
</tr>
<tr>
<td>Reconciled Date</td>
<td>Sort by the reconciled date</td>
</tr>
<tr>
<td>Register Order</td>
<td>Sort as within the register</td>
</tr>
<tr>
<td>Other Account Name</td>
<td>Sort by account transferred from/to's name</td>
</tr>
<tr>
<td>Other Account Code</td>
<td>Sort by account transferred from/to's code</td>
</tr>
<tr>
<td>Imposto</td>
<td>Sort by amount</td>
</tr>
<tr>
<td>Descrizione</td>
<td>Sort by description</td>
</tr>
<tr>
<td>Numero</td>
<td>Sort by check/transaction number</td>
</tr>
<tr>
<td>Promemoria</td>
<td>Sort by memo</td>
</tr>
</tbody>
</table>

- **Show Full Account Name**: Show the full account name for subtotals and subtitles
- **Show Account Code**: Show the account code for subtotals and subtitles
- **Primary Subtotal**: Subtotal according to the primary key
- **Primary Subtotal for Date Key**: Do a date subtotal. Only configurable if primary key is date, exact time or register order. One of None, weekly, monthly, quarterly or yearly
- **Primary Sort Order**: One of

<table>
<thead>
<tr>
<th>Ascending</th>
<th>Smallest to largest, earliest to latest</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descending</td>
<td>Largest to smallest, latest to earliest</td>
</tr>
</tbody>
</table>

- **Secondary Key**: Secondary Sort Key. Same options as Primary Key
- **Secondary Subtotal**: Subtotal according to the secondary key
• Secondary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date, exact time or register order. One of None, weekly, monthly, quarterly or yearly

• Secondary Sort Order: One of

<table>
<thead>
<tr>
<th>Ascending</th>
<th>Smallest to largest, earliest to latest</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descending</td>
<td>Largest to smallest, latest to earliest</td>
</tr>
</tbody>
</table>

• Reset defaults button: Reset all values to their defaults

## Displaying Split Account Details

This is controled by the *Detail Level* option on the Display tab.

### Nota

In stable versions before 2.8.0 this option was called *Style* on the General tab.

In *Single* line mode, there's only one line per transaction. So you can have the account name on one side of the equation and

a. the other account name if there's only one other split in the transaction

or

b. "Split" if there are multiple other splits in the transaction. You can't display multiple "other" account names in one line. There's just no room for it.

In the case of *Multi-Line* mode, this report uses a completely different concept. For each transaction, every split (both the split in this account and the split(s) in the other account(s) !) is printed on a separate line. And every split really means every split: both the split which belongs in the account being reported and the split(s) in the other account(s) that balance the transaction. So even the most basic transaction, with only two splits (this account and other account) will print two lines in multiline mode.

For a simple transaction like this

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Conto</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cheques Received</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;multiple payers&quot;</td>
<td>IncomeAccount</td>
<td></td>
<td>£30.00</td>
</tr>
<tr>
<td>BankAccount</td>
<td>£30.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

then on a Transaction Report for the bank account the details appear pretty much as above.

For clarity of the accounts, you might enter transactions with multiple splits referring to the same account. For example, the above transaction might well be entered like this

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Conto</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cheques Received</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;FirstPayer&quot;</td>
<td>IncomeAccount</td>
<td></td>
<td>£10.00</td>
</tr>
<tr>
<td>&quot;SecondPayer&quot;</td>
<td>IncomeAccount</td>
<td></td>
<td>£20.00</td>
</tr>
<tr>
<td>BankAccount</td>
<td>£30.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When this transaction is printed on the bank account’s Transaction Report in *Single* line mode, then under other account it simply prints the word *split* instead of the account name.
To display the additional split detail, you need to set Single/Multi-Line to Multi-Line and then tick Display -> Account Name. Do NOT tick Display -> Other Account Name.

You can choose whether or not to turn off the full account name using Display -> Use Full Account Name.

Use Full Other Account Name has no effect in Multi-Line mode.

**Attività e passività**

I resoconti di attività e passività includono il rapporto sul saldo, i resoconti sugli investimenti e il resoconto sul patrimonio netto.

- **Portafoglio avanzato:**
  
  **Columns**
  
  - Account: Stock Account
  
  - Symbol: Ticker Symbol/Abbreviation as defined in the Security Editor. A report option can suppress this column.
  
  - Listing: Type as defined in the Security Editor. A report option can suppress this column.
  
  - Shares: Number of shares (quantity). A report option sets how many decimal places to show. A report option can suppress this column.
  
  - Price: Unit market price as at report date. A report option can suppress this column.
  
  - Basis: Cost of all shares acquired by any means, including brokerage fees if the option to include them is checked. Report option *Basis calculation method* can be set to Average, LIFO or FIFO.
  
  - Value: Number of shares * Unit market price as at report date
  
  - Money In: Sum of the cost of stock purchased, excluding stock acquired as part of a Dividend Reinvestment Plan. I.e. External money used to purchase shares.
  
  - Money Out: Money from selling shares or a spin off transaction.
  
  - Realized Gain: Money received for selling shares minus basis for shares sold, minus brokerage fees for the sale if the option to include them in basis is checked.
  
  - Unrealized Gain: Value less Basis for unsold shares
  
  - Total Gain: Realized Gain + Unrealized Gain
  
  - Rate of Gain: Total Gain / Money In * 100 (from GnuCash 2.6.1 onwards)
  
  - Income: Total of all income transactions associated with a stock account.

**Nota**

To include income from dividends which are not reinvested (if there is no split to the stock account in the income transaction, the report has no way of associating the income with a particular stock):

Ensure there is a dummy transaction split to the stock account with quantity 0, price 1 and value 0 in the dividend transaction. Enter the dummy stock split with no values in the
dividend account and it will create the transaction with price 1 even though you cannot see the Price column in that register.

In GnuCash 2.6.6, this report was modified to simplify the recording of dividend and interest payments. With this change it may not be necessary to include the dummy stock split in the transaction. The report will find income (and expense) transactions that are in the parent account of the stock account being reported on. This is done by looking in the parent account for transactions that have exactly two splits (not counting trading account splits) where the other split is to an income or expense account with the same name as the stock's account.

For example given an account structure like

```
Assets (type ASSET)
   Broker (type ASSET)
      Widget Stock (type STOCK)
   Income (type INCOME)
      Dividends (type INCOME)
      Widget Stock (type INCOME)
```

A transaction that debits the "Assets:Broker" account and credits the "Income:Dividends:Widget Stock" account will count as income even though it doesn't have a split with account "Assets:Broker:Widget Stock".

This only works if the parent account ("Assets:Broker" in this case) is a Bank or Asset account and the Income/Expense account has the same name as the stock account. It won't
Resoconti e diagrammi

double count transactions that have a dummy split since they won't have exactly two split transactions.

It will not work if the income or expense account split is to a subaccount of the account with the same name as the stock account i.e. "Income:Dividends:Widget Stock:Franked"

• Brokerage Fees: Brokerage Fees

• Total Return: Total Gain + Income

• Rate of Return: Total Return / Money In * 100

Common report options are described in sezione chiamata «Configuring Reports and Charts»

Report Specific Options

• Accounts Tab

  • Include accounts with no shares: Unchecked (default) or checked.

• Display Tab

  • Show ticker symbols: Checked (default) or unchecked. If unchecked, Symbol column will be omitted.

  • Show listings: Checked (default) or unchecked. If unchecked, Listing column (source of shares price quotes) will be omitted.

  • Show number of shares: Checked (default) or unchecked. If unchecked, Shares column will be omitted.

  • Share decimal places: The number of decimal places to show in the number of shares. Default is 2.

  • Show prices: Checked (default) or unchecked. If unchecked, Price column will be omitted.

• Scheda Generali

  • Price Source: Nearest in time (default) or Most Recent.

  • Basis calculation method: Average (default), FIFO or LIFO.

  • Set preference for price list data: Checked (default): Use price list data. If there is no relevant price list data, transaction prices will be used and there will be a warning. Unchecked: Get prices from stock transactions.

  • How to report brokerage fees: Include in basis (default), Include in gain or Ignore.

• Istogramma delle attività:

The Asset Barchart report displays bars that present the value of all assets in a GnuCash file over time. By default, the report shows all accounts in Accounts Receivable, Current Assets, Fixed Assets, Investments and Special Accounts (if they exist) and it displays monthly bars for the current financial period. This report provides a graphic view of the assets in the file over time.
Like all the generic reports, the user can assign a title and save the report with its selected options for re-use later.

The display is in the form of either a stacked barchart or simple barchart with an option to display a table of the values.

This report calculates and displays a default of 8 bars or up to 24 separate asset accounts value at the end of the day on several dates through a specified time period. The report automatically selects the most significant accounts to display with all other selected accounts summed as *Other*.

The report exploits the outline structure of the chart of accounts to allow the user to select top level accounts and sub-accounts down to a user-selectable depth. Selected sub-accounts below the selected depth are automatically *summed up* into the next level when it is also selected. The default number of sub-account levels is 2, giving a summary view. Increasing the number of sub-levels increases the detail available to display. It is possible to un-select a higher level account and leave sub-accounts selected to force greater detail to appear in the report.

By default the report includes all *asset* accounts and sub-accounts, as well as *Imbalance* and *Orphan* Special accounts in whatever currencies or commodities may be present. The report's base currency is the default currency of the GnuCash file but if the file has data for multiple currencies, then it can be changed to another currency.

Since each account may be individually selected, the report can be designed to focus on a small subset of data such as current assets or investments.

The overall interval of the report defaults to start at the start of the current accounting period and to end at the end of the current accounting period. Numerous other starting choices and ending choices are available.

The first bar shows the selected values at the end of the day on the first date chosen. There are a number of choices for step size from *day* to *year* with the default being *month*. Note that if any step date would fall on the 29th, 30th or 31st in a month that does not have such a date the next interval will be 31 days later. For that step only the date will *slip* up to 3 days into the following month. This is true for releases at least through 2.4.13. Bug 639049 is open in Bugzilla to modify this behavior.

Currently, there is no option to start the report on the last day of any period. There is also no option to show *beginning* balances or *end of previous step* balances. This makes it difficult to correlate this report to business quarterly reports, for example.

The Net Worth linechart report, Liability barchart report and Net Worth barchart report are similar except for the graphic type and default account groups selected.

Other features are customizable in a manner similar to other standard reports.

- Grafico a torta delle attività:
- Saldo medio:
- Rapporto sul saldo: questo resoconto riassume le attività, le passività e il capitale. Quando vengono mantenute correttamente, le attività dovrebbero essere pari alla somma tra passività e capitali; se così non è, allora è presente uno sbilancio all’interno dei conti.
- Balance Sheet using eguile-gnc:
• Giornale generale:

• Libro mastro generale:

• Portafoglio degli investimenti: questo resoconto riassume il valore delle azioni nel paniere corrente.

• Istogramma:

• Grafico a torta delle passività:

• Istogramma del patrimonio netto: il patrimonio netto è rappresentato dalla differenza tra il valore delle attività e quello delle passività.

• Grafico del patrimonio netto: andamento nel tempo del patrimonio netto (differenza tra il valore delle attività e quello delle passività).

• Grafico a dispersione del prezzo:

**Resoconti per gli affari**

I resoconti per gli affari includono i rapporti su clienti e venditori, le fatture stampabili e i resoconti Aging reports.

**Resoconto venditori**

**Customer Summary**

**Fattura semplice**

**Resoconto dipendenti**

**Fattura elaborata**

**Resoconto di lavoro**

**Payable Aging**

This report provides a listing of vendors and their aged outstanding balances. Vendors may be included if they have posted business transactions (e.g. invoices) for the selected accounts payable account. It shows their current balance, and how much they have due from invoices over time periods 0-30 days, 31-60 days, 61-90 days, and over 90 days. The report also contains links to each vendor and to their current vendor report.

Optionally, vendor address details may be also shown.

**Suggerimento**

To export vendor address details, say in order to do a mail merge, select the optional vendor address details in the report options display tab, apply the options to regenerate the report, then copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html file, then read into a spreadsheet.
Opzioni del resoconto

Nota

See Common Report Options in the Configuring Reports and Charts section of this help manual for more details of the common options.

• General tab

  • Report name: Enter a descriptive name for this report - see common report options.

  • Stylesheet: Select a style sheet for this report - see common report options.

  • To: Select a date to report on or a named date. Transactions up to and including the selected date will be used to calculate the outstanding aged balances. See common report options.

  • Report's currency: Select the currency to display the values in - see common report options.

  • Price Source: Select the source of price information used for currency conversion if needed. One of

    | Average Cost            | The volume-weighted average cost of purchases |
    |-------------------------|-----------------------------------------------|
    | Weighted Average (default) | The weighted average of all currency transactions in the past |
    | Most recent             | The most recent recorded price |
    | Nearest in time         | The price recorded nearest in time to the report date |

  • Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

  • Sort By: Sort companies by one of

    | Name (default)       | Company name |
    |----------------------|--------------|
    | Total Owed           | Total amount owed to company |
    | Bracket Total Owed   | Amount owed in oldest bracket. If same, use next oldest |

  • Sort Order: One of

    Increasing (default)

    Decreasing

  • Show zero balance items: Show companies even if they have a zero outstanding balance.

  • Due or Post Date: Leading date. Which date to use to determine aging. One of

    Due Date (default)

    Post Date

  • Payable Account: The accounts payable account used to select vendors to be reported. Vendors are included if they have a posted business transaction (usually an invoice) on or before the report date and also meet the Show zero balance items criteria.

  • Display tab
• Address Name: Display vendor address name. This, and other fields, may be useful if copying this report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.

• Phone: Display address phone number.

• Fax: Display address fax number.

• Email: Display email address.

• Active: Display vendor active status.

Fattura stampabile

Receivable Aging

This report provides a listing of customers and their aged outstanding balances. Customers may be included if they have posted business transactions (e.g. invoices) for the selected accounts receivable account. It shows their current balance, and how much they have outstanding from invoices over time periods 0-30 days, 31-60 days, 61-90 days, and over 90 days. The report also contains links to each customer and to their current customer report.

Optionally, customer address details may be also shown.

Suggerimento

To export customer address details, say in order to do a mail merge, select the optional customer address details in the report options display tab, apply the options to regenerate the report, then copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html file, then read into a spreadsheet.

Opzioni del resoconto

Nota

See Common Report Options in the Configuring Reports and Charts section of this help manual for more details of the common options.

• General tab

• Report name: Enter a descriptive name for this report - see common report options.

• Stylesheet: Select a style sheet for this report - see common report options.

• To: Select a date to report on or a named date. Transactions up to and including the selected date will be used to calculate the outstanding aged balances. See common report options.

• Report's currency: Select the currency to display the values in - see common report options.
• Price Source: Select the source of price information used for currency conversion if needed. One of

<table>
<thead>
<tr>
<th>Price Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Cost</td>
<td>The volume-weighted average cost of purchases</td>
</tr>
<tr>
<td>Weighted Average (default)</td>
<td>The weighted average of all currency transactions in the past</td>
</tr>
<tr>
<td>Most recent</td>
<td>The most recent recorded price</td>
</tr>
<tr>
<td>Nearest in time</td>
<td>The price recorded nearest in time to the report date</td>
</tr>
</tbody>
</table>

• Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

• Sort By: Sort companies by one of

<table>
<thead>
<tr>
<th>Sort By</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (default)</td>
<td>Company name</td>
</tr>
<tr>
<td>Total Owed</td>
<td>Total amount owed by company</td>
</tr>
<tr>
<td>Bracket Total Owed</td>
<td>Amount owed in oldest bracket. If same, use next oldest</td>
</tr>
</tbody>
</table>

• Sort Order: One of

<table>
<thead>
<tr>
<th>Sort Order</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increasing (default)</td>
<td></td>
</tr>
<tr>
<td>Decreasing</td>
<td></td>
</tr>
</tbody>
</table>

• Show zero balance items: Show companies even if they have a zero outstanding balance.

• Due or Post Date: Leading date. Which date to use to determine aging. One of

<table>
<thead>
<tr>
<th>Due or Post Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due Date (default)</td>
<td></td>
</tr>
<tr>
<td>Post Date</td>
<td></td>
</tr>
</tbody>
</table>

• Receivables Account: The accounts receivable account used to select customers to be reported. Customers are included if they have a posted business transaction (usually an invoice) on or before the report date and also meet the Show zero balance items criteria.

• Display tab

• Address Source: Which customer address fields to display. One of

<table>
<thead>
<tr>
<th>Address Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing (default)</td>
<td>Address fields from billing address.</td>
</tr>
<tr>
<td>Shipping</td>
<td>Address fields from shipping address.</td>
</tr>
</tbody>
</table>

• Address Name: Display customer address name. This, and other fields, may be useful if copying this report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.
• Phone: Display address phone number.
• Fax: Display address fax number.
• Email: Display email address.
• Active: Display vendor active status.

Tax Invoice

Resoconto clienti

Entrate e Uscite

I resoconti per entrate e uscite includono il flusso di liquidi e i rapporti sulle entrate.

• Flusso di liquidi:
• Stato patrimoniale:
• Istogramma delle uscite:
• Grafico a torta delle uscite:
• Uscite per giorno della settimana:
• Grafico delle entrate e delle uscite:
• Istogramma delle entrate:
• Income Piechart:
• Income Statement: This report summarizes sources of income and expenditure. (This report was called Profit & Loss in gnucash-1.8.)
• Entrate per giorno della settimana:
• Profit & Loss: This is the same report as the Income Statement but with a different title.
• Bilancio di previsione: questo resoconto riassume le fonti di reddito e di spesa.

Esempi e personalizzazioni

Resoconto di benvenuto di esempio

Resoconto multicolonna personalizzato

This report is used to place multiple reports into a single report window to examine a set of financial information at a glance.

Sample Report with Examples
Budget Report

This report is used to compare budgeted and real amounts for selected accounts. It allows you to review how well you follow the budget.

The report is generated as a table in which each row represents an account and each set of columns shows the budgeted amount, the real amount, and the difference between them for each report period.

Each entry in the real amount column is the sum of all the splits in the row's account over the column's period. For example, if the report is set up for monthly periods, the column is for May, and the row is for Expenses:Groceries, then the value will be the sum of all Expenses:Groceries splits for that May.

The report supports selecting a range of periods instead all of them. Periods that are out of range can be included in report as the consolidated columns around the selected range. This allows you to focus on particular periods, for example the current one, and is especially useful for budgets with many periods. For example, if you have a 12 period budget you can make a 3 column report with the format "(all periods before columns set) (current period columns set) (all periods after columns set)" that is easily fits on the screen and allows you to match values with account names.

Budget report options

Nota

Here we describe only options that are specific for the Budget Report. You can find information about standard parameters in sezione chiamata «Configuring Reports and Charts».

- **Show budget** - include the budgeted values for the period
- **Show actual** - include the real values for the period
- **Show difference** - include the difference between budgeted and real values for the period. Enabling this option does not force including budgeted and actual values in report
- **Show Column with totals** - Adds a final column set containing budgeted, real value, and difference columns summing those values across all periods of the report.
• **Rollup budget amounts to parent** - not used in report, can be deleted or should be fixed

• **Include accounts with zero total balances and budget values** - enables display of accounts with no budget or splits in any period.

• **Budget** - Select the budget to use for report generation

• **Report for range of budget periods** - Enables reporting on a subset of the budget by selecting a beginning and an ending period.

• **Range start** - a combobox with a list of variants how to select start period:
  1. **First** - select first budget period
  2. **Previous** - select previous period.
  3. **Current** - select current period.
  4. **Next** - select next period.
  5. **Last** - select last budget period
  6. **Manual** - enables spinbox where you can select exact period

  **Nota**
  
  The current, previous, and next options select the period based on the date on which the report is run, with current being the period in which the date falls, previous being the one before that, and next the period after. If the current date falls outside the date range covered by the budget, the first or last period will be used as appropriate.

• **Exact start period** - options for select exact start period, enabled only if range start option is set to Manual

• **Range end** - a combobox with a list of variants how to select end period. Values are the same as in Range start options

• **Exact end period** - the same as Exact start period but for the end of range

• **Include collapsed periods before selected** - if on, then includes in report all budget periods, that are before selected period range, as a single consolidated column set

• **Include collapsed periods after selected** - if on, then includes in report all budget periods, that are after selected period range, as a single consolidated column set.

### Printing or Exporting Reports and Charts

**Nota**

Da verificare!!! Come personalizzare la stampa con Gnome?


Most reports, being presented in HTML, can also be copied and pasted into a spreadsheet.
La finestra di stampa di un documento di GnuCash permette di selezionare la stampante alla quale inviare il lavoro di stampa o il file su cui stampare il documento. La finestra fornisce anche un pulsante di Anteprima per controllare il documento prima di inviarlo in stampa. Premendo Stampa il lavoro verrà inviato alla stampante selezionata mentre premendo Annulla la finestra verrà chiusa senza effettuare alcuna stampa.

Stampando dalla finestra del registro, verrà stampato il resoconto dei conti, che è anche chiamato resoconto del registro. In esso sono elencate le transazioni nel conto con un totale. Gli altri resoconti vengono invece stampati come sono visualizzati nella schermata del resoconto.

Creating Reports and Charts

Nota

Questa sezione potrebbe dover essere aggiornata!!!

Se i resoconti forniti da GnuCash non soddisfano le proprie esigenze, è possibile crearne di nuovi. Per farlo è necessario conoscere Scheme (un linguaggio di programmazione simile a LISP) ed è anche consigliato avere accesso al codice sorgente di GnuCash.


Accessing the GnuCash API

It is also necessary to access data from the engine to get information for your report. This is since version 2.1.x performed by a set of Scheme wrapper functions that are documented in the file src/engine/swig-engine.c. Up to version 2.0.5 it was src/g-wrap/gnc.html. Examine some of the other reports in src/scm/report for an indication of how they are used.

Some users started a table in https://wiki.gnucash.org/wiki/Custom_Reports#The_GnuCash_API.

Because the above file only contains the syntax of the function you can use the Doxygen source documentation either local after running

```
./configure --enable-doxygen --enable-html-docs
make doc
```

on your sources or online https://code.gnucash.org/docs/MAINT/ or https://code.gnucash.org/docs/MASTER/ to get more information about the functions.

Report Rendering

Attualmente, i resoconti sono prodotti richiamando una API di generazione HTML, che fornisce una dialettica di HTML e la disegna con un widget HTML. Questa procedura presenta delle limitazioni, in particolare quando si tenta di allineare gli oggetti con precisione, come può rendersi necessario per stampare su fatture pre-stampate.
Capitolo 10. Personalizzare GnuCash

Opzioni di visualizzazione del conto

Il comando Filtra per è utilizzato per impostare o modificare la vista della finestra della struttura ad albero dei conti. La scheda dei Conti permette di selezionare la tipologia dei conti che devono essere mostrati. Queste impostazioni influenzano distintamente ogni finestra aperta della struttura dei conti.

La scheda Altro permette invece di abilitare o disabilitare due opzioni: se visualizzare i conti nascosti e se mostrare i conti che hanno un totale nullo.

La finestra della struttura dei conti, mostra di default solamente la quantità di ogni commodity che si possiede, nella colonna del Totale. Spesso, però, può essere utile visualizzare altri valori; per fare questo si può premere il pulsante Opzioni nella barra del titolo (la piccola freccia verso il basso sul lato destro della barra del titolo nella finestra principale dei conti) e selezionare le voci da visualizzare. Queste scelte influenzano tutte le finestre aperte della struttura dei conti.

Impostare le preferenze

The GnuCash Preferences window allows you to customize your GnuCash session by setting several options. From the GnuCash menu select Edit → Preferences (GnuCash → Preferences on Mac OS X). The GnuCash Preferences window will open. Using the tabs on the left make your desired changes. The settings in this dialog are set per user and not stored with the file. This is in contrast to the settings described in sezione chiamata «Book Options» , which are kept with, and are part of, the file (or Book), and as such are common to all users. So GnuCash Preferences settings are individual to each user who uses a given file and any changes made by one user will not affect other users of that file. Also, a given user’s preferences will be common to all files that that user opens with GnuCash.

Suggerimento

Fermando il cursore per qualche secondo sopra le opzioni presenti in questa finestra, verranno mostrate delle descrizioni più approfondite sulla voce selezionata.

Nota

The changes you make will be applied at once.

Per chiudere la finestra delle Preferenze di GnuCash, premere il pulsante Chiudi.

Ogni scheda della finestra delle Preferenze di GnuCash ha una sezione dedicata nel seguito. Per un elenco delle schede, consultare Capitolo 10, Personalizzare GnuCash.
Período contabile

Figura 10.1. The Preferences window, Accounting Period tab

- Start Date: This item sets the accounting period’s start date.
  - Relative: Use the specified relative starting date for profit/loss calculations. Also use this date for net assets calculations. Relative defines start by today or start of current/previous year, quarter, month.
  - Absolute: Use the specified absolute starting date for profit/loss calculations. Also use this date for net assets calculations.

- End Date: This item sets the accounting period’s end date.
  - Relative: Use the specified relative ending date for profit/loss calculations. Also use this date for net assets calculations.
  - Absolute: Use the specified absolute ending date for profit/loss calculations. Also use this date for net assets calculations.

- Contenuto della barra di riepilogo
  - Include grand total: If checked, show in the Summarybar a grand total of all accounts converted to the default currency.
  - Include non-currency totals: if this option is selected, GnuCash will include in the Summarybar a total for non-currency items (for instance number of shares).
Conti

Figura 10.2. The Preferences window, Accounts tab

- Separator Character: The account separator is the character that separates a parent account from its sub-account, for example Utilities:Electric. The default is a : (Colon), but you can also select / (Slash), \ (Backslash), - (Dash) or . (Period), or any Unicode character that isn’t a letter or a number.

- Reverse Balanced accounts: This option lets you determine whether account balances will display as positive or negative numbers:
  - Entrate e uscite assegna un saldo a credito positivo ai conti delle entrate a un saldo a debito negativo ai conti delle uscite. Consultare sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.
  - Conti crediti (predefinita) visualizza un saldo positivo per i conti che normalmente hanno un saldo in credito (entrate, crediti, passività, capitali). Consultare sezione chiamata «Tipi di conti in GnuCash» per maggiori informazioni su questo tipo di conti.
  - Nessuno mostra tutti i saldi a credito come negativi e tutti i saldi a debito come positivi.

- Labels: Select this option if you want column headings in the register to refer to debits and credits instead of the default informal headings such as withdrawal and deposit.

- Default Currency: This item determines which currency will be selected by default when creating new accounts.
  - Locale: Use the system locale currency for all newly created accounts.
  - Choose: specify the currency to use, independent of your system settings.

- Account Color: This option lets you manage the display of the account color set in the Edit Account window:
Personalizzare GnuCash

- Show the Account Colors as background: show the accounts color as account name background in the Accounts Page.
- Show the Account Colors on tabs: show the accounts color as background in the account register tabs.

Impresa

Figura 10.3. The Preferences window, Business tab

- Generali
  - Enable extra buttons: If checked, extra toolbar buttons for common business functions are shown.
  - Open in new window: If checked, each invoice will be opened in its own top level window. If clear, the invoice will be opened in the current window.
  - Accumulate splits on post: Whether multiple entries in an invoice which transfer to the same account should be accumulated into a single split by default.

- Fatture
  - Report for printing: Allows to select the invoice report to be used for printing.
  - Tax Included: Whether tax are included by default in entries on invoices. This setting is inherited by new customers and vendors.
  - Auto pay on posting: If enabled, at post time automatically attempt to pay customer documents with outstanding pre-payments and counter documents.
### Nota

Counter documents are documents with opposite sign. For example for an invoice, customer credit notes and negative invoices are considered counter documents.

The pre-payments and documents obviously have to be against the same customer.

- Ricevute
  - Notify when due: Lets you set whether you want to be notified at GnuCash startup of when a bill is soon to be due.
  - Days in advance: How many days before the due date to warn about bills coming due.
  - Tax Included: Whether tax are included by default in entries on bills. This setting is inherited by new customers and vendors.
  - Auto pay on posting: If enabled, at post time automatically attempt to pay vendor documents with outstanding pre-payments and counter documents.

### Nota

Counter documents are documents with opposite sign. For example for a bill, vendor credit notes and negative bills are considered counter documents.

The pre-payments and documents obviously have to be against the same vendor.

### Data e ora

**Figura 10.4. The Preferences window, Date/Time tab**

![Preferences window, Date/Time tab](image)
• Formato della data

• Use 24-hour clock: Lets you specify if you want to use 24 or 12 hours time format. That is if 11 o’clock at night should be represented as 11PM or 23:00.

• Date Format: This option controls the appearance of the date (you could see a preview of the date beside any of the choices). The available choices are:

  • US: Use the date format common in the United States.
  • UK: Use the date format common in the United Kingdom.
  • Europe: Use the date format common in continental Europe.
  • ISO: Use the date format specified by the ISO-8601 standard.
  • Locale: Use the date format specified by the system locale.

• Date completion: This option lets you manage the case when a date is entered without a year:

  • In the current calendar year: (Default) Dates will be completed so that they are within the current calendar year.
  • In a sliding 12-month window starting a configurable number of months before the current month: Dates will be completed so that they are close to the current date. You can enter the maximum number of months to go backwards in time when completing dates.

Generali

Figura 10.5. The Preferences window, General tab

Generali
• Display "Tip of the Day" dialog: This option displays or hides the Tip of the Day screen when GnuCash is started.

• Show splash screen: With this option you can enable or disable the visualization of the startup screen while GnuCash is starting up.

• Perform account list setup on new file: This option turns off the display of the New Account Hierarchy Setup assistant when the entry File → New File is selected from the GnuCash menu.

• Set book option on new files to use split "action" field for "Num" field on registers/reports: If selected, the displayed setting on the New Book Options dialog for the Use Split Action Field for Number setting will be selected and, if saved, the book option for the new file will be set so that the "Num" field on registers shows/updates the split-action field and the transaction-num field is shown on the second line in double line mode (and is not visible in single line mode). Otherwise, the displayed setting on the dialog will not be selected and, if saved, the book option for the new file will be set so that the "Num" field on registers shows/updates the transaction-num field. See the discussion in sezione chiamata «Book Options» about how to set book options including the option for sezione chiamata «Use Split Action Field for Number». Regardless of the setting of this preference, the user can modify the initially displayed setting for this option on the New Book Options dialog before saving the options.

Nota

If the New Book Options dialog appears in situations where a new book is being set up, the settings from this preference will determine the default setting for the corresponding check box on the dialog. However, the OK button on the New Book Options dialog must be pressed for the setting to be made for the new book; otherwise it will default to not selected.

• Numeri

• Display negative amounts in red: If you turn off this option, GnuCash will display negative numbers in black.

• Automatic Decimal Point: This option will automatically insert a decimal point into numbers you type in.

• Decimal Places: This field allows you to set the number of decimal places to be used.

• File

Nota

Le opzioni seguenti sono rilevanti solamente per i file salvati in formato XML.

• Compress files: This option determines whether the GnuCash data file will be compressed or not.

• Show auto-save confirmation question: If this option is enabled, GnuCash will show you a confirmation screen each time the auto-save process is started.

• Auto-save time interval: This field sets the number of minutes between each automatic saving of the file. Set to 0 to disable the auto-save feature.

• Enable timeout on "Save changes on closing" question: If enabled, the Save changes on closing question will only wait a limited number of seconds for an answer. If the user didn’t answer within
that time, the changes will be saved automatically and the question window closed. You can set the
number of seconds in the Time to wait for answer field.

- Retain log files: In this section you could set your preferences about the log files using the provided
  radio buttons.
  - Never: Disable the creation of log files.
  - For: Enter a specific number of days for which keep the files.
  - Forever: Disable the auto deletion of log files; retains the log files forever.

- Finestra di ricerca
  - New search limit: Defaults to "new search" if fewer than this number of items is returned.

**Online Banking**

**Figura 10.6. The Preferences window, Online Banking tab**

- Importazione file QIF
  - Show documentation: The first time you use the QIF importer you may notice that the importer has
detailed instructions on how to import a file. Once you have become familiar with using the importer,
you might want to turn off this option. Turning off the option gives you less detail in the importer
screens.

  - Default transaction status (overridden by the status given by the QIF file): In this section you could
set the default status for imported transactions using the provided self-explaining radio buttons:
    - Not cleared (Default)
    - Liquidata
• Riconciliata

• Importatore generico

  • Enable skip transaction action: Enable the SKIP action in the transaction matcher. If enabled, a transaction whose best match’s score is in the yellow zone (above the Auto-ADD threshold but below the Auto-CLEAR threshold) will be skipped by default.

  • Enable update match action: Enable the UPDATE AND RECONCILE action in the transaction matcher. If enabled, a transaction whose best match’s score is above the Auto-CLEAR threshold and has a different date or amount than the matching existing transaction will cause the existing transaction to be updated and cleared by default.

  • Use Bayesian matching: Use Bayesian algorithms to match new transactions with existing accounts.

  • Match display threshold: The minimal score a potential match must have to be displayed in the match list.

  • Auto-add threshold: A transaction whose best match’s score is in the red zone (above display threshold, but below or equal to Auto-add threshold) will be added by default.

  • Auto-clear threshold: A transaction whose best match’s score is in the green zone (above or equal to Auto-clear threshold) will be cleared by default.

  • Commercial ATM fees threshold: In some places commercial ATMs (not belonging to a financial institution) are installed in places like convenience store. These ATMs add its fee directly to the amount instead of showing up as a separate transaction or in your monthly banking fees. For example, you withdraw $100, and you are charged $101.50 plus Interac fees. If you manually entered that $100, the amounts won’t match. You should set this to whatever is the maximum such fee in your area (in units of your local currency), so the transaction will be recognized as a match by GnuCash.

  • Automatically create new commodities: Enables the automatic creation of new commodities if any unknown commodity is encountered during import. If not enabled, the user will be asked what to do with each unknown commodity.

• Online Banking

  **Nota**

  This section is shown only if GnuCash is compiled with Aqbanking and HBCI support.

  • Close log window when finished: Close the log window when the operation is completed.

  • Remember PIN: Enable this option if you want GnuCash to remember the PIN you enter for online banking authentication.

  • Verbose debug messages: Enable this option if you want GnuCash to show more information about the online banking operations.
La scheda Stampa permette di configurare alcune opzioni che governano la stampa su carta degli assegni.

- **Print date format**: Enable this option if you want to print on the check, below the actual date, its format in 8 point type.

- **Print blocking chars**: Enable this option to print a series of three asterisks before and after each text field in the check.

- **Default font**: Click the button on the left to open a Pick a Font screen in which you can customize the font that will be used to print checks.
Registro

Figura 10.8. The Preferences window, Register tab

- **Operazioni**
  - 'Enter' moves to blank transaction: If selected, move the cursor to the blank transaction at the end of the register after the user presses the **Enter** key. Otherwise the cursor will be moved down one row.
  - Auto-raise lists: If selected, all lists will automatically be expanded when input focus is in the list field.
  - Tab order includes Transfer on Memorised Transaction: If selected, when the transaction is auto filled, pressing the **Tab** key in the register the cursor’s jump will include the Transfer field.

- **Riconciliazione**
  - Check cleared transactions: If selected, automatically check off cleared transactions when reconciling.
  - Automatic interest transfer: If selected, prior to reconciling an account which charges or pays interest, prompt the user to enter a transaction for the interest charge or payment. Currently only enabled for Bank, Credit, Mutual, Asset, Receivable, Payable, and Liability accounts.
  - Automatic credit card payment: If selected, after reconciling a credit card statement, prompt the user to enter a credit card payment.
  - Always reconcile to today: If selected, always open the reconcile screen with today’s date for statement date, regardless of previous reconciliation.

- **Grafica**
  - Use system theme colors: If selected, the system color theme will be applied to register windows. Otherwise the original GnuCash register color will be used.
• Double mode colors alternate with transactions: If selected, configures the register window to alternate between the primary and secondary colors with each transaction, instead of each row.

• Draw horizontal lines between rows: If selected, GnuCash will draw a horizontal line between each row.

• Draw vertical lines between columns: If selected, GnuCash will draw a vertical line between the cells in each row.

Predefinite del registro

Figura 10.9. The Preferences window, Register Defaults tab

La scheda delle preferenze Predefinite del registro influenza il comportamento delle finestre del registro delle transazioni.

• Stile predefinito

Qui è possibile scegliere tra 3 diversi stili per la finestra del registro:

• Basic ledger: Show all transactions on one line. (Two in double line mode.)

• Auto-split ledger: Automatically expand the current transaction to show all splits. All other transactions are shown on one line. (Two in double line mode.)

• Transaction journal: All transactions are expanded to show all splits.

• Altre predefinite

• Register opens in a new window: If selected, register will be in a separate window instead of in a tab.

• Double line mode: If selected, show two lines of information for each transaction instead of one.
• Only display leaf account names: If selected, only the name of the leaf accounts will be displayed in the Account selection popup. The default behaviour is to display the full account name including the path in the account tree.

Avvertimento

Abilitare questa opzione presuppone che vengano utilizzati dei nomi unici per i conti figli.

• Number of transactions: How many transactions to show in a register. Set to 0 to show all transactions.

Resoconti

Figura 10.10. The Preferences window, Reports tab

La scheda delle preferenze Resoconti influenza sul comportamento dei resoconti di GnuCash.

• Default Report Currency: This item determines which currency will be used by default when creating reports. You can choose:

  • Locale: Use the system locale currency for all newly created reports.

  • Choose: Use the specified currency for all newly created reports.

• Posizione

  • Report opens in a new window: if you select this option, the reports will open up in a new window, instead of in a tab.
Transazioni pianificate

La scheda delle preferenze Transazioni pianificate governa il comportamento delle transazioni pianificate in GnuCash. Maggiori informazioni relative alle transazioni pianificate sono reperibili in sezione chiamata «Pianificare le transazioni».

- Assistente dall’ultimo avvio
  - Run when data file opened: If selected, the Since Last Run screen will appear on GnuCash start-up (or rather when GnuCash opens the file).

- Predefinite dell’editor transazioni
  - Auto-Create new transactions: If selected, new scheduled transactions will automatically be entered into the register. If the auto-create option is enabled, you could also check Notify before transactions are created so that you will be able to confirm creating the transactions.

  - Create in advance: The default number of days in advance to create the registered scheduled transactions.

  - Remind in advance: The default number of days in advance to remind on new scheduled transactions.
Finestre

Figura 10.12. The Preferences window, Windows tab

- **Geometria finestra**
  - Save window size and position: If selected, next time GnuCash starts will re-use the windows size and position configured in the last run.

- **Schede**
  - Show close button on notebook tabs: Adds a small close icon on each tab, to make it easier to close the various tabs.
  - Bring the most recent tab to the front: If selected, the newly created tab will be shown over the other tabs.
  - Width: The width of tab label expressed in characters.

  **Nota**

  If the text in the tab is longer than this value (the test is approximate) then the tab label will have the middle cut and replaced with an ellipsis.

- **Posizione delle schede**
  - Posiziona le schede in Alto (predefinita), in Basso, a Sinistra o a Destra.

- **Posizione della barra di riepilogo**
  - Posiziona la barra di riepilogo In alto o In basso (predefinita) nella finestra principale di GnuCash.
**Book Options**

The File → Properties menu item is used to set or modify choices that affect how a specific GnuCash file (also referred to as a Book) operates. Selecting this menu item brings up the Book Options dialog. This dialog also appears in situations where you are importing transactions into a new book, with the title New Book Options. It is automatically raised in these 'new book' situations because these settings can affect how imported data are converted to GnuCash transactions and so should be considered and set before your first import (specifically, the sezione chiamata «Use Split Action Field for Number» setting).

The settings in this dialog are kept with, and are part of, the file (or Book). This is in contrast to the settings described in sezione chiamata «Impostare le preferenze», which are set per user and not stored with the file. So Book Options settings are shared by all users who use a given file and any changes made by one user will affect all users of that file.

**Suggerimento**

Pausing the cursor for a couple of seconds over options in these tabs will display a tooltip with a more detailed description of the choice.

The Book Options dialog has five buttons that are common to all tabs. The Reset defaults button takes all items on the visible tab and sets their value to the default setting; it only affects the visible tab. The Help button opens up a help window to this section. The Cancel button closes the dialog, making no changes to the saved settings for Book Options. The Apply button is initially insensitive but becomes sensitive when any setting is set or changed. Selecting it saves the setting(s) for the book but keeps the Book Options dialog open. Typically, the changes are reflected in the affected areas of GnuCash as soon as the button is pressed, so it can be used to 'see' the effect of a given option without having to re-open the dialog. The Apply button is not sensitive on the dialog if it appears during transaction import (that is, 'new book') situations. The OK button behaves like the Apply button except that it immediately closes the dialog, as well.

**Accounts Book Options Tab**

The Accounts tab of this dialog allows the selection of options that affect how accounting registers function.

**Use Trading Accounts**

Check the Use Trading Accounts checkbox to have trading accounts used for transactions involving more than one currency or commodity.

**Suggerimento**

To avoid several problems on multiple currency accounting read Peter Selinger's Tutorial on multiple currency accounting [https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html].

**Day Threshold for Read-Only Transactions**

Use the Day Threshold for Read-Only Transactions spin-box to choose the number of days before today, prior to which, transactions will be read-only and cannot be edited anymore in the registers. This threshold is marked by a red line in the account register windows. If zero, all transactions can be edited and none are read-only. This feature is intended to be used to guard against accidental changes to non-current transactions.
Use Split Action Field for Number

Nota

This option is only available in GnuCash version 2.6 or later.

Check the Use Split Action Field for Number checkbox to have the split action field of the anchor split used for the 'Num' column in registers, reports and import/export functions, where applicable, in place of the transaction number; the transaction number is then shown as 'T-Num' on reports and on the second line of registers. This choice has a corresponding effect on business features.

The difference between the two is that with the checkbox not selected, the same 'Num' is displayed for a given transaction regardless of what register it is viewed in and with the checkbox selected, a different 'Num' can be entered/displayed for a given transaction in each register it is viewed in. In both cases, the 'next number logic' of the 'Num' cell is based on the account of the register the transaction is entered to or viewed from but in one case it fills the transaction number, in the other, it fills the split action field of the anchor split. In both cases, both fields are visible and can be viewed and used as free-form text in double-line mode for any value the user wants.

Avvertimento

Initial setup of GnuCash: It is expected that, after careful consideration of the consequences, this option will be set when a new GnuCash file is created and not changed thereafter (see next warning). For this reason, a preference is provided (see Setting Preferences - General ) that can establish an initial default setting for new files, so that if you will have more than one file, it is easier to set them all up consistently. You may wish to set up a test file and experiment with the two settings to understand the differences before establishing your first real GnuCash file.

Suggerimento

Moving from Quicken: For users that are switching from other personal accounting applications, such as Quicken, selecting this option may be more consistent with the numbering approach used there and can preserve the numbering of historical data brought over; this option should be set before performing the initial import.

Avvertimento

Changing this option for an existing GnuCash file: If you change this option for an existing file, historical data will not be changed. This means that if you set the option one way, enter (or import) transactions, then change the option and enter (or import) additional transactions and switch back-and-forth, you will end up with a file that will appear to have inconsistent treatment of numbers in registers, reports and exports. This is because the setting of this option at the time of data entry/import determines where the number data is stored and the setting at the time of data display/reporting/exporting determines which field is displayed as number.

There is no reason to avoid changing this option for an existing GnuCash file if you understand the implications. If you elect to make this change, it should probably be done between accounting periods with the understanding that number data prior to the date the option is changed will be displayed/reported/exported differently from that after the date.

Avvertimento

If you change this option, and press Apply or OK, open registers and labels on query and sorting dialogs will be refreshed to reflect the new option immediately. But open reports need to be individually reloaded by the user to have the change reflected on the report.
Avvertimento

This option is only available in GnuCash version 2.6 or later. If a GnuCash file from an earlier version is opened in version 2.6 or later, and this feature is not used, this feature will not prevent the file from being opened in the earlier version of GnuCash. However, if the option is set, the file will not be able to be opened by the earlier version, even if the option is set back to its original setting. A warning dialog will be displayed from the earlier version. Do not set this option if you want to open the file with an earlier version.

Budgeting Book Options Tab

The Budgeting tab allows you to specify the budget to be used for reports when none has otherwise been specified.

Business Book Options Tab

The Business tab allows you to enter values that are in turn used by the business features of GnuCash:

- **Company Name**: The name of the company.
- **Company Contact Person**: The name of the contact person to print on invoices.
- **Company Phone, Fax, Email Address**: The references of your business.
- **Company Website URL**: The internet address of the company’s website.
- **Company ID**: The tax ID of your company.
- **Default Customer TaxTable**: The default taxtable applicable to your most common customers.
- **Default Vendor TaxTable**: The default taxtable applicable to your most common vendors.
- **Fancy Date Format**: The default date format used for fancy printed dates (e.g. on invoices).
- **Reset Defaults**: Press the button to reset all values to their defaults.

Nota

None of the above values is required to use GnuCash but, if given, will be used throughout the program. (f.e. in reports, invoices etc...)

Counters Book Options Tab

The Counters tab allows you to set the ‘previous’ value for each number indicated: Bill, Customer, Employee, etc. These counters are used by the Capitolo 7, Business Features of GnuCash.

The number entered here will be incremented when the various business features calculate a value for a corresponding field on a dialog. For example, if you leave the Customer Number field blank on the
New Customer dialog, the customer will be assigned the number in the counter field plus 1. The numbers displayed in the tab are incremented as these business features are used. (But note that if you have the Book Options dialog open, you need to close it and re-open it to see the changes; the displayed field values are not automatically refreshed.)

The corresponding format fields are used to specify printf-style format strings that are used to format the printing of the number. For example, to put the literal "C - " in front of the customer number, you would put "C - %li" (without the quotes) in the customer format string field. If the value in the customer number field was 5, the next customer added would be assigned the number "C - 6". As another example, if you wanted the number to be printed with leading zeros and 5 characters wide, you would enter "C - %05li" and the next customer number would be assigned the number "C - 00006".

Nota

For historical reasons GnuCash accepts multiple format specifiers although they all yield the same end result. You can choose "li", "lli" or I64i".

Modificare i fogli di stile

GnuCash fornisce quattro tipi predefiniti di fogli di stile per le pagine web dei resoconti. Questi fogli di stile possono essere modificati utilizzando l’editor HTML. Per accedervi, selezionare Modifica → Fogli di stile....

Utilizzando l’editor dei fogli di stile è possibile visualizzare e modificare le impostazioni di un foglio di stile.

Nota

Cambiando il foglio di stile, verrà modificato l’aspetto di tutti i resoconti a cui il foglio di stile è associato. È necessario eseguire il comando Aggiorna per visualizzare i cambiamenti, se il o i resoconti sono visualizzati al momento della modifica.

Per aggiungere un nuovo foglio di stile, selezionare il pulsante Nuovo... nel riquadro del foglio di stile; verrà visualizzata la finestra per il Nuovo foglio di stile. Immettere il Nome e selezionare un modello. Per rimuovere un foglio di stile, selezionarlo dalla lista e premere Elimina.

Foglio di stile predefinito

Il foglio di stile Predefinito presenta quattro schede per modificarne l’aspetto nei resoconti che lo utilizzano: Colori, Caratteri, Generali e Tabelle.

Scheda Colori

• Colore alternativo delle celle: il colore da alternare sulle righe della tabella.

Scheda Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.

• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.

• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.
Personalizzare GnuCash

- Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.
- Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.
- Cella del totale: selezionare il carattere e la dimensione per le celle del totale.
- Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.
- Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.

Scheda Generali

- Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.
- Immagine di sfondo: usare il pulsante Sfoglia per selezionare un’immagine da utilizzare come sfondo nei resoconti.
- Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

Scheda Tabelle

- Spaziatura tra le celle: permette di specificare lo spazio tra le celle
- Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.
- Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Foglio di stile Semplice

Il foglio di stile Semplice presenta quattro schede per modificare l’aspetto dei resoconti: colori, generali, immagini e tabelle.

Colori

- Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.
- Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.
- Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.
Personalizzare GnuCash

Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.
• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.
• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.
• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.
• Intestazione: selezionare il carattere e la dimensione per l’intestazione.
• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.
• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.
• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.
• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.

Generali

• Redattore: Nome della persona che ha preparato il resoconto.
• Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.
• Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.
• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

Immagini

• Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
• Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
• Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.
• Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

Tabelle

• Spaziatura tra le celle: permette di specificare lo spazio tra le celle
• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.
• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.
Fogli di stile Piè di pagina

Il foglio di stile Piè di pagina presenta le stesse cinque schede dello stile Easy per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.

Colori

• Colore dello sfondo: apre il selezionatore di colore per sceglierne uno nuovo.
• Colore del testo: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore del testo della cella: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore del collegamento: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore alternativo delle celle: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per sceglierne uno nuovo.
• Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.

Stili

• Titolo: selezionare il carattere e la dimensione per i titoli.
• Collegamento al conto: il carattere e la dimensione per il collegamento al conto.
• Cella numerica: selezionare il carattere e la dimensione dei numeri per le celle numeriche.
• Valori negativi in rosso: se attivata, i valori negativi saranno visualizzati in rosso.
• Intestazione: selezionare il carattere e la dimensione per l’intestazione.
• Cella di testo: selezionare il carattere e la dimensione del testo per le celle di testo.
• Cella del totale: selezionare il carattere e la dimensione per le celle del totale.
• Cella dell’etichetta del totale: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.
• Cella con etichetta centrata: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.

Generali

• Redattore: Nome della persona che ha preparato il resoconto.
• Preparato per: Nome della società od organizzazione per cui il resoconto è stato preparato.
• Visualizza informazioni sul redattore: mostra le informazioni sul redattore nel resoconto.
• Abilita collegamenti: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.
• Piè di pagina: il testo da inserire a piè pagina del resoconto.

Immagini

• Immagine di sfondo: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
• Striscione di intestazione: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
• Allineamento dell’intestazione: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.
• Logo: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

Tabelle

• Spaziatura tra le celle: permette di specificare lo spazio tra le celle
• Imbottitura della cella: specifica lo spazio tra i bordi della cella e il suo contenuto.
• Larghezza del bordo della tabella: permette di impostare la larghezza dei bordi delle tabelle.

Foglio di stile Technicolor

Il foglio di stile Technicolor fornisce cinque schede per modificare l’aspetto dei resoconti: Colori, Stili, Generali, Immagini e Tabelle.

Colori

• Colore dello sfondo: apre il selezionatore di colore per scegliere uno nuovo.
• Colore del testo: apre il selezionatore del colore per scegliere uno nuovo.
• Colore del testo della cella: apre il selezionatore del colore per scegliere uno nuovo.
• Colore del collegamento: apre il selezionatore del colore per scegliere uno nuovo.
• Colore alternativo delle celle: apre il selezionatore del colore per scegliere uno nuovo.
• Colore della cella del sottotitolo e del subtotale: apre il selezionatore del colore per scegliere uno nuovo.
• Colore della cella del sotto-sottotitolo e del totale: apre il selezionatore del colore per scegliere uno nuovo.
• Colore della cella della somma complessiva: apre il selezionatore del colore per scegliere il colore da assegnare alle righe della somma complessiva.
**Stili**

- **Titolo**: selezionare il carattere e la dimensione per i titoli.
- **Collegamento al conto**: il carattere e la dimensione per il collegamento al conto.
- **Cella numerica**: selezionare il carattere e la dimensione dei numeri per le celle numeriche.
- **Valori negativi in rosso**: se attivata, i valori negativi saranno visualizzati in rosso.
- **Intestazione**: selezionare il carattere e la dimensione per l’intestazione.
- **Cella di testo**: selezionare il carattere e la dimensione del testo per le celle di testo.
- **Cella del totale**: selezionare il carattere e la dimensione per le celle del totale.
- **Cella dell’etichetta del totale**: selezionare il carattere e la dimensione del testo per la cella di intestazione dei totali.
- **Cella con etichetta centrata**: selezionare il carattere e la dimensione del testo delle celle con l’etichetta centrale.

**Generali**

- **Redattore**: Nome della persona che ha preparato il resoconto.
- **Preparato per**: Nome della società od organizzazione per cui il resoconto è stato preparato.
- **Visualizza informazioni sul redattore**: mostra le informazioni sul redattore nel resoconto.
- **Abilita collegamenti**: se attivata, verranno visualizzati in blu i collegamenti ipertestuali nei resoconti.

**Immagini**

- **Immagine di sfondo**: permette di ricercare una immagine da utilizzare come sfondo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
- **Striscione di intestazione**: permette di ricercare una immagine da utilizzare come intestazione nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.
- **Allineamento dell’intestazione**: selezionare dalla lista a discesa un valore tra sinistra, centro e destra per specificare la posizione dello striscione superiore del o dei resoconti.
- **Logo**: permette di ricercare una immagine da utilizzare come logo nei resoconti utilizzando il pulsante Sfoglia. Il pulsante Pulisci annulla la selezione.

**Tabelle**

- **Spaziatura tra le celle**: permette di specificare lo spazio tra le celle
- **Imbottitura della cella**: specifica lo spazio tra i bordi della cella e il suo contenuto.
- **Larghezza del bordo della tabella**: permette di impostare la larghezza dei bordi delle tabelle.
Impostare le opzioni per i resoconti delle tasse

The Income Tax Information dialog is used to set Tax Report Options. The settings on accounts in this dialog are used by the TXF Export function in reports to select the accounts for export. To access this dialog go to Edit → Tax Report Options.

If the Income Tax features are used, it is strongly recommended that the Tax Info column be made visible on the accounts tab (click large downward-pointing arrow and select Tax Info check box). The Tax Info column will display the Form/Schedule and tax category (e.g., Schedule D Dividend, cap gain distrib.) assigned to an account, if any. Alternatively, it will display the following error messages which can be corrected through Edit → Tax Report Options

- Relativo alle tasse ma non ha un codice
- Entità e tipo dell’imposta non specificati
- Tax type "tax_type": invalid code "code" for account type
- Not tax-related; tax type "tax_type": invalid code "code" for account type
- Codice imposta "codice" non valido per il tipo di imposta "tipo_imposta"
- Not tax-related; invalid code "code" for tax type "tax_type"
- No form: code "code", tax type "tax_type"
- Not tax-related; no form: code "code", tax type "tax_type"
- No description: form "form", code "code", tax type "tax_type"
- Not tax-related; no description: form "form", code "code", tax type "tax_type"
- Not tax-related; no description: "form"("copy") "desc" (code "code", tax type "tax_type")

The Income Tax Identity must be set in order to assign codes to individual accounts. Click Edit to set the identity. The Tax Name is optional. If entered, it will be printed at the top of the report. A Type must be selected in order to activate the tax category selections. The choices are:

- Individual, Joint, etc. - Files US Form 1040 Tax Return
- Partnership - Files US Form 1065 Tax Return
- Corporation - Files US Form 1120 Tax Return
- S Corporation - Files US Form 1120S Tax Return
- None - No Income Tax Options Provided

While the Income Tax Entity Type can be changed after tax categories have been assigned to accounts, you should be cautioned that you will need to manually change each one if you do so, which could be quite tedious. The tax categories are unique for each Income Tax Entity Type, so changing the type will make all previously assigned categories invalid. It is assumed (and highly recommended) that each GnuCash file is for only one tax entity and this is where you specify its type of tax entity. You should not keep,
for example, personal and partnership accounts mixed in one GnuCash file if you plan to use the Income Tax Reporting features.

A given TXF code can be assigned to multiple accounts. The Tax Schedule Report will combine accounts by code and generate a detailed TXF record for each account and a summary TXF record for the total as calculated by the report.

For codes for which the "Payer Name Source" is not grayed, the payer on the TXF record will be based on what is specified here, either the account name of the account or the account name of the account’s parent account. This feature is typically used for interest accounts or stocks or mutual funds that pay dividends where the individual payees are shown on the tax schedule. For example, if the parent account’s name is the name of your broker and the sub-account’s names are the names of individual stocks that pay dividends and the name on the 1099-DIV received is that of the broker, in order to match that name, you would select 'Parent Account'; the total dividends from the broker would be exported and, if you had several brokers, there would be an amount exported and a subtotal for each broker, along with each brokers name. Alternatively, if you had a parent account named Directly Held, for example, and below it sub-accounts for one or more stocks, you would receive a 1099-DIV from the issuer of each stock separately and, in order to match that name, you would select Current Account; the total dividends from each stock would be exported and, if you had several stocks, there would be an amount exported and a subtotal for each stock, along with each stock’s name as the payer.

Some tax Forms/Schedules need to have multiple copies filed under some circumstances (for example, Schedule C if a taxpayer and spouse have separate businesses). For tax categories on these Forms/Schedules, the Copy Number is not grayed out and can be used to segregate accounts by copy number.

- Accounts: This pane contains the list of accounts. Select an account to set a TXF category. If no account is selected nothing is changed. If multiple accounts are selected, all of the accounts will be set to the selected item.

- Tax Related: Select this check-box to add tax information to an account then select the TXF Category below. This setting is displayed on the account edit dialogue but cannot be changed from there.

- TXF Categories: Select the desired one. A detailed description appears just below (if available, otherwise it says No help available), along with the TXF code for the category and information about what line number on the form or schedule the amounts are included in by tax year (used for detailed sort on report).

- Payer Name Source: Select an option to determine where the text description that is exported along with the value of the account is derived from, as described above. This is usually the name of a bank, stock, or mutual fund that pays dividends or interest. Occasionally, it is a description of a deduction.

- Copy Number: A copy number that is exported along with the value of the account. This is used to segregate amounts between different copies of the same Form/Schedule that may need to be filed (e.g., Schedule C(1), Schedule C(2), etc.). This is also used to sort the report.

**TXF Export - Known Anomalies and Limitations**

**TaxCut 1999**

- Code: N488 "^ Sched B \ Div. income, cap gain distrib."

- Code: N286 "^ Sched B \ Dividend income"

These two codes, from the same payer, are not correlated. The user will have to adjust for this after import.

**TaxCut 1999, 2000**
• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the date field and does not import the individual payment amounts, only the total. The date and individual payment amounts, only matter if you have to compute the penalty. (this may be a TurboTax enhancement)

• Code: N460 " W-2 \ Salary or wages, self"

• Code: N506 " W-2 \ Salary or wages, spouse"

• and other related codes.

Use Copy Number to separate information from more than one job.

TurboTax 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the dates outside of the tax year. This is a problem for the last payment that is due Jan 15. GnuCash changes the the date of the last payment to Dec 31 for the export unless the "Do not use special date processing" option is selected in the report options display tab. The user will have to adjust for this after import. The date only matters if you have to compute the penalty.

TXF Tax eXport Format

• Duplicate Codes

Codes can be assigned to multiple accounts and the amounts will be summed for all the accounts generating one detail TXF record per account and one summary TXF record for the sum. Codes that let you select "Payer Name Source" will generate a separate summary TXF account with each change in payer. Selecting the "Print TXF export parameters" option will cause the report to show to which codes this applies (Payer Name Source option Y) and, for the accounts assigned to those codes, the Name Source each account is set to and the TXF item number that will be assigned to each. A summary TXF record will be generated for each change in assigned item line number. These may not be handled the same by TaxCut and TurboTax.

• Code: N673 "Short/Long gain or loss"

Short term or long term gain or loss from the sale of a security; generates TXF output for only the date sold and sales amount, with the date acquired and cost basis information left blank (to be separately added in the tax software). The code can be assigned to either a short-, long-, or mixed-term gain/loss income account and the security sales transaction should be entered as illustrated in Section 8.7, Selling Shares, of the GnuCash Tutorial and Concepts Guide. The report uses the transaction split of the gain/loss account to find one or more other splits in the same transaction with negative share quantities. For each of these found, it generates a detailed TXF output record with the quantity sold, the name of the security, the date sold, and the sales amount. Note that if, for a given transaction, more than one transaction split is to a gain/loss income account assigned to code 673, TXF output data will be erroneously repeated. That is because the report will fetch the same data, and re-output it, for each transaction split set to a gain/loss income account within the same transaction. For this reason, there should be no more than one gain/loss account entered per transaction to use this tax reporting code properly. (Note that no amounts are used from GnuCash’s lot-tracking; a future enhancement is expected to use this data to provide capital gain reporting).

Detailed TXF Category Descriptions

Table 32. Detailed TXF Category Descriptions
### Tabella 10.1. Detailed TXF Category Descriptions

<table>
<thead>
<tr>
<th>Tax Form \ TXF Code</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
<tr>
<td>&lt; help \ H001</td>
<td>Categories marked with a «&lt;» or a «^» , require a Payer identification to be exported. «&lt;» indicates that the name of this account is exported as this Payer ID. Typically, this is a bank, stock, or mutual fund name.</td>
</tr>
<tr>
<td>Name of Current account is exported.</td>
<td></td>
</tr>
<tr>
<td>^ help \ H002</td>
<td>Categories marked with a «&lt;» or a «^» , require a Payer identification to be exported. «^» indicates that the name of the PARENT of this account is exported as this Payer ID. Typically, this is a bank, stock, or mutual fund name.</td>
</tr>
<tr>
<td>Name of Parent account is exported.</td>
<td></td>
</tr>
<tr>
<td># help \ H003</td>
<td>Categories marked with a «#» not fully implemented yet! Do not use these codes!</td>
</tr>
<tr>
<td>Non ancora implementato, NON usare!</td>
<td></td>
</tr>
<tr>
<td>none \ N000</td>
<td>This is a dummy category and only shows up on the tax report, but is not exported.</td>
</tr>
<tr>
<td>Tax Report Only - No TXF Export</td>
<td></td>
</tr>
<tr>
<td><strong>Help F1040 \ H256</strong></td>
<td>Form 1040 is the main form of your tax return.</td>
</tr>
<tr>
<td>Form 1040 - the main tax form</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N261</strong></td>
<td>Amounts received as alimony or separate maintenance. Note: child support is not considered alimony.</td>
</tr>
<tr>
<td>Alimony received</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N257</strong></td>
<td>Miscellaneous income such as: a hobby or a farm you operate mostly for recreation and pleasure, jury duty pay. Exclude self employment income, gambling winnings, prizes and awards.</td>
</tr>
<tr>
<td>Other income, misc.</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N258</strong></td>
<td>Amounts you receive from your employer while you are sick or injured are part of your salary or wages. Exclude workers’ compensation, accident or health insurance policy benefits, if you paid the premiums.</td>
</tr>
<tr>
<td>Sick pay or disability pay</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N260</strong></td>
<td>Refund of state or local income tax refund (or credit or offset) which you deducted or took a credit for in an earlier year. You should receive a statement, Form 1099-G. Not reportable if you didn’t itemize last year.</td>
</tr>
<tr>
<td>State and local tax refunds</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N262</strong></td>
<td>Contribution to a qualified IRA. If you or your spouse are covered by a company retirement plan, this amount could be limited or eliminated.</td>
</tr>
<tr>
<td>IRA contribution, self</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N263</strong></td>
<td>Contributions to a Keogh or HR 10 plan of a sole proprietor or a partnership.</td>
</tr>
<tr>
<td>Keogh deduction, self</td>
<td></td>
</tr>
<tr>
<td><strong>F1040 \ N264</strong></td>
<td>Amounts paid as alimony or separate maintenance. Note: child support is not considered alimony.</td>
</tr>
<tr>
<td>Alimony paid</td>
<td></td>
</tr>
</tbody>
</table>
### Personalizzare GnuCash

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>&lt; F1040\N265</em> Early withdrawal penalty</td>
<td>Penalty on Early Withdrawal of Savings from CD’s or similar instruments. This is reported on Form 1099-INT or Form 1099-OID.</td>
</tr>
<tr>
<td><em>F1040\N266</em> Social Security income, self</td>
<td>The part of any monthly benefit under title II of the Social Security Act. These will be reported on Form SSA-1099.</td>
</tr>
<tr>
<td><em>F1040\N269</em> Taxable fringe benefits</td>
<td>Fringe benefits you receive in connection with the performance of your services are included in your gross income as compensation. Examples: Accident or Health Plan, Educational Assistance, Group- Term Life Insurance, Transportation (company car).</td>
</tr>
<tr>
<td><em>F1040\N481</em> IRA contribution, spouse</td>
<td>Contribution of a working spouse to a qualified IRA. If you or your spouse are covered by a company retirement plan, the deductible contribution could be limited or eliminated.</td>
</tr>
<tr>
<td><em>F1040\N482</em> IRA contrib., non-work spouse</td>
<td>IRA contribution for a non-working spouse.</td>
</tr>
<tr>
<td><em>F1040\N483</em> Social Security inc., spouse</td>
<td>Spouse’s part of any monthly benefit under title II of the Social Security Act. These will be reported on Form SSA-1099.</td>
</tr>
<tr>
<td><em>F1040\N516</em> Keogh deduction, spouse</td>
<td>Spouse Contributions to a Keogh or HR 10 plan of a sole proprietor or a partnership.</td>
</tr>
<tr>
<td><em>F1040\N517</em> SEP-IRA deduction, self</td>
<td>Contributions made to a simplified employee pension plan (SEP-IRA).</td>
</tr>
<tr>
<td><em>F1040\N518</em> SEP-IRA deduction, spouse</td>
<td>Spouse contributions made to a simplified employee pension plan (SEP-IRA).</td>
</tr>
<tr>
<td><em>F1040\N519</em> RR retirement income, self</td>
<td>The part of tier I railroad retirement benefits, which are treated as a social security benefits. These will be reported on Form RRB-1099.</td>
</tr>
<tr>
<td><em>F1040\N520</em> RR retirement inc., spouse</td>
<td>Spouse’s part of tier I railroad retirement benefits, which are treated as a social security benefits. These will be reported on Form RRB-1099.</td>
</tr>
<tr>
<td><em>F1040\N521</em> Federal estimated tax, quarterly</td>
<td>The quarterly payments you made on your estimated Federal income tax (Form 1040-ES). Include any overpay from your previous year return that you applied to your estimated tax. NOTE: If a full year (Jan 1, YEAR to Dec 31, YEAR) is specified, GnuCash adjusts the date to Mar 1, YEAR to Feb 28, YEAR+1. Thus, the payment due Jan 15 is exported for the correct year.</td>
</tr>
<tr>
<td><em>F1040\N607</em></td>
<td>Contributions made to your medical savings account that were not reported on your Form W-2.</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Medical savings contribution, self</td>
<td>Contributions made to your spouse’s medical savings account that were not reported on their Form W-2.</td>
</tr>
<tr>
<td>$F1040 \ N608$</td>
<td></td>
</tr>
<tr>
<td>Medical savings contribution, spouse</td>
<td>Contributions made to your SIMPLE retirement plan that were not reported on your Form W-2.</td>
</tr>
<tr>
<td>$F1040 \ N609$</td>
<td></td>
</tr>
<tr>
<td>SIMPLE contribution, self</td>
<td>Contributions made to your spouse’s SIMPLE retirement plan that were not reported on your spouse’s Form W-2.</td>
</tr>
<tr>
<td>$F1040 \ N610$</td>
<td></td>
</tr>
<tr>
<td>SIMPLE contribution, spouse</td>
<td>The amount of federal income taxes withheld from your part of any monthly benefit under title II of the Social Security Act.</td>
</tr>
<tr>
<td>$F1040 \ N611$</td>
<td></td>
</tr>
<tr>
<td>Fed tax withheld, Social Security, self</td>
<td>The amount of federal income taxes withheld from your spouse’s part of any monthly benefit under title II of the Social Security Act.</td>
</tr>
<tr>
<td>$F1040 \ N612$</td>
<td></td>
</tr>
<tr>
<td>Fed tax withheld, Social Security, spouse</td>
<td>The amount of federal income taxes withheld from your part of tier I railroad retirement benefits, which are treated as a social security benefits.</td>
</tr>
<tr>
<td>$F1040 \ N613$</td>
<td></td>
</tr>
<tr>
<td>Fed tax withheld, RR retire, self</td>
<td>The amount of federal income taxes withheld from your spouse’s part of tier I railroad retirement benefits, which are treated as a social security benefits.</td>
</tr>
<tr>
<td>$F1040 \ N614$</td>
<td></td>
</tr>
<tr>
<td>Fed tax withheld, RR retire, spouse</td>
<td>The amount of interest you paid this year on qualified student loans.</td>
</tr>
<tr>
<td>$F1040 \ N636$</td>
<td></td>
</tr>
<tr>
<td>Student loan interest</td>
<td>Form 1099-G is used to report certain government payments from federal, state, or local governments.</td>
</tr>
<tr>
<td>Help $F1099-G \ N634$</td>
<td></td>
</tr>
<tr>
<td>Form 1099-G - certain Government payments</td>
<td>Refund of state or local income tax refund (or credit or offset) which you deducted or took a credit for in an earlier year. You should receive a statement, Form 1099-G. Not reportable if you didn’t itemize last year.</td>
</tr>
<tr>
<td>$F1099-G \ N260$</td>
<td></td>
</tr>
<tr>
<td>State and local tax refunds</td>
<td>Total unemployment compensation paid to you this year. Reported on Form 1099-G.</td>
</tr>
<tr>
<td>$F1099-G \ N479$</td>
<td></td>
</tr>
<tr>
<td>Unemployment compensation</td>
<td>If you received an overpayment of unemployment compensation this year or last and you repaid any of it this year, subtract the amount you repaid from the total amount you received.</td>
</tr>
<tr>
<td>$F1099-G \ N605$</td>
<td></td>
</tr>
<tr>
<td>Unemployment comp repaid</td>
<td>The amount of federal income taxes withheld from your unemployment compensation.</td>
</tr>
<tr>
<td>$F1099-G \ N606$</td>
<td></td>
</tr>
<tr>
<td>Fed tax withheld, unemployment comp</td>
<td>Qualified state tuition program earnings you received this year.</td>
</tr>
<tr>
<td>$F1099-G \ N672$</td>
<td></td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
<tr>
<td>Qualified state tuition earnings</td>
<td>Form 1099-MISC is used to report miscellaneous income received and direct sales of consumer goods for resale.</td>
</tr>
<tr>
<td>Help F1099-MISC\H553</td>
<td></td>
</tr>
<tr>
<td>Form 1099-MISC - MISCellaneous income</td>
<td>The amount of prizes and awards that are not for services performed. Included is the fair market value of merchandise won on game shows.</td>
</tr>
<tr>
<td>^ F1099-MISC\N259</td>
<td></td>
</tr>
<tr>
<td>Prizes and awards</td>
<td>The amount of prizes and awards that are not for services performed. Included is the fair market value of merchandise won on game shows. Included is all punitive damages, any damages for nonphysical injuries or sickness, and any other taxable damages, deceased employee’s wages paid to estate or beneficiary.</td>
</tr>
<tr>
<td>^ F1099-MISC\N557</td>
<td></td>
</tr>
<tr>
<td>Other income</td>
<td>Amounts received for all types of rents, such as real estate rentals for office space, machine rentals, and pasture rentals.</td>
</tr>
<tr>
<td>^ F1099-MISC\N555</td>
<td></td>
</tr>
<tr>
<td>Rents</td>
<td>The gross royalty payments received from a publisher or literary agent.</td>
</tr>
<tr>
<td>^ F1099-MISC\N556</td>
<td></td>
</tr>
<tr>
<td>Royalties</td>
<td>The amount of federal income tax withheld (backup withholding) from 1099-MISC income.</td>
</tr>
<tr>
<td>^ F1099-MISC\N558</td>
<td></td>
</tr>
<tr>
<td>Federal tax withheld</td>
<td>Your share of all proceeds from the sale of a catch or the fair market value of a distribution in kind that you received as a crew member of a fishing boat.</td>
</tr>
<tr>
<td>^ F1099-MISC\N559</td>
<td></td>
</tr>
<tr>
<td>Fishing boat proceeds</td>
<td>The amount of payments received as a physician or other supplier or provider of medical or health care services. This includes payments made by medical and health care insurers under health, accident, and sickness insurance programs.</td>
</tr>
<tr>
<td>^ F1099-MISC\N560</td>
<td></td>
</tr>
<tr>
<td>Medical/health payments</td>
<td>The amount of non-employee compensation received. This includes fees, commissions, prizes and awards for services performed, other forms of compensation for services you performed for a trade or business by which you are not employed. Also include oil and gas payments for a working interest.</td>
</tr>
<tr>
<td>^ F1099-MISC\N561</td>
<td></td>
</tr>
<tr>
<td>Non employee compensation</td>
<td>The amount of crop insurance proceeds as the result of crop damage.</td>
</tr>
<tr>
<td>^ F1099-MISC\N562</td>
<td></td>
</tr>
<tr>
<td>Crop insurance proceeds</td>
<td>The amount of state income tax withheld (state backup withholding) from 1099-MISC income.</td>
</tr>
<tr>
<td>^ F1099-MISC\N563</td>
<td></td>
</tr>
<tr>
<td>State tax withheld</td>
<td>Form 1099-MSA is used to report medical savings account distributions.</td>
</tr>
<tr>
<td>Help F1099=MSA \H629</td>
<td></td>
</tr>
<tr>
<td>Form 1099-MSA Medical Savings Account</td>
<td></td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Descrizione</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>F1099-MSA \ N631</td>
<td>MSA gross distribution</td>
</tr>
<tr>
<td>F1099-MSA \ N632</td>
<td>MSA earnings on excess contrib</td>
</tr>
<tr>
<td>Help F1099-R \ H473</td>
<td>Form 1099-R - Retirement distributions</td>
</tr>
<tr>
<td>^ F1099-R \ N475</td>
<td>Total pension gross distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N476</td>
<td>Total pension taxable distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N477</td>
<td>Total IRA gross distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N478</td>
<td>Total IRA taxable distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N529</td>
<td>Pension federal tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N530</td>
<td>Pension state tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N531</td>
<td>Pension local tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N532</td>
<td>IRA federal tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N533</td>
<td>IRA state tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N534</td>
<td>IRA local tax withheld</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>^ F1099-R \ N623</td>
<td>SIMPLE total gross distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N624</td>
<td>SIMPLE total taxable distribution</td>
</tr>
<tr>
<td>^ F1099-R \ N625</td>
<td>SIMPLE federal tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N626</td>
<td>SIMPLE state tax withheld</td>
</tr>
<tr>
<td>^ F1099-R \ N627</td>
<td>SIMPLE local tax withheld</td>
</tr>
<tr>
<td>^ F2106 \ H380</td>
<td>employee business expenses</td>
</tr>
<tr>
<td>^ F2106 \ N381</td>
<td>Education expenses</td>
</tr>
<tr>
<td>^ F2106 \ N382</td>
<td>Automobile expenses</td>
</tr>
<tr>
<td>^ F2106 \ N384</td>
<td>Local transportation expenses</td>
</tr>
<tr>
<td>^ F2106 \ N385</td>
<td>Other business expenses</td>
</tr>
<tr>
<td>^ F2106 \ N386</td>
<td>Meal/entertainment expenses</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td>home overnight and other business meals and entertainment.</td>
</tr>
<tr>
<td><strong>F2106\N387</strong></td>
<td>Reimbursement for business expenses from your employer that is NOT included on your Form W-2. Note: meals and entertainment are NOT included here.</td>
</tr>
<tr>
<td>Reimb. business expenses (non-meal/ent.)</td>
<td></td>
</tr>
<tr>
<td><strong>F2106\N388</strong></td>
<td>Reimbursement for meal and entertainment expenses from your employer that is NOT included on your Form W-2.</td>
</tr>
<tr>
<td>Reimb. meal/entertainment expenses</td>
<td></td>
</tr>
<tr>
<td><strong>F2106\N389</strong></td>
<td>Fees to employment agencies and other costs to look for a new job in your present occupation, even if you do not get a new job.</td>
</tr>
<tr>
<td>Job seeking expenses</td>
<td></td>
</tr>
<tr>
<td><strong>F2106\N390</strong></td>
<td>cost and upkeep of work clothes, if you must wear them as a condition of your employment, and the clothes are not suitable for everyday wear. Include the cost of protective clothing required in your work, such as safety shoes or boots, safety glasses, hard hats, and work gloves.</td>
</tr>
<tr>
<td>Special clothing expenses</td>
<td></td>
</tr>
<tr>
<td><strong>F2106\N391</strong></td>
<td>Your use of the business part of your home must be: exclusive, regular, for your trade or business, AND The business part of your home must be one of the following: your principal place of business, a place where you meet or deal with patients, clients, or customers in the normal course of your trade or business, or a separate structure (not attached to your home) you use in connection with your trade or business. Additionally, Your business use must be for the convenience of your employer, and You do not rent all or part of your home to your employer and use the rented portion to perform services as an employee. See IRS Pub 587.</td>
</tr>
<tr>
<td>Employee home office expenses</td>
<td></td>
</tr>
<tr>
<td><strong>F2106\N383</strong></td>
<td>Travel expenses are those incurred while traveling away from home for your employer. The cost of getting to and from your business destination (air, rail, bus, car, etc.), taxi fares, baggage charges, and cleaning and laundry expenses. Note: meal and entertainment expenses are not included here.</td>
</tr>
<tr>
<td>Travel (away from home)</td>
<td></td>
</tr>
<tr>
<td><strong>Help F4137\H503</strong></td>
<td>Form 4137 is used to compute social security and Medicare tax owed on tips you did not report to your employer.</td>
</tr>
<tr>
<td>Form 4137 - tips not reported</td>
<td></td>
</tr>
<tr>
<td><strong>F4137\N505</strong></td>
<td>The amount of tips you did not report to your employer.</td>
</tr>
<tr>
<td>Total cash/tips not reported to employer</td>
<td></td>
</tr>
<tr>
<td><strong>Help F2441\H400</strong></td>
<td>Form 2441 is used to claim a credit for child and dependent care expenses.</td>
</tr>
<tr>
<td>Form 2441 - child and dependent credit</td>
<td></td>
</tr>
</tbody>
</table>
### Tax Form \ TXF Code

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; F2441 \ N401 Qualifying child/dependent care expenses</td>
<td>The total amount you actually paid to the care provider. Also, include amounts your employer paid to a third party on your behalf.</td>
</tr>
<tr>
<td>&lt; F2441 \ N402 Qualifying household expenses</td>
<td>The cost of services needed to care for the qualifying person as well as to run the home. They include the services of a babysitter, cleaning person, cook, maid, or housekeeper if the services were partly for the care of the qualifying person.</td>
</tr>
<tr>
<td>Help F3903 \ H403 Form 3903 - moving expenses</td>
<td>Form 3903 is used to claim moving expenses.</td>
</tr>
<tr>
<td>F3903 \ N406 Transport/storage of goods</td>
<td>The amount you paid to pack, crate and move your household goods and personal effects. You may include the cost to store and insure household goods and personal effects within any period of 30 days in a row after the items were moved from your old home.</td>
</tr>
<tr>
<td>F3903 \ N407 Travel/lodging, except meals</td>
<td>The amount you paid to travel from your old home to your new home. This includes transportation and lodging on the way. Although not all members of your household must travel together, you may only include expenses for one trip per person. Do not include meals.</td>
</tr>
<tr>
<td>Help F4684 \ H412 Form 4684 - casualties and thefts</td>
<td>Form 4684 is used to report gains and losses from casualties and thefts.</td>
</tr>
<tr>
<td>F4684 \ N416 FMV after casualty</td>
<td>The fair market value (FMV) is the price at which the property would change hands between a willing buyer and seller, each having knowledge of the relevant facts. The FMV after a theft is zero if the property is not recovered. The FMV is generally determined by competent appraisal.</td>
</tr>
<tr>
<td>F4684 \ N413 Basis of casualty property</td>
<td>Cost or other basis usually means original cost plus improvements. Subtract any postponed gain from the sale of a previous main home. Special rules apply to property received as a gift or inheritance. See Pub 551, Basis of Assets, for details.</td>
</tr>
<tr>
<td>F4684 \ N414 Insurance/reimbursement</td>
<td>The amount of insurance or other reimbursement you received expect to receive.</td>
</tr>
<tr>
<td>F4684 \ N415 FMV before casualty</td>
<td>The fair market value (FMV) is the price at which the property would change hands between a willing buyer and seller, each having knowledge of the relevant facts. FMV is generally determined by competent appraisal.</td>
</tr>
<tr>
<td>Help F4835 \ H569 Form 4835 is used to report farm rental income received as a share of crops or livestock produced</td>
<td>Form 4835 is used to report farm rental income received as a share of crops or livestock produced.</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Form 4835 - farm rental income</td>
<td>by your tenant if you did not materially participate in the operation or management of the farm. Use a different copy of Form 4835 for each farm rented.</td>
</tr>
<tr>
<td>F4835\N572 Total cooperative distributions</td>
<td>Distributions received from a cooperative. This includes patronage dividends, non patronage distributions, per-unit retain allocations, and redemption of non qualified notices and per unit retain allocations. Reported on Form 1099-PATR.</td>
</tr>
<tr>
<td>F4835\N571 Sale of livestock/produce</td>
<td>Income you received from livestock, produce, grains, and other crops based on production. Under both the cash and the accrual methods of reporting, you must report livestock or crop share rentals received in the year you convert them into money or its equivalent.</td>
</tr>
<tr>
<td>F4835\N573 Agricultural program payments</td>
<td>Government payments received for: price support payments, market gain from the repayment of a secured Commodity Credit Corporation (CCC) loan for less than the original loan amount, diversion payments, cost-share payments (sight drafts), payments in the form of materials (such as fertilizer or lime) or services (such as grading or building dams). Reported on Form 1099-G.</td>
</tr>
<tr>
<td>F4835\N574 CCC loans reported/election</td>
<td>Generally, you do not report CCC loan proceeds as income. However, if you pledge part or all of your production to secure a CCC loan, you may elect to report the loan proceeds as income in the year you receive them, instead of the year you sell the crop.</td>
</tr>
<tr>
<td>F4835\N575 CCC loans forfeited/repaid</td>
<td>The full amount forfeited or repaid with certificates, even if you reported the loan proceeds as income. See IRS Pub 225.</td>
</tr>
<tr>
<td>F4835\N576 Crop insurance proceeds received</td>
<td>You generally include crop insurance proceeds in the year you receive them. Treat as crop insurance proceeds the crop disaster payments you receive from the federal government.</td>
</tr>
<tr>
<td>F4835\N577 Crop insurance proceeds deferred</td>
<td>If you use the cash method of accounting and receive crop insurance proceeds in the same tax year in which the crops are damaged, you can choose to postpone reporting the proceeds as income until the following tax year. A statement must also be attached to your return. See IRS Pub 225.</td>
</tr>
<tr>
<td>F4835\N578 Other income</td>
<td>Illegal Federal irrigation subsidies, bartering income, income from discharge of indebtedness, state gasoline or fuel tax refund, the gain or loss on the sale of commodity futures contracts, etc.</td>
</tr>
<tr>
<td>F4835\N579 Car and truck expenses</td>
<td>The business portion of car or truck expenses, such as, for gasoline, oil, repairs, insurance, tires, license plates, etc.</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>F4835 \ N580</strong></td>
<td>Chemicals used in operating your farm, such as insect sprays and dusts.</td>
</tr>
<tr>
<td><strong>F4835 \ N581</strong></td>
<td>Your expenses for soil or water conservation or for the prevention of erosion of land used in farming. To take this deduction, your expenses must be consistent with a plan approved by the Natural Resources Conservation Service (NRCS) of the Department of Agriculture.</td>
</tr>
<tr>
<td><strong>F4835 \ N582</strong></td>
<td>Amounts you paid for custom hire (machine work) (the machine operator furnished the equipment). Do not include amounts paid for rental or lease of equipment you operated yourself.</td>
</tr>
<tr>
<td><strong>F4835 \ N583</strong></td>
<td>Contributions to employee benefit programs, such as accident and health plans, group-term life insurance, and dependent care assistance programs. Do not include contributions that are a incidental part of a pension or profit-sharing plan.</td>
</tr>
<tr>
<td><strong>F4835 \ N584</strong></td>
<td>The cost of feed for your livestock. Generally, you cannot currently deduct expenses for feed to be consumed by your livestock in a later tax year. See instructions for Schedule F.</td>
</tr>
<tr>
<td><strong>F4835 \ N585</strong></td>
<td>The cost of fertilizer, lime, and other materials applied to farm land to enrich, neutralize, or condition it. You can also deduct the cost of applying these materials. However, see Prepaid Farm Supplies, in Pub 225, for a rule that may limit your deduction for these materials.</td>
</tr>
<tr>
<td><strong>F4835 \ N586</strong></td>
<td>The costs of freight or trucking of produce or livestock.</td>
</tr>
<tr>
<td><strong>F4835 \ N587</strong></td>
<td>The costs of gas, fuel, oil, etc. for farm equipment.</td>
</tr>
<tr>
<td><strong>F4835 \ N588</strong></td>
<td>Premiums paid for farm business insurance, such as: fire, storm, crop, theft and liability protection of farm assets. Do not include premiums for employee accident and health insurance.</td>
</tr>
<tr>
<td><strong>F4835 \ N589</strong></td>
<td>The interest you paid to banks or other financial institutions for which you received a Form 1098, for a mortgage on real property used in your farming business (other than your main home). If you paid interest on a debt secured by your main home, and any proceeds from that debt were used in your farming operation, refer to IRS Pub 225.</td>
</tr>
<tr>
<td><strong>F4835 \ N590</strong></td>
<td>The interest you paid for which you did not receive a Form 1098 (perhaps someone else did, and you are...</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
<tr>
<td>Interest expense, other</td>
<td>liable too), for a mortgage or other loans for your farm business.</td>
</tr>
<tr>
<td><strong>F4835 \ N591</strong></td>
<td>The amounts you paid for farm labor. Do not include amounts paid to yourself. Count the cost of boarding farm labor but not the value of any products they used from the farm. Count only what you paid for household help to care for farm laborers.</td>
</tr>
<tr>
<td>Labor hired</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N592</strong></td>
<td>Enter your deduction for contributions to employee pension, profit-sharing, or annuity plans. If the plan included you as a self-employed person, see the instructions for Schedule C (Form 1040).</td>
</tr>
<tr>
<td>Pension/profit-sharing plans</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N593</strong></td>
<td>The business portion of your rental cost, for rented or leased vehicles, machinery, or equipment. But if you leased a vehicle for a term of 30 days or more, you may have to reduce your deduction by an inclusion amount. For details, see the instructions for Schedule C (Form 1040).</td>
</tr>
<tr>
<td>Rent/lease vehicles, equip.</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N594</strong></td>
<td>Amounts paid to rent or lease property such as pasture or farm land.</td>
</tr>
<tr>
<td>Rent/lease land, animals</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N595</strong></td>
<td>Amounts you paid for repairs and maintenance of farm buildings, machinery, and equipment. You can also include what you paid for tools of short life or minimal cost, such as shovels and rakes.</td>
</tr>
<tr>
<td>Repairs and maintenance</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N596</strong></td>
<td>The amounts paid for seeds and plants purchased for farming.</td>
</tr>
<tr>
<td>Seeds and plants purchased</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N597</strong></td>
<td>Amounts paid for storage and warehousing of crops, grains, etc.</td>
</tr>
<tr>
<td>Storage and warehousing</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N598</strong></td>
<td>Livestock supplies and other supplies, including bedding, office supplies, etc.</td>
</tr>
<tr>
<td>Supplies purchased</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N599</strong></td>
<td>Real estate and personal property taxes on farm business assets; Social security and Medicare taxes you paid to match what you are required to withhold from farm employees’ wages and any Federal unemployment tax paid; Federal highway use tax.</td>
</tr>
<tr>
<td>Imposte</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N600</strong></td>
<td>Amounts you paid for gas, electricity, water, etc., for business use on the farm. Do not include personal utilities. You cannot deduct the base rate (including taxes) of the first telephone line into your residence, even if you use it for business.</td>
</tr>
<tr>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td><strong>F4835 \ N601</strong></td>
<td>The costs of veterinary services, medicine and breeding fees.</td>
</tr>
<tr>
<td>Vet, breeding, medicine</td>
<td></td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
<tr>
<td><em>F4835 \ N602</em></td>
<td>Other farm expenses</td>
</tr>
<tr>
<td></td>
<td>Include all ordinary and necessary farm rental expenses not deducted elsewhere on Form 4835, such as advertising, office supplies, etc. Do not include fines or penalties paid to a government for violating any law.</td>
</tr>
<tr>
<td><em>Help F4952 \ H425</em></td>
<td><em>Form 4952 - investment interest</em></td>
</tr>
<tr>
<td></td>
<td>Form 4952 is used to compute the amount of investment interest expense deductible for the current year and the amount, if any, to carry forward to future years.</td>
</tr>
<tr>
<td><em>F4952 \ N426</em></td>
<td><em>Investment interest expense</em></td>
</tr>
<tr>
<td></td>
<td>The investment interest paid or accrued during the tax year, regardless of when you incurred the indebtedness. Investment interest is interest paid or accrued on a loan (or part of a loan) that is allocable to property held for investment.</td>
</tr>
<tr>
<td><em>Help F6252 \ H427</em></td>
<td><em>Form 6252 - income from casual sales</em></td>
</tr>
<tr>
<td></td>
<td>Form 6252 is used to report income from casual sales of real or personal property when you will receive any payments in a tax year after the year of sale (i.e., installment sale).</td>
</tr>
<tr>
<td><em>F6252 \ N428</em></td>
<td><em>Selling price</em></td>
</tr>
<tr>
<td></td>
<td>Enter the total of any money, face amount of the installment obligation, and the FMV of other property that you received or will receive in exchange for the property sold.</td>
</tr>
<tr>
<td><em>F6252 \ N429</em></td>
<td><em>Debt assumed by buyer</em></td>
</tr>
<tr>
<td></td>
<td>Enter only mortgages or other debts the buyer assumed from the seller or took the property subject to. Do not include new mortgages the buyer gets from a bank, the seller, or other sources.</td>
</tr>
<tr>
<td><em>F6252 \ N431</em></td>
<td><em>Depreciation allowed</em></td>
</tr>
<tr>
<td></td>
<td>Enter all depreciation or amortization you deducted or should have deducted from the date of purchase until the date of sale. Add any section 179 expense deduction. Several other adjustments are allowed. See Form 6252 instructions.</td>
</tr>
<tr>
<td><em>F6252 \ N432</em></td>
<td><em>Expenses of sale</em></td>
</tr>
<tr>
<td></td>
<td>Enter sales commissions, advertising expenses, attorney and legal fees, etc., in selling the property.</td>
</tr>
<tr>
<td><em>F6252 \ N434</em></td>
<td><em>Payments received this year</em></td>
</tr>
<tr>
<td></td>
<td>Enter all money and the fair market value (FMV) of any property you received in this tax year. Include as payments any amount withheld to pay off a mortgage or other debt, such as broker and legal fees. Do not include interest whether stated or unstated.</td>
</tr>
<tr>
<td><em>F6252 \ N435</em></td>
<td><em>Payments received prior years</em></td>
</tr>
<tr>
<td></td>
<td>Enter all money and the fair market value (FMV) of property you received before this tax year from the sale. Include allocable installment income and any other deemed payments from prior years. Do not include interest whether stated or unstated.</td>
</tr>
<tr>
<td><em>Help F8815 \ H441</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Form 8815 is used to compute the amount of interest you may exclude if you cashed series EE U.S.</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Form 8815 - EE U.S. savings bonds sold for education</td>
<td>savings bonds this year that were issued after 1989 to pay for qualified higher education costs.</td>
</tr>
<tr>
<td>F8815\N442</td>
<td>Qualified higher education expenses</td>
</tr>
<tr>
<td>F8815\N443</td>
<td>Nontaxable education benefits</td>
</tr>
<tr>
<td>F8815\N444</td>
<td>EE US savings bonds proceeds</td>
</tr>
<tr>
<td>F8815\N445</td>
<td>Post-89 EE bond face value</td>
</tr>
<tr>
<td>Help F8863\H639</td>
<td>Form 8863 - Hope and Lifetime Learning education credits</td>
</tr>
<tr>
<td>F8863\N637</td>
<td>Hope credit</td>
</tr>
<tr>
<td>F8863\N638</td>
<td>Lifetime learning credit</td>
</tr>
<tr>
<td>Help F8829\H536</td>
<td>Form 8829 - business use of your home</td>
</tr>
<tr>
<td>F8829\N537</td>
<td>Deductible mortgage interest</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>F8829 \ N538</strong></td>
<td>Real estate taxes</td>
</tr>
<tr>
<td></td>
<td>The total amount of real estate taxes that would be deductible whether or not you used your home for business (i.e., amounts allowable as itemized deductions on Schedule A, Form 1040). Form 8829 computes the deductible business portion.</td>
</tr>
<tr>
<td><strong>F8829 \ N539</strong></td>
<td>Assicurazione</td>
</tr>
<tr>
<td></td>
<td>The total amount of insurance paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.</td>
</tr>
<tr>
<td><strong>F8829 \ N540</strong></td>
<td>Repairs and maintenance</td>
</tr>
<tr>
<td></td>
<td>The total amount of repairs and maintenance paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.</td>
</tr>
<tr>
<td><strong>F8829 \ N541</strong></td>
<td>Utilities</td>
</tr>
<tr>
<td></td>
<td>The total amount of utilities paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.</td>
</tr>
<tr>
<td><strong>F8829 \ N542</strong></td>
<td>Other expenses</td>
</tr>
<tr>
<td></td>
<td>If you rent rather than own your home, include rent paid for your home, in which an area or room is used regularly and exclusively for business. Form 8829 computes the deductible business portion.</td>
</tr>
<tr>
<td><strong>Help F8839 \ H617</strong></td>
<td>Form 8839 - adoption expenses</td>
</tr>
<tr>
<td></td>
<td>Form 8839 is used to report qualified adoption expenses.</td>
</tr>
<tr>
<td><strong>F8839 \ N618</strong></td>
<td>Adoption fees</td>
</tr>
<tr>
<td></td>
<td>Adoption fees that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.</td>
</tr>
<tr>
<td><strong>F8839 \ N619</strong></td>
<td>Court costs</td>
</tr>
<tr>
<td></td>
<td>Court costs that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.</td>
</tr>
<tr>
<td><strong>F8839 \ N620</strong></td>
<td>Attorney fees</td>
</tr>
<tr>
<td></td>
<td>Attorney fees that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.</td>
</tr>
<tr>
<td><strong>F8839 \ N621</strong></td>
<td>Traveling expenses</td>
</tr>
<tr>
<td></td>
<td>Traveling expenses (including meals and lodging) while away from home, directly related to, and for the principal purpose of, the legal adoption of an eligible child.</td>
</tr>
<tr>
<td><strong>F8839 \ N622</strong></td>
<td>Other expenses</td>
</tr>
<tr>
<td></td>
<td>Other expenses that are reasonable and necessary, directly related to, and for the principal purpose of, the legal adoption of an eligible child.</td>
</tr>
<tr>
<td><strong>Home Sale \ N392</strong></td>
<td>Home Sale worksheets (was F2119)</td>
</tr>
<tr>
<td></td>
<td>Home Sale worksheets (replaces Form 2119) are used to report the sale of your personal residence. See IRS Pub 523.</td>
</tr>
<tr>
<td><strong>Home Sale \ N393</strong></td>
<td>Selling price of old home</td>
</tr>
<tr>
<td></td>
<td>The selling price is the total amount you receive for your home. It includes money, all notes, mortgages, or other debts assumed by the buyer as part of</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Home Sale \ N394</strong></td>
<td>Selling expenses include commissions, advertising fees, legal fees, title insurance, and loan charges paid by the seller, such as loan placement fees or &quot;points.&quot;</td>
</tr>
<tr>
<td><strong>Expense of sale</strong></td>
<td>the sale, and the fair market value of any other property or any services you receive. Reported on Form 1099-S.</td>
</tr>
<tr>
<td><strong>Fixing-up expenses</strong></td>
<td>Fixing-up expenses are decorating and repair costs that you paid to sell your old home. For example, the costs of painting the home, planting flowers, and replacing broken windows are fixing-up expenses. Fixing-up expenses must meet all the following conditions. The expenses: Must be for work done during the 90-day period ending on the day you sign the contract of sale with the buyer; Must be paid no later than 30 days after the date of sale; Cannot be deductible in arriving at your taxable income; Must not be used in figuring the amount realized; and Must not be capital expenditures or improvements.</td>
</tr>
<tr>
<td><strong>Cost of new home</strong></td>
<td>The cost of your new home includes costs incurred within the replacement period (beginning 2 years before and ending 2 years after the date of sale) for the following items: Buying or building the home; Rebuilding the home; and Capital improvements or additions.</td>
</tr>
<tr>
<td><strong>Schedule A - itemized deductions</strong></td>
<td>Schedule A is used to report your itemized deductions.</td>
</tr>
<tr>
<td><strong>Subscriptions</strong></td>
<td>Amounts paid for subscriptions to magazines or services that are directly related to the production or collection of taxable income. (example: subscriptions to investment publications, stock newsletters, etc.).</td>
</tr>
<tr>
<td><strong>Gambling losses</strong></td>
<td>Gambling losses, but only to the extent of gambling winnings reported on Form 1040. Note: not subject to the 2% AGI of limitation.</td>
</tr>
<tr>
<td><strong>Medicine and drugs</strong></td>
<td>Prescription medicines, eyeglasses, contact lenses, hearing aids. Over-the-counter medicines are not deductible.</td>
</tr>
<tr>
<td><strong>Medical travel and lodging</strong></td>
<td>Lodging expenses while away from home to receive medical care in a hospital or a medical care facility related to a hospital. Do not include more than $50 a night for each eligible person. Ambulance service and other travel costs to get medical care.</td>
</tr>
<tr>
<td><strong>State income taxes</strong></td>
<td>State income taxes paid this year for a prior year. Include any part of a prior year refund that you chose to have credited to this years state income taxes.</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sched A \N276</td>
<td>Real estate taxes</td>
</tr>
<tr>
<td>Sched A \N277</td>
<td>Other taxes</td>
</tr>
<tr>
<td>Sched A \N280</td>
<td>Cash charity contributions</td>
</tr>
<tr>
<td>Sched A \N281</td>
<td>Tax preparation fees</td>
</tr>
<tr>
<td>Sched A \N282</td>
<td>Investment management fees</td>
</tr>
<tr>
<td>Sched A \N283</td>
<td>Home mortgage interest (1098)</td>
</tr>
<tr>
<td>Sched A \N284</td>
<td>Points paid (no 1098)</td>
</tr>
<tr>
<td>Sched A \N484</td>
<td>Doctors, dentists, hospitals</td>
</tr>
<tr>
<td>Sched A \N486</td>
<td>Misc., subject to 2% AGI limit</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>job search expenses; certain educational expenses. You may need to file Form 2106.</td>
<td></td>
</tr>
<tr>
<td>Sched A \ N485</td>
<td>The fair market value of donated property, such as used clothing or furniture.</td>
</tr>
<tr>
<td>Sched A \ N522</td>
<td>State estimated tax payments made this year.</td>
</tr>
<tr>
<td>Other miscellaneous itemized deductions that are not reduced by 2% of adjusted gross income, such as casualty and theft losses from income-producing, amortizable bond premium on bonds acquired before October 23, 1986, federal estate tax on income in respect to a decedent, certain unrecovered investment in a pension, impairment-related work expenses of a disabled person.</td>
<td></td>
</tr>
<tr>
<td>Sched A \ N535</td>
<td>Enter personal property tax you paid, but only if it is based on value alone. Example: You paid a fee for the registration of your car. Part of the fee was based on the car’s value and part was based on its weight. You may deduct only the part of the fee that is based on the car’s value.</td>
</tr>
<tr>
<td>Sched A \ N544</td>
<td>Local income taxes that were not withheld from your salary, such as local income taxes you paid this year for a prior year.</td>
</tr>
<tr>
<td>Sched A \ N545</td>
<td>Home mortgage interest paid, for which you did not receive a Form 1098 from the recipient. The interest could be on a first or second mortgage, home equity loan, or refinanced mortgage.</td>
</tr>
<tr>
<td>Help Sched B \ H285</td>
<td>Schedule B is used to report your interest and dividend income.</td>
</tr>
<tr>
<td>^ Sched B \ N286</td>
<td>Ordinary dividends from mutual funds, stocks, etc., are reported to you on a 1099-DIV. Note: these are sometimes called short term capital gain distributions. Do not include (long term) capital gain distributions or non-taxable dividends here, these go on Sched D</td>
</tr>
<tr>
<td>&lt; Sched B \ N287</td>
<td>Taxable interest includes interest you receive from bank accounts, credit unions, loans you made to others. There are several categories of interest, be sure you select the correct one!</td>
</tr>
<tr>
<td>&lt; Sched B \ N288</td>
<td>Interest on U.S. obligations, such as U.S. Treasury bills, notes, and bonds issued by any agency of the United States. This income is exempt from all state and local income taxes. There are several categories of interest, be sure you select the correct one!</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>&lt; Sched B \ N289</td>
<td>Interest income, State and municipal bond</td>
</tr>
<tr>
<td>&lt; Sched B \ N290</td>
<td>Interest income, tax-exempt private activity bond</td>
</tr>
<tr>
<td>&lt; Sched B \ N487</td>
<td>Dividend income, non-taxable</td>
</tr>
<tr>
<td>&lt; Sched B \ N489</td>
<td>Interest income, non-taxable</td>
</tr>
<tr>
<td>&lt; Sched B \ N490</td>
<td>Interest income, taxed only by fed</td>
</tr>
<tr>
<td>&lt; Sched B \ N491</td>
<td>Interest income, taxed only by state</td>
</tr>
<tr>
<td>&lt; Sched B \ N492</td>
<td>Interest income, OID bonds</td>
</tr>
<tr>
<td>&lt; Sched B \ N524</td>
<td>Interest income, Seller-financed mortgage</td>
</tr>
<tr>
<td>&lt; Sched B \ N615</td>
<td>Fed tax withheld, dividend income</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>&lt; Sched B \ N616</td>
<td>Fed tax withheld, interest income</td>
</tr>
<tr>
<td>Help Sched C \ H291</td>
<td>Schedule C - self-employment income</td>
</tr>
<tr>
<td>Sched C \ N293</td>
<td>Gross receipts or sales</td>
</tr>
<tr>
<td>Sched C \ N294</td>
<td>Meals and entertainment</td>
</tr>
<tr>
<td>Sched C \ N296</td>
<td>Returns and allowances</td>
</tr>
<tr>
<td>Sched C \ N297</td>
<td>Wages paid</td>
</tr>
<tr>
<td>Sched C \ N298</td>
<td>Legal and professional fees</td>
</tr>
<tr>
<td>Sched C \ N299</td>
<td>Rent/lease vehicles, equip.</td>
</tr>
<tr>
<td>Sched C \ N300</td>
<td>Rent/lease other business property</td>
</tr>
<tr>
<td>Sched C \ N301</td>
<td>Supplies (not from Cost of Goods Sold)</td>
</tr>
<tr>
<td>Sched C \ N302</td>
<td>Other business expenses</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Sched C \N303</strong></td>
<td>Other business income</td>
</tr>
<tr>
<td><strong>Sched C \N304</strong></td>
<td>Pubblicità</td>
</tr>
<tr>
<td><strong>Sched C \N305</strong></td>
<td>Bad debts from sales/services</td>
</tr>
<tr>
<td><strong>Sched C \N306</strong></td>
<td>Car and truck expenses</td>
</tr>
<tr>
<td><strong>Sched C \N307</strong></td>
<td>Commissions and fees</td>
</tr>
<tr>
<td><strong>Sched C \N308</strong></td>
<td>Employee benefit programs</td>
</tr>
<tr>
<td><strong>Sched C \N309</strong></td>
<td>Depletion</td>
</tr>
<tr>
<td><strong>Sched C \N310</strong></td>
<td>Insurance, other than health</td>
</tr>
<tr>
<td><strong>Sched C \N311</strong></td>
<td>Interest expense, mortgage</td>
</tr>
<tr>
<td><strong>Sched C \N312</strong></td>
<td>Interest expense, other</td>
</tr>
<tr>
<td><strong>Sched C \N313</strong></td>
<td>Office expenses</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><em>Sched C\N314</em></td>
<td>You can set up and maintain the following small business retirement plans for yourself and your employees, such as: SEP (Simplified Employee Pension) plans; SIMPLE (Savings Incentive Match Plan for Employees) plans; Qualified plans (including Keogh or H.R. 10 plans). You deduct contributions you make to the plan for yourself on Form 1040.</td>
</tr>
<tr>
<td><em>Sched C\N315</em></td>
<td>The cost of repairs and maintenance. Include labor, supplies, and other items that do not add to the value or increase the life of the property. Do not include the value of your own labor. Do not include amounts spent to restore or replace property; they must be capitalized.</td>
</tr>
<tr>
<td><em>Sched C\N316</em></td>
<td>Include the following taxes: State and local sales taxes imposed on you as the seller of goods or services; Real estate and personal property taxes on business assets; Social security and Medicare taxes paid to match required withholding from your employees’ wages; Also, Federal unemployment tax paid; Federal highway use tax.</td>
</tr>
<tr>
<td><em>Sched C\N317</em></td>
<td>Expenses for lodging and transportation connected with overnight travel for business while away from your tax home.</td>
</tr>
<tr>
<td><em>Sched C\N318</em></td>
<td>The costs of electricity, gas, telephone, etc. for your business property.</td>
</tr>
<tr>
<td><em>Sched C\N493</em></td>
<td>If you are a merchant, use the cost of all merchandise you bought for sale. If you are a manufacturer or producer, this includes the cost of all raw materials or parts purchased for manufacture into a finished product. You must exclude the cost of merchandise you withdraw for your personal or family use.</td>
</tr>
<tr>
<td><em>Sched C\N494</em></td>
<td>Labor costs are usually an element of cost of goods sold only in a manufacturing or mining business. In a manufacturing business, labor costs that are properly allocable to the cost of goods sold include both the direct and indirect labor used in fabricating the raw material into a finished, salable product.</td>
</tr>
<tr>
<td><em>Sched C\N495</em></td>
<td>Materials and supplies, such as hardware and chemicals, used in manufacturing goods are charged to cost of goods sold. Those that are not used in the manufacturing process are treated as deferred charges. You deduct them as a business expense when you use them.</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sched C \ N496</td>
<td>Cost of Goods Sold - Other costs</td>
</tr>
<tr>
<td>Help Sched D \ H320</td>
<td>Schedule D - capital gains and losses</td>
</tr>
<tr>
<td># Sched D \ N321</td>
<td>Short Term gain/loss - security</td>
</tr>
<tr>
<td># Sched D \ N323</td>
<td>Long Term gain/loss - security</td>
</tr>
<tr>
<td>^ Sched D \ N488</td>
<td>Dividend income, capital gain distributions</td>
</tr>
<tr>
<td># Sched D \ N673</td>
<td>Short/Long Term gain or loss</td>
</tr>
<tr>
<td>Help Sched E \ H325</td>
<td>Schedule E - rental and royalty income</td>
</tr>
<tr>
<td>Sched E \ N326</td>
<td>Rents received</td>
</tr>
<tr>
<td>Sched E \ N327</td>
<td>Royalties received</td>
</tr>
<tr>
<td>Sched E \ N328</td>
<td>Pubblicità</td>
</tr>
<tr>
<td>Sched E \ N329</td>
<td>Auto and travel</td>
</tr>
<tr>
<td>Sched E \ N330</td>
<td>Cleaning and maintenance</td>
</tr>
<tr>
<td>Tax Form TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sched E N331</td>
<td>Commissioni</td>
</tr>
<tr>
<td>Sched E N332</td>
<td>Assicurazione</td>
</tr>
<tr>
<td>Sched E N333</td>
<td>Legal and professional fees</td>
</tr>
<tr>
<td>Sched E N334</td>
<td>Mortgage interest expense</td>
</tr>
<tr>
<td>Sched E N335</td>
<td>Other interest expense</td>
</tr>
<tr>
<td>Sched E N336</td>
<td>Repairs</td>
</tr>
<tr>
<td>Sched E N337</td>
<td>Supplies</td>
</tr>
<tr>
<td>Sched E N338</td>
<td>Imposte</td>
</tr>
<tr>
<td>Sched E N339</td>
<td>Utilities</td>
</tr>
<tr>
<td>Sched E N341</td>
<td>Other expenses</td>
</tr>
<tr>
<td>Sched E N502</td>
<td>Management fees</td>
</tr>
<tr>
<td>Help Sched F H343</td>
<td>Schedule F - Farm income and expense</td>
</tr>
<tr>
<td>Sched F N344</td>
<td>Labor hired</td>
</tr>
<tr>
<td>Tax Form \ TXF Code</td>
<td>Descrizione</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sched F \ N345</td>
<td>Repairs and maintenance</td>
</tr>
<tr>
<td>Sched F \ N346</td>
<td>Interest expense, mortgage</td>
</tr>
<tr>
<td>Sched F \ N347</td>
<td>Interest expense, other</td>
</tr>
<tr>
<td>Sched F \ N348</td>
<td>Rent/lease land, animals</td>
</tr>
<tr>
<td>Sched F \ N349</td>
<td>Rent/lease vehicles, equip.</td>
</tr>
<tr>
<td>Sched F \ N350</td>
<td>Feed purchased</td>
</tr>
<tr>
<td>Sched F \ N351</td>
<td>Seeds and plants purchased</td>
</tr>
<tr>
<td>Sched F \ N352</td>
<td>Fertilizers and lime</td>
</tr>
<tr>
<td>Sched F \ N353</td>
<td>Supplies purchased</td>
</tr>
<tr>
<td>Sched F \ N355</td>
<td>Vet, breeding, and medicine</td>
</tr>
<tr>
<td>Sched F \ N356</td>
<td>Gasoline, fuel, and oil</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N357</em></td>
<td>Amounts paid for storage and warehousing of crops, grains, etc.</td>
</tr>
<tr>
<td>Storage and warehousing</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N358</em></td>
<td>Real estate and personal property taxes on farm business assets; Social security and Medicare taxes you paid to match what you are required to withhold from farm employees’ wages and any Federal unemployment tax paid; Federal highway use tax.</td>
</tr>
<tr>
<td>Imposte</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N359</em></td>
<td>Premiums paid for farm business insurance, such as: fire, storm, crop, theft and liability protection of farm assets. Do not include premiums for employee accident and health insurance.</td>
</tr>
<tr>
<td>Insurance, other than health</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N360</em></td>
<td>Amounts you paid for gas, electricity, water, etc., for business use on the farm. Do not include personal utilities. You cannot deduct the base rate (including taxes) of the first telephone line into your residence, even if you use it for business.</td>
</tr>
<tr>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N361</em></td>
<td>The costs of freight or trucking of produce or livestock.</td>
</tr>
<tr>
<td>Freight and trucking</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N362</em></td>
<td>Your expenses for soil or water conservation or for the prevention of erosion of land used in farming. To take this deduction, your expenses must be consistent with a plan approved by the Natural Resources Conservation Service (NRCS) of the Department of Agriculture.</td>
</tr>
<tr>
<td>Conservation expenses</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N363</em></td>
<td>Enter your deduction for contributions to employee pension, profit-sharing, or annuity plans. If the plan included you as a self-employed person, see the instructions for Schedule C (Form 1040).</td>
</tr>
<tr>
<td>Pension/profit sharing plans</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N364</em></td>
<td>Contributions to employee benefit programs, such as accident and health plans, group-term life insurance, and dependent care assistance programs. Do not include contributions that are a incidental part of a pension or profit-sharing plan.</td>
</tr>
<tr>
<td>Employee benefit programs</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N365</em></td>
<td>Include all ordinary and necessary farm expenses not deducted elsewhere on Schedule F, such as advertising, office supplies, etc. Do not include fines or penalties paid to a government for violating any law.</td>
</tr>
<tr>
<td>Other farm expenses</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N366</em></td>
<td>Chemicals used in operating your farm, such as insect sprays and dusts.</td>
</tr>
<tr>
<td>Chemicals</td>
<td></td>
</tr>
<tr>
<td><em>Sched F \ N367</em></td>
<td>Amounts you paid for custom hire (machine work) (the machine operator furnished the equipment). Do not include amounts paid for rental or lease of equipment you operated yourself.</td>
</tr>
<tr>
<td>Custom hire expenses</td>
<td></td>
</tr>
</tbody>
</table>
### Tax Form \ TXF Code

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Sched F\N372</em></td>
<td>Government payments received for: price support payments, market gain from the repayment of a secured Commodity Credit Corporation (CCC) loan for less than the original loan amount, diversion payments, cost-share payments (sight drafts), payments in the form of materials (such as fertilizer or lime) or services (such as grading or building dams). Reported on Form 1099-G.</td>
</tr>
<tr>
<td><em>Sched F\N373</em></td>
<td>Generally, you do not report CCC loan proceeds as income. However, if you pledge part or all of your production to secure a CCC loan, you may elect to report the loan proceeds as income in the year you receive them, instead of the year you sell the crop.</td>
</tr>
<tr>
<td><em>Sched F\N374</em></td>
<td>The amount forfeited or repaid with certificates, even if you reported the loan proceeds as income. See IRS Pub 225.</td>
</tr>
<tr>
<td><em>Sched F\N375</em></td>
<td>You generally include crop insurance proceeds in the year you receive them. Treat as crop insurance proceeds the crop disaster payments you receive from the federal government.</td>
</tr>
<tr>
<td><em>Sched F\N376</em></td>
<td>If you use the cash method of accounting and receive crop insurance proceeds in the same tax year in which the crops are damaged, you can choose to postpone reporting the proceeds as income until the following tax year. A statement must also be attached to your return. See IRS Pub 225.</td>
</tr>
<tr>
<td><em>Sched F\N377</em></td>
<td>Illegal Federal irrigation subsidies, bartering income, income from discharge of indebtedness, state gasoline or fuel tax refund, the gain or loss on the sale of commodity futures contracts, etc.</td>
</tr>
<tr>
<td><em>Sched F\N368</em></td>
<td>Amounts you received from the sale of livestock, produce, grains, and other products you raised.</td>
</tr>
<tr>
<td><em>Sched F\N369</em></td>
<td>Amounts you received from the sales of livestock and other items you bought specifically for resale. Do not include sales of livestock held for breeding, dairy purposes, draft, or sport. These are reported on Form 4797, Sales of Business Property.</td>
</tr>
<tr>
<td><em>Sched F\N370</em></td>
<td>The income you received for custom hire (machine work).</td>
</tr>
<tr>
<td><em>Sched F\N371</em></td>
<td>Distributions received from a cooperative. This includes patronage dividends, non patronage distributions, per-unit retain allocations, and redemption of non qualified notices and per unit retain allocations. Reported on Form 1099-PATR.</td>
</tr>
<tr>
<td><strong>Tax Form \ TXF Code</strong></td>
<td><strong>Messaggi TXF di aiuto estesi</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>Descrizione</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Sched F \ N378**
Cost of resale livestock/items
The cost or other basis of the livestock and other items you actually sold.

**Sched F \ N543**
Car and truck expenses
The business portion of car or truck expenses, such as, for gasoline, oil, repairs, insurance, tires, license plates, etc.

**Help Sched H \ H565**
Schedule H - Household employees
Schedule H is used to report Federal employment taxes on cash wages paid this year to household employees. Federal employment taxes include social security, Medicare, withheld Federal income, and Federal unemployment (FUTA) taxes.

^ **Sched H \ N567**
Cash wages paid
For household employees to whom you paid $1,100 (as of 1999) or more each of cash wages that are subject to social security and Medicare taxes. To find out if the wages are subject to these taxes, see the instructions for Schedule H.

^ **Sched H \ N568**
Federal tax withheld
Federal income tax withheld from total cash wages paid to household employees during the year.

**Help Sched K-1 \ H446**
Schedule K-1 - partnership income, credits, deductions
Schedule K-1 is used to report your share of a partnership’s income, credits, deductions, etc. Use a separate copy of Schedule K-1 for each partnership.

# **Sched K-1 \ N448**
Ordinary income or loss
Your share of the ordinary income (loss) from the trade or business activities of the partnership. This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)

# **Sched K-1 \ N449**
Rental real estate income or loss
The income or (loss) from rental real estate activities engaged in by the partnership. This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)

# **Sched K-1 \ N450**
Other rental income or loss
The income or (loss) from rental activities, other than the rental of real estate. This is reported to you on Schedule K-1. (You usually report this on Schedule E, See instructions for Schedule K-1)

**Sched K-1 \ N451**
Interest income
The amount of interest income the partnership reported to you on Schedule K-1. (You report this on Schedule B)

**Sched K-1 \ N452**
Dividends, ordinary
The amount of dividend income the partnership reported to you on Schedule K-1. (You report this on Schedule B)

# **Sched K-1 \ N453**
Net ST capital gain or loss
The short-term gain or (loss) from sale of assets the partnership reported to you on K-1. (You report this on Schedule D)
### Tax Form \ TXF Code

<table>
<thead>
<tr>
<th>Descrizione</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td># Sched K-1 \ N454</td>
<td>Net LT capital gain or loss</td>
</tr>
<tr>
<td>Sched K-1 \ N455</td>
<td>Guaranteed partner payments</td>
</tr>
<tr>
<td># Sched K-1 \ N456</td>
<td>Net Section 1231 gain or loss</td>
</tr>
<tr>
<td>Sched K-1 \ N527</td>
<td>Royalties</td>
</tr>
<tr>
<td>Sched K-1 \ N528</td>
<td>Tax-exempt interest income</td>
</tr>
<tr>
<td>Help W-2 \ H458</td>
<td>Form W-2 - Wages earned and taxes withheld</td>
</tr>
<tr>
<td>^ W-2 \ N267</td>
<td>Reimbursed moving expenses, self</td>
</tr>
<tr>
<td>^ W-2 \ N460</td>
<td>Salary or wages, self</td>
</tr>
<tr>
<td>^ W-2 \ N461</td>
<td>Federal tax withheld, self</td>
</tr>
<tr>
<td>^ W-2 \ N462</td>
<td>Social Security tax withheld, self</td>
</tr>
<tr>
<td>^ W-2 \ N463</td>
<td>Local tax withheld, self</td>
</tr>
<tr>
<td>^ W-2 \ N464</td>
<td>State tax withheld, self</td>
</tr>
<tr>
<td>^ W-2 \ N465</td>
<td>Dependent care benefits, self</td>
</tr>
<tr>
<td>^ W-2 \ N480</td>
<td>Medicare tax withheld, self</td>
</tr>
</tbody>
</table>
### Tax Form \ TXF Code

<table>
<thead>
<tr>
<th>TXF Code</th>
<th>Descrizione</th>
<th>Messaggi TXF di aiuto estesi</th>
</tr>
</thead>
<tbody>
<tr>
<td>N506</td>
<td>Salary or wages, spouse</td>
<td>The total wages, tips, and other compensation, before any payroll deductions, your spouse receives from your spouse’s employer.</td>
</tr>
<tr>
<td>N507</td>
<td>Federal tax withheld, spouse</td>
<td>The amount of Federal income tax withheld from your spouse’s wages for the year.</td>
</tr>
<tr>
<td>N508</td>
<td>Social Security tax withheld, spouse</td>
<td>The amount of social security taxes withheld from your spouse’s wages.</td>
</tr>
<tr>
<td>N509</td>
<td>Local tax withheld, spouse</td>
<td>The amount of local taxes withheld from your spouse’s wages.</td>
</tr>
<tr>
<td>N510</td>
<td>Medicare tax withheld, spouse</td>
<td>The amount of Medicare taxes withheld from your spouse’s wages.</td>
</tr>
<tr>
<td>N511</td>
<td>State tax withheld, spouse</td>
<td>The amount of state taxes withheld from your spouse’s wages.</td>
</tr>
<tr>
<td>N512</td>
<td>Dependent care benefits, spouse</td>
<td>The amount dependent care benefits, including the fair market value of employer-provided or employer-sponsored day-care facilities your spouse received.</td>
</tr>
<tr>
<td>N546</td>
<td>Reimbursed moving expenses, spouse</td>
<td>Qualified moving expense reimbursements paid directly to your spouse by your spouse’s employer.</td>
</tr>
<tr>
<td>N547</td>
<td>Form W-2G - gambling winnings</td>
<td>Form W-2G is used to report certain gambling winnings.</td>
</tr>
<tr>
<td>N549</td>
<td>Gross winnings</td>
<td>The amount of gross winnings from gambling. This may include winnings from horse racing, dog racing, jai alai, lotteries, keno, bingo, slot machines, sweepstakes, and wagering pools. If the amount is large enough, it will be reported on Form W-2G.</td>
</tr>
<tr>
<td>N550</td>
<td>Federal tax withheld</td>
<td>The amount of federal income taxes withheld from gross gambling winnings.</td>
</tr>
<tr>
<td>N551</td>
<td>State tax withheld</td>
<td>The amount of state income taxes withheld from gross gambling winnings.</td>
</tr>
</tbody>
</table>


---

### Ripristina avvisi...

GnuCash visualizza degli avvisi quando si cerca di effettuare determinate operazioni, come rimuovere una transazione o le suddivisioni da una transazione. La finestra di avviso presenta l’opzione di non visualizzare più questi messaggi alla ripetizione dell’operazione. Le opzioni Ricordalo e non chiedermelo di nuovo e

### Changing the Language

La lingua dell’interfaccia di GnuCash non è direttamente modificabile dalle preferenze del programma.

Il metodo per cambiare lingua del programma dipende dal sistema operativo in cui GnuCash viene eseguito.

#### Linux

In genere è necessario impostare le variabili di sistema `LANGUAGE` e `LANG` prima di avviare GnuCash. Per farlo occorre aprire una finestra di terminale ed eseguire il seguente comando:

```
LANGUAGE=ll_LL LANG=ll_LL gnucash
```

`ll_LL` è la lingua con cui avviare GnuCash (`de_DE` per il tedesco, `it_IT` per l’italiano ecc...)

**Nota**

In alcuni sistemi (per esempio Ubuntu) la codifica può far parte del nome, come `ll_LL.UTF-8`.

#### MacOSX

Per utilizzare una traduzione diversa da quella selezionata automaticamente, è possibile eseguire il seguente comando in Terminal.app:

```bash
defaults write $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app) AppleLanguages "(de, en)"
```

È possibile usare qualsiasi codice di lingua si desideri, in luogo di Tedesco (de) e Inglese (en). Comunque, se il file per la traduzione non è presente, il comando non funzionerà.

Per reimpostare i valori originali, eseguire:

```bash
defaults delete $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/GnuCash.app)
```

#### Finestre™

Se si sta eseguendo GnuCash 2.4.0 (o successivo) su Windows, è possibile impostare la lingua dell’interfaccia modificando il file `environment` con un editor di testo (per esempio Notepad). Di norma questo file è installato nella cartella `c:\Programmi\gnucash\etc\gnucash`. Modificare il file in modo che le ultime righe siano come le seguenti:

```plaintext
# If you wish GnuCash to use a different language, uncomment the two
# below and set LANG to your preferred locale
LANG=ll_LL
LANGUAGE={LANG}

ll_LL è la lingua con cui avviare GnuCash (de_DE per il tedesco, it_IT per l’italiano ecc...)
```
Suggerimento

Maggiori e più aggiornate informazioni relative all’argomento possono essere reperite sulla pagina delle impostazioni della lingua [https://wiki.gnucash.org/wiki/Locale_Settings] nel wiki di GnuCash.
Appendice A. Suggerimenti e consigli utili su GnuCash


This chapter gives you some background informations about Finance::Quote.

Finance::Quote Sources

There are 3 types of sources of which the first - currency - is hardcoded and responsible to fetch ISO currencies. The other two can be selected in the security editor.

Finance::Quote Sources - Currency source

<table>
<thead>
<tr>
<th>GnuCash Name</th>
<th>Finance::Quote Name</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valuta</td>
<td>currency</td>
<td>In 2012 happened a modification on the website. Make shure, you updated F::Q to version 1.18.</td>
</tr>
</tbody>
</table>

Fonti delle quotazioni - fonti individuali

<table>
<thead>
<tr>
<th>GnuCash Name</th>
<th>Finance::Quote Name</th>
<th>URL, Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amsterdam Euronext eXchange, aex NL</td>
<td>aex</td>
<td><a href="http://www.aex.nl">http://www.aex.nl</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>includes Futures and Options</td>
</tr>
<tr>
<td>American International Assurance, HK</td>
<td>aiahk</td>
<td><a href="http://www.aia.com.hk">http://www.aia.com.hk</a></td>
</tr>
<tr>
<td>Association of Mutual Funds In India, IN</td>
<td>amfiindia</td>
<td><a href="http://www.amfiindia.com">http://www.amfiindia.com</a></td>
</tr>
<tr>
<td>Athens Stock Exchange, GR</td>
<td>asegr</td>
<td><a href="http://www.ase.gr">http://www.ase.gr</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="https://www.asx.com.au">https://www.asx.com.au</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Requires at least F::Q 1.41 to get quotes for stocks starting with 'X', like «XRO», which are not indices.</td>
</tr>
<tr>
<td>BAMOSZ funds, HU</td>
<td>bamosz</td>
<td><a href="http://www.bamosz.hu">http://www.bamosz.hu</a></td>
</tr>
<tr>
<td>BMO NesbittBurns, CA</td>
<td>bmonesbittburns</td>
<td><a href="http://bmonesbittburns.com">http://bmonesbittburns.com</a></td>
</tr>
<tr>
<td>Bucharest Stock Exchange (Bursa de Valori Bucuresti), RO</td>
<td>bsero</td>
<td><a href="http://www.bvb.ro">http://www.bvb.ro</a></td>
</tr>
<tr>
<td>Budapest Stock Exchange (BET), ex-BUX, HU</td>
<td></td>
<td><a href="http://www.bet.hu">http://www.bet.hu</a></td>
</tr>
<tr>
<td>GnuCash Name</td>
<td>Finance::Quote Name</td>
<td>URL, Notes</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Citywire Funds, GB</td>
<td>citywire</td>
<td><a href="http://citywire.co.uk">http://citywire.co.uk</a></td>
</tr>
<tr>
<td>Colombo Stock Exchange, LK</td>
<td>cse</td>
<td><a href="http://www.cse.lk">http://www.cse.lk</a></td>
</tr>
<tr>
<td>Cominvest Asset Management, cominvest ex-Adig, DE</td>
<td></td>
<td><a href="http://www.cominvest-am.de">http://www.cominvest-am.de</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Obsolete, update: <a href="http://eggert.org/software/Comdirect.pm">http://eggert.org/software/Comdirect.pm</a></td>
</tr>
<tr>
<td>Deka Investments, DE</td>
<td>deka</td>
<td><a href="http://www.deka.de">http://www.deka.de</a></td>
</tr>
<tr>
<td>DWS, DE</td>
<td>dwsfunds</td>
<td><a href="http://www.dws.de">http://www.dws.de</a></td>
</tr>
<tr>
<td>Equinox Unit Trusts, ZA</td>
<td>za_unittrusts</td>
<td><a href="http://www.equinox.co.za">http://www.equinox.co.za</a></td>
</tr>
<tr>
<td>Fidelity Investments, US</td>
<td>fidelity_direct</td>
<td><a href="http://www.fidelity.com">http://www.fidelity.com</a></td>
</tr>
<tr>
<td>Finance Canada</td>
<td>financecanada</td>
<td><a href="http://finance.canada.com">http://finance.canada.com</a></td>
</tr>
<tr>
<td>Financial Times Funds service, ftfunds</td>
<td></td>
<td><a href="http://funds.ft.com">http://funds.ft.com</a></td>
</tr>
<tr>
<td>GB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finanzpartner, DE</td>
<td>finanzpartner</td>
<td><a href="http://www.finanzpartner.de">http://www.finanzpartner.de</a></td>
</tr>
<tr>
<td>First Trust Portfolios, US</td>
<td>ftportfolios_direct</td>
<td><a href="http://www.ftportfolios.com">http://www.ftportfolios.com</a></td>
</tr>
<tr>
<td>Fund Library, CA</td>
<td>fundlibrary</td>
<td><a href="http://www.fundlibrary.com">http://www.fundlibrary.com</a></td>
</tr>
<tr>
<td>GoldMoney spot rates, JE</td>
<td>goldmoney</td>
<td><a href="http://www.goldmoney.com">http://www.goldmoney.com</a></td>
</tr>
<tr>
<td>Helsinki stock eXchange, FI</td>
<td>hex</td>
<td><a href="http://www.hex.com">http://www.hex.com</a></td>
</tr>
<tr>
<td>Man Investments, AU</td>
<td>maninv</td>
<td><a href="http://www.maninvestments.com.au">http://www.maninvestments.com.au</a></td>
</tr>
<tr>
<td>Morningstar, GB</td>
<td>mstaruk</td>
<td><a href="http://morningstar.co.uk">http://morningstar.co.uk</a></td>
</tr>
<tr>
<td>Morningstar, JP</td>
<td>morningstarjp</td>
<td><a href="http://www.morningstar.co.jp">http://www.morningstar.co.jp</a></td>
</tr>
<tr>
<td>Morningstar, SE</td>
<td>morningstar</td>
<td><a href="http://www.morningstar.se">http://www.morningstar.se</a></td>
</tr>
<tr>
<td>Motley Fool, US</td>
<td>fool</td>
<td><a href="http://www.fool.com">http://www.fool.com</a></td>
</tr>
<tr>
<td>New Zealand stock eXchange, NZ</td>
<td>nzx</td>
<td><a href="http://www.nzx.com">http://www.nzx.com</a></td>
</tr>
<tr>
<td>Paris Stock Exchange/ boursorama, FR</td>
<td></td>
<td><a href="http://www.boursorama.com">http://www.boursorama.com</a></td>
</tr>
<tr>
<td>Paris Stock Exchange/LeRevenu, lerevenu</td>
<td></td>
<td><a href="http://bourse.lerevenu.com">http://bourse.lerevenu.com</a></td>
</tr>
<tr>
<td>Platinum Asset Management, AU</td>
<td>platinum</td>
<td><a href="http://www.platinum.com.au">http://www.platinum.com.au</a></td>
</tr>
<tr>
<td>SIX Swiss Exchange Funds, CH</td>
<td>sixfunds</td>
<td><a href="http://www.six-swiss-exchange.com">http://www.six-swiss-exchange.com</a></td>
</tr>
<tr>
<td>SIX Swiss Exchange Shares, CH</td>
<td>sixshares</td>
<td><a href="http://www.six-swiss-exchange.com">http://www.six-swiss-exchange.com</a></td>
</tr>
<tr>
<td>Skandinaviska Enskilda Banken seb_funds</td>
<td></td>
<td><a href="http://seb.se">http://seb.se</a></td>
</tr>
<tr>
<td>Sharenet, ZA</td>
<td>za</td>
<td><a href="http://www.sharenet.co.za">http://www.sharenet.co.za</a></td>
</tr>
</tbody>
</table>
### Suggerimenti e consigli utili su GnuCash

<table>
<thead>
<tr>
<th>GnuCash Name</th>
<th>Finance::Quote Name</th>
<th>URL, Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>StockHouse Canada, CA</td>
<td>stockhousecanada_fund</td>
<td><a href="http://www.stockhouse.ca">http://www.stockhouse.ca</a></td>
</tr>
<tr>
<td>TD Waterhouse Canada, CA</td>
<td>tdwaterhouse</td>
<td><a href="http://www.tdwaterhouse.ca">http://www.tdwaterhouse.ca</a></td>
</tr>
<tr>
<td>TD Efunds, CA</td>
<td>tdefunds</td>
<td><a href="http://www.stockhouse.ca">http://www.stockhouse.ca</a></td>
</tr>
<tr>
<td>TIAA-CREF, US</td>
<td>tiaacref</td>
<td><a href="http://www.tiaa-cref.org">http://www.tiaa-cref.org</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Also here were changes, which require at least F::Q 1.18.</td>
</tr>
<tr>
<td>Toronto Stock eXchange, CA</td>
<td>txs</td>
<td><a href="http://www.TMXmoney.com">http://www.TMXmoney.com</a></td>
</tr>
<tr>
<td>Trustnet, GB</td>
<td>trustnet</td>
<td><a href="http://www.trustnet.co.uk">http://www.trustnet.co.uk</a></td>
</tr>
<tr>
<td>Union Investment, DE</td>
<td>unionfunds</td>
<td><a href="http://www.union-invest.de">http://www.union-invest.de</a></td>
</tr>
<tr>
<td>Vanguard, US</td>
<td>vanguard</td>
<td>part of AlphaVantage module</td>
</tr>
<tr>
<td>VWD, DE (unmaintained)</td>
<td>vwd</td>
<td>See <a href="https://lists.gnucash.org/pipermail/gnucash-user/2008-February/023686.html">https://lists.gnucash.org/pipermail/gnucash-user/2008-February/023686.html</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yahoo USA</td>
<td>yahoo</td>
<td><a href="https://finance.yahoo.com/">https://finance.yahoo.com/</a></td>
</tr>
<tr>
<td>Yahoo Asia</td>
<td>yahoo_asia</td>
<td><a href="http://sg.finance.yahoo.com">http://sg.finance.yahoo.com</a></td>
</tr>
<tr>
<td>Yahoo Australia</td>
<td>yahoo-australia</td>
<td><a href="http://au.finance.yahoo.com">http://au.finance.yahoo.com</a></td>
</tr>
<tr>
<td>Yahoo Brasile</td>
<td>yahoo_brasil</td>
<td><a href="http://br.finance.yahoo.com">http://br.finance.yahoo.com</a></td>
</tr>
<tr>
<td>Yahoo Europa</td>
<td>yahoo_europe</td>
<td><a href="http://finance.uk.yahoo.com">http://finance.uk.yahoo.com</a></td>
</tr>
<tr>
<td>Yahoo Nuova Zelanda</td>
<td>yahoo-nz</td>
<td><a href="http://nz.finance.yahoo.com">http://nz.finance.yahoo.com</a></td>
</tr>
<tr>
<td>Yahoo Finance through JSON call</td>
<td>yahoo-json</td>
<td></td>
</tr>
<tr>
<td>Zuerich Investments (outdated)</td>
<td>zifunds</td>
<td></td>
</tr>
</tbody>
</table>

### Finance::Quote Sources - Multiple sources

Tabella A.3. Fonti multiple per le quotazioni

<table>
<thead>
<tr>
<th>Nome</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia (Yahoo, ...)</td>
</tr>
<tr>
<td>Australia (ASX, Yahoo, ...)</td>
</tr>
<tr>
<td>Brasile (Yahoo, ...)</td>
</tr>
<tr>
<td>Canada (Yahoo, ...)</td>
</tr>
<tr>
<td>Canada Mutual (Fund Library, ...)</td>
</tr>
<tr>
<td>Dutch (AEX, ...)</td>
</tr>
<tr>
<td>Europa (Yahoo, ...)</td>
</tr>
<tr>
<td>Grecia (ASE, ...)</td>
</tr>
<tr>
<td>India Mutual (AMFI, ...)</td>
</tr>
<tr>
<td>Fidelity (Fidelity, ...)</td>
</tr>
</tbody>
</table>
Suggerimenti e consigli utili su GnuCash

Nome
Finland (HEX, ...)
First Trust (First Trust, ...)
France (Boursorama, ...)
Nasdaq (Yahoo, ...)
Nuova Zelanda (Yahoo, ...)
NYSE (Yahoo, ...)
Romania (bsero, ...)
T. Rowe Price
U.K. Unit Trusts
USA (Yahoo, Fool ...)

Sources: src/engine/gnc-commodity.c:gnc_quote_source (commit 05da881, which was adjusted for Finance::Quote 1.38), GnuCash-Wiki, bugzilla, mailing list archive.

Yahoo Specifics

Yahoo offers quotes from many exchanges and markets. If you are not asking for US markets, you have to specify where to look. A typical Yahoo symbol has the form <ISIN><markets suffix>.

Tabella A.4. Yahoo Codes for Exchanges and Markets

<table>
<thead>
<tr>
<th>Country</th>
<th>Exchange</th>
<th>Suffix</th>
<th>Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>Buenos Aires Stock Exchange</td>
<td>.BA</td>
<td>30 min</td>
</tr>
<tr>
<td>Australia</td>
<td>Australian Stock Exchange</td>
<td>.AX</td>
<td>20 min</td>
</tr>
<tr>
<td>Austria</td>
<td>Vienna Stock Exchange</td>
<td>.VI</td>
<td>15 min</td>
</tr>
<tr>
<td>Brazil</td>
<td>BOVESPA - Sao Paolo Stock Exchange</td>
<td>.SA</td>
<td>15 min</td>
</tr>
<tr>
<td>Canada</td>
<td>Toronto Stock Exchange</td>
<td>.TO</td>
<td>15 min</td>
</tr>
<tr>
<td>Canada</td>
<td>TSX Venture Exchange</td>
<td>.V</td>
<td>15 min</td>
</tr>
<tr>
<td>Chile</td>
<td>Santiago Stock Exchange</td>
<td>.SN</td>
<td>15 min</td>
</tr>
<tr>
<td>China</td>
<td>Shanghai Stock Exchange</td>
<td>.SS</td>
<td>30 min</td>
</tr>
<tr>
<td>China</td>
<td>Shenzhen Stock Exchange</td>
<td>.SZ</td>
<td>30 min</td>
</tr>
<tr>
<td>Denmark</td>
<td>Copenhagen Stock Exchange</td>
<td>.CO</td>
<td>15 min</td>
</tr>
<tr>
<td>France</td>
<td>Euronext</td>
<td>.NX</td>
<td>15 min</td>
</tr>
<tr>
<td>France</td>
<td>Paris Stock Exchange</td>
<td>.PA</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Berlin Stock Exchange</td>
<td>.BE</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Bremen Stock Exchange</td>
<td>.BM</td>
<td>15 min</td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td><strong>Exchange</strong></td>
<td><strong>Suffix</strong></td>
<td><strong>Delay</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------</td>
<td>------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Germany</td>
<td>Dusseldorf Stock Exchange</td>
<td>.DU</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Frankfurt Stock Exchange</td>
<td>.F</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Hamburg Stock Exchange</td>
<td>.HM</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Hanover Stock Exchange</td>
<td>.HA</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Munich Stock Exchange</td>
<td>.MU</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>Stuttgart Stock Exchange</td>
<td>.SG</td>
<td>15 min</td>
</tr>
<tr>
<td>Germany</td>
<td>XETRA Stock Exchange</td>
<td>.DE</td>
<td>15 min</td>
</tr>
<tr>
<td>Greece</td>
<td>Athens Stock Exchange</td>
<td>.AT</td>
<td>15 min</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Hong Kong Stock Exchange</td>
<td>.HK</td>
<td>15 min</td>
</tr>
<tr>
<td>India</td>
<td>Bombay Stock Exchange</td>
<td>.BO</td>
<td>15 min</td>
</tr>
<tr>
<td>India</td>
<td>National Stock Exchange of India</td>
<td>.NS</td>
<td>Real-time**</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Jakarta Stock Exchange</td>
<td>.JK</td>
<td>10 min</td>
</tr>
<tr>
<td>Israel</td>
<td>Tel Aviv Stock Exchange</td>
<td>.TA</td>
<td>20 min</td>
</tr>
<tr>
<td>Italy</td>
<td>Milan Stock Exchange</td>
<td>.MI</td>
<td>20 min</td>
</tr>
<tr>
<td>Japan</td>
<td>Nikkei Indices</td>
<td>N/A</td>
<td>30 min</td>
</tr>
<tr>
<td>Mexico</td>
<td>Mexico Stock Exchange</td>
<td>.MX</td>
<td>20 min</td>
</tr>
<tr>
<td>Netherlands</td>
<td>Amsterdam Stock Exchange</td>
<td>.AS</td>
<td>15 min</td>
</tr>
<tr>
<td>New Zealand</td>
<td>New Zealand Stock Exchange</td>
<td>.NZ</td>
<td>20 min</td>
</tr>
<tr>
<td>Norway</td>
<td>Oslo Stock Exchange</td>
<td>.OL</td>
<td>15 min</td>
</tr>
<tr>
<td>Russia</td>
<td>Moscow Interbank Currency Exchange (MICEX)</td>
<td>.ME</td>
<td>15 min</td>
</tr>
<tr>
<td>Singapore</td>
<td>Singapore Stock Exchange</td>
<td>.SI</td>
<td>20 min</td>
</tr>
<tr>
<td>South Korea</td>
<td>Korea Stock Exchange</td>
<td>.KS</td>
<td>20 min</td>
</tr>
<tr>
<td>South Korea</td>
<td>KOSDAQ</td>
<td>.KQ</td>
<td>20 min</td>
</tr>
<tr>
<td>Spain</td>
<td>Barcelona Stock Exchange</td>
<td>.BC</td>
<td>15 min</td>
</tr>
<tr>
<td>Spain</td>
<td>Bilbao Stock Exchange</td>
<td>.BI</td>
<td>15 min</td>
</tr>
<tr>
<td>Spain</td>
<td>Madrid Fixed Income Market</td>
<td>.MF</td>
<td>15 min</td>
</tr>
<tr>
<td>Spain</td>
<td>Madrid SE C.A.T.S.</td>
<td>.MC</td>
<td>15 min</td>
</tr>
<tr>
<td>Spain</td>
<td>Madrid Stock Exchange</td>
<td>.MA</td>
<td>15 min</td>
</tr>
</tbody>
</table>
## Suggerimenti e consigli utili su GnuCash

<table>
<thead>
<tr>
<th>Country</th>
<th>Exchange</th>
<th>Suffix</th>
<th>Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sweden</td>
<td>Stockholm Exchange</td>
<td>.ST</td>
<td>15 min</td>
</tr>
<tr>
<td>Switzerland</td>
<td>Swiss Exchange</td>
<td>.SW</td>
<td>30 min</td>
</tr>
<tr>
<td>Taiwan</td>
<td>Taiwan OTC Exchange</td>
<td>.TWO</td>
<td>20 min</td>
</tr>
<tr>
<td>Taiwan</td>
<td>Taiwan Stock Exchange</td>
<td>.TW</td>
<td>20 min</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>FTSE Indices</td>
<td>N/A</td>
<td>15 min</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>London Stock Exchange</td>
<td>.L</td>
<td>20 min</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>London Stock Exchange</td>
<td>.IL</td>
<td>20 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>BATS Exchange</td>
<td>N/A</td>
<td>Real-time</td>
</tr>
<tr>
<td>United States of America</td>
<td>Chicago Board of Trade</td>
<td>.CBT</td>
<td>10 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>Chicago Mercantile Exchange</td>
<td>.CME</td>
<td>10 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>Dow Jones Indexes</td>
<td>N/A</td>
<td>Real-time</td>
</tr>
<tr>
<td>United States of America</td>
<td>NASDAQ Exchange</td>
<td>N/A</td>
<td>Real-time*</td>
</tr>
<tr>
<td>United States of America</td>
<td>New York Board of Trade</td>
<td>.NYB</td>
<td>30 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>New York Commodities Exchange</td>
<td>.CMX</td>
<td>30 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>New York Mercantile Exchange</td>
<td>.NYM</td>
<td>30 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>New York Stock Exchange</td>
<td>N/A</td>
<td>Real-time*</td>
</tr>
<tr>
<td>United States of America</td>
<td>NYSE Mkt</td>
<td>N/A</td>
<td>Real-time*</td>
</tr>
<tr>
<td>United States of America</td>
<td>OTC Bulletin Board Market</td>
<td>N/A</td>
<td>Real-time*</td>
</tr>
<tr>
<td>United States of America</td>
<td>OTC Markets Group</td>
<td>N/A</td>
<td>15 min</td>
</tr>
<tr>
<td>United States of America</td>
<td>S &amp; P Indices</td>
<td>N/A</td>
<td>Real-time</td>
</tr>
</tbody>
</table>


### TIAA-CREF Specifics

TIAA-CREF Annuities are not listed on any exchange, unlike their mutual funds TIAA-CREF provides unit values via a cgi on their website. The cgi returns a csv file in the format

```
bogus_symbol1,price1,date1
bogus_symbol2,price2,date2
..etc.
```

where `bogus_symbol` takes on the following values for the various annuities:
**Nota**

The symbols are case-sensitive and changed their capitalization in the last time.

**Tabella A.5. Pseudo simboli da utilizzare per le quotazioni TIAA-CREF**

<table>
<thead>
<tr>
<th>Nome</th>
<th>Symbol</th>
<th>bogus</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREF Bond Market Account</td>
<td>CREFbond</td>
<td>41081991</td>
</tr>
<tr>
<td>CREF Equity Index Account</td>
<td>CREFequi</td>
<td>41082540</td>
</tr>
<tr>
<td>CREF Global Equities Account</td>
<td>CREFglob</td>
<td>41081992</td>
</tr>
<tr>
<td>CREF Growth Account</td>
<td>CREFgrow</td>
<td>41082544</td>
</tr>
<tr>
<td>CREF Inflation-Linked Bond Account</td>
<td>CREFinfb</td>
<td>41088773</td>
</tr>
<tr>
<td>CREF Money Market Account</td>
<td>CREFmony</td>
<td>41081993</td>
</tr>
<tr>
<td>CREF Social Choice Account</td>
<td>CREFsoci</td>
<td>41081994</td>
</tr>
<tr>
<td>CREF Stock Account</td>
<td>CREFstok</td>
<td>41081995</td>
</tr>
<tr>
<td>TIAA Real Estate Account</td>
<td>TIAAreal</td>
<td>41091375</td>
</tr>
<tr>
<td>TIAA-CREF Bond Fund (Retirement)</td>
<td>TIDRX</td>
<td>4530828</td>
</tr>
<tr>
<td>TIAA-CREF Bond Index Fund (Retirement)</td>
<td>TBIRX</td>
<td>20739662</td>
</tr>
<tr>
<td>TIAA-CREF Bond Plus Fund (Retirement)</td>
<td>TCBRX</td>
<td>4530816</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets Equity Fund (Retirement)</td>
<td>TEMSX</td>
<td>26176543</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets Equity Index Fund (Retirement)</td>
<td>TEQSX</td>
<td>26176547</td>
</tr>
<tr>
<td>TIAA-CREF Equity Index Fund (Retirement)</td>
<td>TIQRX</td>
<td>4530786</td>
</tr>
<tr>
<td>TIAA-CREF Global Natural Resources Fund (Retirement)</td>
<td>TNRRX</td>
<td>39444919</td>
</tr>
<tr>
<td>TIAA-CREF Growth &amp; Income Fund (Retirement)</td>
<td>TRGIX</td>
<td>312536</td>
</tr>
<tr>
<td>TIAA-CREF High Yield Fund (Retirement)</td>
<td>TIHRX</td>
<td>4530821</td>
</tr>
<tr>
<td>TIAA-CREF Inflation-Linked Bond Fund (Retirement)</td>
<td>TIKRX</td>
<td>4530829</td>
</tr>
<tr>
<td>TIAA-CREF International Equity Fund (Retirement)</td>
<td>TNERX</td>
<td>302323</td>
</tr>
<tr>
<td>TIAA-CREF International Equity Index Fund (Retirement)</td>
<td>TRIEX</td>
<td>300269</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Growth Fund (Retirement)</td>
<td>TILRX</td>
<td>4530785</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Growth Index Fund (Retirement)</td>
<td>TRIRX</td>
<td>299525</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Value Fund (Retirement)</td>
<td>TRLCX</td>
<td>301332</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Value Index Fund (Retirement)</td>
<td>TRCVX</td>
<td>304333</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2010 Fund (Retirement)</td>
<td>TCLRX</td>
<td>302817</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2015 Fund (Retirement)</td>
<td>TCLRX</td>
<td>302393</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2020 Fund (Retirement)</td>
<td>TCLRX</td>
<td>307774</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2025 Fund (Retirement)</td>
<td>TCLRX</td>
<td>313994</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund (Retirement)</td>
<td>TCLRX</td>
<td>307240</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund (Retirement)</td>
<td>TCLRX</td>
<td>309003</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund (Retirement)</td>
<td>TCLRX</td>
<td>300959</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund (Retirement)</td>
<td>TCLRX</td>
<td>9467597</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund (Retirement)</td>
<td>TCLRX</td>
<td>9467596</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund (Retirement)</td>
<td>TCLRX</td>
<td>34211330</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2010 Fund (Retirement) Index</td>
<td>TLTRX</td>
<td>21066482</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2015 Fund (Retirement) Index</td>
<td>TLGRX</td>
<td>21066496</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2020 Fund (Retirement) Index</td>
<td>TLWRX</td>
<td>21066479</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2025 Fund (Retirement) Index</td>
<td>TLQRX</td>
<td>21066485</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund (Retirement) Index</td>
<td>TLHRX</td>
<td>21066435</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund (Retirement) Index</td>
<td>TLYRX</td>
<td>21066475</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund (Retirement) Index</td>
<td>TLZRX</td>
<td>21066473</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund (Retirement) Index</td>
<td>TLMRX</td>
<td>21066488</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund (Retirement) Index</td>
<td>TLLRX</td>
<td>21066490</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund (Retirement) Index</td>
<td>TTIRX</td>
<td>34211328</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle Income Index Fund Retirement (Retirement)</td>
<td>TRCIX</td>
<td>21066468</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle Income Fund Retirement (Retirement)</td>
<td>TLIRX</td>
<td>9467594</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Growth Fund Aggressive (Retirement)</td>
<td>TSARX</td>
<td>40508431</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Income Fund Retirement (Retirement)</td>
<td>TSCTX</td>
<td>40508433</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Growth Fund Retirement (Retirement)</td>
<td>TSGRX</td>
<td>40508437</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Income Fund Retirement (Retirement)</td>
<td>TLSRX</td>
<td>40508427</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Moderate Fund Retirement (Retirement)</td>
<td>TSMTX</td>
<td>40508460</td>
</tr>
<tr>
<td>TIAA-CREF Managed Allocation Fund Retirement (Retirement)</td>
<td>TITRX</td>
<td>4530825</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Growth Fund Retirement (Retirement)</td>
<td>TRGMX</td>
<td>305499</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Value Fund Retirement (Retirement)</td>
<td>TRVRX</td>
<td>315272</td>
</tr>
<tr>
<td>TIAA-CREF Money Market Fund Retirement (Institutional)</td>
<td>TIEXX</td>
<td>4530771</td>
</tr>
<tr>
<td>TIAA-CREF Real Estate Securities Fund Retirement (Institutional)</td>
<td>TRRSX</td>
<td>300081</td>
</tr>
<tr>
<td>TIAA-CREF S&amp;P 500 Index Fund Retirement (Institutional)</td>
<td>TRSPX</td>
<td>306105</td>
</tr>
<tr>
<td>TIAA-CREF Short-Term Bond Fund Retirement (Institutional)</td>
<td>TISRX</td>
<td>4530818</td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Blend Index Fund Retirement (Institutional)</td>
<td>TRBIX</td>
<td>314644</td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Equity Fund Retirement (Institutional)</td>
<td>TRSEX</td>
<td>299968</td>
</tr>
<tr>
<td>TIAA-CREF Social Choice Equity Fund Retirement (Institutional)</td>
<td>TRSCX</td>
<td>300078</td>
</tr>
<tr>
<td>TIAA-CREF Bond Fund Retirement (Institutional)</td>
<td>TIBDX</td>
<td>307276</td>
</tr>
<tr>
<td>TIAA-CREF Bond Index Fund Retirement (Institutional)</td>
<td>TBIIX</td>
<td>20739664</td>
</tr>
<tr>
<td>TIAA-CREF Bond Plus Fund Retirement (Institutional)</td>
<td>TIBFX</td>
<td>4530820</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| TIAA-CREF Emerging Markets
Equity Fund (Institutional)                                               |        | 26176540   |
| TIAA-CREF Emerging Markets
Equity Index Fund (Institutional)                                          |        | 26176544   |
| TIAA-CREF Enhanced
International Equity Index Fund
(Institutional)                                                               |        | 9467603    |
| TIAA-CREF Enhanced
Large-Cap Growth Index Fund
(Institutional)                                                              |        | 9467602    |
| TIAA-CREF Enhanced
Large-Cap Value Index Fund
(Institutional)                                                               |        | 9467606    |
| TIAA-CREF Equity Index Fund
(Institutional)                                                                 |        | 301718     |
| TIAA-CREF Global Natural Natural Resources Fund (Institutional)              |        | 39444916   |
| TIAA-CREF Growth & Income
Fund (Institutional)                                                            |        | 314719     |
| TIAA-CREF High Yield Fund
(Institutional)                                                                   |        | 4530798    |
| TIAA-CREF Inflation-Linked
Bond Fund (Institutional)                                                        |        | 316693     |
| TIAA-CREF International Equity
Index Fund (Institutional)                                                        |        | 305980     |
| TIAA-CREF International Equity
Index Fund (Institutional)                                                        |        | 303673     |
| TIAA-CREF Large-Cap Growth
Fund (Institutional)                                                              |        | 4530800    |
| TIAA-CREF Large-Cap Growth
Index Fund (Institutional)                                                        |        | 297809     |
| TIAA-CREF Large-Cap Value
Fund (Institutional)                                                              |        | 300692     |
| TIAA-CREF Large-Cap Value
Index Fund (Institutional)                                                        |        | 302308     |
| TIAA-CREF Lifecycle 2010 Fund
(Institutional)                                                                   |        | 4912376    |
| TIAA-CREF Lifecycle 2015 Fund
(Institutional)                                                                   |        | 4912355    |
| TIAA-CREF Lifecycle 2020 Fund
(Institutional)                                                                   |        | 4912377    |
| TIAA-CREF Lifecycle 2025 Fund
(Institutional)                                                                   |        | 4912384    |
### Suggerimenti e consigli utili su GnuCash

<table>
<thead>
<tr>
<th>Nome</th>
<th>Symbol</th>
<th>bogus</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund (Institutional)</td>
<td>TCRIX</td>
<td>4912364</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund (Institutional)</td>
<td>TCIIX</td>
<td>4912375</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund (Institutional)</td>
<td>TCOIX</td>
<td>4912387</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund (Institutional)</td>
<td>TTFIX</td>
<td>9467607</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund (Institutional)</td>
<td>TFIIX</td>
<td>9467601</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund (Institutional)</td>
<td>TTRIX</td>
<td>34211329</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2010 Fund (Institutional)</td>
<td>TLTIX</td>
<td>21066484</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2015 Fund (Institutional)</td>
<td>TLFIX</td>
<td>21066498</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2020 Fund (Institutional)</td>
<td>TLWIX</td>
<td>21066480</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2025 Fund (Institutional)</td>
<td>TLQIX</td>
<td>21066486</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund (Institutional)</td>
<td>TLHIX</td>
<td>21066495</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund (Institutional)</td>
<td>TLYIX</td>
<td>21066477</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund (Institutional)</td>
<td>TLZIX</td>
<td>21066474</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund (Institutional)</td>
<td>TLXIX</td>
<td>21066478</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund (Institutional)</td>
<td>TLLIX</td>
<td>21066492</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund (Institutional)</td>
<td>TTIIX</td>
<td>34211326</td>
</tr>
<tr>
<td>TIAA-CREF Retirement Income Fund (Institutional)</td>
<td>TRILX</td>
<td>21066463</td>
</tr>
<tr>
<td>TIAA-CREF Retirement Income Fund (Institutional)</td>
<td>TLRIX</td>
<td>9467595</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Aggressive Growth Fund (Institutional)</td>
<td>TSAIX</td>
<td>40508428</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Conservative Fund (Institutional)</td>
<td>TCSIX</td>
<td>40508425</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Growth Fund (Institutional)</td>
<td>TSGGX</td>
<td>40508434</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Income Fund (Institutional)</td>
<td>TSITX</td>
<td>40508450</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Moderate Fund (Institutional)</td>
<td>TSIMX</td>
<td>40508443</td>
</tr>
<tr>
<td>TIAA-CREF Managed Allocation Fund (Institutional)</td>
<td>TIMIX</td>
<td>4530787</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Growth Fund (Institutional)</td>
<td>TRPWX</td>
<td>297210</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Value Fund (Institutional)</td>
<td>TIMVX</td>
<td>316178</td>
</tr>
<tr>
<td>TIAA-CREF Money Market Fund (Institutional)</td>
<td>TCIXX</td>
<td>313650</td>
</tr>
<tr>
<td>TIAA-CREF Real Estate Securities Fund (Institutional)</td>
<td>TIREX</td>
<td>303475</td>
</tr>
<tr>
<td>TIAA-CREF S&amp;P 500 Index Fund (Institutional)</td>
<td>TISPX</td>
<td>306658</td>
</tr>
<tr>
<td>TIAA-CREF Short-Term Bond Fund (Institutional)</td>
<td>TISIX</td>
<td>4530784</td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Blend Index Fund (Institutional)</td>
<td>TISBX</td>
<td>309018</td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Equity Fund (Institutional)</td>
<td>TISEX</td>
<td>301622</td>
</tr>
<tr>
<td>TIAA-CREF Social Choice Equity Fund (Institutional)</td>
<td>TISCX</td>
<td>301897</td>
</tr>
<tr>
<td>TIAA-CREF Tax-Exempt Bond Fund (Institutional)</td>
<td>TITIX</td>
<td>4530819</td>
</tr>
<tr>
<td>TIAA-CREF Bond Fund (Retail)</td>
<td>TIORX</td>
<td>4530794</td>
</tr>
<tr>
<td>TIAA-CREF Bond Index Fund (Retail)</td>
<td>TBILX</td>
<td>20739663</td>
</tr>
<tr>
<td>TIAA-CREF Bond Plus Fund (Retail)</td>
<td>TCBPX</td>
<td>4530788</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets Equity Fund (Retail)</td>
<td>TEMRX</td>
<td>26176542</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets Equity Index Fund (Retail)</td>
<td>TEQKX</td>
<td>26176545</td>
</tr>
<tr>
<td>TIAA-CREF Equity Index Fund (Retail)</td>
<td>TINRX</td>
<td>4530797</td>
</tr>
<tr>
<td>TIAA-CREF Global Natural Resources Fund (Retail)</td>
<td>TNRLX</td>
<td>39444917</td>
</tr>
<tr>
<td>TIAA-CREF Growth &amp; Income Fund (Retail)</td>
<td>TIIXR</td>
<td>4530790</td>
</tr>
</tbody>
</table>
### Suggerimenti e consigli utili su GnuCash

<table>
<thead>
<tr>
<th>Nome</th>
<th>Symbol</th>
<th>bogus</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIAA-CREF High Yield Fund</td>
<td>TIYRX</td>
<td>4530830</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Inflation-Linked Bond Fund</td>
<td>TCILX</td>
<td>313727</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF International Equity Fund</td>
<td>TIERX</td>
<td>4530827</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Growth Fund</td>
<td>TIRTX</td>
<td>4530791</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Value</td>
<td>TCLCX</td>
<td>302696</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle Retirement Income Fund</td>
<td>TLRRX</td>
<td>9467600</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Aggressive Growth Fund</td>
<td>TSALX</td>
<td>40508429</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Conservative Fund</td>
<td>TSCLX</td>
<td>40508432</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Growth</td>
<td>TSGLX</td>
<td>40508435</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Income</td>
<td>TSILX</td>
<td>40508438</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Moderate</td>
<td>TSMLX</td>
<td>40508453</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Managed Allocation</td>
<td>TIMRX</td>
<td>4530817</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Growth</td>
<td>TCMGX</td>
<td>305208</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Value</td>
<td>TCMVX</td>
<td>313995</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Money Market Fund</td>
<td>TIRXX</td>
<td>4530775</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Real Estate Securities Fund</td>
<td>TCREX</td>
<td>309567</td>
</tr>
<tr>
<td>(Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Short-Term Bond</td>
<td>TCTRX</td>
<td>4530822</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Equity</td>
<td>TCSEX</td>
<td>297477</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Social Choice</td>
<td>TICRX</td>
<td>4530792</td>
</tr>
<tr>
<td>Equity Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Tax-Exempt Bond</td>
<td>TIXRX</td>
<td>4530793</td>
</tr>
<tr>
<td>Fund (Retail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Bond Fund (Premier)</td>
<td>TIDPX</td>
<td>21066506</td>
</tr>
<tr>
<td>(Premier)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIAA-CREF Bond Index Fund (Premier)</td>
<td>TBIPX</td>
<td>21066534</td>
</tr>
<tr>
<td>(Premier)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Suggerimenti e consigli utili su GnuCash

<table>
<thead>
<tr>
<th>Nome</th>
<th>Symbol</th>
<th>bogus</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIAA-CREF Bond Plus Fund TBPPX (Premier)</td>
<td></td>
<td>21066533</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets TEMPX Equity Fund (Premier)</td>
<td></td>
<td>26176541</td>
</tr>
<tr>
<td>TIAA-CREF Emerging Markets TEQPX Equity Index Fund (Premier)</td>
<td></td>
<td>26176546</td>
</tr>
<tr>
<td>TIAA-CREF Equity Index Fund TCEPX (Premier)</td>
<td></td>
<td>21066530</td>
</tr>
<tr>
<td>TIAA-CREF Global Natural TNRPX Resources Fund (Premier)</td>
<td></td>
<td>39444918</td>
</tr>
<tr>
<td>TIAA-CREF Growth &amp; Income TRPGX Fund (Premier)</td>
<td></td>
<td>21066461</td>
</tr>
<tr>
<td>TIAA-CREF High Yield Fund TIHPX (Premier)</td>
<td></td>
<td>21066501</td>
</tr>
<tr>
<td>TIAA-CREF Inflation-Linked TIKPX Bond Fund (Premier)</td>
<td></td>
<td>21066500</td>
</tr>
<tr>
<td>TIAA-CREF International Equity TREPX Fund (Premier)</td>
<td></td>
<td>21066466</td>
</tr>
<tr>
<td>TIAA-CREF International Equity TRIPX Index Fund (Premier)</td>
<td></td>
<td>21066462</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Growth TILPX Fund (Premier)</td>
<td></td>
<td>21066499</td>
</tr>
<tr>
<td>TIAA-CREF Large-Cap Value TRCPX Fund (Premier)</td>
<td></td>
<td>21066467</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2010 Fund TCTPX (Premier)</td>
<td></td>
<td>21066521</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2015 Fund TCFPX (Premier)</td>
<td></td>
<td>21066528</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2020 Fund TCWPX (Premier)</td>
<td></td>
<td>21066518</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2025 Fund TCQPX (Premier)</td>
<td></td>
<td>21066522</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund TCHPX (Premier)</td>
<td></td>
<td>21066527</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund TCYPX (Premier)</td>
<td></td>
<td>21066517</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund TCZPX (Premier)</td>
<td></td>
<td>21066516</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund TTFPX (Premier)</td>
<td></td>
<td>21066444</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund TCLPX (Premier)</td>
<td></td>
<td>21066526</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund TTRPX (Premier)</td>
<td></td>
<td>34211331</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2010 Fund (Premier)</td>
<td>TLTPX</td>
<td>21066483</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2015 Fund (Premier)</td>
<td>TLFPX</td>
<td>21066497</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2020 Fund (Premier)</td>
<td>TLWPX</td>
<td>21066434</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2025 Fund (Premier)</td>
<td>TLVPX</td>
<td>21066481</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2030 Fund (Premier)</td>
<td>TLHPX</td>
<td>21066494</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2035 Fund (Premier)</td>
<td>TLYPX</td>
<td>21066476</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2040 Fund (Premier)</td>
<td>TLPRX</td>
<td>21066487</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2045 Fund (Premier)</td>
<td>TLMPX</td>
<td>21066489</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2050 Fund (Premier)</td>
<td>TLLPX</td>
<td>21066491</td>
</tr>
<tr>
<td>TIAA-CREF Lifecycle 2055 Fund (Premier)</td>
<td>TTIPX</td>
<td>34211327</td>
</tr>
<tr>
<td>TIAA-CREF Retirement Income Fund (Premier)</td>
<td>TLIPX</td>
<td>21066493</td>
</tr>
<tr>
<td>TIAA-CREF Retirement Income Fund (Premier)</td>
<td>TPILX</td>
<td>21066470</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Aggressive Growth Fund (Premier)</td>
<td>TSAPX</td>
<td>40508430</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Conservative Fund (Premier)</td>
<td>TLSPX</td>
<td>40508426</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Growth Fund (Premier)</td>
<td>TSGPX</td>
<td>40508436</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Income Fund (Premier)</td>
<td>TSIPX</td>
<td>40508451</td>
</tr>
<tr>
<td>TIAA-CREF Lifestyle Moderate Fund (Premier)</td>
<td>TSMPX</td>
<td>40508456</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Growth Fund (Premier)</td>
<td>TRGPX</td>
<td>21066464</td>
</tr>
<tr>
<td>TIAA-CREF Mid-Cap Value Fund (Premier)</td>
<td>TRVPX</td>
<td>21066455</td>
</tr>
<tr>
<td>TIAA-CREF Money Market Fund (Premier)</td>
<td>TPPXX</td>
<td>21066469</td>
</tr>
<tr>
<td>Nome</td>
<td>Symbol</td>
<td>bogus</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>TIAA-CREF Real Estate Securities Fund (Premier)</td>
<td>TRRPX</td>
<td>21066459</td>
</tr>
<tr>
<td>TIAA-CREF Short-Term Bond Fund (Premier)</td>
<td>TSTPX</td>
<td>21066445</td>
</tr>
<tr>
<td>TIAA-CREF Small-Cap Equity Fund (Premier)</td>
<td>TSRPX</td>
<td>21066446</td>
</tr>
<tr>
<td>TIAA-CREF Social Choice Equity Fund (Premier)</td>
<td>TRPSX</td>
<td>21066460</td>
</tr>
</tbody>
</table>

Source: Comments in https://rt.cpan.org/Ticket/Attachment/1121440/589997/Tiaacref.pm.zip
Appendice B. GNU Free Documentation License

Versione 1.1, marzo 2000
Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other written document «free» in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of «copyleft», which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The «Document», below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as «you».

A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.

A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The «Invariant Sections» are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.

The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.

A «Transparent» copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.

The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies of the Document numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy of the Document, free of added material, which the general network-using public has access to download anonymously at no charge using public-standard network protocols. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.
4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

• A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

• B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has less than five).

• C. State on the Title Page the name of the publisher of the Modified Version, as the publisher.

• D. Preserve all the copyright notices of the Document.

• E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

• G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

• H. Include an unaltered copy of this License.

• I. Preserve the section entitled «History», and its title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled «History» in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

• J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the «History» section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

• K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

• L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

• M. Delete any section entitled «Endorsements». Such a section may not be included in the Modified Version.

• N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant Section.
GNU Free Documentation License

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some or
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified
Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled «Endorsements», provided it contains nothing but endorsements of your
Modified Version by various parties—for example, statements of peer review or that the text has been
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as
a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names
for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but
different contents, make the title of each such section unique by adding at the end of it, in parentheses, the
name of the original author or publisher of that section if known, or else a unique number. Make the same
adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled «History» in the various original documents,
forming one section entitled «History»; likewise combine any sections entitled «Acknowledgements», and
any sections entitled «Dedications». You must delete all sections entitled «Endorsements.»

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License,
and replace the individual copies of this License in the various documents with a single copy that is included
in the collection, provided that you follow the rules of this License for verbatim copying of each of the
documents in all other respects.

You may extract a single document from such a collection, and disribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works,
in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation is called an «aggregate», and this License does not apply to the other self-contained works thus compiled with the Document, on account of their being thus compiled, if they are not themselves derivative works of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License provided that you also include the original English version of this License. In case of a disagreement between the translation and the original English version of this License, the original English version will prevail.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation [http://www.gnu.org/lsf/lsf.html] may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License «or any later version» applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the Free Software Foundation.

Addendum

To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices just after the title page:

Copyright Cristian Marchi, 2011

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.1 or any later version published by the Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy of the license is included in the section entitled «GNU Free Documentation License». 
If you have no Invariant Sections, write «with no Invariant Sections» instead of saying which ones are
invariant. If you have no Front-Cover Texts, write «no Front-Cover Texts» instead of «Front-Cover Texts
being LIST»; likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.